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1.1 OVERVIEW

As one of the applications within the InEight portfolio of products, InEight Control is a project
management tool used for:

¢ Managing account codes

Measuring progress

Forecasting final man-hours and costs

¢ Managing revenue

Managing budget/contract changes

1.1.1 Account Code Management

Within InEight Control, you can define and assign account codes to your cost items. This association
can be synced to your ERP, and can also be used to benchmark data with other projects.

Control
Account Code
Management
ACS Register .
CBS Register

Define Qty
Contribution

1.1.2 Progress Measurement
InEight Control is the application where your Cost Breakdown Structure and budget are established
and where you can monitor project progress. You can:

e Import your conformed estimate and structure from InEight Estimate
¢ Create and manage cost items

e Import approved quantities from InEight Plan
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¢ Import final hours and costs from your ERP system
e Track your actuals and compare them against your Current Budget and earned values

The following workflow illustrates how these functions relate and pass information between systems.

Estimate

+ X
=] Conform Estimate /

WBS Structure

Control

Estimate

Progress
Measurement

) Final Hours and Costs
CBS Register
WBS Structure / Budgeted
Quantities & Hours Create & Manage
Cost Iltems
Analyze Planned
Earned and Actual Budget/Forecasts
Quantities

Plan

You can utilize this information to analyze trends, track productivity factors, and measure progress.

Tasks H
CBES Pos.. Description % Complete C B-Total C.. C B-Earned Total . Total Cost (To Date) C B-Total Cost G/L(T..
Infrastructure 0o 514,193.548.20 550,054.65 53.000.00
Maobilization 000 510.,794.00 50.00 50.00 50.00
L ‘West Screen Demelition 0.38 54.605.59 1. 7r2as $3,000.00 {81,227.13)
West - Removal-Conduit 0.34 53,000 aa 51

1.1.3 Forecasting

InEight Control provides options for forecasting final costs, man-hours, and productivity for your
project.
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i|

€8S position Description Resource Forccaat(170) UoM Forecnat final Forecast il Forecast final
[} _ Earthwork 5 1000000 CY § 400,000.00 800000
5] _ Concrete 6 10,000.00 CY $1,500,000.00 30,000.00
[} _ Structural Steel 100000 Ton §1,000,03571 2000071
5] 4 Erect Steel - Heavy 5 80000 Ton §800,000.00 16,000.00
=} 42 Erect Steel - Light 5 20000 Ton §200,000.00 4000.00
[} 43 Bolted Connections 8 200000 Ea $35.71 on

man
hours/Unit

20.00

20.00

20.00

Task details < esen > H Forecast | Created from Live forec.. ~ = { ove >
Forecast final
(=] productivity

factor

You can forecast your remaining work based on any of the following Forecast Methods:

Current Budget

Current Estimate

Average performance

Committed Cost

Manual Entry

1.1 Overview

You can save private forecasts, share them with others, and push them to a “live” forecast which can

be reviewed by all and used for official reporting. You can also compare the Live Forecast to other

forecasts created, for example to compare to the previous month’s forecast.

The workflow diagram below illustrates how forecasting functions relate to the rest of InEight Control

and other systems.

Forecasting

CBS Register Final Hours and Costs

Forecast Method
Setup

Live
Forecast Budget/
Forecasts

Forecasts

Quantities

InEight Inc. | Release 26.5
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1.1.4 Revenue Management

Within InEight Control, you can create and manage pay items for tracking pay quantities, actual and
forecasted revenue, and how much has been billed to the client.

Control

Forecasting

CBS Register

Forecast Method
Setup

Live

Forecasts
Forecast

Revenue Management

Change Management

Change Register Pay Item Register

Budget Move Create/Manage
Pay Items

Budget

Qty/MH
A Analyzed Planned & Forecast Revenue

Contract
Adjustment

Track Billed Revenue

1.1.5 Change Management

InEight Control allows you to manage changes to quantities, man-hours, and costs in each cost item as
needed during the execution of the project. You can make three different kinds of changes within the
Change Management register:
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¢ Budget move — Movement of costs between cost items where the total dollars moved must
balance to zero. There is no revenue associated with this type of change

¢ Budget quantity and man-hour adjustment — change to quantities or man-hours within the
project without changing costs

¢ Contract adjustment — both the budget and the revenue either increase or decrease and are not
required to be a net zero transaction. You will associate pay items with the change order to
reflect the revenue change

Approved changes update your Current Budget within the CBS register.

The below workflow shows the relationship of Change Management to the rest of InEight Control.

Control
CBS Register
A
|
— Approved changes Control
update Current Budget

Change Management

Change Register

Budget Qty/MH Contract Qty

Budget Move Adjustment Adjustment

Pay Items
. Pay ltems
Register

Below is an example of what the Change Register looks like in InEight Control.

Change Register

D CCo Issue # Description Type Discipline Total Budget § adjust
200 ao om Increase budget in the code for Plan and Progress Contract adjustment 1 54.800.00

210 Increase budget quantity for proper preduction factar Budget Oty&MH adjustment 1 50,00
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1.1.6 InEight Control Workflow

The following workflow illustrates how all the functions of InEight Control work together.

Estimate

+x
%8

Historical Benchmarking
Estimate Control
Conform Estimate / WBS Structure

Progress

Measurement Forecasting

Account Code
Management

CBS Register

Final Hours and Costs

ACS Register Create & Manage

Cost Items
Define Qty Account
Analyze Planned
Earned and Actual

Forecast Method

Setu
P Budget/Forecasts

) Quantities
Live

Forecasts
_ Forecast

WBS Structure / Budgeted
Quantities & Hours

— Approved changes
update Current Budget
I

Change Management

Change Register

Budget Qty/MH Contract Qty

Plan

Pay ltems

) Pay ltems
Register
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CHAPTER 2 —- GENERAL
NAVIGATION

2.1 Page Navigation ...
2.1.1 Navigate the InEight Control WorkspacesPage .....................
2.1.2Right Toolbar Overview ...

2.2WOrKSPACES .. ...

2.3 CBSregister ...

2.4 ACS register . ...l
241 ACS Navigation ... .

25Payltemsregister ... .
2.5.1 Pay ltemsregistercolumns ...
252MovePay ltems ... .

26 Change Register ... ... .

2.7 AuditLogregister ... .

2.8 Columns/Grouping/Sorting ...
2.8.1Resize columnwidth ... ..
2.8.2Move Columns ... ...
2.8.3SortColumns ... .
284 FilterColumns ...
2.8.5FilterIndicator ...
2.8.6 GrOUPING ...

29DataBIOCKS ...l
2.9.1 Data Block Categories ...
29.2ManageDataBlocks ... ..
2.9.3 Data Block ContextMenu ...
294 CustomDataBlocks ... .

210 VIeWSetS ...
2.10.1 Sending Views and DataBlocks ...

21T ROWDENSITY ..o

212 AUt LOQG ..o
2121 CBS
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2.2, 2 ACS 76
2.2 3 Pay Rems 77
2124 Integration ... 78
2.2 5 IMpPOrt NS OrY 79
213 Project Introduction ... 86

2.1 PAGE NAVIGATION

You can access Control within the InEight Cloud Suite using the link provided by your manager or
facilitator. To access Control, you must open a project by selecting Main menu > All projects &

organizations.

= X  Welcome Gabriela Truijillo

INEIGHT &

GT Gabriela Trujillo
Main menu

FAVORITES
C-XYZ

Road & Bridge Project | 106000

Steel Structure Training Job 2| 105...
st select a pro
SETTINGS Please selec

All projects & organizations

ii Master data libraries

Suite administration

Praofile

The All projects & organizations page opens to the Projects tab that shows all projects you are

associated with.
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All projects & organizations

2.1 Page Navigation

®

] Name Stat...
O 105091 Steel Structure Training Job Active
[ 105092 Steel Structure Training Job 2 Active
[ 105003 Steel Structure Tral 1Job 3 Active
O 105094 Steel Structure Partner Job Active
[ | 183850 Wards Island WWTP Active
[  BMSTest BMS Test New
[0  Heavy PM Estimate Heavy PM Estimate Active
[ | Training Job Training Job Active

Organization
C-XYZ
C-XYZ
c-Xvz
C-XYZ
C-XYzZ
Cc-X¥z
C-XYZ

C-XYzZ

PROJECTS

ORGANIZATIONS

Created by
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Brenda Steven
Jeremy cheek

sterling yazzie

Created on

08/31/2018 1:40:49 PM
08/31/2018 1:4412 PM
08/31/2018 1:44:46 PM
08/31/2018 1:45:25 PM
11/07/2018 8:02:08 AM
10/20/2020 1:55:15 PM
01/08/2019 1:33:34 PM

09/11/2018 10-28:37

Forecast duration

® Q

Original cantract ... Contract n []

You can search projects by clicking the Search icon at the top right of the page. This search function
searches all columns in the page.

All projects & organizations

®

1] Name Stat..
O | 105091 Steel Structure Training_Job Active
[ | 105092 Steel Structure Training Job 2 Active
OJ | 105093 Steel Structure Training_Job 3 Active
J | 105094 Steel Structure Partner Job Active
O | 183850 Wards Island WWTP Active
[ | BMSTest BMS Test New
[J | Heavy PM Estimate Heavy PM Estimate Active
[ | Training Job Training Job Active

Organization
C-XYZ
c-xvz
C-XYZ
c-xvz
C-XYZ
c-xvz
C-XYZ

C-XYZ

PROJECTS

ORGANIZATIONS

Created by
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Brenda Steven
Jeremy cheek

Sterling yazzie

Created on

08/31/2018 1:40:49 PM
08/31/201831:44:12 PM
08/31/2018 1:44:46 PM
08/31/20181:45:25 PM
11/07/2018 8:02:08 AM
10/20/2020 1:55:15 PM
01/08/2019 1:33:34 PM

09/11/201810:28:37 ...

Search.

Click a project name to open it. The project opens to the Project home landing page. In the Project

home landing page, you can access Control from the left menu.

Steel Structure Training Job 2 | 105092 ©

Model

@

Steel Structure Training Job 2 | 105092 / Proj

X

Add project image
Minimum of 540px x 360px

Document

@ Schedule

- Control

Waorkspaces

Project library

Plan

Quantity tracking

InEight Inc. | Release 26.5

home

& Links

Organization
Learn.InEight

InEight University

Project
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2.1.1 Navigate the InEight Control Workspaces Page

In the Project home landing page, under Control, click Workspaces to open the Workspaces module.

E {2t Steel Structure Training Job 2| 105092 / Project ho

Add project image
Minimum of 540px x 360px

Steel Structure Training Job 2 | 105092 @

@] Model o
=

Document
@ Schedule

Control

| Workspaces

Project library

L;‘J Plan

Quantity tracking

/ Control / Workspaces

& Training Jol @ L C
6
e e s ACs PAY ITEMS CHANGE! D e View : | ce+ce v

pons v ® @= > s m v & = Q
Y - - - o
0 Tasks H REEEENS < eoee > z | Current estimate
3/ CBS. Description Resources Forecast UoM CE total MHrs CE total cost
(m] position phase (T10) qty
code
o II| Job Overhead 1002 | 100 LumpSum | 0.00 $31250 *
1Y O N o 1069 Is 1000000 CY | 800000 $400,000.0¢
o |I| Concrete 107 Is 1000000  CY 1 30,000.00 $1,500,000.00

Overview - Control Workspaces Page

1 Left Navigation Opens a side panel where you can quickly access pages across the
Menu InEight Suite, such as settings, favorite projects, and other InEight
applications.
2 Home Menu Returns to the Organization or Project home landing page.
3 Help Menu Opens a window where you can quickly access eLearning courses,
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10

11

12

2.1 Page Navigation

Overview - Control Workspaces Page (continued)

User Profile

Right
Navigation
Menu

Tabs

Viewset Menu

Actions Menu

Left Toolbar

Right Toolbar

Side Toolbar

Register
content

Knowledge Library topics, and training videos.

Access your User Profile and update preferences such as language
and number formats.

Opens a side panel where you can quickly access project-specific
pages and applications.

Navigate to the CBS (Cost Breakdown Structure), ACS (Account
Code Structure), Pay items, Change Register and Audit Log pages.

Display different preset views and manage custom viewsets.
Select available actions for the current register tab you are viewing.

Contains commonly-used buttons to make changes in the register. In
this case, Add is used to add cost items, Edit to edit cost items, and
Delete to remove a cost item from the project.

Contains functions for the register page you are currently viewing.
(Additional information shown below).

Contains options for filtering the register and indicators for filtering
and sorting.

Displays page content in rows and columns, grouped together in
customizable data blocks.

2.1.2 Right Toolbar Overview

The right toolbar allows you to use functions for the register page. The toolbar options change

depending on which tab you select (CBS, ACS, Pay Items, Change Register, or Audit Log). The right
toolbar is commonly used for the CBS register page. The following image and table show the right

toolbar functions:

InEight Inc. | Release 26.5
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0G

View . CE+CB v

m O b =

Overview - Workspaces Page CBS Tab - Right Toolbar

1 Group Columns Group rows of the cost breakdown structure by like information from

2 Undo

3 Display
Currency

4  AddData
Block

5 Import

6 Export

7  Row Density

8  Find

Page 34 of 632

selected columns.

Access a list of entries from the current day and select specific entries
to undo.

Display currency in the CBS as entered or as the project default
currency.

Open a panel where you can manage data blocks and add data blocks
to your view.

Import cost item data from an Excel File.

Export your register view to an Excel file. Only the data blocks
currently displayed on the page will be exported to the file.

Adjust the line height at which the register content is displayed.
Choose between Relaxed, Narrow, or Tight.

Find value in register content by selecting a data block column,
selecting either the Begins with or Contains criteria, then entering the
value to search for.
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2.2 WORKSPACES

The Workspaces page is the main space where you do most of your project management tasks such as
tracking progress, managing budget changes, and forecasting. The Workspaces page lets you access
different areas of project tracking in the CBS, ACS, Pay Items, Change Register, and the Audit Log
register tabs.

2.3 CBS REGISTER

When you open Workspaces, you land on the Cost Breakdown Structure (CBS) tab by default. The CBS
is the main tab where you manage and track progress of your cost items that make up the cost
breakdown structure of your project. You can manage items such as:

e CBS structure — Use the CBS position column to view the hierarchy of your superior and
subordinate cost items. You can move cost items to adjust their position within the cost
breakdown structure.

¢ Color code hierarchy — You have the option to differentiate your CBS structure by color. Click
on the Tasks data block ellipsis to select Color-coded CBS position and Color-coded terminal
items to help you identify the position level of the hierarchy where a specific cost item is located.

¢ Add, edit, and delete cost items — Easily add, edit, or delete superior and subordinate cost

acs PAY ITEMS CHANGE REGISTER AUDITLOG Cost categonies -
potons v @ B 9 $ m I B = Q
A 4 . " .
Tasks £ || Taskdetails S osen > H
v e8S Description WBS phasa Resourcas Foracast (1/0) Uoh Actual labor Actual Actual FOM Acwal Actual
] position code aty cost (to date) construction rented supplies cost materials co
- equipment ‘equipment (to date) (to date)
a
i':? (] PURCHASE CLEAR DIE. 646 000 & KS $0.00 $0.00 $0.00 So00
(] PURCHASE GASOLINE 647 000 & KS $0.00 $0.00 $0.00 So00
(] MAINTENANCE ST&S 648 000  KS $0.00 $0.00 $0.00 $000
(] LUBE TRUCK 649 000  KS $0.00 $0.00 $0.00 $000
(] MAINTENANCE HAZAR. 650 000 PLS $0.00 $0.00 $0.00 $000
O 8. SALES TAX-EQUIPMEN. 651 125671083  KS $0.00 $0.00 $0.00 $000
o © 8. Equipment Fuel 652 100 Gal $000 $0.00 $0.00 S000
o & Diesel On-Road 653 100 Gal 5000 5000 $0.00 s000 .
o &  Diesel Dyed 654 100 Gal 5000 5000 $0.00 s000
=] 8. Gasoline 655 100 Gal s000 5000 $0.00 s000
(m] 8. UTILITIES CONSTRUCT. 656 000 A PLS $000 $000 $0.00 $o00
(m] 8. RAILROAD PROTECTIV. 657 134443000  K$ $000 $000 $0.00 $o00
O B STRUCTURES ADDLB. 658 134443000 PLS $0.00 $0.00 $0.00 So00
O 8 Project Management 659 000 PLS $0.00 $0.00 $0.00 So00
(] 8 Staff Expenses 660 000  PLS $0.00 $0.00 $0.00 $000
-
Subtotals 1359 $7,558,833.03 $BT4713.54 soo0 $38,238168.41 $10820
. L4
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For more information, see Cost Item Overview.

2.4 ACS REGISTER

Control User Guide

The Account Code Structure (ACS) is where you can view and manage account codes at the project
level. You can view the account codes assigned to your cost items. The related parent account codes,
account code details, and quantity contributors are also shown.

You can view other budget information that is automatically pulled into the ACS Details data block by
clicking the right arrow on the ACS details data block to view the additional panels. You can select from

multiple columns to view budget information such as:

e Total Cost
e Unit Cost

¢ Unit Rates

¢ Primary and Secondary Quantity Ratios

e Quantities Complete

e Account Code Tags

Actions =

ACS

37 Account code

)

A%
A~ 99.09
A 99.00.02
99.00.02.002
A~ 990004
99.00.04.002
A~ 990806

99.09.06.002

2.4.1 ACS Navigation

Descri...

Change Order.

Back charges

Back charges

Back charges...

Back charges

Back charges

Back charges...

Back charges

ACS details
Primary Qty
1.00000000000
0.00000000000
1.00000000000
1.00000000000
0.00000000000
1.00000000000
0.00000000000

1.00000000000

Primary UoM

PLS

PLS

PLS

PLS

PLS

PLS

PLS

PLS

PAY ITEMS

Auto-quantit
(e Rl

0O 000 o0oooo

CHANGE REGISTER AUDIT LOG View | unsaved (Quantity Managem.. v
+ i
oOom B B = Q
Ceoo > | ACS qty contributors
Notes Forecast total cost Forecast total MHrs. Contribute Contribute
Primary to Primary to
Primary Secondary
% 3 $187,829,311.97999998927 3,535,755.04678499978
l% $187,829,311.97999998927 3,535,755.04678499978 O
% $209,963,377.59999999404 3,535,755.04678499978 O
B $200,963,377 50999999404 3,535,755.04678499978 O
l% (522,134,065.62000000104) 0.00000000000 O
% $200.00000000000 0.00000000000 O
% $0.00000000000 0.00000000000 D
% $0.00000000000 0.00000000000 O

The ACS tree lets you easily navigate up and down your ACS structure and provides a way to filter
down to a subset in the structure. Open the ACS tree slide-out panel by clicking on the ACS tree icon on

the side toolbar.

Page 36 of 632
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£ ACS PAY ITEMS CHANGEREGISTER Unsaved (Project Contrals) ~ w
Actions  w 0 Djf ﬁ E 1= Q
T acst =
ree " =
v Expandall % Collapse all 2 Account code Description Primary Qty
20 Job Related Overhead o Job Related Overhead 100
51 Grading

51 Gradin 1.00

61 Concrete ¢
~ 52 Metals 61 Concrete 10,000.00
#~ §2.03 Structural Steel and Connections ~ B2 Metals 0.00

~ §2.03.0 . rial St(_)
62.03.02 Structural Steel Industrial S, ~ 6203 Structural Steel and Connections 0.00
# 52.03.02.004 Structural Steel Industria(..)
62.03.02 Structural Steel Industrial Structures 600.00
62.03.02.004.02 Structural Steel Indust(..) - B

62.03.02.004.06 Structural Steel Indust(..) ~ 62.03.02.004 Structural Steel Industrial - Erect Stee! 600.00
62.03.02.006 Structural Steel Industria(_.) 62.03.02.004.02 Structural Steel Industrial - Erect Steel - Li 200.00
62.03.02.004.06 Structural Steel Industrial - Erect Steel - H... 400.00
62.03.02.006 Structural Steel Industrial - Bolted Connec. 2,000.00

Like the CBS color-coded hierarchy, you have the option to differentiate your account codes by color.
Click on the ACS data block ellipsis to select this option to help you identify at which level of the
hierarchy a specific account code is located.

2.5 PAY ITEMS REGISTER

You can manage pay items in the Pay Items tab in Control. Pay items typically represent the owner-
required deliverables a contractor must submit pricing for. In Control, pay items are used to distribute
the cost calculated in the Cost Breakdown Structure and all markup, fees or contingencies calculated in
the pay items. This allows the total estimate value to be distributed to a structure different from the
CBS.

You can group pay items in a hierarchy by utilizing the Position Code column.

In the Pay Items tab, you can manage your project’s pay items and their structure. The image and table
below show the Pay Items tab functions:
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PAY ITEMS

CHANGE REGISTER

AUDITLOG

Price

A o G =

Q|

Lock/unlock price

sync

Budget move and contract adjustment »

Steel - L

subtotals 3 (1 pay items selected)

Earthwork -...

(& Insert pay item B 1821002

(%) Delete pay item(s)

[@ Payitem details

2
2, Billed revenue details

&, il multiple pay items

ésg,sawl & $7508870

Current
pay qty

Current forecast
(1/0) aty

o Revenue snapshot:  Current revenue foreca

+ and drop it here to grou

p by that colur

UoM Curren
methe

000 Each Cost

000 Ea unitpri

st v

IBlHeddate 10/01/2015 to 06/13/2025 ml

Current revenue forecast o

May 2025
Change ord
April 2025 S

March 2025

February 2025

January 2025

]

2, Actual revenue detsils

$0.00

I ™ S

In the Actions drop-down menu, you can:
» Lock/unlock price - You can select to lock and unlock price and lock
project budget and price.

» Sync- You can select to sync pay items, billed revenue, and forecast
revenue with other applications.

» Budget move and contract adjustment - You can selectto do a
budget move, budget quantity and man hour adjustment, and

contract adjustment.

Upper left toolbar actions:

» Add and delete pay items
e Claim revenue

* Move to - Move pay items within the structure using another pay item
position, number, or description.

Upper right toolbar actions:

the register.
» Find - Search scope items.

Filter - Create a query filter in the query builder.
Sorting - Sort in ascending or descending order.
Import and Export - Import and export sets of data.
Row density - Select from relaxed, narrow, or tight row density on

You can select from the default Revenue and Price views. You can create

new views, save updated views, and rename and delete custom views.

Actions
2 Toolbar
actions
3 View
4 Revenue
Page 38 of 632

You can view snapshot data for past periods. When the Enable manual

InEight Inc. | Release 26.5



Control User Guide 2.5 Pay ltems register

T T

shapshot snapshots option is turned on in the project's Project Tracking settings,
you can also create a manual snapshot using the Take revenue snapshot
option from the drop-down list and the Take snapshots options in the
Actions drop-down menu.

5 Billed date Filter the revenue data based on a selected time frame of billed dates to
filter apply to columns based on the billed date. To reset the filter, click the
Calendar icon, and then select To date.
When you use the Billed date filter, the To date option includes all bills and
all cost item actuals. Selecting a date range filters to bills and actuals only
within that date range.

6 Right-click Right-click a pay item to do the following:
menu ¢ Insert pay item
options « Delete pay item(s)
» View pay item details
* View billed revenue details
 Bill multiple pay items
» View actual revenue details

2.5.1 Pay ltems register columns

There are multiple columns available in the Pay Items register where you can easily view and manage
cost item data. You can use the pre-defined Revenue and Price views to load revenue or price-relevant
columns. You can also use the Column Chooser feature to manage columns and then save your custom
defined view.

Key columns shown in the register relate to your budget and revenue.

2.5.1.1 Revenue forecasting columns

Data in these columns help you understand the projected revenue and health of your project. For
more information, see Revenue forecasting columns.

2.5.1.2 Change management columns

When integrated with InEight Change, you can view project changes such as budget moves that involve
items like quantity, man-hour, and contract adjustments. Data in these columns let you view the
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number of change orders and amounts, providing greater visibility to track the progress of the project
and better manage costs.

c8s Acs PAY ITEMS CHANGE REGISTER AUDIT LOG V' Unsaved (Revenue) -

Actions ¥ ® ® & [EMoet $ v O G = Q

Revenue snapshot: Cumentrevenue forecast ¥ Billed date: 0514/2025 to 11/2472025 [

+ Pay item Pay item Description Current price Revenue Current Is Change order Billed Billed change Total change Billed P
position number forecast billing billed revenue order amount order amount aty €
method
a
1 Fixed final pri. $7506000  Default Fixed final price (m] @ @ $0.00 $0.00 §60.00 000 g
1 1 15t Mobilization Paym. $10,200,00000 Default Unit price (m] $0.00 $0.00 $0.00 0.00
1 1 1st Mobilization Paym... $10,200,00000 Default Unit price (m} $0.00 $0.00 $0.00 0.00
2 Unitprice~F..  Unclassified Excavation $50006000 Default Unit price [m] @ o $0.00 $0.00 $60.00 0.00
0 2 2z 2nd Mobilization Paym $11,700,000.00  Default Unit price (m] $0.00 $0.00 $0.00 000
2 2 2nd Mobilization Paym. $11,700,00000  Default Unit price (m) $0.00 $0.00 $0.00 0.00
0 3 3 Punchlist Completion $2,000000.00  Default Unit price (m] $0.00 $0.00 $0.00 0.00
~3 3 Punchlist Completion $15006000 Rollup (m] $8,100.00 $0.00 $60.00
31 Fixed final pri. $150,060.00 Default Fixed final price @ $8100.00 $0.00 §60.00 2000 !
~d 4 Final Acceptance Miles. $325000  Rollup (m] §750.00 $0.00 $16,000.00
. >
Subtotals 1068 (1 pay items selected) $1,030927.345.96 $8850.00 $0.00 $44,760.00 $

The following are key Change columns in the Pay Items register:

¢ Change orders — View the change order number, which helps you in associating the change
order or contract adjustment.

¢ Billed change order amount — Amount billed to a customer from an actual change order.

¢ Total change order amount — Shows how much of a pay item’s price is from change orders.

2.5.2 Move Pay ltems

You can reorder pay items on the Pay Items tab. Use the Move to button to rearrange pay items into
superior, equal, or subordinate positions.
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1. Select the pay item(s) to be moved, and then click Move to.

CBs ACS

Actions = @ ® é, Move to

Drag a column he

%7 Pay item position Pay item Description Curr... Curr... c

O number price unit p

price q
O 23 23 Install Double Yellow Line $1.584.00 $3.00
O 24 24 Grind and Install Double Yell... § 28250 $0.50
75 25 Install Yellow Dashed and S $162.00 $0.30
O 26 26 Grind and Install 12-inch So. $ 665.00 $19.00
O 27 27 Grind and Install Directional... $5,800.00 $725.00
28 28 Install 4-inch Solid White Li $ 27450 $0.30
O 29 29 Grid and Install 4-inch Solid... $518.75 $1.25
30 30 Install 8-inch Solid White Li $60.00 $ 060
M 31 31 Grind and Install 8-inch Soli... §1.185.00 $3.00

2. Enter the pay item position, pay item number, or the description. Select the correct pay item
from the drop-down options. This is the position that the selected pay item will be moved to.

Actions - @ ® ‘1337 23 O

23 - 23 - Install Double Yellow Line @

3. Click the Move to icon.

23 - 23 - Install Double Yellow Line| | ©

4. To move the selected pay item(s) to an equal position, select Sibling. To move the pay item(s)
into a subordinate position, select Child.

Move to 23 as: = Child = Sibling @
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To move a pay item into a child position, the parent pay item must have a value of 0 for
billed revenue, billed quantity, and current price, and no cost items can be assigned to it.

5. The selected pay item(s) will now show in the new position.

CBs ACS

Actions = @ ® @G, Move to

3 Pay item position Pay item Description Curr... Curr...
O number price unit
price
O 23 23 Install Double Yellow Line $1,584.00 $3.00
24 25 Install Yellow Dashed and S... $162.00 $0.30
25 28 Install 4-inch Solid White Li... §274.50 $030
26 30 Install 8-inch Solid White Li... 5 60.00 5060
O 27 24 Grind and Install Double Yell . $28250 5050

2.6 CHANGE REGISTER

In the Change Register tab, you can review the details of contract adjustments and budget moves, and
either revise, reject, or approve the changes (with the applicable permissions).

Page 42 of 632 InEight Inc. | Release 26.5



Control User Guide

2.7 Audit Log register

cBs Acs PAY ITEMS AUDIT LOG

Actions ¥ $ v B T = Q
) Description cco Creation Issue # Last Last Notes Status Total Total Total Type

date changed changed budget budget contract probabili.
by on cost MH price
a0 03/31/2023 Nathaniel Tures 03/04/2025 L] ©) Approved 566,741.2000. 000000000  $0.00000000 Contractadjus. 10000000000
430 03/31/2023 Nathaniel Tures 03/04/2025 & ? Revised $1.612,831.06. 000000000 $0.00000000  Contract adjus. 000000000 %
120 ora1/2028 Nathaniel Tures 02/0412025 B2 © Approved $126648.920. 000000000 $0.00000000 Contractadius.. 100.00000000..
a0 EWto ESDC 03/20/2023 Nathaniel Tures 02/04/2025 2 © Approved ($0.00000100) 15549125146 $0.00000000  Budget move
400 T&M Offset March 23 03/21/2023 Nathaniel Tures 03/04/2025 &2 () pproved ($ 28134268 0.00000000 $0.00000000  Contract adjus.. 100.00000000.
390 03/15/2023 Nathaniel Tures 03/04/2025 2 ©) Approved $0.00000000 6500000000  $0.00000000 Budget move
380 ‘Sheladia Budget Mo 03/15/2023 Nathaniel Tures 03/04/2025 & () approved ($ 3.764.5000. 7390993849 $0.00000000  Contractadjus_.  100.00000000.
a0 CSIE to Contingency 03115/2023 Nathaniel Tures 03/0412025 B (@) Approved ($24944.710.  -1,912.000000. $0.00000000  Contractadjus..  100.00000000...
61 03/21/2023 Nathaniel Tures 02/04/2025 2 © Rejected 427213600 000000000 $0.00000000  Contract adjus. 0.00000000 %
360 03/03/2023 Nathaniel Tures 03/04/2025 B 2 Revised $42,731 3600, 000000000 $0.00000000 Contractadjus.  0.00000000 %
30 03/03/2023 Nathaniel Tures 03/04/2025 2 ©) Approved 343,000,000 000000000  $0.00000000 Contractadjus_. 100.06000000.
340 03/03/2023 Nathaniel Tures 03/04/2025 B (@) approved $1.38563599. 986187317457 $0.00000000  Contractadjus_. 100.00000000.
331 0321/2023 Nathaniel Tures. 03/04/2025 B © Rejected (§ 367.35658. 0.00000000 $0.00000000  Contract adjus. 0.00000000 %
210 02/05/2023 Nathaniel Tures 03/04/2025 & 2 Revised (§ 367.35658. 000000000 $0.00000000  Contract adjus. 000000000 %
321 03/21/2023 Nathaniel Tures 03/04/2025 B © Rejected ($ 48113550, ©,00000000 $0.00000000  Contract adjus. 0.00000000 %
220 02/05/2023 Nathaniel Tures 03/04/2025 2 2 Revised (548113550 000000000 $0.00000000  Contract adjus. 0.00000000 %
a1 o Nathaniel Turss nanaimnrs ] O reiorred % onnmas na nonanann &0 naannann  cantract adiss 0 anannnan . ¥
Subtotals $20659689. 643494563 $0.00000000

For more information, see Change Approval Process in Change Management.

2.7 AUDIT LOG REGISTER

The Audit Log register tab captures changes that were made within InEight Control and is broken down
into five sub-tabs located on a left sidebar menu.

e CBS
e ACS
e Payitems

¢ |ntegration
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¢ Import history

Actions ¥

c8s

ACS

Pay items

Integration

Import history

CHANGE REGISTER AUDITLOG

c8s ACS PAY ITEMS

Audit 1D Datatype e type Description was Attribute
121534506 Actuals Cost Item KIEEngineering Sc_ 4447 Claimed Equipment
121534505 Actuals Cost Item Intercompany Auto_. 2082 Claimed Equipment
121534604 Actuals Cost item [=1) 2083 Claimed Equipment.
121534603 Actuals Cost item Miscellaneous Rev.. 2086 Claimed Equipment
121534602 Actuals Cost Item JOR Line Item 2000 Claimed Equipment.
121534601 Actuals Cost Item Miscellaneous Rev.. 2088 Claimed Equipment,
121534600 Actuals Cost ltem iDesign Review N4 Claimed Equipment,
121534599 Actuals Cost ltem AB - New Carrollto.. 1151 Claimed Equipment
121534598 Actuals Cost Item KIEFHV Protection 1174 Claimed Equipment
121534597 Actuals Cost Item sheladia ESDCDSUB 1612 Claimed Equipment
121534596 Actuals Cost Item SheladiaESDCFES 1616 Claimed Equipment
121534595 Actuals Cost item JAC Fire Protection.. 1028 Claimed Equipment
121534504 Actuals Cost Item Kim ASD - Cheverly 1080 Claimed Equipment
121534593 Actuals Cost Item NOTINUSE 1907 Claimed Equipment
121534592 Actuals Cost Item NOTINUSE 1908 Claimed Equipment
«

For more information, see Audit Log in General Navigation.

Changed by
InEight Service Acc.
Inight Service Acc.
Inight Service Acc.
InEight Service Acc.
Inight Service Acc.
Inight Service Acc.
In€ight Service Acc.
InEight Service Acc.
InEight Service Acc.
In€ight Service Acc.
Inight Service Acc.
InEight Service Acc.
InEight Service Acc.
InEight Service Acc.

InEight Serviee Acc.

Changed date

06/22/202511:05:

06/22/202511.05:

06/22/2025 1105

06/22/2025 1105

06/22/202511:05;

06/22/202511.05:

06/22/2025 1105,

06/22/202511.05

06/22/202511:05:

06/22/2025 1105

06/22/2025 1105,

06/22/20251105,

06/22/202511:05:

06/22/202511.05:

06/22/2025 1105

Y

Value before
106340000000
106340000000
10,634.0000000
10,986.0000000
11,626.0000000
11,626.0000000
11,659.0000000
125830000000
12,538 0000000
12,118.0000000
12,118.0000000
12,652 0000000
12,735.0000000
12,959.0000000

13,599.0000000

2.8 COLUMNS/GROUPING/SORTING

Control User Guide

= Q
Value after
10,648 0000000 i
10,648 0000000
10,648.0000000
11,000.0000000
11,640.0000000
11,640.0000000
11,673.0000000
12,597.0000000
12,552 0000000
12.132.0000000
121320000000
12,666.0000000
12,749.0000000
12,973.0000000

13,613.0000000

v

You can customize the columns on your pages according to your preferences. Changes made to

columns and filtering will be retained across projects each time you access Control.

2.8.1 Resize column width

You can resize the width of a column to let you view the data more clearly. To resize a column, select

the column border on the right, and then drag it to a new position.
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UoM % Ct
ﬁ- +||+

Lump Sum
CY

CY

Ton

Ton

To auto-fit the column to its contents, double-click the column border.
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I
UoM %

<[+

00  Lump Sum
o0  CY

00 CY

00  Ton

2.8.2 Move Columns

You can move a column from one place to another to customize your view using drag and drop.

To move a column, select the column header, and then drag and drop the column into a new position.
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Resour...

=1

=

Notice that two black arrows indicate the new position of the column.

+ UoM

t

1.00
10,000.00

10,000.00

IT... T Clarr UIT...

it pay ore...

ice q + UoM [T/0)
S7H98% ALY 0.00
291902 1.00 0.00
1,821,09_. 1.00 0.00

2.8.3 Sort Columns

UoM
 —

Lump Sum

CY

CY

UoM

Each

Each

Each

2.8 Columns/Grouping/Sorting

You can sort columns by clicking the column header. Click once to sort the column in ascending order.
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Description

N

000 - Specifications
31510-151-DRG-CC-013

Bolted Connections
Concrete

Concrete - Materials
Earthwork

Earthwork - Maternials
Erect Steel - Heavy
Erect Steel - Light

Job Overhead

Click the column header a second time to sort the column in descending order.
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Description

NV

Structure Steel - Materials
Sstructural Steel

Materials

Job Overhead

Erect Steel - Light

Erect Steel - Heavy
Earthwork - Maternals
Earthwork

Concrete - Materials

Concrete

To clear the sorting, click the column header a third time.
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2.8.4 Filter Columns

You can filter your column data to only show specific information you want to view. There are two
ways to set a filter:

2.8.4.1 Method 1: Filter from Column Header

You can set a filter for a column by clicking the Filter icon on any column header. This opens a drop-
down list of items you can filter by to apply to that specific column.

- ]
% complete ‘ | CE total MHrs CE total

0.0 Show items with value that:

21.3 Greater than v
6.9 . $
19.8 S

157 AND {Ii

16.3 Equal v
100.0 S
34.5 $
35.0 S

If you want to remove a single filter, locate the column you filtered, click the Filter icon, and then click
the Clear button.

Selecting the Filter icon will remove all the filters applied to the columns.
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2.8.4.2 Method 2: Filter by Query

You can also set a filter by clicking the Filter icon and selecting Query.

On the CBS and ACS tabs, the Filter icon shows on the side toolbar. On the Pay Items tab,
Change Register, and Audit Log, the Filter icon shows on the top right toolbar.

» ﬁ
w
» Query...

it

Mo saved queries

L 1 Job Overhead
2 Earthwork

The filter by Query option is helpful when you:
¢ Need to search for the column you need to filter
¢ Need to apply filters to more than one column

Selecting Query opens the Query builder slide-out panel, where you can set the filter criteria.

2.8.4.3 Query Builder

You can build a query using multiple criteria. Each criterion includes a column, an operator, and a
value. Use the AND/OR options to combine criteria and define how they relate to each other. The
following image and table show the Query builder functions:
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ﬂuery builder «

@ SR
o Columns e Operator: e Value:

Y
o @ Description v Contains hd Steel ®

@ AND e - Contains v ®e

I T ™

1 Filter icon Opens the Query builder slide-out panel.
2 Query Click the Save as icon to the right to input a name for the query. Open the
name query name drop-down menu to select a saved query.
3 Save Query Click the Save as icon to enter a name for a new query, and then click the
icons Save icon to save the query. Click the Delete icon to delete the saved
query.
4 Columns Open the Columns drop-down menu to select the column that the filter

criterion will apply to.

5 Operator Open the Operator drop-down menu to select the condition to be applied
to the selected column.

6 Value Enter the value you want to search for.
7 Addicon Click the Add icon to add another criterion to the query.

8 AND/OR Click AND/OR to define how the query criteria relate to one another.
options When you click here, the options toggle between “And” and “Or”.

9 Deleteicon Click the Delete icon to remove the criterion from the query.
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I T ™

10 Reset Click the Reset button to remove the filter criteria from the CBS and close
the Query builder.

11 Apply Click the Apply button to apply the filter criteria to the CBS.

2.8.5 Filter Indicator

On the CBS tab, in addition to the two filtering methods, there is also a Filter indicator on the side
toolbar. When a filter is applied, the Filter indicator turns yellow. Hover over the icon to view details of
the applied filters.

_

» % complete greater than 0

{Ij + UoM equal CY

— I
(] Erect Steel - Light
O 5.2 Concrete - Materi.

Clicking the filter icon will remove all of the applied filters.

2.8.6 Grouping

Several tabs in Workspaces let you organize your data into groups based on column. This is useful
when you want to view related records together, or if you want to see subtotal values by group.

InEight Inc. | Release 26.5 Page 53 of 632



2.8 Columns/Grouping/Sorting Control User Guide

Note that only columns with a discrete or predefined set of values such as categories, statuses, or units
of measure can be used for grouping.

Group Data by Column Values

1. From the right toolbar, click the Group columns icon. This opens the grouping area at the top of
the page.

[Z]® ¢ m o & = a

Drag a column header and drop it here to group by that column

Hide in Plan, Is termmal Committed Committed Actual qty (to
Progress, and remaining cost total cost late) MHrsIunlt (ta
Design date)

=] i $000 sooo | 0.00

On the Pay ltems tab, the grouping area is always open.

2. Select a column header, and then drag and drop it into the grouping area. Your data is now
grouped based on the values in that column.

Drag a column header and drop it here to group by t
+ Account code

B3
2 (ela
WES phase Account code Hide in Plan,
code Progress, and
Design
1002 Ez(] .
1069 I51 O

3. To create a subgroup, select another column header, and then drag and drop it into the grouping
area.
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Actions ¥ O]
v
Tasks H Current estimate
o gfssmnn Description ‘:«52 phase CE total MHrs CE total cost C
& Account code: (Count:13)
UoM: CY (Count:4)
o P2 Earthwork 1069 it 8,000.00 $400,000.00
O 3 Concrete 1071 H 30,000.00 $1,500,000.00
@] 51 Earthwork - Materials 1085 it 0.00 $250,000.00
[m] 52 Concrete - Materials 1086 H 0.00 $1,000,000.00
Count:4 38,000.00 $3,150,000.00
UoM: Ea (Count:1)
(m] 43 Bolted Connections 1006 H 1,246.00 §62300.00
Count:1 1,246.00 $62,300.00

4. To reverse the sorting of the groups, click the column header inside the grouping area.

e

Tasks

CBS Description
] position

UJ 43 Bolted Connectior

Count:1

UoM: Each (Count:1)

To rearrange the subgrouping, drag and drop a column header inside the grouping area into a
new position.
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| Account code

CBS Descript
(] position
) LJ 43 Bolted C

Click the Close icon on the column header to remove it from the grouping.

5. To remove the grouping on the page, click the Group columns icon again.

2.9 DATA BLOCKS

Each data block is a set of columns grouped together based on categories of information. Using data
blocks helps you organize and manage all the columns on a page.

Data blocks are customizable, and you can view them side by side and move them within the register.
The information in each data block shows in a grid-like format, maintaining a spreadsheet look and
feel.
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cBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
s+ @ 5§ & ¥
. . . ]
Tasks H Task details { o000 ) H Forecast | Greated from Live forec.. ~ F=
CBS position Description WBS Resource Forecast (T/0) UoM Forecast final Forecast final Forecast final
phase quantity cost MHrs
code hours/Unit
1 Job Overhead 1002 | 16 1.00 Lump Sum $695.00 11.00
2 Earthwork 1060] | 5 1000000 CY $ 400,000.00 8,000.00
3 Concrete wn]fe 1000000 CY $1,500,000.00 30,000.00
~4 Structural Steel 1073 100000 Ton $1.000035.71 2000071
41 Erect Steel - Heavy ] | s 80000 Ton $ 800,000.00 16,000.00
42 Erect Steel - Light 1005] | 5 20000 Ton $200,000.00 4000.00
43 Bolted Connections 1006] | & 200000 Ea $35.71 0
A5 Materials 1084 1.00 Each $1.750,000.00 0.00
51 Earthwork - Materials 108s] | 1 1000000 CY $250,000.00 0.00
52 Concrete - Materials 1086 ] | 1 10,000.00 €Y $1,000,000.00 0.00
53 Structure Steel - Mat 1087 100000 Ton $500,000.00 0.00
54 1 ana Trailer 1088 100 PIS s000 000
Subtotals 13 $4,650,730.71 58011.71

2.9 Data Blocks

View Forecasts -
o B = Q
< 000 >
Forecast final Forecast fina
productivity unit cost
11.00 0.00
0.80 1.00
3.00 1.00
20.00 105 $
20.00 1.00 $
20.00 1.00 $
0.00 1,400.00
0.00 0.00 $1.79
0.00 0.00
0.00 0.00
0.00 0.00
000 000

Each type of data block has its own unique default settings such as date range selectors and date

preset options (for financial periods). You can choose the total number of columns and panels for each

data block.

2.9.1 Data Block Categories

There are three categories of data blocks: Standard, Cost Category and Custom.

2.9.1.1 Standard Data Block

Standard data blocks include the following:
e Task Details
e Actuals
e Current Budget & Estimate
e Forecast
¢ Forecast Delta
e Live Forecast
e Schedule

You can customize the columns grouped within each of these data blocks.
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2.9.1.2 Forecast Data Block

When you add a forecast data block to your view, you are prompted to select the specific forecast to
show in this data block. You can create a new private or shared forecast or select an existing forecast.

Forecast

Create new

@ New private forecast

(3 New shared forecast

Recent

Name Last Viewed

Forecast - AC

Y

08/21/2025 8:48:59 AM

Created from Live forecast 08/21/2025 8:48:30 AM

[

08/21/2025 8:48:30 AM

. Project Forecast
2 08/21/2025 8:48:24 AM

o  Created from Live forecast 08/21/2025 8:47:54 AM
E-=3 08/21/2025 8:47:54 AM

See Forecast Management for more details on forecast data blocks.

2.9.1.3 Cost Category Data Block

The Cost category data blocks organize key project progress information by cost category, and include
the following:

Cost categories: Actuals

Cost categories: Current Budget

Cost categories: Current Estimate

Cost categories: Forecast

You can change the columns in Cost Category data blocks.

2.9.2 Manage Data Blocks

You can manage your data blocks by opening the Add data block slide-out panel. To open the Add data
block slide-out panel, click the Add data block icon.
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View : | CE+CB v

= O s m(b B = Q

In the Add data block slide-out panel, you can switch between Thumbnail view or List view.

2.9.2.4 Thumbnail View

Thumbnail view is the default view of the Add data block slide-out panel. In this view, data blocks are
shown as thumbnails.

To add a data block to your view, drag and drop it onto the page from the slide-out panel.

Add data block HH Tasks
ass
3/ CBS Description
Standard data blocks position
O 1 Job Overhead
;:1 W] 2 Earthwork
3 Concrete
Schedule
<€E‘> 4 Structural Steel
41 Erect Steel - Heavy
Cost category data blocks
[} 42 Erect Steel - Light
O 43 Bolted Connections
(] v 5 Materials
Custom data blocks O 51 Earthwork - Materials
(] 52 Concrete - Materials
O 53 Structure Steel - Materials

Create custom data blocks Subtotals 11

4 ——

To delete a custom data block, drag and drop it onto the Delete icon.
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Add data block as=
ass
Standard data blocks
Cost category data blocks
Custom data blocks
Committ
(%DCGSIS
Drag here
to delete ;
Create custom data blocks @

Note: You cannot delete preset data blocks.

2.9.2.5 List View

Click the List View icon to switch to List view.
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Add data block

Standard data blocks

2.9 Data Blocks

In this view, data blocks are shown in a list. You can search for a specific data block from the search

bar. You can also add a data block to your view by double-clicking it from the list.
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i

Add data block

Click to add a data block from the list
Task details
Actuals
Current budget
Current estimate
Forecast delta
Live forecast
Forecast
Schedule
Cost categories : Actuals

Cost categories : CB

Create custom data blocks @

2.9.3 Data Block Context Menu

The data block Context Menu allows you to perform different operations specific to the data block you
select.

Task details < eees > aciclo JERERRSEY | -
cl

hoose columns

Resource Forecast UoM MHrs
(T/0) . date)
guantity Filter

1.00° Lump Sum Save data block as. .

1000000  CY
Remove data block
1 1.00 Each
h 10,000.00 @ CY 0.00

The following table provides an overview of Context Menu options:
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Data Block Context Menu

Title Description

Choose columns Open the column chooser menu and move, add, and remove
columns from the data block.

Filter Filter data within a data block.
Save data block as Create a copy of the existing data block and save it.
Remove data block Remove the data block from the current view.

Color coded terminal ~ Add colors to terminal items of your current data block.
items
(Tasks data block

only)

Color-coded CBS Adds colors to all CBS lines.
position
(Tasks data block only)

Show/Hide WBS Display or remove the WBS Phase Code column within the Tasks
Phase Code data block.

(Tasks data block

only)

In the following step by step, you will learn how to modify a custom or an existing data block using the
Context Menu.

Edit a Data Block

1. In the CBS register, select the Context Menu icon of the custom data block you created.
2. Select Choose columns from the context menu.

3. Add a new column to your custom data block.
4

. Remove a column from your custom data block by selecting the header and clicking the left-
facing arrow to return it to the left column.
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CBS > Editdata block

@ Define title and type o Choose ani d customize columns

Actuals : Panel 1
ALPHABETICAL BY CATEGORY RECENT

T

Actuals - to - ]

Oty complee (to €8 MHrs G/L (to date) Total cost (to date)  CB total cost G/L (to
CE cost earned (to date) ZH) date)

CE cost expended % ¢ - 4—__—_

CE CPI

CE cost burn rate

5. To close the slide out panel, click the APPLY button on the bottom right of the slide out.

2.9.4 Custom Data Blocks

You can create a custom data block based on your needs. Custom data blocks can be organized by
color-coded type, and you can apply the same header functionality used in preset data blocks. Custom
data blocks can be added to your view or saved for future use.

Create a Custom Data Block

1. From the right toolbar, click the Add data block icon.

View : | CE+CB -

E O s |m|F L = Q

2. From the Add data block slide-out panel, click Create custom data blocks.
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2.9 Data Blocks

3.

Actions = @ Dﬁ ®

Add data block -

Standard data blocks

Task Actuals Current
details budget estimate

Forecast Live Forecast
delta forecast

Cost category data blocks

Cost Cost
categori categori
es:Act... es:CE

Custom data blocks

Committ
ed Costs

Create custom data blocks @

«

position

O

g 00000 ooooo

Subtotals 11

In the data block title field, enter a name for your data block.

InEight Inc. | Release 26.5
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CBS » Create new data block

° Define title and type (2)‘ Choose and customize columns

* Data block title Preview
Contracts

Contracts <o > H

* Data block type
® General

O Forecast

O Live forecast
O Forecast delta
O Actuals

O schedule

O Revenue

O Cost category
O Tasks

4. Under Data block type, select the type that best fits your data block.

The forecast, live forecast, forecast delta, and actuals data block types have unique
header features.

5. Click Next.

6. Add columns to your data block. You can add a column by double-clicking the column from the
left panel, or by dragging and dropping the column from the left panel to the data block preview
on the right.
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@ Define title and type o Choose and customize columns

ALPHABETICAL BY CATEGORY

contract

Actual ract cost (to date)

CB subcontract total cost
() CE subcontract total cost

(J CE subcontract unit cost

i [J Forecast remaining subcontract cost @

([0 Forecast subcontract total cost
() Number of contracts

(J OB subcontract total cost

Forecast remaining subcontract cost
Forecast remainina subcontract cost

right arrows.

NT

2.9 Data Blocks

General : Panel 1
oo >
Contracts

Actual subcontract B subcontract total
cost (to date) cost

You can also add or remove columns by selecting the column(s) and using the left and

Contracts

Actual subcontract CB subcontract total ¢
cost (to date) cost

7. You can reorder the columns from the data block preview by dragging and dropping columns

into a new position.
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General : Panel 1
Caed

Actual sub CB sub total {3 Forecast remaining (3 Forecast subcontract
cost (to date) cost subcontract cost total cost
+ Numberofconlrac@ <

8. When finished, click Save.

Custom data blocks can be managed from the Add data block slide-out panel.

Actions = @

Add data block H -

Standard data blocks

Cost category data blocks

Custom data blocks

Create custom data blocks @
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2.10 VIEWSETS

Once you have all desired data blocks organized to your liking, you can create a saved view of your
page so that you can always revert to it. This saved view is called a Viewset. The viewset can also be
shared with other users.

Create and Save a Viewset

1. From the CBS register page, click on the View drop-down arrow.

AUDIT LOG View Unsaved (Project controls) -

D $§ & Vv =N » = Q

2. From the Viewset drop-down list, select Save view as.

|
View - | Unsaved (Project controls)
@_ Progress
CE+CB

Cost categories
Project controls

Forecasts

Save view as

New view

3. Name your view [your initials] — Saved view.
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Save view as:

JP- Saved view

Cancel Save

4. Click Save.

2.10.1 Sending Views and Data Blocks

Certain permissions are needed to send views and data blocks to roles.

You can send views to all users that have a certain role. You can also send it to specific projects or full
organizations. To send to a project, you have to be a user on that project or in that organization.

1. With the Viewset selected and shown, from the Viewset drop-down list, select Send view.

2. Inthe Search for a User field, type an employee's name and select their name from the list.
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X

Send view (test danielle) ta

(IS -

s&nd 1o

Users

D

Mo users sslected
Raoles
N roles sebected

Projects

._I___?

1

Ho projects sclecked

Organizations

i
==

Wo organizations s=lecbed

Y Reditdi
=) Remave a

» To send to a project, you have to be a user on that project or organization. Then
select the Send View to drop down list and select the option you want.
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3. Click Send.

Send view (test danielle) to

R

Users

Ugers who have atceas 10 the organizatan

Ugers who have atceas o specalic role
Projecis

Users who have access o project
Oripan s

Usgers whio have aCcess (o an onganization o ".-.Iqﬁui.lé MIZATIAN

&

o projects selecten
DOrganizations

Mo arganizations selected

N Bhainin
:_' SMAavE i

Cancel

4. The selected Viewset will send a notification to the selected employee, and will be available in
their drop-down list with sender’s name and when the Viewset was sent.
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Wiew . fest daniele -

View sent by Sunilbabu G5

View sent one 08971 &/ 2020 ",

Budget Surnmanyy{1) &L
3 - -'I'.
|'I|I-III'||:I1.'I' |:'r Bul.-ll:IE| Elil-llll.lll-: lf_ I Lt
contrazts B
Budget Summang 1 | 10
Budget Summany{1) (i)

Y iEW miare k

If the user does not have the proper permissions to view all the columns in the view that was
sent to them, then the employee will only be able to view the columns for which they have
permissions.

2.11 ROW DENSITY

The row density feature allows you to change the spacing between rows within the various pages and
slide out panels in Control, allowing you to view your data with the amount of spacing you prefer.

There are three options available:
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¢ Relaxed

Tasks

e Narrow

CBS position

Tasks

e Tight

CBS position

Tasks

CBS position

Description

Job Overhead

Earthwork

Earthwork Review

Earthwork

Description

Job Overhead
Earthwaork
Earthwork Review
Earthwork

Concrete

Description

SJUL UVELNNSOU
Earthwork
Earthwork Review
Earthwork
Concrete

Structural Steel

Task details < eeee >

Resource

Forecast
(T/0)
guantity

1.00

10,000.00

1.00

10,000.00

Task details < eeee >

Rezource

Forecast
(1/0)
guantity
1.00

10,000.00
1.00
10,000.00

10,000.00

Task details < eese

Resource

Forecast
(T/0)
quantity

10,000.00
1.00
10,000.00
10,000.00
1,000.00

Control User Guide

UoM

Lump Sum

;Y

Each

CY

UoM

Lump Sum
cY

Each

cY

cY

UoM

Curnp sunn
cY

Each

CcY

CcY

Ton

The Row density icon is available on the CBS, ACS, Pay Items, Change Register, and Audit Log tabs.
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E O $ o B § (1] Q

When you select the Row density icon, a drop-down menu appears, where you can select the row
density (space between rows) you prefer.

Row density
Relaxed
Marrow

® Tight

The row density you select applies to all registers within Control, including all tabs and slide out panels
on the Workspaces and Project Library pages.

Row density is user-specific, so different users can apply different row densities within Control, and the
row density option you select will remain the next time you log in.

Row density is independent from the Viewsets you create. The row density you select is
therefore not saved as part of your viewsets.

2.12 AUDIT LOG

The Audit Log tab within the CBS register is used to capture changes that were made within InEight
Control and is broken down into five sub-tabs located on a left sidebar menu. Each log is designed to
capture the changes that happened within each of the different registers and during synchronization.

All five audit logs can be accessed by selecting the Audit log tab on the menu bar, then selecting each
individual audit log on the far left.
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Actions =

CBS

ACS

Pay items

Integration

Import history

Audit
1D

4871359
4871358
4871357

4871356

2.12.1 CBS

Data
type

CBS

CBS

CBS

CBS

Item
type

Cost ltem

Cost ltem

Cost ltem

Cost ltem

Desc

Concrete

Earthwork

Job Overh.

Structural...

WBS

1o

1069

1002

1073

ACS

Attrik

Schedule

Schedule

Schedule

Scheduled

Chan

by
Michael M
Michael M
Michael M

Michael M

PAY ITEMS

Chan
date

07/23/20

07/23/20

07/23/20

07/23/20

Value
befor

False

False

False

False

Control User Guide

CHANGE REGISTER AUDIT LOG

Value
after

True

True

True

True

Actuz
comp

You can access the CBS audit log by selecting CBS from the left side menu.

Forec
total
co...

Forec
total
co...

The CBS audit Log captures changes in the CBS register and utilizes an attribute field to identify what
type of change was made. Other columns include:

¢ Changed By (who made the change)

¢ Change Date (the date and time the change was made)

e The attribute value before and after

e Forecast cost before and after

e Forecast man-hours before and after

¢ Posting date before and after

CBS

ACS

Pay items

Integration

Import history

2.12.2 ACS

You can access the ACS Audit Log by selecting ACS from the left side menu.

Audit
ID

4871359
4871358
4871357

4871356

Data
type

CBS

cBs

CBS

CBS

Item
type

Cost Item

Cost Item

Cost Item

Cost Item

Desc WBS

Concrete 107

Earthwork 1069

Job Qverh.. 1002

Structural... | 1073

Attrik

Schedule

Schedule ..

Schedule

Scheduled

Chan

by

Michael M

Michael M...

Michael M

Michael M...

Chan
date

07/23/20

07/23/20...

07/23/20

07/23/20..

Value
befor

False

False

False

False

Value
after

True

True

True

True

The ACS Audit Log functions similarly to the CBS Audit Log, but contains the changes that were made
within the ACS (Account Code Structure) tab. The fields utilized to capture what changes were made

are:
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Change attribute

2.12.3 Pay Items

Changed By (who made the change)

Attribute value before and after

.

W e

Changed Date (the date and time the change was made)

.......

You can access the Pay Item Audit Log by selecting Pay Items from the left side menu.

Audit ID Data type
cBs
ACS 4873330 Pay Item
4872029 Pay Item
Integration 4872028 Pay Item
Import history 4872027 Pay Item

Item type

Pay Item

Pay Item

Payltem

Pay ltem

Deseription

Pay ltem 1

Pay item Attribute
No.

001

1

1

1

Billing Method

Pay item tag 8

Pay tem tag 6

Payitem tag 4

Changed
by

Renee Japp
Renee Japp
Renee Japp

Renee Japp

Changed Value
date before

07/26/2019 01 Cost Plus
07/24/2019 02:
07/24/2019 02:

07/24/2019 02:

Value after

Fixed Final Price

2.12 Audit Log

The Pay Item Log again functions similarly but contains changes that were made to the pay items. The

fields utilized to capture what changes were made are:

e Attribute

¢ Changed By (who made the change)

e Changed Date (the date and time the change was made)

¢ Value before and Value after

e Total price before and after
Audit ID Description Attribute Ebtl;anged SQ{ZHQEd \;:\Lgree Value after
1333638 Testing 07/31 Description paul trippi 07/31/201908: .  Test Testing 07/31
1333637 Testing 07/31 Sales Order paul trippi 07/31/2019 08 S1
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Total price
before

$1040.0000000

$40.000000000
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2.12.4 Integration

You can access the Integration/Sync Audit Log by selecting Integration from the left side menu.

Audit ID Interface Status Processing details Start Finish User name Log Handle
cBS

ACS 65639 ActualQty Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 4a229816-€aa6-431b-811

Pay items 65638 LiveForecast Succeeded 4ofd 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 ce90c8df-1916-4a50-847

Integration 65637 Budget Succeeded 4ofd 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 43b8dc1c-6825-413a-9c

Import history 65636 cBS Succeeded 4ofd 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 0985605a-745¢-4127-88

The Sync Audit Log is different from the other three. This log is used to capture:

¢ Whether the syncronization process between InEight Control and the ERP system was completed
successfully

¢ How long the sync process took to complete and who requested the sync
It keeps track of the functions performed under the Actions > Sync menu.
The syncing process will be discussed further in thel2.3 Audit Log - Integration on page 548.
To help troubleshoot sync issues, you can click the link under the Processing details column to get

more information on which steps succeeded, are suspended, or failed.

rﬁ} Last updated: 08/29/2018 01:03 PM
2 Use shorfcut key F5 to refresh status

Completed details - - Plan quantities pull: 31570

Step Status
Step 1: Recieving data Complete
Step 2: Populating data Complete
© 2018 InEight Inc. Privacy and Terms | v 18.3 INEIGHT

If a sync error should occur, you can click on the Log Handle link to obtain troubleshooting information.
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Log Handle

4a229816-€aa6-431b-811

ce90c8df-1916-4a50-847.

This brings you into the InEight Suite App Logs screen, where you can see information relating to the
error including Level, Time, Domain, Area, Exception Message, Exception Type and Correlation Id,
which can help you determine the cause of the sync error.

2.12.5 Import history

You can access the Import history audit log by selecting Import history from the left side menu.

The Import history log contains status information for all imports coming into all InEight products. For
example, cost item and actuals import processes can both be viewed in the Import history log for
status, then you can eventually make corrections and reprocess.

File name Status  Processi Total Errors Total dded

Py A Added Created Created st st
cBS Details line imported estimate pay
i ite

d La La
y by date edited edited

ms by date

AcS Market_St_9_8_17_GMP_Baseline.xer (Mark.. € Failed Step3 1842 0 0 0 0 ReneeJapp  07/24/20191.. ReneeJapp  07/24/20191

Pay items Market_St_9_8_17_GMP_Baseline.xer (Mark... € Failed Step3 1842 i 0 0 0 Renee Japp 07/23/20191... Renee Japp 07/23/20191

Integration Bookl xlsx »o 2 2 0 0 0 Renee Japp 07/12/20190... paul trippi 07/30/2019 0.

Import history Market_St_9_8_17_GMP_Baseline xer (Mark Cancelled  Step5 i i 0 0 0 Renee Japp 07/10/20190.. Renee Japp 07/23/20191

[¥

The Import history audit log allows you to take action on import and sync failures, based on error
messages. Error messages are contained within the error file for those imports that have failed import.

You can view progress in sync longs, view error messages, and then resolve issues in effort to continue

with your import.

Control — Audit Log

[ emm | SmEw

1 File name The name of the actual import file being used to import data.

2 Status The current status of the import file. There are six import status that
can define the current state of an import process.

3 Processing This column describes the processing state in which the file is being
Details processed. This column is not applicable for all statuses.

4 Total line This is the total line items that are included within the Excel import file.
items
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Control — Audit Log (continued)

T T S

5 Errors This is a count of the number of errors during import.

6 Total import This is the total amount of records that were successfully imported
from the Excel import file.

7 Added This is the total amount of added estimate resources that were added in
estimate the CBS.
resources

8 Added pay This is the total amount of pay items successfully imported from the
items Excel import file.

9 Created by This is user responsible for importing the Excel upload file.

10 Created date  This is the actual date the Excel upload file was imported.
11 Last edited by This is the last user to edit the Excel upload file.

12 Last edited This is the last date the Excel upload file was edited.
date

File name Status 2 Last Last
ate edited by edited
m date

Total line Errors Total Added Added pay Created by Created
ems importe imate items dat
NEWPROJ.xer (D.. /. Pend.. M@ step5 18 0 0 0 0 paul trippi 08/02/2019 12:1... paul trippi 08/02/2019 12:1...

NEWPRO.xer (D. Cancelled  Step5 0 0 0 0 0 paul trippi 08/02/201912:1... paul trippi 08/02/2019 12:1
NEWPROJ.xer (0. Cancelled  Step5 0 0 0 0 0 paul trippi 08/02/201912:0... paul trippi 08/02/2019 12:1

NEWPRO.xer (D. Cancelled  Step5 0 0 0 0 0 paul trippi 08/02/201912:0... paul trippi 08/02/2019 12:0.

If you hover over one of these Status symbols below, it provides you with a brief explanation of the
selected status.

Here are some examples:

Database update failed € Failed C

Import Cancelled
0 of 0 items contains errors Cancelled
d the import
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Import complete
842 items imported successfully

@ Complete
B

"v
3 4
o

Pending

00f 111 line items contain errors

"v
3 4
o

PP Continue Import
@ cancel @ Complete

2.12 Audit Log

There are six possible import statuses listed below.

Import history Statuses

Failed @ i

Failed with ==+
errors

"v
¥
(S}

Pending

Cancelled

Processing

Complete © comiee

Definition

Import failed due to a duplicate row within the
Excel file.

Import failed with an attachment to download
with further information.

The Excel import file is pending, further action
is needed. The double blue arrows will open a
new window where you can correct and re-
process the Excel import file. The blue circle
with the line through it will cancel the import
completely.

The Excel import file has been cancelled.

The Excel import is still processing. Once this
is complete, the status will move into one of
the other five statuses.

Processing of the Excel import files is
complete.

2.12.5.1 Pending status

When an import is in a Pending status, this means that further action is needed to complete the Excel

file import.

Pending Pp @

There are two options:

InEight Inc. | Release 26.5
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Option 1

Control User Guide

1. By selecting the double blue errors, you will be taken to another window to continue processing

the faulty records.

File name Status

CBS Import.csv

Pendin

s[mle

As an example, in the below screenshot, there are 3 existing errors. If you hover over one of the

errors, it will tell you what needs to be corrected.

In this case, there is an issue with the account code assignment, as the pop-up hover suggests.

Auditlog > Importhistory > CBS Import.csv

Status Details (& wBs phase code)

Import status CBS match status

Pending + 101002 [1] [Job Overhead]
Pending + 101069 [2] [Earthwork]
Pending + 101071 (3] [Concrete]
Pending + 101073 [4] [Structural Steell
Pending « 101074[4.1] [Erect Steel - H.
Pending + 101005 [4.2] [Erect Steel - Li
Pending + 101006 [4.3] [Bolted Connec.
Pending ' 101084(5] [Materials]

Error 101085 [5.1] [Earthwork - M.
Error + 101086 (5.2] [Concrete - Mat
Error V' 101087 [4.4] [Module 01 - Er

|3 errors remaini | [ Find next error ]

Import Columns A

Import method CBS position Description

Update existing items o... | 1 Job Overhead

Update existing items o... 2 Earthwork
Update existing items 0. 3 Concrete
Update existing items o... 4 Structural Steel
Update existing items o... 4.1 Erect Steel - Heavy
Update existing items o... 4.2 Erect Steel - Light
Update existing items .. 4.3 Bolted Connections
Update existing items 0.. 5 Materials
Update existing items o.. | 5.1 Earthwork - Materials
Update existing items o... 5.2 Concrete - Materials

Update existing items .. 4.4 Module 01 - Erect Steel

WBS phase code

1002

1069

107

1073

1074

1005

1006

1084

1085

1086

1087

Cancel

Account code

20
5

6

62.03.02.004.06

62.03.02.004.02

62.03.02.006

1112233

1112234 (<}
1112235 Value must match an existing account code €
1112236 [<]

2. When you double click into one of the 3 errors, it will take you directly into an account code

assignment screen where you can make the correction.

From here you can select an account code and click on Assign.
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Assign account code
Search
Select Account code
00
00.03

00.03.02

Description

Overhead.6233 EDIT

OH - Get Work

OH - Estimating

D) 00.03.02.002

00.03.02.006

00.03.02.008

00.03.02.010

00.03.02.014

00.03.02.016

00.03.02.018

OH - Estimating - Research & Qu_..

OH - Estimating - Prepare Estima...

OH - Estimating - Review (Pre-Bid)

OH - Estimating - Post Bid

OH - Estimating - Management

OH - Estimating - 2nd Estimates

OH - Estimating - Engineering (Pr...

UoM

PLS

MWk

MWk

MWk

MWk

MWk

MWk

MWk

MWk

MWk

Cancel

2.12 Audit Log

3. After all corrections have been made to the existing errors, you can select the Import button on

the top right on the screen.

Description

Job Overhead
Earthwork
Concrete

Structural Steel

InEight Inc. | Release 26.5

'WBS phase code

1002

1069

107

1073

Account code

20

51

61

Cancel
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4. A warning message appears stating that changes will be made, and this project will be disabled
until completion.

Importing cost items will update the CBS for all connected users, Notify all
users that changes need to be saved prior to continuing with import. Upon
commitment of import, this project will be disabled until completion
Please note this may take several mins,

Active Users -

bridgette quintero v

5. Once processing has finished, you will receive an Import complete message.

X

Import complete

The project has updated and is now enabled.

Close

6. The Import history page now shows that the imported file is now successfully imported and
updates the Last edited date.

File name Status Total line Errors Total Added Added pay Created by Created date Last edited Last edited
items imported estimate items by date
rrrrrrrrr

CBS Import.csv @ Complete n 0 0 0 0 Keith Anderson 06/19/201906:30 .. paul trippi 07/31/201910:32
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Option 2

1. Selecting cancel, the blue circle with the line through it, will cancel the import completely.

File name Status
CB5S Import.csv Pending E

2.12.5.2 Failed with errors status

When an import is in a Failed with errors status, the system will generate a Word error report. The
document displays detected errors while attempting to import the Excel file values. Errors will need to
be reviewed within the Word document

e Failed with errors 4

An example of the Failed with errors Word error file provides direction on how to proceed with
correcting the Excel import errors, and a course of action to run the import again
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Import actuals CBS data: CBS impeort.xls

File Import attempted on: 7/31/201% 3:45:03 BM

The fellowing errcrs were detected while attempting to import actual
values intoc control.

Review the errors below, cnce all the errors hawve been resoclwed,
reattempt the import to Centrol.

Errer l: Posting date in external system must be walid (this error
affects 10 WBS/CBS items cut of 10 total attempted imported WES/CBS items
and 10 rows cut of 10 total attempted imported rows)
WBS: 2804
CBS: 10
Row: 7
WBS: 2505
CES: 11
Row: 8
WES: 280§
CBES: 12
Row: 9
WBS: 2807

CES: 13
Row: 10

The only option with a Failed with errors status is to review the errors, resolve them within the initial
Excel file import, and then re-import the file.

2.13 PROJECT INTRODUCTION

You will be using the project titled “Steel Structure Training Job” for the InEight Control training.
Within this Control training, you will create cost items and other data that will be utilized in trainings
covering the other InEight products (Plan, Progress, etc.)

The project consists of the construction of multiple steel support platforms in a greenfield site. The
project scope ranges from site preparations, concrete foundation and footing pours, steel erection,
and bolted connections.
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by

Bb % y.d
.biy/q /—\
=7/ AW/A\

= >\ _._;__f_f

A — ___/_..
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North Area

0103105 |07 105 11113 [15] 17 |19 2123 25 |27 29

| 02 0406 |08 |10 112 |14 1618 |20 22|24 2628 | 30]

South Area

v
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CHAPTER 3 — COST ITEM SETUP

3.1 Costitem setup Workflow ... 90
3.2Cost Iltem OVervIeW .. . 91
3.2.1 Cost Breakdown Structure ... . 91
3.2, 2 CBS Tree . 94
3.23CostitemMenu ... 96
3.2.4 Costltem Dashboard ... ... . 97
3.3 C0St M 99
3.3.1 Costltem Creation ... 99
3.3.2Required Cost &M ... ... 106
3.3.3 Costltem Arrangement ... 108
3.3.4 Viewing the CBS Grouped by Column ... 110
3.3.5CostItem Deletion ... .. 111
3.3.6 Copying Cost ltems with Resources ... 113
3.3.7 Design total gty and Design total MHrs columnsinthe CBS ......................... 115
3.3.8 Create costitems in InEight Change ... 116
3.4 Hide in Plan, Progress, and Design ... 119
3.4.1 Hidefeatureina costitem ... 120
3.4.2 Hide feature inthe CBS Workspace ... 121
3.4.3Considerations ... . 121
3.5 Costltem EXcel Import .. 122
3.5.1 Forecast Excel Import ... 127
3.5.2Spreadsheet RUIES ... 128
3.5.3 Best Practices and Recommendations ... 130
3.5.4 CBS HierarChy . ... 130
3.5.5Resolving Import Errors ... 139
3.5.6 Excel Import for committed cost ... 140
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3.1 COST ITEM SETUP WORKFLOW

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress

Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

ACS Register Create & Manage

Cost ltems.
Define Qty. Account
Contribution Codes

Analyze Planned
Earned and Actual

Budget/Forecasts

Forecast Method
Setup Quantities

Live
Forecast

Forecasts

WES Structure / Budgeted
Quantities & Hours

roved changes
ﬁ’;ﬂm Currgntgﬂudgg{ Revenue Management

Billed Revenue

Change Management v |
change Register Pay Item Register
Budget Move Create/Manage
Pay Items

Budget
Plan Qry/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue

InEight Control is the application used to create and manage cost items. The cost breakdown structure
developed and maintained in Control is utilized by other InEight applications which inherently share
the same data set to eliminate duplicate data entry.
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Estimate

Control

InEi g ht WBS Structure

Estimate

WBS Structure Create & Manage
Cost ltems

InEight Plan

\I
-
1

Plan

3.2 COST ITEM OVERVIEW

3.2.1 Cost Breakdown Structure

The CBS (Cost Breakdown Structure) is the main tab of the Workspaces page in Control and is the tab

where you typically spend most of your time. Each row in the CBS represents a work activity and is

called a cost item.

InEight Inc. | Release 26.5
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Actions v ®
Y
Tasks

(m] v :);Egmm
[w] 1

& w] 2
[w] 3
=] v 4
[w] 41
=] 42
[w] 43
=] V5
[w] 51
=] 52
[w] 53
=] 6

Description

H RERCGEES

phase
code
Job Overhead 1002 H
Earthwork 1069 }}5
Concrete 107 }}5
Structural Steel 1073
Erect Steel - Heavy 1074 }}5
Erect Steel - Light 1005 }}5
Bolted Connections 1006 }}5
Materials 1084
Earthwork - Materials 1085 H]
Concrete - Materials 1086 H]
Structure Steel - Materials 1087 H
Merrill Iron & Steel - Steel Material 1088 1

PAY ITEMS
< eo00 >
Forecast UoM
(T/0) aty
100 Lump Sum
10,00000  CY
10,00000  CY
1,000.00  Ton
90000  Ton
20000  Ton
200000  Ea
100  Each
10,000.00  Ton
10,00000  CY
1,000.00  Ton
10000 Ton

CHANGE REGISTER

¢ B Current estimate

AUDIT LOG

CE total MHrs

0.00
8,000.00
30,000.00
23,000.00
18,000.00
4,000.00

1,000.00

View : | ce+cB -
O s m L B B Q
< eoo >
CE total cost CE MHrs/unit CE units/MHr
$250,000.00 000 000
$400,000.00 080 1.25
$1,500,000.00 300 033
$1,150,000.00 23.00 004
$900,000.00 20.00 005
$200,000.00 20.00 005
$50,000.00 050 2,00
$1,750,000.00 000 000
$250,000.00 000 000
$1,000,000.00 000 000
$500,000.00 000 000
$50,000.00 000 000

The CBS is organized in a hierarchy of superior and subordinate cost items. A cost item is superior

and/or subordinate based on its relationship to other cost items. This is similar to a parent and a child
relationship where an individual can be both a parent and a child at the same time. The CBS is color

coded to identify which level of the hierarchy a specific cost item is located.

O000o0o0o0odg

O 00O
o
W R
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Description

Job Overhead
Earthwork

Concrete

Structural Steel

Erect Steel - Heavy
Erect Stesl - Light
Bolted Connections
Materials

Earthwork - Materials
Concrete - Materials

Structure Steel - Matenals

1005

1006

1084

1085

10886
1087

Superior
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Tasks :
¥ ngm Deseription m
code

O IS sob Overhead 1002 Subordinate
O R oo 1069

O _ Concrete 107

O _ Structural Steel

O 41 Erect Steel - Heavy T

O 437 Erect Steel - Light 1

O 43 Bolted Connections 1

O _ Materials 10

] 51 Earthwork - Materials 1085

O 52 Concrete - Materials 1086

O 53 Structure Steel - Materials 1087

If a cost item has no subordinates it is considered a terminal cost item. Terminal cost items are where

cost is tracked. All superior items are a roll up of the budget, manhours, and cost of the cost items
below. Terminal items are identified with a special symbol located at the first column of each data

block.

position

0O0O0oo0o0ooou

H RERGCEES

Description WBS Resources )
phase
code y

Job Overhead 1002

Earthwork 1069

Concrete 107

Structural Steel 1073

Erect Steel - Heavy 1074

Erect Steel - Light 1005

Bolted Connections 1006

Materials 1084

This terminology and associated graphics provide a way to communicate and understand the hierarchy
of the Cost Breakdown Structure. The following table provides definitions for each of these terms.

Superior
Subordinate

Terminal

InEight Inc. | Release 26.5

Cost item that has subordinate subcost items that roll up under it.
Cost item that is a child to a superior cost item.

Cost item that has no subordinate beneath it. Costs and hours are
defined at the terminal level.
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As accurate as estimators try to build the estimate, changes occur during the project’s execution that

affect the CBS register in Control. To learn how to maintain, improve, and use the CBS register
properly, this topic focuses on the fundamentals of the Cost Breakdown Structure.

3.2.2CBS Tree

The CBS tree provides a way to navigate up and down your Cost Breakdown Structure and a way to
filter down to a subset of the structure.

You open the CBS tree slide out panel by clicking on the CBS Tree icon on the Side Toolbar.

Actions w O,
h

Tasks

GBS Descnption
position
[] 1 Job Overhead
F:'i [] 9 Earthwork
[] ] Concrete
] v 4 Structural Steel

When selected, the CBS tree icon turns yellow and the slide out panel appears.
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X

w
- CBS tree

Expand all Collapse all

1 Job Overhead
2 Earthwork
3 Concrete
4 4 Structural Steel
& 5 Materials
G
7 Equipment

Select Expand all to expand the entire Cost Breakdown Structure

Select Collapse all to collapse the entire Cost Breakdown Structure

Click on the arrow icons to expand a cost item to view its subordinates

Select a cost item and then click Apply to filter your view to that cost item and its subordinates

To clear the CBS filter, click the CBS tree icon and then click Disable

Actions b @

w

% CBS position

}

|

Edit CBS tree view...

Disable

You can select more than one cost item on the tree to create a customized view.
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3.2.3 Cost Item Menu

Control User Guide

You can access a variety of cost item details and actions from the Cost Item menu.

J 41 Erect d1eel - Heavy
] 42 Erect Steel - Light

43 Bolted Connections

a _ Materials

a 51 Earthwork - Materials

O 52 Concrete - Materials

()] 53 Structure Steel - Materials

O _ Merrill Iron & Steel - Steel Mat
O [ site & Demoiition

] 71 Selective Demolition

] T Site Demolition - Mobilization
O Tl Site Demolition - Building KL
a 7.4 Site Demolition - Footings & F
O 75 Site Demolition - Hard - Buildi
O 76 Site Demolition - Hard - Buildi
O 77 Site Demolition - Hard - Buildi
()] 78 Site Demolition - Driveway Ap

Subtotals 32 (1 rows selected)

4 ——

© 2025 InEight Inc. | | Terms & Conditions |

Privacy Statement

1wi4

Copy »

New cost item

New subordinate cost item

Delete cost items(s)

Adjust CBS position

Update Forecast (T/0) gt...

Cost item details

Actuals details

Change summary

Cost item dashboard

You can open the Cost Item menu in one of two ways:

¢ Right-click the cost item

¢ Click the three vertical dots in the Description column

O
O A3 Bolted Connections

42 Erect Steel - Light

1005

1006

1084

The following table provides details for the options in the Cost Item menu.

Copy cost item

Page 96 of 632

Copy the selected cost item with its associated resources.
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Copy selection Copy the value from a specific cell.
Paste Paste the copied content.
Insert copied cost items Insert the copied cost item in a CBS position that is above,

below, or subordinate to the selected cost item.

New cost item Create a new cost item.

New subordinate cost item Create a new cost item that is subordinate to the selected
cost item.

Delete cost item(s) Delete the selected cost item.

Adjust CBS position Move the selected cost item to a new position in the CBS.

Update Forecast (T/O) gty with Copy the total quantity of the associated component in

Plan component total qty InEight Plan to the Forecast (T/O) quantity of the selected
cost item.
Cost item details Open the Cost Item Details slide-out panel, where you can

manage the cost item.

Actuals details Open the Actuals Details slide-out panel, where you can
input claimed quantities and view actuals history and
commitments.

Change summary Open the Change Order Details slide-out panel, where you
can view associated change orders, the budget change
summary, and the change order summary.

Contract details Open the Contract Details slide-out panel, where you can
view associated contract details from InEight Contract.

Cost item dashboard Open the Cost Item Dashboard slide-out panel.

3.2.4 Cost Iltem Dashboard

The Cost Item Dashboard slide-out panel shows multiple cost item affiliated graphs. These graphs let
you further analyze cost item past and current performance trends related to time-phased distribution,
current budget changes, value over time, completion progress indicators, and a CBS audit history log.
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1074
Erect Steel - Heavy
Time phased distribution Current budget changes
$8K $14,000
.-.C
$6.4K .ot $11,200
OO.’
‘0
54.8K +* 8,400
l.‘
§3.2K $5,600
$1.6K ,.-O' $2,800

Aug-2021 Sep-2021 Oct-2021 Nov - 2021
tly Time phased budget Actuals Earned budget
1l; Time phased forecast «O» Time phased budget Actuals
Earned budget «Om Time phaszed forecast

Value change over time CBS audit log history

5900K 900
Ju' _

5720K 720
§540K 540 Jun
$360K 360
May
$180K 180
Apr
50 0

Cost
Apuenty

Oct-2020 Dec-2020 Jan-2021 Feb-2021 Mar-2021
CBqty Mar
Completion progress Feb
50% 1.00

. 6 8 10
0% 100% 0
0% -
castRemainingManH
% complete CBCPI - _built lock
1.00 1.00 B CBS - Forecast method

BS - Estimate Tag 2

A
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3.3 COST ITEMS

While most of your project structure typically imports from your estimating system, you may need to
adjust the Cost Breakdown Structure (CBS) to better reflect how the work will be executed in the field.
Additionally, contract changes or newly added scope may require updates. To accommodate these
needs, you can add, edit, and rearrange cost items as necessary.

If you need to build additional structure from the ground up, you can create new cost items manually.
This flexibility allows you to construct an entirely new project structure within Control — even starting
from a blank project if needed.

3.3.1 Cost Item Creation

In Control, you can create a new cost item in two ways:

* New Cost Item: Creates a new cost item at the same hierarchy level as the selected item, using
the next available number. For example, if you select 1.6, the new item will be 1.7 (if available).

¢ New Subordinate Cost Item: Creates a new cost item one level below the selected item, using
the next available number at that level. For example, if you select 1.6, the new item will be 1.6.x,
where x is the next available number.

When creating a new cost item, there are multiple fields available for populating the cost item details.
Not all fields are required; you can edit these details after the cost item has been created. The
following table provides more information on the available options.

| Fed | Reued | Demis

Description Optional Text field for the name or description of the cost
item.
Forecast T/O qty Required The Forecast Takeoff Quantity is the amount

of work or materials expected to be completed
for the cost item. This value can be updated as
project details progress.

UoM Required The Unit of Measure is the standard
measurement used to quantify the Forecast
T/O qty, such as linear feet, cubic yards, or
labor hours.
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el | Rewies | Dems

Cost source

Current Estimate
fields

Cost segment

Pay item
assignment

Account code

Live forecast
method

Page 100 of 632

Required

Optional

Required

Optional

Optional

Optional

Indicates how the cost item’s value is derived -
either as a Plug (a lump-sum amount) or as
Detail (built from associated quantities, rates,
or resources).

If available, input costs, unit rates, man-hours,
and/or equipment hours. Many of these values
are linked, and changes to these values will
update related values as well as the Current
Estimate total cost. Fields include CE total
cost, CE total MHrs, CE total equipment Hrs,
CE unit cost, CE MHr/Unit, CE Units/MHrs,
and CE labor cost/MHrs.

Categorizes whether the cost item is a direct or
indirect cost.

» Direct Cost - Costs that directly pertain
to the deliverables (pay items) of the job

» Job Overhead - Overhead costs
associated with running and managing
the job (e.g., management, jobsite
facilities)

» Business Overhead - Overhead costs
associated with running the business
(not directly related to running the job)

» Subcontract - Subcontract associated
costs

Select an existing pay item to associate to this
cost item.

Select an organizational account code for this
cost item.

Select how the live forecast is calculated for
this cost item. Forecast Method applies to
individual cost items and can be changed at
any time.
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| Fed | Reied | Demls

Allow as-built Required Determines whether you can enter actual
costs and quantities for a cost item.

* None - Cost item does not accept cost or
quantities. This is typically seen in
Superior cost items

» All - Allows a cost item to accept both
direct costs and quantities

» Quantities - Cost item only accepts
quantities

» Cost - Cost item only accepts costs, man
hours, and equipment hours

Quantity driver Required Defines how a cost item’s Forecast T/O qty is
controlled.

» Superior Cl - Automatically updates the
quantity based on changes to a parent
cost item using a proportional multiplier

» Fixed - Keeps the quantity constant
regardless of changes to related cost

items
Currency Required Select a currency unit for this cost item.
As-built lock Optional Select the checkbox to lock the ERP status for

this cost item. Once you lock the ERP status,
your ERP does not allow the cost item to be

progressed.
Hide in Plan, Optional Select the check box to make this cost item
Progress, and unavailable for claiming in InEight Plan,
Design Progress, and Design. For more information,

see Hide in Plan, Progress, and Design.

CBS contribute qty Optional Select the check box to add the Forecast (T/O)
gty of this cost item with any other selected
siblings to the superior (parent) cost item. Note
that the UoM must be the same for all cost
items.

Create A New Cost Item
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1. From the CBS tab of Control > Workspaces, click the Add Cost Item icon on the top left toolbar.

CBS
Actions = @
Y
Tasks

3 CBS Description Wg!
O position pha
cod
O Job Overhead 100
i':'i (] Earthwork 106

2. Select Create a new blank cost item, and then click Yes.

Are you sure you want to add a new cost item?

Inherit data from parent cost item

@® Create new blank cost item

¢ To specify the CBS position of the new cost item, first select an existing cost item from the
CBS, and then click Add Cost Item > New cost item.

3. The New cost item dialog box opens to the Details tab. Enter the cost item details as needed.
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New cost item

New cost item

(® Add new costitem

Forecast T/0 qty

1.00

DETAILS

ATTRIBUTES

CE unit cost

$0.00

CE total cost

$0.00

3.3 Cost Items

Description * Forecast T/0 qty *UoM WBS phase code
1.00 PLS -
« Cost source CE total cost CE total MHrs CE total equipment Hrs
Plug A $0.00 0.00 0.00
CE unit cost CE MHr/Unit CE Units/MHrs CE labor cost/MHrs
$0.00 0.00 0.00 $0.00

Cancel

4. When finished, click Save.

Create a New Subordinate Cost Item

1. From the CBS tab of Control > Workspaces, select the superior cost item.

CBS ACS
Actions = @ I_ﬁ ®
]
Tasks :
% CBS Description WBS
position phase
code
O 1 Job Overhead 1002
f:'i (] 2 Earthwork 1069
O g Concrete 107
~v 4 Structural Steel 1073
O 41 Erect Steel - Heavy 1074
(] 42 Erect Steel - Light 1005

2. On the top left toolbar, click Add cost item > New subordinate cost item.
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CBS

Actions W @' D& ®

Y New cost item

New subordinate cost item

— O v cp:EsSitinn

O Job Overhead
f:'i - Earthwork

O Concrete
J. 2 Structural Steel

)

FCennt C4aal Ilamina

3. Select Inherit data from parent cost item, and then click Yes.

Are you sure you want to add a new cost item?

@ Inherit data from parent cost item I

O Create new blank cost item

¢ Note that the fields in the New cost item window are populated with the existing data
from the selected cost item.

4. Modify the cost item details as needed.
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Structural Steel

Structural Steel

® Add new cost item

Forecast T/0 qty

1,000.00

Description

Structural Steel

* Cost source

Plug -

CE unit cost

$0.00

* Cost segment

Job Overhead -

DETAILS

« Forecast T/0 qty

1,000.00

CE total cost

$0.00

CE MHr/Unit

Pay item assignment

ATTRIBUTES

CE unit cost

$0.00

*UoM

Ton

CE total MHrs

CE Units/MHrs.

Account code

CE total cost

$0.00

WBS phase code
CE total equipment Hrs

CE labor cost/MHrs

None

Cancel

$0.00

5. When finished, click Save.

3.3.1.1 Create Multiple Cost Items

When you need to create multiple cost items, you can save time by including additional cost items in
the New cost item window. From the left panel, click Add new cost item to add another cost item

record.

Precast Concrete

New cost item

(®) Add new cost item

DETAILS

Forecast T/O gty UoM

1.00 PLS

To copy the details of a new cost item record, click the Copy cost item icon.
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Precast Concrete - Wall 20"x20"

Precast Concrete

Precast Concrete - . )

Forecast T/O qty
(+) Add new cost item

1.00

When you’re finished, click Save. The new cost items will appear in sequence in the CBS.

4.4 Precast Concrete Wall - 8" 1089 69.00 Ea
45 Precast Concrete Wall - 9" 1090 7100 Ea
46 Precast Concrete Wall - 20" 1091 100 Ea
47 Precast Concrete Wall - 20"X20" 1092 2900 Ea

3.3.2 Required Cost Items

The Required cost items feature lets you create standardized or commonly used cost items at the
organization level, and then add them at the project CBS level. Changing any of the required cost items
at the organization level, such as the account code or UOM, also updates the cost items at the project
level.

When required cost items are added in Settings > Control > Others > Required cost items, the feature
provides standardization across all projects for those cost items that are commonly used.
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{at 5100000 - I Seitings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE OTHERS
@)
® Required cost items @
® ©

n O Description = UoM Account code Allow as-built
& ] Foundation footers concreate 65656 EA None -
ij" m} Steel wire 5inch 9958925 EA None

JE? ] Synthetic wood rafters 98265 EA None

] Test_Copylnsert] 001 Bag None
= ] Test_Copylnsert2 022 Acre None -
4 >

This feature can be a substitute for copying and pasting cost items from one project into another and
ensures the same WBS phase code is being used regardless of the project a team member is working
on.

fat 103961 | Ten Mile Slide - Phase 2 (Carrying) / Control / Workspaces

CBS

Actions O]

el Torecasi me ription WES phase code Number of
contracts
Claim multiple CBS quantities
icial Results 1000
‘_:1 Budget move and contract adjustment »
Rev Internal 1103
Lock/unlock budget b
| Add required cost items Rev Internal 1104
sync > ation/Caontin... 1701
= | weneral Project Ri.. 1102
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3.3.3 Cost Item Arrangement

As the project progresses, you may need to rearrange cost items in the CBS to accommodate project
changes.

Move a Cost Item

1. Select the cost item(s) that you want to move.

2. Right-click the cost item(s) to open the cost item menu, and then select Adjust CBS position.

] v 5 Structural Steel Copy R
] 5.1 Erect Steel - Heavy

] 52 Erect Steel - Light

] 53 Bolted Connections

] v b Materials

B.1 Precast Concrete Wall - 8"

6.2 Precast Concrete Wall - 9"

6.3 Precast Concrete Wall - 20" ® Delete cost items(s)

6.4 Precast Concrete Wall - 20"X20" Ly Adjust CBS position

] 65 Earthwork - Materials

O 6.6 Concrete - Materials m Update Forecast (T/0) qt..

3. In the Adjust CBS Position window, drag and drop the selected cost item(s) into a new position in
the CBS.
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e This icon indicates that the cost item is moved into a subordinate position.

CBS ,  AdjustCBS Position

Move to
o ¥ CBS position Description 'WBS phase code
o I o:overhead 1002
O I certhwork 1069
[m] _ Concrete 1071
O _ Precast Concrete * 4items selected| = 1093
O _ Structural Steel 1073
[} 541 Erect Steel - Heavy 1074
[} 52 Erect Steel - Light 1005
O 53 Bolted Connections 1006
[m] _ Materials 1084
6.1 Precast Concrete Wall - 8" 1089
6.2 Precast Concrete Wall - 9" 1090
6.3 Precast Concrete Wall - 20" 1001
6.4 Precast Concrete Wall - 20"X20" 1092

e This icon indicates that the cost item is moved into an equal position.

Precast Concrete 1093
e o se.m,

(m] 51 Erect Steel - Heavy 1074
a 52 Erect Steel - Light 1005
[m] 53 Bolted Connections 1006
6.1 Precast Concrete Wall - 8" 1089
62 Precast Concrete Wall - 9" 1090
63 Precast Concrete Wall - 20" 1091
6.4 Precast Concrete Wall - 20"X20" 1092

¢ If you prefer not to use drag and drop, click the Move to icon. Input the applicable CBS
position, and then click Move to again. Select Child to move the cost item(s) into a
subordinate position, or Sibling to move the cost item(s) to an equal position.

1
CBS , AdjustCBS Position CBS >  AdjustCBS Position
Move to — | 4[1093] Precast Concrete (ag | 7))
¥ CBS position Description ¥ CBS position Description

4. Confirm the new position in the Adjust CBS Position window. When finished with the changes,
click Save.
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3.3.4 Viewing the CBS Grouped by Column

Navigating the CBS can be challenging when searching for specific information, as data is often
distributed across multiple levels. Projects may contain large volumes of diverse data, making it
difficult to locate and view relevant details- especially in a flat list format. The CBS Group By feature
helps simplify this by allowing users to organize the CBS into logical groupings based on shared
attributes. You can drag and drop column headers to group cost items by the criteria most relevant to
your workflow.

CBS Group by Column

1. On the CBS register tab, select the Group Columns icon on the right toolbar.

AUDIT LOG View : | cE+CB A

B9 $§ m O [ &= Q

- Current estimate C o0 )

2. Drag the column header of a column and drop it into the grey grouping area.

¢ Note that this feature can only be used with columns with a predefined set of discrete
values, such as UoM or Allow as-built.

=+ Change status Drag a column header and drop it here to group by that column

Task details { o000 > : B Current estimate
WBS Change status Allow as-built As-built lock CE total MHrs CEt

phase
code

1002 ! Al 0 i 0.00
1069 i Al a i 800000
107 i Al =} i 30,000.00
1073 None O 21,000.00
1074 i . Al O i 18,000.00
1005 i o) Al @] I 2,000.00
1006 ' Al O ! 1,000.00
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Actions ¥ ®

v ==

cBS Description
(J  position

& Change status: (Count:2)
o 3 Concrete
w] 52 Concrete - Materials
Count:2

Change status: (Count:4)

[m] 41 Erect Steel - Heavy
[m] 42 Erect Steel - Light

[w] 43 Bolted Connections

o 6 Merrill Iron & Steel - Steel Material

< oven >
WBS Change status Allow as-built
B
1071 ' Al
1086 ' Al
1074 ' Al
1005 ' Al
1006 ' Al
1088 ! None

As-built lock

0

0000

¢ | Current estimat

CE total MHrs

30,000.00
0.00
30,000.00

18,000.00
2,000.00
1,000.00

0.00

3.3 Cost Items

3. To add subgroupings, drag and drop additional column headers into the grouping area. You can
rearrange these headers in the grouping area to modify the subgroups.

Actions v ®
v
Tasks
cBS Description
(J  position
& Change status: (Count:2)
Pay item assignment: 002 (Count:2)
o 3 Concrete
o |s2 Concrete - Materials
Count:2
Change status: (Count:4)
Pay item assignment: (Count:1)
o B MerrillIron & Steel - Steel Material
Count:1
Pay item assignment: 003 (Count:3)
[m] 41 Erect Steel - Heavy
o |a2 Erect Steel - Light
o 43 Bolted Connections

Count:3

4. To return to the standard CBS, click the Group columns icon again.

3.3.5 Cost Item Deletion

WBS
phase
code

1071
1086

1088

1074
1005

1006

t | Task details

WBS phase
code

fion
11086

11088

fio7a
11005

11006

< ooce >
Pay item CBS contribute
assignment qty

002

002 w]
003 w]
003 w]
003 w]

0

$

m o B = Q

¢ § Current estimate

CE total MHrs

30,000.00
0.00

30,000.00

0.00
0.00

18,000.00
2,000.00
1,000.00

21,000.00

CE total cost

$1,500,000.00
$1.,000,000.00
$2,500,000.00

$80,000.00
$80,000.00

$979,.272.00
$100,000.00
$50,000.00
$1,129,272.00

CE MHrs/unit

3.0
0.0

20.00
20.00

You can delete one cost item or multiple cost items by selecting the cost items, right clicking, and then

selecting Delete Cost Item.

When deleting cost items from the CBS, deleting the forecast, clearing out the account code, or
changing attributes to delete a cost item is not necessary.
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4]
(X

v o4

v 5

0000000 o0ooagao

4.1
4.2
4.3

5.1
52
5.3
5.4
55

Earthwork
Concrete
Structur:
Erect Ste
Erect Ste
Bolted Ci
Materiale

Earthwor

Copy

Mew cost item

Control User Guide

1069

New subordinate cost item

Concrete

Structure

Delete cost items(s)

Material:

Materialt

Subtotals 14 (1 rows selected)

R [ |®]|® ®

< [

[~]

Adjust CBS position

Cost item details

Actuals details

Change summary

Cost item dashboard

You can also select a cost item and click the Delete icon on the left toolbar.

© B e

Actions w

CBS position
[
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A cost item must meet the following conditions to be deleted:

* Total Cost (To Date) =0, MH (To Date) = 0, Eqp Hours (To Date) = 0, Qty Complete (To
Date)=0

e CB-Total Cost =0, C B-Total MH = 0, CB-Total Quantity = 0, C B-Qty Remaining =0

* [f the cost item is a parent item, all the subordinate cost items will also need to be
checked to see if they can be deleted

If you are deleting multiple cost items and do not meet the following conditions for deletion, a
downloadable file appears that lists all of the validations and why they failed.

3.3.6 Copying Cost Items with Resources

You can copy and paste entire cost items with resources from the CBS tab to any cost item you select.

When you copy a cost item, you cannot copy the current budget because the current budget
must be approved in a contract adjustment or budget move.

Follow the step by step to copy a cost item.

Copy and paste cost items

1. From the CBS tab, select one or more cost items that you want to copy that contain a resource.

This can be checked in the Resources column. If the cost item has a 1 or higher, then a
resource is attached to that cost item.

2. Right-click your selected cost items.

3. Hover over the Copy selection and select Copy cost item.
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(<< I <

O 00000oo0oooono

O

Subtotals 96 (3 rows selected)

| InEight Inc.

31
3.2
Vo4
41
42
v 43
431
432
v 5
5.1
52
v 6
6.1
6.2
6.3

Excavation Copy
Embankm

Aggregate

Furnish &

Finegrade

Install Agc

Flace Agg

Blue Top £

Asphalt Ce @ Delete cost items(s)
Furnish &

Install Hot

36 Inch RC r_,t? Cost item details
Furnish R(

Excavate |

Install RCI Change summary

Privacy Statement Temr I?

4. Right-click on another cost item in the CBS tab.

Control User Guide

2 Copy cost item

WZGsy

5. Hover over the option Insert copied cost items. You have three options as to where to place the

copied cost items:

¢ |Insert above

¢ |nsert below
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¢ |nsert as a subordinate

Tasks

% CBS

position
]

O w2
(] 21
] v 22
(] 2.2
v 23
O v 231
(] v 237,
(] 23.
d 23.
(] 23.

Description

Financial Results Analysis

Misc. Rev Internal

Misc. Rev Internal

Escalation/Contingency

General Project Risk

Directs
Direct Labour
Grading Work
I

Resurface Existing Accet

Maintain Access Road

Clear & Grub Bench B &\

 RERGEENS

Resources

Copy 3

Insert copied cost items  »
MNew cost item
New subordinate cost item

Delete cost items(s)

3.3 Cost Items

£ osee > ]
Forecast (T/0) UoM
aty
1.00  PLS
1.00 PLS
1.00  PLS
1.00 Each
5245 K$
1.00 PLS

1.00  PLS

LS
T Insert above

z
‘L Insert below

k
— Insert as subordinate

050 HA

You can also view the pasted cost items in the Resources tab of the Cost item details slide-out panel.

3.3.7 Design total qty and Design total MHrs columns in the CBS

Control displays the sum of the Forecast T/O quantity from the associated InEight Design items against
the attributed cost items. You can compare the Design total quantity and Design total man-hours to

the Forecast (T/O) quantity and Forecast hours columns, to make sure the values match up with what

is in Design.

InEight Inc. | Release 26.5
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Design total gty Design total MHrs
Forecast T/0 .q‘[},' as determined Current estimate man hours as
and pulled from the Design determined and pulled from the
application (Quantity item - PESiQ” application (Quantity
Forecast TO qty) item - CE MHrs)
i Forecast Design total Design total ¥ Forecast
remaining cost qty MHrs method
55259890046 53,898 000 0993  Rollup
55,760,886.07 370000 0651  Rollup

3.3.8 Create cost items in InEight Change

You can also create cost items with resources in Change, and then have them created in Control upon
the approval of a contract adjustment. This reduces the amount of extra steps needed for creating cost

items in multiple areas.

Creating cost items in Change is performed by first creating an issue with your newly created cost

items, then executing your change order.
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683 | Art Museum - Addrtion / Change

Executed Change order sent to Control

Change management >  GCO-Demo 22.2-New scope
Executed ... Cost Billing mark.. Markup  Margin Deductions  Netva.. CCOstatus Pricing status Proposal status
$6,116.00 $5,560.00 $0.00 $556.00 10.00% $0.00 $6,116.. . . - -
| Exe
. SUPPORTING WORKFLOW -
Actions ¥ DETAILS PRICING DOCUMENTS ASSIGNMENTS > = G
|
)
A Pricing summary ROM Estimate Proposal Agreed

. Direct cost total

# Labor

» |ssue 75 - New scope «

Labor cost item pricing
Labor subtotal

# Materials

~ 13sue 75 - New scope h
Materials cost item pricing
pu

In Control, go into the Change Register and click on the change order to review the new cost items that
originated from Change.

cBs Acs PAY ITEMS CHANGE REGISTER AUDITLOG
Actions = S 4 o = Q
1D Description cco Crea... Issue
Ch... date # 28.0 % X
New scope
6. 280 New scope Demo222  02/28/2022 75
Type Status Originated on Originated by
6. 270 Budget Move: IWO/ 11/29/2021 Contract adjustment (Cost ite @ cco-Approved 02/28/2022 Morgan Smith
16 260 Budget Allowance M 11/29/2021 Last changed on Last changed by Approved on Approved by Approval probability
02/28/2022 Morgan Smith 02/28/2022 Morgan Smith 100.00%
16. 250 Buyout Gain: PVS; M. 11/23/2021
6. 240 Budget Move: Temp 11/04/2021 Pay item details
Payitem Description Current billing Adjusted Adjusted Adjusted Locked date
6. 230 Budget Move: Temp 11/04/2021 number methed current price current unit current pay qty
price
6. 221 Budget Move: Morol. 11/04/2021 2 Amendment #2 Fixed final price $6116.00 $0.00 6116.00
,
6. 220 Budget Move: Morol 11/02/2021
$6,116.00 $0.00
16.. 21.0 Budget Move: Adjust 11/01/2021
Cost item details
16 200 Budget Move: BTAm 11/01/2021 CBS position Description WBs Adjusted CB Adjusted CB Adjusted CB Locked date
phgse total cost total MHrs total Qty
code
16. 19.0 Budget Move: Distrib. 10/29/2021
136 New scope - Plug values 1352 $5150.00 50.00 100 | 0282022
6. 180 Temp Entrance: Lab. 09/30/2021 02
137 New scope - Resources 1354 $410.00 0.00 100 | 02282022
6. 172 Buyout Adjustment 09/23/2021 Siel =
6. 171 Buyout Adjustment. .. 09/23/2021
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Revise the change order to make any further adjustments, such as associating pay items to your cost
items. Notice how the cost category assignments have all come over to Control that originated from
the change document.

Changeregister > 28.0 - Contract adju..
€COtotal budget  CCO unassigned budget  Net budget change et quantity change  Net man hour change | Markup Fee | Net contract change  CCO agreed price CCOunassigned price  Approval probabilty
$5560.00 $000 5600 Yes 50.00 5000 3000 | 5000 $6116.00 611600 100.00% - Executed Change Order
ouu tems =
® ] assigneostto v X
GBS position Description wes B total cost Adjusted CB Markup Markuy  New scope - Flug values
= phase total cost %
= CB total cost Pending budget cost CBtotal Mirs 8 total quantity
A Unsssigned costitems: s000 500
000 $515000
u] \ s41000
Cost eategory CB total cost Pending
A~ Total 5515000
50.00
$000
5000
sobo
55,0000
s000
$000
000
GEA s0.00
Undefined 0.00
Total 5000 $515000
Subtotals 2 5000 5556000 . suw o .

(Ccancel | (oratt | [ Back ] m

Approving the change order creates the new cost items with the resources specified in Change, and
places them within the hierarchy specified in the contract adjustment, and if none is specified, then
they are placed at the bottom of the CBS.
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CBS ACS PAY [TEMS CHANGE REGISTER
Actions -
e I P R T L - [
by on tag 1 tag 2 tag 3
28.0 New scope 02/28/2022 02/28/2022 5} fj CCO-Pending
270 Budget Move: WO/ 1y29/2021 | (@) Details  11/29/2021 B (©) Approved
26.0 Budget Allowance M... 11/29/2021 11/29/2021 % (_ Approved
250 Buyout Gain: PVS; M. 1172372021 B H?vl:e 11/23/2021 B (%) Approved
240 Budget Move: Temp . | 11/04/2021 nppl;g-.'e 1/04/2021 B (@ Approved
230 Budget Move: Temp ... 11/04/2021 /04/2021 = (©) Approved
221 Budget Move: Morol 11/04/2021 ok 021 E £ Draft
e At . i 3 = S
Tasks i
#: CBS position Description WES
O phase
code
] w 413 Visqueen Material - Available 1229
O 414 LICENSES, PERMITS, & BONDS 1039
O 415 Security Personnel IWO - Available 1320
| 416 Available 1169
] 417 Available nn
0 418 Available 172
(]} 419 Available 1183
] 420 Available 1158
] 421 Available 1349
(]} 422 Available 1143
] 423 Available 1147
(] 424 Available 1150
[} 425 Available 1126
(]} 426 Available 1127
[} 427 Available (R3]
] 428 Available 1132
] 429 Available 1136
(] 430 Available 1107
] 431 Available 1110
(] 432 Available 1339
J ~ 433 Construction Equipment 1070
] v 434 FINISH CARPENTRY 1188
a w 4_3_5 SHEAR CORE WALLS mnan
] 436 New scope - Plug values 1353
] 437 New scope - Resources 1354
Subtotals 41

3.4 HIDE IN PLAN, PROGRESS, AND DESIGN

When you create a cost item, there are multiple fields and options available for populating the cost
item details. The Hide in Plan, Progress, and Design option is available for you to select to make the
cost item unavailable for claiming in the InEight Plan, Progress, or Design applications. This feature is
typically used to make sure items such as indirect or overhead items do not get claimed against.
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By selecting the Hide in Plan, Progress, and Design check box, you can hide items, so they do not show
in those applications. This makes it easier for the supervisor or foreman in the field to see only their
work-related tasks.

The hide feature drives whether the cost item shows in Plan, Progress and Design. When the hide
feature is not selected, the cost item shows in Plan, Progress, and Design. Those applications use the
Allow as-built and the As-built lock to determine which type of actuals can be claimed (cost, quantity,
man hours, equipment hours) or whether the cost item should not have actuals.

In Control, you can use the hide feature in combination with the Allow as-built and As-built lock feature
to do the following:

e Determine if you can claim quantities in Control when the hide feature is selected.

¢ Allow other applications to sync claimed quantities when the hide feature is not selected and
Allow as-build is selected for quantities.

3.4.1 Hide feature in a cost item

On the CBS tab, when you add or edit a cost item , you have the option to select the Hide in Plan,
Progress, and Design check box in the details for the cost item.

New cost item

New cost item
DETAILS ATTRIBUTES

® Addnew costitem

+ Cost source CE total cost CE total MHrs CE total equipment Hre

CE unit cost CE MHr/Unit CE Units/MHrs CE labor cost/MHrs

+ Allow as-built + Quantity driver « Currency

None v Superior CI v usD § hd

[] As-buiitlock [[] Hide in Plan, Progress, and [] ces contribute gty
Design
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3.4.2 Hide feature in the CBS Workspace

On the CBS tab in the CBS Task details block, you can select the check box for the cost item to hide it in
the Plan, Progress, and Design applications.

= fat  Road & Bridge Project | 1060_. / Control / Workspaces

cBS ACS PAY T >
Actions  w @ oD ]
O B guassition Description Account code E;g;rigs:!zl;d I= terminal
Design
& O VAR Road - Rampand ..
O 11 Structural South .. O
(] 112 Walls - SB Ramp/... O
O 113 Structural - SB Ra... 0
] 114 Traffic Model - De.. 0
O 115 Roadway - Civil D O
O 116 Drainage - System O
O 117 Landscape - SBR.. 0
O 118 D16 408 Permit 0
O 119 Geo Report O
O w2 Construction
(] v 21 Bridge Work
O 211 Erect Structural St... 0
Subtotals 14

3.4.3 Considerations

* You must select to hide the cost item before any claiming is done in Plan, Progress, or Design.
After claiming is received for the cost item, the hide option is then unavailable.

¢ When the job-to-date quantities, costs, or man-hours are not zero, and you elect to hide the cost
item, a message shows indicating that you cannot edit the setting, as shown in the following
example.
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Unable to edit the setting for Hide in Plan,
Progress, and Design if the Job-to-Date

Quantities are not zero.

You must post a negative claim that results in a Job-to-Date
Quantity that eguals 0 within the Plan & Progress application.
Then you can change the setting for Hide in Plan, Progress, and

Design

To select the setting, you must post a negative claim that will result in the quantities, costs, or
man-hours to equal zero.

¢ You must have applicable Control permissions for Actuals in InEight Platform. For more
information, see Manage users.

3.5 COST ITEM EXCEL IMPORT

When you need to add multiple cost items to your project, adding them manually can be tedious and
time consuming. To save time, if you can export your cost items to Microsoft Excel (e.g., export to Excel
from your estimating software), you can import them into Control, allowing you to update your
estimate in bulk, without needing to manually enter data into individual cells.

Click the Import icon on the right toolbar of the Control > Workspaces page to go access the Excel
import feature.

= O $ m|F|l B = Q

The table below indicates the data you can import into Control from Excel.

Data Type CBS Columns

Tasks CBS position, Description, UoM, code-related fields, user-defined fields, other
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Data Type CBS Columns

settings found in the Task details data block in Control.

Schedule Schedule ID, schedule dates, Scheduled, Schedule plug days, Plug days,
Cost curve, Roll up schedule

Current CE final MHrs, final costs, total equipment hours, MHr/Unit, units/MHr,

Estimate equipment hour/unit, labor cost/MHr, equipment cost/MHr, Secondary Qty,
Scales 1, 2, and 3.

Cost Total and unit costs.

Categories

When you click on the Import icon on the CBS tab of the Workspaces page, you have three import type
options. You can import cost items, actuals, or a schedule.
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Cost items

Actuals

00.00 %

Commitment
99 .02 % 1,

After you make a selection, the Import CBS data window opens.

Overview - Import CBS Dialog box

1 Import from You can either drag and drop or browse to the file to import. Microsoft
Excel Excel files (.xlIsx,, .xIs) and Comma Separated Value (.csv) files can be
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Overview - Import CBS Dialog box (continued)

imported.

2 Options You can add new cost items and update cost items that already exist in
the project, choose to only update existing cost items, or only add new.

3 Costitem When adding and updating cost items, the structure in the spreadsheet
matching you are importing from may be in a different order than the structure in
criteria Control. By specifying a code for matching your cost items, the import

routine will know which cost items in the spreadsheet are new when
adding new items, and which cost items to update with data from the
spreadsheet when updating cost items.

4 Information This information provides a description of available functionality and
message instructions for proceeding to the next step.
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Import CBS data

Import from Excel (xlsx, xls) or Comma separated value (_csv) o

Drag and drop the file here

or browse

Browse

Options
e o

* Import type @ Once the import file is read, Cost item match
options and field mapping can be specified.

Cost items and cost item attributes v Mapping uses row 1 headers from the source
document. New cost items are inserted to the
(® Update existing and new items bottom of the CBS.

Cost item matching criteria

WBS phase code -

3

() Update existing items

() New items

Clicking Next opens the Map columns dialog box, where you can map your Excel columns to the
appropriate column in Control.

Overview - Map Columns Window

1 Template  After you map the import file columns to the CBS columns in Control, you
can save your settings as a template for future use. This is helpful when you
need to make scope changes or updates on a regular basis.

2 Control The names of the column headers in Control that you can map your data to.
field

3 Mapped A green checkmark indicates the column in your import file is mapped
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Overview - Map Columns Window (continued)

correctly to the CBS column. The Green key indicates the matching code
you specified is locked.

4 File The names of the column headers in your import file that you can map to the
columns CBS columns in Control.

1)

Template ‘ Unsaved template - ‘ Bj
Control field e Mapped 9 File columns o
oo oo R
Description v Description
Optional code Blank-do not import
WBS phase code Blank-do not import
Allow as-built Blank-do not import
CBS position (V.4 CBS Position
UoM Blank-do not import
* Required fields ’

[ Cancel ] [ Back ] Next

3.5.1 Forecast Excel Import

When manually importing cost items by either updating existing cost items or importing new cost
items, you can also import forecast values via Excel. How the fields are mapped in Excel determines
which CBS forecast columns are populated.

Examples of some forecast columns that can be mapped via the Excel CBS import cost item process
include, Forecast total cost, Forecast total MHrs, and Forecast total unit cost. Cost categories can also
be selected for importing into Control.
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Import CBS data- ALL PERMISSION LC_12102021054633 xlsx

Map columns

Template  Unsaved template -
Control field Mapped File columns
z : Fe

Live Forecast

Forecast method Blank-do not import
Forecast total Cost Blank-do not import
Forecast total Mhrs Blank-do not import
Forecast total Mhr/Unit Blank-do not import
Forecast total productivity Blank-do not import
Forecast total unit cost Blank-do not import
Forecast remaining cost Blank-do not import
Forecast remaining Mhrs Blank-do not import

(ewa ) (o)

3.5.2 Spreadsheet Rules

For the import process to work correctly, the items in your Excel spreadsheet must be formatted in a
certain way so that Control can recognize the items. The following table indicates important
spreadsheet rules to follow to make sure your data imports successfully.
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T T S

Import Reads the first worksheet within the referenced workbook.
function

Firstrow of  Considered to be the header row of the data. This imports as titles which are
data referenced during the mapping process.
The import stops reading headers if it encounters a blank header cell.

Numbers Needs to be the actual number, and not the summation of cells.
Values cannot contain the $ symbol or other currency symbols.

Second row Considered the first row of data to be imported.
of data

If you make changes in the spreadsheet, you must save the spreadsheet before importing (only
saved data will be imported).

Below is a list of items to be aware of during the population of the import template.

1. The Excel file should not be open while simultaneously using the import wizard.

a. If there are any edits made to the spreadsheet, it must be saved and closed prior to
importing.

2. CBS positions cannot be duplicates. They must be unique to each cost item.
a. The system will show an error if there are any duplicates.

3. The WBS phase codes are not required during the import but must also be unique per cost item.
4. Cost categories are spelling and case sensitive, and must match directly to the cost categories
spelling.

a. The cost categories list can be exported from the import wizard.

5. The Excel sheet cannot contain any blank cells during the import. Blank cells show an error and
cause the import to stall.

6. Make sure any blank columns from an export file are removed before importing again.

7. Date formats must match spreadsheet date formats. The Import Wizard will prompt you to
chose a date format used in the spreadsheet.

a. The Import wizard will prompt you to chose adate format prior to initiating the import.
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3.5.3 Best Practices and Recommendations

1. Use WBS phase code as the matching criteria for updating existing items.

a. WABS phase code are tied 1:1 for each cost item. The CBS position can be changed,
but the WBS phase code remains the same regardless of CBS position.

2. Set up the views for exporting of data to match the import template created. Views are
customizable for flexibility in what is being imported/exported.

3. Import template mapping is unique to each individual user. Master mapping cannot be set at a
global level. It is recommended to provide users with a step-by-step import mapping document
to set up data mapping initially during the on-boarding of InEight.

4. When exporting data in Control, current system drops trailing zeros on CBS positions. Example:
1.10 exports as 1.1.

a. One way to get around this is opening data as a CSV file in Excel.

5. Once you have downloaded the export file, proceed to the following steps.
¢ Open blank Excel sheet
¢ Navigate to Data tab
* Click Get Data > From File > From Text/CSV
¢ Choose downloaded export file
¢ Click Import
e Click Load

Your data will now be imported into the sheet where updates are made. Once you have completed
your updates, you may save and re-import the same file.

3.5.4 CBS Hierarchy

If you select CBS position as the matching criteria for the import, the import routine recognizes the
hierarchy of your structure by the numbering of the codes.
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A2 : B || 1115
A B C

1 CBS position Description Forecast T/O gty
2 11.1.1.5 Parent 1
3 |1.1.1.5.1 Child 1 10
4 11.1.1.5.2 Child 2 1
5 |1.1.1.5.2.1 Child 2.1 15
6 [1.1.1.5.2.2 Child 2.2 20
7 11.1.1.5.3 Child 3 1

After the import is complete, if the CBS position for the new cost items match existing cost items in the
CBS, your new CBS cost items will import as you have defined them. The existing CBS cost items will
shift down and be relabeled to match the next corresponding number.

When adding new cost items to an existing CBS position, a warning message displays informing you the
CBS positions you have picked already exist. The message then asks you to confirm if you would like to
continue with this import.

3.5.4.1 CBS Predictive Hierarchy

New cost items created via the import process automatically adjust the CBS structure hierarchy to
match your import as needed and predict the movements in the current hierarchy, and the hierarchy
that is being added via the Excel import.

Tasks

7~ CBS Description WBS phase
] position code
O v A - Road materials 1000
O v 1. B - Rock 1001
O 1.1.1 C - Mix 1002
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For example, you have three cost items that you want to import, as shown below. Positions 1 and 1.1
already exist in the CBS, and position 2.1.2 is new.

A | B
CBS position Description

1 D - Maintenance
1.1 E - EQuipment
|2.1.2 F - Subcontracts

R S

The import process imports Excel CBS positions 1 and 1.1, and places 2.1.2 at the bottom of the

hierarchy.
Tasks :
w7 CBS Description WBS phase

position code
(] v o1 D - Maintenance 1003
] 1.1 E - Equipment 1004
] v o2 A - Road materials 1000
] v 2.1 B - Rock 1001
) 211 C - Mix 1002
] 21.2 F - Subcontracts 1005

The following steps walk you through the import process.
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The following steps are only applicable when importing new cost items.

Options

* Import type

Cost items and cost item attributes -

() Update existing and new items
(O Update existing items

(@ New items

Import CBS Data

1. From the Control > Workspaces page, on the CBS tab, click on the Import icon on the right
toolbar.

= O $ m Tl T = Q

2. Select Cost Items when the Import CBS data window appears.

3. Click on the Browse button to select a file to import.
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Import CBS data

Import from Excel {.xlsx, .xls) or Comma separated value (.csv)

Drag and drop the file here or browse

Browse...

4. Browse to the Excel file you wish to import.

e The file and its location should be indicated by your instructor if you’re in a classroom
setting, otherwise you can select one of your own

5. Select the import file and click Open.

[4 Open x
4 Il » ThisPC » Desktop v O Search Desktop
(el MNarme Date modified Type Size
3+ Quick access
=) CBS Import File.csv 8/9/2018 11:30 AM Microsoft Excel Com...
[ Desktop - - P - - = = - -
] Copy of MES EndPoints for Suite.xlsx 7/11/2018 2:59 PM Microsoft Excel Work...
¥ Downloads  # = WalkMe £/20/2018 3:56 PM Shortcut
@ Documents o
=/ Pictures -
Control
KSU Materials De ¥ € 4
File name: | CBS Import File.csv v| All Files w

e The import file is now selected
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Import CBS data ICBS Import File csv I

Import from Excel (xlsx, xls) or Comma separated value (_csv)

Drag and drop the file here or browse

Browse...

6. Under Options, select New Items (if not already selected).

7. For the Cost item matching criteria, select Cost items and cost item attributes from the drop-

down list.
Options
* Import type Update existing and new items
Cost items and cost item attributes v Update existing items
® New items
8. Click Next.

* This takes you to the Map columns window
¢ Note that the File columns fields are set to Blank-do not import by default

9. Under File columns, click in the field on the same row as the UoM CBS column, then click
again to expand the drop-down list for that field.
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Map columns

Template | Unsaved template -
Control field Mapped File columns
WBS phase code Blank-do not import
Allow as-built Blank-do not import
CBS position Blank-do not import
UoM Blank-do not import %
Account code | Q\

Blank-do not import
Pay item assignment

CBS Position
Description

CE materials total cost

CE subcontract total cost
Cancel
uom

10. Select UOM from the drop-down list to map the UOM column in the Excel file to the UoM CBS
column.

11. Repeat the selection process to select the appropriate File columns to map to the following CBS
columns:

e CBS position

e Description

e WBS Phase Code

e Forecast (T/0O) quantity
e CE Final MHrs

¢ CE final cost
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e A green check mark indicates successful mapping of your file columns

Import CBS data - costitem import xlsx

Map columns

Template | Unsaved template - ‘ B]
Gontrol field Mapped File columns
CE equipment cost/Hr Blank-do not import a
CE equipment-Hrs/Unit Blank-do not import
CE final cost Blank-do not import
CE final MHrs v CE Final MHrs
CE final unit cost v CE final cost
CE labor cost/MHr Blank-do not import
CE Mhrs/Unit Blank-do not import

[ Cancel } [ Back ] Next

12. To save these settings for future use, click in the Template field and type Steel Structure

Template.
Map columns \
Steel Structure Template = @
Order Data type CBS columns Mapped File columns

13. Click the Save icon to save the template.

ure Template \@ @

i File columns

14. Click Next.
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e A progress bar appears informing you the import is in progress

Import CBS data - CBS Import File.xlsx

Import in progress...

e A prompt appears, indicating the project will be disabled from use during the importing
process

X

You are about to update the CBS structure. Upon commitment of import,

this project will be disabled until completion. Please note this may take
several mins.

15. Click Import now.

e A prompt appears informing you that the project is currently locked for the importing

process
This project is currently locked due to an import in
process
Upon completion, this project will enable automatically. Flease note, this may
take several minutes.
& Redirect me to the projects menu page
Page 138 of 632
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¢ Once completed, you will receive the following prompt, informing you the data imported
successfully

X

Import complete
The project has updated and is now enabled.

3.5.5 Resolving Import Errors

When conducting the import, you may run into errors. This will be indicated when you attend to run
the import routine by the following prompt:

1 of 112 records contain errors

Would you like to resolve errors now or Close and continue later?

The prompt window includes a Review errors and items for import link, which you can click on to
resolve any issues prior to final import. An error resolution page opens where you can identify and
resolve your errors.
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Auditleg > Importhistory > GBS Import File.xlsx

Status Details (% CBS position)

Import status

CBS match status

1 errors remaini.

Import Columns 4

Import method

CBS position

Description

Control User Guide

Cancel import

WBS phase code

CE final
MHrs

Pending No match found, new item Add new items and upd... Bolted Connections 1000

Pending No match found, new item Add new items and upd... Module 01 - Erect Steel... 16000

Pending No match found, new item Add new items and upd... Structural Steel 0

Pending No match found, new item Add new items and upd... Structural Steel 0

Pending No match found, new item Add new items and upd... Module 001 - Erect Ste... 0

Error No match found, new item Add new items and upd.. Structural Steel [x] |
Pending No match found, new item Add new items and upd Materials 0

Pending Mo match found, new item &dd new items and nnd Frninment n

There can be situations where the cost item Excel import process will successfully process some
cost items, but fail to import other cost items. In this situation the process will show as failed.
For example, you imported 100 cost items, and 90 of the cost items import successfully. There
are 10 cost items that did not import successfully. In this scenario you would need to resolve the
import errors.

3.5.6 Excel Import for committed cost

Importing committed cost mainly helps to keep track of subcontract cost items where you would have
a purchase order that would drive all of your cost.

You can import two types of committed cost:

e Open/Remaining Committed Cost
e Total committed cost

Open/Remaining Committed Cost is the cost you still have left to pay on the purchase order. Total
committed cost is the total purchase order amount for the purchase order.

Committed cost were previously located in different areas of Control. You can have Open and Total
committed cost columns in your CBS. The same columns are also in the Commitments tab of the Actual
Details Slideout where you can make manual edits to the committed costs. Columns in CBS for Open
and Total committed costs only reflects the manual edits you made in the Actual Details Slideout. Open
and Total committed costs are also shown in cost item details slideout cost categories tab.
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You can import committed costs using the import icon on the CBS and selecting Commitment.

s m [

Import:

precast
Cost items

Actuals

5 36,500.00

¢ 25,000.00 Eﬂrr'lmitmerﬁl1

[

400.
300

& R 0nn NN \.j i

3.5.6.2 Generating the commitment cost Excel spreadsheet

To bring in committed cost from the excel import, you first need an existing value in your CBS that

matches the Excel Spreadsheet value. This can be one of two options:

 WBS phase code
» CBS position

You will also need the Type of committed cost you want to import, either Open/Remaining Committed

Cost or Total commitment.

A B

WBS phase code
1003
1003
1004
1004

L5, [ - W I N T Y

InEight Inc. | Release 26.5

C

Cost

Jr | Type

Category
100 Undefined
100 Undefined
450 Undefined labor
750 Undefined labor

E

Type

Open com
Total com
Open com
Total com

imitment
mitment
imitment
mitment
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Open/Remaining Committed Cost and Total commitment types need to be spelled exactly word
for word as it is written in the screenshot. If you shorten any of the wording in the Type column,
the system will not accept the import and you will receive an error.

Each Type of committed cost has to be its own line item on the Excel spreadsheet. You can do multiple
transactions for one cost item, but only one commitment type per line item. if they are different types,
you need to separate them out into different line items.

D3 v Jr Undefined
A B C D E F

1 |WBS phase code Cost Category Type

2 1003 100 Undefined Open commitment
3 1003 100|Undefined o Total commitment
4 1003 100 Undefined labor Total commitment
5 1004 450 Undefined labor Open commitment
6 1004 750 Undefined labor Total commitment

Each column needs to be created and defined if you are to do a Commitment Excel Import. You must
include a Cost column and a Category column as shown in the above image.

Open/Remaining Committed Cost should never be greater than your total. Open/Remaining
Committed Cost cost should either be equal or less than the Total commitment cost.

3.5.6.3 Importing commitment data

Follow the step by step to Import commitment data.
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Import Commitment Costs

1. From Control's CBS tab, select the import icon. Then select Commitment.

s m B [

Import:

precast .
: Cost items

Actuals
$ 36,500.00 400,
¢ 25,000.00 Cnmmitmerj]_l 300

& R 0nn NN \j i

2. After you have created your Excel spreadsheet with your commitment costs, select Browse from
the Import from Excel window. Then select the Excel file name you saved.

3. After you return to the Import commitment data window, under the Options section, select the
Import type drop down arrow. If it is not already selected, select the Commitment values
option.

Options

*Import type

Commitment values v
Select one
Cost items and cost item attributes
Actuals values

Commitment values
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4. Select the Cost item matching criteria drop down and choose either WBS phase code or CBS
position.
Cost item matching criteria

WBS phase code -

WRBS phase code

CBS position @

5. After selecting the drop down options, select Next in the bottom right corner.

6. From the Map columns screen, select the columns you are importing from your Excel
spreadsheet.

Import commitment data - cBSDataBlock - 2020-12-08T121215.813.csv

Map columns

Template Unsaved template hd

Control field Mapped File columns

Tasks

CBS position nly used if
WBS phase code -
Commitments b

| SN

* Commitment type

Cost Blank-do not import
Cost categories

WBS phase code
Cost

Category

Type

7. The Control field should match the File columns. For example, Commitment type in Control field
should match Type in File columns as shown below. Once done, select Next.
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Map columns

Template Unsaved template - Ef_'l
Control field Mapped File columns
Tasks
CBS position nly used if matching
WBS phase code Q¢ WBS phase code
Commitments
* Commitment type v Type
Cost v 4 Cost
Cost categories v

8. If there are no errors in the mapping stage, you should see a green check mark on the next
screen, indicating everything is ready to be imported.

Document contains no errors
5 record(s) ready for import

Select next to continue with import steps.

If you receive any errors in the mapping stage, you will receive an error with a download option
to download a word document that shows you all the errors.
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10.
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Import commitments CBS data: CBSDataBlock - 2020-12-08T121215.813.csv
File Import attempted on: 12/8/2020 9:04:55 PM

The following errors were detected while attempting to import commitment
values into controel.

Review the errors below, once all the errors have been resolved,
reattempt the import to Control.

Error 1: ﬂbvalid commitment type. (this error affects 2 WBS/CBS items cut
of 2 total attempted imported WBS/CBS items and 4 rows out of 4 total
attempted imported rows)

WBS: 1003
CBS: 1.3
Row: 1, 2
WBS: 1004
CBS: 1.4
Row: 3, 4

Click Next and then select Import now. This will create a line item in the Import history section
of the Audit Log tab.

From Control, go to the Audit Log tab. Then select Import history. Hover over the yellow triangle
to view the information on the pending import item.

Actions -

' ! Stat
CBES Pending .

0 of 5 line items contain errors Pe_ » @

ACS M Cont | 1 Iékl
ontnue Impor re. »@

Import history
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CBSDataBloc..

Commitment

. |
Fay items @ cance 9 Failed .. 4
) CBSDataBloc.. Commitment e Failed .. 4
Integration -
CBSDataBloc.. Commitment 9 Failed i
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After the pending import is Complete, the committed costs populate in the Cost
Categories Details tab, as well as the CBS. It the costs also appear in the Commitments tab

from the Actuals Details Slideout and populates into the new Open and Total cost
committed columns.

If the imported commitment costs fail to import, the Aduit Log Import history would show that the
import failed completely.
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CHAPTER 4 — COST ITEM
MANAGEMENT

4.1 Cost item managementworkflow ...
4.2 Estimate Resources ... ..
4.2.1 Navigate to Estimate Resources ...
4.2.2 Manage estimate resources ...
423 Resourcerates ...
4.2.4 Add estimate resourcestoajob ...
4.25Datacolumns ...l
4.3 Costitemdetails ...

45Detailstab ... .
4.5.1 Pay item contribute quantity ...
4.6 Attributestab ...
4.7 Costcategoriestab ... .
4.8 Current Estimate Resourcestab ...
4.8.1 CostDriver ...l
4.8.2 Productivity and overall settings ...
4 9 ForecastResourcestab ... ..
4.9.1 Productivity and overall settings ...
4.9.2ResourceDetails ... .

410 Issuetagginginthe CBS ... . . .. . ..
4171 Lock Budget ... ..
4111 Budgetsvs Estimate ...
411.2 Lock Budgetand Price ...
4.11.3 Unlock Budgetand Price ...
412 Assigned vendors ...
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4.1 COST ITEM MANAGEMENT WORKFLOW

Estimate

Historical Benchmarking

Control
Conform Estimate / WBS Structure

Progress F @

orecasting

Account Code ML Final Hours and Costs
Management CBS Register

ACS Register Create & Manage

Cost Items
Define Qty Account
Contribution Codes

Analyze Planned
Earned and Actual

Forecast Method Budget/Forecasts
Setup Quantities

Live
Forecast

Forecasts

WS Structure / Budgeted
Quantities & Hours

roved changes
ﬂﬁﬁm Cu(rfntgsuﬂgff Revenue Management

Billed Revenue

Change Management v |
Change Register Pay ltem Register
Budget Move Create/Manage
Pay ltems

Budget
Plan Qty/MH Analyzed Planned & Forecast Revenue
I ent
Contract
Adjustment Track Billed Revenue

4.2 ESTIMATE RESOURCES

InEight Control refers to labor, equipment, materials, installed equipment, and supplies as resources.
These resources are used as the basic building blocks for detailing the estimated costs which create
your budget.

The Project library includes all resources used to estimate costs for the cost items in the cost
breakdown structure (CBS).
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fat  Steel Structure Training Job 2. / Control / Project library

ESTIMATE RESOURCES
Resource Description
Labar code
Construction eguipment O 1.601.1.08 Laborer
Rented construction O 1.C.01.1.06 Crane Operatar
equipment
Installed material O 1.C.001.0.07 Civil Operator
Installed equipment O 1.C.04.7.02 Concrete Foreman
Supplies ] 1.C.04.1.03 Concrete Journeyman
Linique O 1.C.04.1.04 Concrete Apprentice
O 1.C.05.1.02 Ironworker Foreman
O 1.C.05.1.03 Ironworker Journeyman
O 1.C.05.1.04 Ironworker Apprentice
O 1.C.05.1.08 Civil Foreman
O 1.C.05.1.09 Civil Journeyman
O 1.C.05.1.23 Civil Apprentice
O Loo1 General Labor
O LWLBJ Welder Journeyman

Most of the CBS cost detail is imported directly from InEight Estimate, but you might need to
create additional cost item detail for conforming your budget and creating change orders.

Estimate resources in the Project library are organized into seven resource types:

Resource Description

Labor Human resources that perform the work, classified by trade (e.g., pipefitters,
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Resource Description

Construction
Equipment

Rented
Construction
Equipment

Installed
Material

Installed
Equipment

Supplies

Unique

electricians, iron workers).

Owned construction equipment.

Construction equipment rented from a third party.

Materials that remains installed on site after the project is completed, (e.g.,
concrete, piping, aggregate).

Equipment that remains installed on site after the project is completed, (e.g.,
boilers, heat exchangers, vessels, cooling towers).

Expendable items that are not permanently installed (e.g., small tools,
consumables).

Resources of a unique nature which cannot be associated with other
resource types (e.g., dump fees, hauling charges and equipment rented by
the month, and subcontracted work).

Estimate resources are the equivalent of the Resource Rate Register in InEight Estimate.

4.2.1 Navigate to Estimate Resources

To access the Estimate resources page, go to the project home page, and then click Project library. The
Project library page opens and shows the Estimate Resources tab.
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= {3 Steel Structure Training Job | 105031 / Project home

Add project image

Steel Structure Training Job | 105091 @

Quantity forecasting

Engineering
p— Steel Structure Training Job | 105091 / Control / Project library
Control ESTIMATE RESOURCES REVENUE
e P ——
_—/— Resource Deseription Default Unit of Utiization
e code Quantity measure count
Plan
1c01105 Laborer 000  Hour 139134
Quantity tracking Construction equipment
Work packaging :;:mm'slw:lm ) 1.€01.1.06 Crane Operator 000  Hour 58658
P
e — 1.c010.07 Civil Operator 000  Hour 14545
104102 Concrete Foreman 000  Hour 30000
Installed equipment
o 104103 Concrete Journeyman 000  Hour 90000
1.C04.1.04 Concrete Apprentice 000 Hour 90000
Unique
1.€051.02 Ironworker Foreman 000  Hour 34500
O 1co0s103 Konworker Joumeyman 000  Hour 103500
1C051.04 Ironworker Apprentice 000  Hour 103500
1.605.1.08 Civil Foreman 000  Hour 7212
1€051.09 Civil Journeyman 000  Hour 14545
1005123 Civil Apprentice 000  Hour 21818
N ol General Labor 000  Hour ¢
« C—

You can also access Estimate Resources from the CBS page. In the CBS page, select a line item and then
hover over the resource number in the Resources column of the Task details data block. In the
Resource Summary dialog box, click Resource library to open the Project library.

@  Steel Structure Training Job| 1050-. / Control / Workspaces )
c8s ACS PAY ITEMS CHANGE REGISTER au ) Project (
Actions v ® 0 $ m 5
4 Resource summary
Tasks H Tas | Code Description Quantity UoM Work Hrs CE-unitcost  CE total cost I
3/ CBS _ Description Reso. tl
O position ~
1 1.C05.1.09 Civil Journey.. 2.0 Each 145455 $57.50 $83636.36
m} 1 Job Overhead
ey 2 1605123 Civil Apprent..  3.00 Each 218182 $4500 $98,181.82
O 2 Earthwork El
3 1.601.1.05 Laborer 3.00 Hour 2181.82 $35.00 $76,363.64
3 Concrete 5
4 1.€01.1.07 Civil Operator  2.00 Each 145455 $65.00 $94545.45
v o4 Structural Steel
5 1.C.05.1.08 Civil Foreman ~ 1.00 Each T27.27 $65.00 $4727273
v
(] 41 Erect Steel - Heavy 5

(®) Assignresource  View more

]} 42 Erect Steel - Light 5
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4.2.2 Manage estimate resources

You can manage estimate resources by adding, deleting, or editing estimate resources.

® ¢ ®

Resource Descrip
Labor G2
Construction equipment O 1601105 Laborer
Rented construction (] 1.C.01.1.06 Crane O
equipment
Installed material o e Givil op
Installed equipment ] 1.C.04.1.02 Concret
Supplies (] 1.C.04.1.03 Concret
Unique O 1.C.04.1.04 Concret

To add an estimate resource to the Estimate Resources library, you must first choose the resource type
in the left-side section (Labor, Construction equipment, etc.), and then click the Add estimate resource
icon. In the Add estimate resource dialog box, enter the applicable required and optional resource
data, and then click Add to add the estimate resource.

Add labor estimate resource

= Code = Description

LABOO1-JS Welder

SETUP RESQURCE RATES

Account code * Cost driver * Cost curve

Cl Duration Employed Cost Item

Estimating resources tag 1 Estimating resources fag 2 Estimating resources tag 3

Estimating resources user defined 1 Estimating resources user defined 2 Estimating resources user defined 3

Estimating resources user defined 4 Estimating resources user defined 5 Estimating resources user defined 6
v

You can add your own notes to review later and to communicate with other users information about
the estimate resource. Click the Show notes icon at the top right to open the Conversation notes and
add additional notes.
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4.2 Estimate Resources

To edit or delete an estimate resource, select the estimate resource, and then click the Edit estimate
resource or Delete estimate resource icon. If an estimate resource has been assigned to a project, it

cannot be deleted.

4.2.3 Resource rates

In the Resource Rates tab, you can import, modify, and add billable rates to estimate resources. This is
particularly helpful for time and material or cost plus contracts to drive accurate invoicing.

Resource billing rates are also used for Forecast final revenue, as it will rely on the billing rates of the
resources on the cost items that are assigned to pay items. These values generate revenue forecast for
cost items that are associated to a cost plus or time and material (billing method) pay item.

Add labor estimate resource

= Code + Description
LABOO1-JS Welder
SETUP RESOURCE RATES
Billing rate $50.00
Billing rate markup $50.00
Billing rate markup % 0.00 %
Charge rate $5000

4.2.4 Add estimate resources to a job

After resources are created, you can add them to a job.
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Add estimate resources

Go to Workspaces > CBS register.

Control User Guide

Right-click a cost item, and then in the context menu, select Cost item details.

1

2

3. On the Cost item details slide-out, select the Current Estimate Resources tab.
4

Expand the Current estimate resources section, and then click the Add resource button.

Actions  w ®
Y
Tasks
v CBS
position
O 1
&
m] 2
m] 3
O ~d
O 41
(m] 42
43
O v 5
m] 5.1
O 5.2
[m] 53
O 54

“ ®

Description

Job Overhead

Earthwork

Concrete

structural Steel

Erect Steel - Heavy

Erect Steel - Light

Bolted Connections

Materials

Earthwork - Mater.

Concrete - Materi.

Structure Steel - ..

EA/123

Subtotals 12 (1 rws selected)

L}

cas ACS PAY ITEMS CHANGE REG VIEW | New view -~
B = =
B 9 $ m F O = Q
X
1006
Bolted Connections
CURRENT ESTIMATE
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details v
Current estimate resources ~
Row # Code Description Quantity UoM Work CE unit
O hours cost
a
[m] 1.C.05.1.04 Ironworker Apprentice 300 Each 600.00
(] 1.C01.1.05 Laborer 200 Each 400.00
(] 1.C.05.1.02 Ironworker Foreman 100  Each 200.00
[m] 1..01.1.06 Crane Operator 100  Each 200.00
. v
4 CEE—— 3
v

Productivity and overall settings

Resource details

5. Inthe Add a resource dialog box, select the resources to add to the cost item, and then click

Add.
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X
Add a resource
CONSTRUCTION RENTED INSTALLED INSTALLED
LABOR EQUIPMENT CONSTRUCTION EQ... MATERIAL EQUIPMENT SUPPLIES UNIQUE

Il et — - A - e ke

] 1.c01.1.07 Civil Operator 000  Hour 1,454.55 $65.00 | ClDuration a

] 1.c.04.1.02 Concrete Foreman 000 Hour 3,000.00 $65.00 ClDuration

O 1.C04103 Concrete Joumney 000  Hour 9,000.00 $5500 | ClDuration

O 1.C04104 Concrete Apprentice 000  Hour 9,000.00 $4500  ClDuration

1.C05.1.02 Ironworker Foreman 000 | Hour 600.00 $65.00 ClDuration

1.C05103 Ironworker Journe._ 000 Hour 1,800.00 §55.00 ClDuration

(] 1.C.05.1.04 Ironworker Appren... 0.00 | Hour 1,800.00 $45.00  ClDuration

[m] 1.C051.08 Civil Foreman 0.00 | Hour T271.27 $65.00 | ClDuration

] 1.C.05.1.00 Civil Journeyman 0.00  Hour 1,454.55 §57.50  ClDuration

O 1.C.05.1.23 Civil Apprentice 000 | Hour 2,181.82 $45.00  ClDuration

Lo01 General Labor 000 | Hour 0.00 $50.00 ClDuration

4 L4

3 items selected

4.2.5 Data columns

You can view, add, and remove columns on the Estimate Resources page. To view all available
columns, click the Column chooser icon at the right of the column headers. In the Column chooser, you
can select and deselect columns from your view.

The following image and table show key columns available in the Resource library.
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= ft  Steel Structure Training Job | 105.. / Control / Project library

ESTIMATE RESOURCES REVENUE
® = Q
Resource Description Default Unit of Utilization € E-unit cost Cost driver Account
Labor code Quantity measure count (Scale 1) cade
a
Construction equipment [} 1.C01.1.05 Laborer 000  Hour 13913.42 13500  Cl Duration
Rented construction O 1.C.01.1.06 Crane Operator 0.00  Hour 5,865.80 21000 ClDuration
equipment
e e [} 1.colio7 Civil Operator 000  Hour 145455 210.00  Ci Duration
Installed equipment [} 1.C.04.1.02 Concrete Foreman 000  Hour 3,000.00 210.00  Ci Duration
Supplies [} 1.C041.03 Concrete Journeyman 000  Hour 9,000.00 180.00  Ci Duration
Unique [} 1.C04104 Concrete Apprentice 000  Hour 9,000.00 150.00  CI Duration
[} 1.C05.1.02 Ironworker Foreman 000  Hour 3.450.00 210.00 = CI Duration
1.C05.1.03 Ironworker Journeyman 000  Hour 10,350.00 180.00  CI Duration
Y
(] 1C05104 Ironworker Apprentice 000  Hour 10,350.00 15000  Cl Duration
O 1.0.05.1.08 Civil Foreman 0.00  Hour 12127 210.00  CIDuration
O 1.C.05.1.09 Civil Journeyman 0.00  Hour 1454.55 188.00  CIDuration
[} 1.C.05.1.23 Civil Apprentice 0.00  Hour 2181.82 150.00  Cl Duration
4 GEEEN— L4

Resource code  Alphanumeric label to quickly identify resources.
Description Additional label to provide more resource detail.

Default Quantity The quantity the resource will have by default when it is assigned to a cost
item.

Unit of measure The unit the resource is measured by.
Utilization count The number of units of that resource being used in the project.

C E -Unit cost The resource’s rate per unit.
(Scale 1)

Cost driver Shows what drives the cost for that resource when it is assigned to a cost
item (cost, quantity, or fixed).

Account code Code assigned to resources for accounting and benchmarking purposes.
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4.3 COST ITEM DETAILS

4.4 COST ITEM DETAILS OVERVIEW

The cost item detail slide out panel contains many different fields to edit and enter cost item-related
information. To access the cost item slide-out panel, select the cost item, and then right-click the
selected cost item. In the context menu, select Cost item details. In the Cost item details slide-out,
there are four tabs to select from:

e Details tab

e Attributes tab

e Cost Categories tab

e Current Estimate Resources

e Forecast Resources tab

CURRENT ESTIMATE

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES

FORECAST RESOURCES

All editable cells in the cost item detail slide-out panel are single click.

4.5 DETAILS TAB

The Details tab contains the values and settings related to the cost detail of the item.
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| 1069
'| Earthwork
CURRENT ESTIMATE
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES

Forecast T/O qty UoM CE unit cost CE total cost CBS position
10,000.00 CY $40.00 $ 400,000.00 2
Last changed on Last changed by
07/02/2025 06:51 AM InEight Service Account
Description Account code * Cost source

Earthwork 51 Detail -
= Forecast T/0 gty =UoM @ Live forecast method

10,000.00 CY - Current estimate -
CE total cost CE unit cost Average performance settings
$ 400,000.00 $40.00 hd
CE total MHrs CE total equipment Hrs CE labor cost/MHrs
8,000.00 0.00 $50.00
CE MHr/Unit CE Units/MHrs = Cost segment
0.80 1.25 Direct Cost -
« Allow as-built Pay item assignment = Currency
All - ool usp $ hd
] As-built lock * Quantity driver CBS contribute qty
-

[] Hide in Plan, Progress, and Design Pay item contribute gty

Below is an explanation of some of the key settings on the Details tab.

Cost source

Live
Forecast
method

Cost
segment
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Indicates how costs are entered on the cost item.

» Detail - Resources and duration defined to determine costs
 Plug - Unit and total costs entered at the cost category level

Determines the Forecast Method for the cost item. For more information, see
Forecasting overview.

Categorizes whether the cost item is a direct or indirect cost.
« Direct Cost - costs that directly pertain to the deliverables (pay items) of
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4.5 Details tab

Allow as-
built

Quantity
driver

Cost item
contribute

quantity
Hide in
Plan,

Progress,
and Design

Pay item
contribute
quantity

InEight Inc. | Release 26.5

the job

» Job Overhead - Overhead costs associated with running and managing
the job (e.g., management, jobsite facilities)

» Business Overhead - Overhead costs associated with running the
business (not directly related to running the job)

» Subcontract - subcontract associated costs

Determines whether you can enter actual costs and quantities for a cost item.
* None - Cost item does not accept cost or quantities. This is typically seen
in Superior cost items
» All - Allows a cost item to accept both direct costs and quantities
» Quantities - Cost item only accepts quantities
» Cost - Cost item only accepts costs, man hours, and equipment hours.

Superior cost item will have the Forecast T/O qty update when the superior cost
item (parent cost item) receives an update. The change to the qty will be the
original value multiplied by the same multiplier that was applied to the superior
cost item.

For example: if the superior cost item qty doubles, the item with Superior CI will
double as well. Cost items with Fixed as the selection will not be affected by
changes to the parent cost item.

Checked cost items will have the Forecast T/O qty roll-up to the parent cost
item if the UoM on both of the items are the same.

Select this feature to make the cost item unavailable for claiming in InEight
Plan, Progress, and Design. For more information, see Hide in Plan, Progress,

and Design.

Checking this box lets you choose which cost items contribute to the Pay item's
forecast (T/O) quantity and can affect earnings rules for the associated pay
item. This field is only visible if you have the Enable Pay item Forecast (T/O)
quantity rollups setting turned on in Settings > Control > Revenue.
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4.5.1 Pay item contribute quantity

The Pay item contribute gty function works only when the Pay item Forecast (T/O) gty rollups toggle is
set to On in Settings > Control > Revenue. If you have a unit price pay item, its forecast (T/O) quantity
is the sum of all the contributing cost items forecast (T/O) quantities.

This function lets you define which cost items roll up their quantities to a pay item.

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVEMLIE

r Unit price
Earnings amounts based on

(@ Forecast (T/Q) gty

") CE total cost

[y

o

Pay item Forecast (T/0) qty rollups

Enahle pay item Forecast [T,-’D} qty rollu DS @, Unit pnce pay tem Forecast (T/0) quantities wall
rollup based on contributing cost items’ Forecast

(T/0) quantities

—
W]

In the CBS, you can quickly modify the pay item contribute quantity either in bulk or by selecting a
single cost item.
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Multiple cost items selected

Tasks
3 CBS De... - ITES c c CURRENT ESTIMATE
a4 . DETAILS ATTRIBUTE COST CATEGORIES -
position . RESOURCES

v 3 Misc. 1 Last changed on Last changed by

05/23/2022 11:49 PM rakesh gunda-ptriine..
v 3 Misc. |
7 316 B/C BE
9 h Description Account code * Cost source
O 3161 B888C (Varies) Detail
O 3162 8888 C * Forecast T/0 qty * UoM
— 1.00000000000 PLS - | As-built lock
L 3163 8888 ( —]
M 3164 Bower OFtotalcost CE unit cost D Live foreca
— Rollup
L 3165

CE total MHrs CE total equipment Hrs CE labor cost/MHrs

CE MHr/Unit CE Units/MHrs « Cost segment

(Varies)
* Allow as-built Pay rtem assignment * Cumrency
- 2 CAD §
* Quantity driver
Superior CI - | 7| CBS contribute gty | Hide in plan/Progress

W | Pay item contribute gty

Selecting the Pay item contribute qty check box updates both the Current forecast (T/O) and the
Update earning rules, only if Earnings rules are set to calculate based on Forecast (T/0) qty value in Pay
items.
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Py item 1B Descrigtion
2 2
Galculatz caming amaunts by:

®) Forecast (T/0) qiy
) CE total cost

GHE Paaifion Beacript.. Py item Enming %
cantrin.
quantity
3 Misc, Rev Exte. -] 500000000000 %
a1 Wiz, R Exte 000000000000 %
316 B/C BEEE Osle. 000000000000 %
1165 000000000000 %
3161 B3BE OslerLa.. O 1500000000000 %
3164 Bowen Island . 000000000000 %
3162 BEHE Osler g, a 0000000000 %
2163 2482 Osler 3l | 00000000000 %,

2000000000000 %

] Default Earreng Aules

Deselecting the Pay item contribute gty check box in the CBS also updates both the Current forecast
(T/0) and the Update earning rules.

Pary item 10 Deacrption
F 2

Gabeulate earmeng amounts by:

(W Farecast [T/0) gty

(T} CF total cost
€83 Position Descript.. Py item Eaming %

o,

quandity
1 Mist: Rew Exte i} 500000000000 %
11 Mize. Rew Exte.. a 0.00000000000 %
116 E/C 8888 Dsle_. a 0.00000000000 %
1165 0.00000000000 %
3161 BE3E Dsler La. o 1500000000000 %
3164 Bowen Island . 000000000000 %
ERES 8838 Dsler Eq.. o OU0ICO00IN00 %
363 4828 Osler 3rd m} 00000A00H000 %

00000000000 %

[ Default Eaming Rules

4.6 ATTRIBUTES TAB

The Attributes tab allows you to tag the new cost item with user-defined entries.
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4.7 Cost categories tab

1. User-Defined Fields —free text fields that you can type values into manually

2. Tags — Many of these fields are validated fields (known as tags), meaning you can choose from
options in a drop-down list

1074

Erect Steel - Heavy

DETAILS

CBStag 16

CBStag 19

CBS tag 22

CBS tag 25

CB

©

user defined 3

CB

@

user defined 6

ATTRIBUTES

CB

@

user defined 9

CB

©

user defined 12

CB

@

user defined 15

CBS tag 17

CBS tag 20

CBS tag 23

CBS user defined 1

CBS user defined 4

CBS user defined 7

CBS user defined 10

CBS user defined 13

COST CATEGORIES

RESOURCES

CES tag 18

Hand Place

Machine Finish

Other

Shoulder Barrier - Walls
Cut Off Pile

Splice Pile

Clear

CBS user defined 8

CBS user defined 11

CBS user defined 14

Some of these tags and their drop-down values are defined at the organizational level and others are
customizable via the Project Settings under the Configure tag list value.

4.7 COST CATEGORIES TAB

The Cost Categories tab allows you to view your current budget, actuals, live forecast and forecast

remaining cost, broken down into more detailed cost categories (e.g., labor, construction equipment,

supplies, materials, etc.).

The header in the Cost Categories tab shows the % Complete, Live forecast method, and the Latest

actuals in forecast values.
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% Complete "

297 T7TTTTTTT8 %

Cost category

~ Total
v Labor
v Construction
v FOM Rented
~ Supplies
v Materials
~ Subcontract

“ Fees

DETAILS ATTRIBUTES COST CATEGORIES
Li vd Latest actuals in forecast
values
Committed cost hd O 08/21/2020
TOTAL PER UNIT
Current budget Total cost (to date) Current estimate % Live forecas * |
$100.00000 $30,565.15556 $100.00000 $31,565.15556
5 0.00000 $44111.00000 $ 0.00000 $45111.00000
5041477 $0.02304 S 040477 $0.02304
5004148 $0.00230 $0.04148 $0.00230
$ 0.00000 (4 14,000.00000) $ 0.00000 (% 14,000.00000)
$0.00000 (5 51.40000) $ 0.00000 (5 51.40000)
$0.00000 $ 0.00000 $ 0.00000 $ 0.00000
5$99.54376 $5.53021 $99.54376 5553021

Control User Guide

RESQURCES

$1.000.00000
$1.000.00000
$0.00000
$0.00000
$0.00000
$0.00000
$0.00000
$ 0.00000

If you have the correct permissions, you can change the Live forecast method. You can also change the

view of the Cost Categories values to show either Total or Per Unit cost.

1004

Peimilsss

% Coamplels

297 TTTTTTTTE %

Cost categary

# Tatal
~ Labor

% Mnmchioebinn

BETAILS

Al THIBUITES

CuG | GATELURIES

Lanlesl mgluals m farecast

Commitbted cast
Currant budges
Cuarent estimate
AVETAgE pn:rrg'l_'r'_']'liu'lﬂl:'

-
Mo

Lommmigted cask

valuas
* O 0B21/ 020
TOTAL PER LUNIT
Wtal cost (1o data) Curmamt estimats W L
5 30 545 15565 S 10000000 5 31 565 15566
S 8117 DRI 5 000000 & 4511100000
2 M &M A1AT % N N30

This is also where you enter the estimated cost into the different cost categories for the plug cost

source.

You can expand the labor category and enter your cost at the appropriate level (e.g., Labor Base

wages). You need to enter the cost under the appropriate level of the category. For example, if you
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enter the cost at the Labor category level, the cost will appear in Undefined Labor level because you
did not enter it at a specific sub-category level.

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES
Cost category Current Budget Total Cost (To Date) Current Estimate
4 Total $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00 A
4 Labor $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00
Labor Base $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00
¥ Labor Burden $0.00 $0.00 $0.00 $0.00 $0.00
Undefined Labor Undefined Labor $0.00 $0.00 50.00 $0.00
¥ Construction Equipment $0.00 $0.00 50.00 $0.00 50.00

The following Step by Step walks you through adding costs to the Cost Categories tab of the Cost item
details slide out panel.

Enter Costs in Cost Categories

Within the InEight Control main page, on the CBS tab, right click on the cost item you created.
Select Cost Item Details to open the Cost item details slide out panel.
Click on the Cost Categories sub tab.

Under the Current Estimate column, expand the Labor cost category.

o ~ 0N~

In the Current Estimate column, enter a value in the Current Estimate column for Labor Base,
then press the Tab key.

4.8 CURRENT ESTIMATE RESOURCES TAB

The Current Estimate Resources tab is where you can view and manage the CE resources for terminal
cost items.

From the Current Estimate Resources tab you can view and manage:

e Cost item details
e Current estimate resources

¢ Productivity and overall settings
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¢ Resource details

DETAILS

Control User Guide

o CURRENT ESTIMATE -
ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details A
Forecast T/0 gty UoM CE total cost CE remaining cost CBS position Cost source
10,000.00 cY $1,000,000.00 §1,000,000.00 52 Detail -
Current estimate resources ~
Row # Code Description Quantity UocM Work CE unit
hours cost
1 colo4 Concrete Bulk Commodities | 10000 cCY 0
Productivity and overall settings A
Remaining  Total
Remaining hours Remaining units/hour Remaining hours/unit
Remaining man hours Remaining units/man hour Remaining man hours/unit
Resource details ~
Rem.
C01.04
Concrete Bulk Commedities
‘When
(O] Cost category Amount
~ Total $100.00
Billing rate $100.00
Billing rate markup 5000
Billing rate markup % 0.00 %
Charge rate $100.00
Markup amount 5000
Markup % 0.00 %

To see a total sum of the resources in Current estimate resources, you must have the Cost

Source set to Detail.
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DETAILS ATTRIBUTES

Cost item details

800.00

Current estimate resources
Productivity and overall settings

Resource details

tab of the cost item.

4.8.1 Cost Driver

Forecast T/0 qty UoM CE total cost

Ton $ 800,000.00

COST CATEGORIES

CURRENT ESTIMATE

4.8 Current Estimate Resources tab

ol g
RESOURCES FORECAST RESOURCE

CE remaining cost

$ 800,000.00

~
CBS position Cost source
41 .
Detail ~
v
Plug

When the cost item’s cost source is set to Plug, you will not use the Current Estimate Resources
tab. Instead, costs are “plugged” or entered directly into cost categories on the Cost Categories

Each type of resource has a default cost driver. For example, Labor resources are duration driven so

their default cost driver is Cl Duration, meaning their costs are driven by the duration of the cost item.

If you want a resource to only be assigned to a specific cost item or work activity for half the time, you

can change its quantity to .5 and it will be driven by half of the cost item’s hours.
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1005
Erect Steel - Light

DETAILS

Cost item details

Forecast T/0 gty UoM

200.00 on

Current estimate resources

®

Row # Code

—

1.C.01.1.05
1.C.05.1.04
1.C.01.1.06
1.C.05.1.03

O0O0D0ODo

1.C.05.1.02

ATTRIBUTES

CE total cost

$ 155,000.00

Description

Laborer

Ironworker Apprentice
Crane Operator
Ironworker Journeyman

Ironworker Foreman

- CURRENT ESTIMATE
COST CATEGORIES RESOURCES

CE remaining cost CBS position

$155,000.00 42

Quantity UoM h’d‘urk
ours

2 Each
0.5 |Each
Each

3 Each

Each

Control User Guide

FORECAST RESOURCES

Cost source

Detail ~

CE unit
cost

800
200
400
1200
400

Updating the total quantity of a resource with Cl quantity as the cost driver will not auto-update

the hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to Cl

Quantity or Fixed.
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DETAILS

Cost item details

Forecast T/0 gty UoM

800.00 on

Current estimate resources

® ®

Row # Code

4]

1.C.05.1.04

(=]

1.C.05.1.02

1.C.05.1.03

w

.

1.C.01.1.05

wn

1.C.01.1.06

cost impact.

ATTRIBUTES

CE total cost

$ 800,000.00

Description

Ironworker Apprentice
Ironworker Foreman
Ironworker Journeyman
Laborer

Crane Operator

COST CATEGORIES

CURRENT ESTIMATE

4.8 Current Estimate Resources tab

FORECAST RESOURCES

RESOURGES
CE remaining cost CBS position Cost source
)00 41 .
$ 800,000.00 . Detail
CE total Cost Cost
cost driver curve
4500 $ 216,000.00 Employed Cos...
65.00 $104,000.00 Employed Cos...
55.00 $264,000.00 Employed Cos...
35.00 $112,000.00 Cl Duration Employed Cos...
65.00 $104,000.00 - . Employed Cos...
Cl Quantity
Fixed
L]

If you change the Cost Driver to Cl Quantity, the fields below will not be editable. It causes the
adjusted duration to become zero or read-only. However, it can be editable if it does make a

With CI Quantity as your cost driver for your resources, you can adjust the Work Hours manually,
where previously that column was read-only. For example, perhaps you want your Laborer to work
specifically 80 hours. The Forecast (T/O) Qty is very significant when it comes to quantity driven
resources. It determines how the cost is driven and what affects the cost of that specific line item.

For example, perhaps there is a scope change and you need to change the Forecast (T/O) Qty from 900

to 350.
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1074
Erect Steel - Heavy
DETAILS ATTRIBUTES

Forecast T/O qty UoM CE unit cost
900.00 Ton $1,000.00
Last changed on Last changed by
07/02/2025 06:51 AM Toby Stow

Description Account code

Erect Steel - Heavy 62.03.02.0C
* Forecast T/0 gty *UoM
900.00 Ton

A dialog box shows to choose whether it will affect the CE unit cost or CE total cost. Typically, you keep

the unit cost constant and adjust the total cost.

Proportionally adjust CE unit cost or CE total cost
?

You can modify Forecast T/0 gty by propertionally adjusting CE unit cost or CE total
cost. Specify the value you would like to modify:

(") CE unit cost

(@) CE total cost

=)

Note that the Welder’s work hours adjust because they are driven by the Forecast (T/O) quantity of the

cost item.

When the Cost Driver is set on Fixed, you can only update the resource’s hours by typing into the
resource itself and updating the work hours directly.
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Many of the numbers are tied to equations under the Productivity resources below. If you edit the
numbers, it will have an impact on the resources depending on the cost driver.

4.8.2 Productivity and overall settings

On the Current Estimate Resources tab, you can manage duration and quantities for the following

calculations:

- Calculation
1 Remaining hours/units
2 Remaining man hours/units

3 Remaining equipment hours/units
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1069
Earthwork
CURRENT ESTIMATE
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details ~
Forecast T/O qty UoM CE total cost CE remaining cost CBS position Cost source
10,000.00 cY $ 400,000.00 4 400,000.00 2 Detail -
Current estimate resources ~
Row # Code Description Quantity Uoh Work CE unit
O hours cost
A
O 1 1.C.051.09 Civil Journeyman 200 Each 1.454.55
_J 2 1.C051.23 Civil Apprentice 3.00 Each 2181.82
O 3 1.C01..05 Labarer 3.00 Each 2181.82
O 4 1coiaoT Civil Operator 200 Each 1454.55
L
4 G >
Productivity and overall settings ~
Remaining  Total
Remaining hours Rernaining units/hour Remaining hours/unit
7ITT 1375 0.07
Remaining man hours Remaining units/man hour Remaining man hours/unit
B8,000.00 1.25 0.80
q Remaining equipment hours Hermaining units/equipment hour Remaining equipment hours/unit
When updating the quantity of duratien driven labor resources
® Proportionally update Units\Man hours
O Proportionally update Hours
e

Resource details

Total duration hours (Remaining hours) are used to calculate labor and equipment resource work

hours where:
e Work Hours (resource) = Hours (total duration) x Quantity (resource)
¢ Total Remaining man hours = Sum (Labor Resource Work Hours)
e Total Remaining equipment hours = Sum (Equipment resource Work hours)

Total remaining duration hours are calculated using either the total value or one of the following unit
rate options in the Productivity and overall settings section:
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e Remaining hours (Duration)

° Unit rates are proportionate to total value based on Forecast T/O qty.
° Total man hours and equipment hours are proportionate to total hours based on labor and

equipment resource quantity.

e Remaining man hours

° Unit rates are proportionate to total value based on Forecast T/O qty.

° Total duration Remaining hours are proportionate to total Man hours based on Labor
resource quantity.

° Total Remaining equipment hours are proportionate to total duration hours based on
Equipment qty.

e Remaining equipment hours

° Unit rates are proportionate to total value based on Forecast T/O qty.

° Total duration hours are proportionate to total Remaining man hours based on Equipment
resource quantity.

° Total Labor hours are proportionate to total remaining duration hours based on Labor
Resource qty.

When one value is entered, all other totals and unit rates in the Productivity and overall settings

section are calculated based on that entry.

4.8.2.1 Updates to resource quantities

The options for the setting When updating the quantity of duration driven labor resources, control
how work hours are calculated when a resource quantity is updated:

¢ Proportionally update Units/Man hours — When you update quantities in the Quantity column,
this option changes the resource work hours in the Work hours column and re-calculates the
total remaining man hours and corresponding unit rates in the Productivity and overall settings
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section.

Current estimate resources

®

- Row # Code

O 1 1C051.09
[m] 2 1.C.051.23
[m] 3 1.C01.1.08
[m] 4 1.C01.0.07

Productivity and overall settings

Remaining hours

72727

Description

Civil Journeyman

Civil Apprentice

Laborer

Civil Operator

Quantity

2.00

3.00

3.00

2.00

Remaining

Remaining units/hour

1375

Total

UoM

Work
hours

1.454.55

2.181.82

2181.82

1.454.55

Remaining hours/unit

0.07

Control User Guide

Remaining man hours

8,000.00

Remaining units/man hour

1.25

Remaining man hours/unit

0.80

Remaining equipment hours

When updating the g ity of

Remaining units/equipment hour

duration driven labor resources

I ® Proportionally update Units\Man hours I

.} Proportionally update Hours

Resource details

Remaining equipment hours/unit

0.00

~
CE unit
cost
a
v
»
~
w

¢ Proportionally update Hours — When you update quantities in the Quantity column, this option
redistributes proportionally across the labor resources in line with the new quantities and does
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not re-calculate but maintains the total remaining man hours.

Current estimate resources

UoM

Each

Each

Each

Each

4.9 Forecast Resources tab

Work
hours

145455

2181.82

2181.82

145455

®
0 Row # Code Description Quantity
O 1 1.C.051.09 Civil Journeyman 2.00
] 2 1.C051.23 Civil Apprentice 3.00
_J 3 1.C0.1.05 Laborer 3.00
] 4 1coaov Civil Operator 2.00
4 G

Productivity and overall settings

Remaining  Total

Remaining hours Remaining units/hour
72727 1375
Remaining man hours Remaining units/man hour
8,000.00 1.25
Remaining equipment hours Remaining units/equipment hour
When up g the quantity of ion driven labor resources

() Proportionally update Units\Man hours
I ® Proportionally update Hours I

Resource details

Remaining hours/unit

007

Remaining man hours/unit

0.80

Remaining equipment hours/unit

4.9 FORECAST RESOURCES TAB

CE unit
cost

The Forecast Resources tab is where you can view and manage estimate resources assigned to a cost

item.
From the Resources tab you can view and manage the:

e Forecast details live forecast method

e Add new resources and adjust duration-driven resources by changing their productivity

¢ View and adjust resource rates of assigned resources
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DETAILS

ATTRIBUTES

COST CATEGORIES

CURRENT ESTIMATE

RESOURCES

Control User Guide

FORECAST RESOURCES

Forecast details

Forecast total cost

Forecast remaining cost

Forecast total MHrs

Forecast remaining MHrs

Live forecast method

$0.00 $0.00 0.00 0.00 Manual (ETC) v
Resources LS
Row # Code Description Estim Remaini... uoM Remaini...
O work hrs
1 1.C01.1.05 Laborer Labor | 0.00 Hour -
Productivity and overall settings A~
Remaining hours Remaining units/hour Remaining hours/unit
0.00 0.00 0.00
Remaining man hours Remaining units/man hour Remaining man hours/unit
0.00 0.00 0.00
Remaining equipment hours Remaining units/equipment hour Remaining equipment hours/unit
0.00 oo oon
Resource details ~
When |
@e Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost
(@)
~ Total $35.00 $30.00 $40.00

4

Like the Details, Attributes, and Cost Categories tabs, you access the Forecast Resources tab from the
Cost Item Details slide out panel.

Tasks
+ CBS Description WBS phase
0 position code
m} 1 Job Overhead 1002
O 2 Earthwark 1069
1non
o Copy >
O 1073
iy 1074
m] 1005
O s 1006
[m] (®) New costitem 1084
m] 1085
(¥) New subordinate cost item
0 1086
=] () Delete cost items(s) ! 1087
] 1088
L Adjust CBS position

Actuals details
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1074
Erect Steel - Heavy

DETAILS ATTRIBUTES
Forecast T/0 qty UoM CE unit cost
80000 Ton $1,000.00
Last changed on Last changed by

02/22/2022 0217 PM Service Account

Description Account code

Erect Steel - Heavy

= Forecast T/0 gty =UoM
200.00 Ton

CE total cost CE unit cost

CE total MHrs

COST CATEGORIES

CE total cost

$800,000.00

£2.03.02.004.06

CE total equipment Hrs

CURRENT ESTIMATE
RESQURCES

CBS position

41

* Cost source

Detail hd

|| As-built lock

Manual (ETC) -

CE labor cost/MHrs
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The Forecast Resources tab shows as an accordion menu where you can select a specific drop down
menu you want to view.

- CURRENT ESTIMATE | -
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES

Forecast details

Resources ~
® ®
Row # Code Description Estim... Remaini... UoM Remaini...
O work hrs
1 1.C.01.1.05 Laborer Labor 0.00 Hour
O 2 1.C.01.7.06 Crane Operator Labor 0.00 Hour

Productivity and overall settings

Resource details

4.9.1 Productivity and overall settings

If the resource’s cost driver is set to Cl Duration, you can change any of the values on the Productivity
tab under Adjusting duration driven resources below, and it will change the work hours of your
resources without you having to do the math yourself.
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DETAILS ATTRIBUTES

Control User Guide

CURRENT ESTIMATE

COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details v
Current estimate resources w
Productivity and overall settings ~
Remaining  Total
Remaining hours Remaining units/hour Remaining hours/unit
1,600.00 0.50 2.00
Remaining man hours Remaining units/man hour Remaining man hours/unit
16,000.00 0.05 20.00
Remaining equipment hours Remaining units/equipment hour Remaining equipment hours/unit
When updating the quantity of duration driven labor resources
@® Proportionally update Units\Man hours
O Proportionally update Hours
Resource details v

4.9.2 Resource Details

Resource Details shows the unit cost category breakdown of the selected resource listed above. The
Resource rates tab expands to a unit breakdown on a selected item under resources. It is fully editable
if you have the right permissions to do so.
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4.9 Forecast Resources tab

Resource details

~

1.C.05.1.04

Ironworker Apprentice

Cost category Scale 1 unit cost Scale 2 unit cost

~ Total $45.00 54500 $60.00
~  Labor 545.00 $45.00 $60.00
~  Construction Equipment $0.00 5000 50.00
*  FOM Rented Equipment $0.00 5000 50.00
~  Supplies $0.00 5000 50.00
~  Materials $0.00 5000 50.00
~  Subcontract $0.00 5000 50.00

4.9.2.1 .Orphan Indicator

If you change the resource rate of one of the assigned resources, then a triangle will appear. The
triangle is an orphan indicator. This means a value associated with this resource does not match the
resource’s value in the Estimated resources in the Project library. When you hover over the triangle, it
will give you a summary of all the differences between the library value and the orphaned value.

Total - Scalel 50.00

FOM Rented Equipm...  0.00

Undefined FOM Rent...  0.00

Most recent change in this item
Attribute Library value

Orphan value

100.00

50.00

50.00

Last changed by

Susan Cappelloni
Susan Cappelloni

Susan Cappelloni

2 Lab001

Last changed on

09/25/2017 02:24 PM
09/25/2017 02:24 PM

09/25/2017 02:24 PM

Welder
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Row # Code Description Quantity uoM Work CE - Unit CE - Tota
Hours Cost Cost [

2 | lab1 lab1 1 Each we 60.00 10

% 3 lab1 lab1 1 Each 4167 $60.00 515

(*) Add estimate resource

PRODUCTIVITY 2
Unit cost charge rates

CHARGE RATE

Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost

4 Total $70.00 & $0.00 $0.00

» Labor $0.00 $0.00 50.00

This is shown in case you want to change the values back to match the library. If you change the values
back to match the library, the triangle will disappear.

4.9.3 Cost Item Man-Hours

Aside from on the Cost Estimate Resources tab, you can also define productivity on the CBS register
page. The following steps walk you through how to add the planned man-hours for a cost item from
the CBS register page.

Define Cost Item Man-Hours

1. On your CBS register tab, make sure the Current estimate data block is displayed on the page, by
selecting the CE + CB viewset.

View: [ce+ce | T kD)

Cost categories
Forecasts

Project controls
Y .
Live forecast
CE Units/MH econdary UON
Unsaved (Progress)

2. Under the CE Total MHrs column, enter 16,000 for a cost item, then press the Tab key. Note — If
the cost item is a “detail” cost source you will not be able to manually adjust this field.
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~ Steel Structure Training Job M)
Actions v c8s ACS PAY ITEMS CHANGE REGISTER AUDITLOG
Tasks = t | Task Details < +e+« > ¢ B Current estimate
cBS Description Resource Forecast uom CE total MHrs CE total cost
| Pasition (T0)
Quantity

O 3 Concrete 1 1000000 CY 30,000.00 $1,500,000.00

O v4 Structural Steel 1,00000 Ton 20,000.00 $1,050,000.00

O 41 Erect Steel - Heavy 1 800.00 Ton $800,000.00

- in e . SIS ST

4.10 ISSUE TAGGING IN THE CBS

You can associate an issue to a cost item in the CBS. Issue Ids in Change have a hierarchy of issues and
subordinate issues. Associated an issue to a cost item applies to parent-level issues. Child issues take
on the cost item of the parent issue.

CBsS ACS PAY ITEMS CHANGE REGISTER
Actions = @ I_‘_I'. ®
v Formula description: Document
Tasks E issue: N/A -_
% CBS position Description WBS phase nt- Last estimated Last estimated Issue [r ce
code actual man actual equip
| % 1185 0.00 hours reversal hours reversal
2 1790 0.00
‘h a2 Cost item 1 up 0.00
33 Cost item 2 0.00
34 X 0.00
35 Detail - labor 0.00
| 6 Detail - CE 100.00
a7 Detail - other 0.00
a8 Detail - mix 10.00
39 Plug 000
40 plug2 000
4 Cost item 1 0 0.00
42 Cost item 2 02 0.00
43 Costitem 3 03 100 04/06/2021 1:18: 03/29/2021 3:08:7
A4 Cost item 4 04 0.00
45 0.00

Subtotals 804 (1 rows selected)

When you click in the Issue column, the Assign issue dialog box is shown. The list of issues originates
from the list of the issues in Change.
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Assign issue

Select  Issue
id

Issue name

Cance

Control User Guide

X

The Assign issue dialog box does not contain the full list of Issues that Change contains.
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' - Change
v G rssvewos o=
®
lssue ID PCOID Client CO 1D Issue name Issue start date Issue stat._. Asgsig

] A 12 Testing 2/1 02172021 Open

] 12.2 G Testing 2/1 02Nrr2o New

O 121 G Testing 2/1.. | 02/17/2021 New

Ll 118 new6 (B). 11/05/2020 New

L 1A newt (Qriginal). | 11/05/2020 Mew

] ~ 10 newt 11/05/2020 Open

(I 10,1 nEwh 11/05/2020 MNew

[ 9 newl newscj. 11/04/2020 Executed @
0 A8 news 11/04/2020 Open

If a parent issue in Change becomes a subordinate while you already have that issue assigned to a cost
item in the CBS, the cost item then changes Issue ID to match the parent item that the linked issue was
then relocated under. For example, if the parent issue ID was a 2 in Change and it was moved under
the parent issue ID 1, then the cost item previously linked to the parent 2 changes to the parent issue
1.
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4.11 LOCK BUDGET

4.11.1 Budgets vs Estimate

You can maintain an Original Budget, a Current Budget, and a Current Estimate, as is shown from the
CBS tab of the Control main page, using a custom data block.

cas Description was Foreca uoM 0 8-Total Cost C B-Tolal Cost C E-Final Cost
Position Phase stTO
Code aty
Job Overhead H 1002 100 Lump Su u $250,000.00 $250,000.00 $250,000.00
Earthwork H 1063 100000. CY u $400,000.00 $400,0071.00 $400,000.00
Concrete 1071 100000.  CY $0.00 $8,000.00 §5,000.00
Cancrete Footings 1088 100000 CY $0.00 $8,000.00 $5,000.00
Place/Strip Footing Forms i 100 50000  SF ! $0.00 $8,000.00 $5,000.00
Pour Faotings [ ) om0 cY ! $0.00 $0.00 $0.00

4.11.1.1 Original Budget

The Original Budget (OB) is a snapshot of the project plan in its original state, prior to execution. It is a
baseline used for comparison as the project progresses. You cannot edit your Original Budget values;
they are read-only in the CBS register, available for reference only.

Once set, the Original Budget never changes.

In the CBS register, you can find the OB values for man-hours, quantities, and costs.

Tasks i TaskDet . < eeee> : |l BM Budget View <>

cas Dessription ES Foreca UomM 0B-Total Cost Descr. Original Budget ¢ B-Total Cost ¢ E-Final Gost
Pasition Phase stTO Total Cost Formula
Coda aty |
Job Overhaad H 1002 100 LumpSu H SZE0,000.00 $250,000.00 $250,000.00
Earthvrork i 1063 100000, CY i $400,000.00 $400,001.00 $400,000.00
Concrete 1071 100000, CY $0.00 $8,000.00 $5,000.00
Concrete Footings 108 100000 CY $0.00 $2,000.00 $5,000.00

4.11.1.2 Current Budget

The Current Budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The Current Budget is therefore the sum of your Original Budget, plus or
minus any approved changes.
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See the Change Management section for more details on managing and approving budget

changes.

In the CBS register, you can find CB values for planned, earned and forecasted costs, hours and

productivity.

Tasks
cBS Description
Position
Job Overhead
Earthwork
Concrete
Concrete Footings

Placerstrip Footing Forms

Four Footings

4.11.1.3 Current Estimate

The Current Estimate (CE) represents the most up to date estimate of your work. You can update your
Current Estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or work flow.

You can use the Current Estimate as a sand box to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the Current or Original Budgets.

Tasks

cas Description
Position

Job Overhead

Earthwork

Concrete

Concrete Footings
Flace/Strip Footing Forms

Pour Faotings

1002

1069

1071

1088

1090

1087

1002

1089

1071

1089

1080

1091

Foreca
stTO
aty
1.00
10,000.0
10000.0
1,000,00

500.00

000

Foreca
ST
Gy
1.00
100000
10,0000
1,000.00

500.00

0.00

sl TaskDet . € +ee> ¢ § BM Budget View

WBS
Phase
Code

uom

Lump Su.

cY

cY

cy

SF

cY

TaskDet.. € +=2=>

was
Phase
Code

uom

Lump Su.

cY

cY

oY

£F

oY

$250,000.00

$400,000.00

$0.00

$0.00

$0.00

$0.00

$250,000.00

$400,000.00

$0.00

$0.00

$0.00

$0.00

Ko
CB-Total Cost  Dascr: Current Budget
Total Cost Formula
NiA

§250,000.00
$400,007.00

$2000.00

$8,000.00

$8,000.00

$0.00

C B-Total Cost

$250,000.00
§400,001.00
§2,000.00
$8,000.00
$2,000.00

$0.00

All editable cells in the Current Estimate CBS grid are single click.

InEight Inc. | Release 26.5

4.11 Lock Budget

$250,000.00

$400,000.00

$5,000.00

$5,000.00

$5,000.00

S0.00

Dascr: Current
Estimata Final Cost
Formula: NJA

§250,000.00

$400,000.00

§5,000.00

$5,000.00

$6,000.00

$0.00
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4.11.2 Lock Budget and Price

When you first create your project, your cost breakdown structure is unlocked, meaning you can make
changes to your current estimate, but there is no locked down budget for tracking purposes. Your
Original Budget and Current Budget data blocks therefore contains no values.

Conlrol * Woikspaces ¥

cas o ACS PAY ITEMS CHANGE REGISTE View: CE+CB -
awors v (@) 2 5 & ¥V E O ® IE Q
The budget is unlocked and only Current estimate can be modified. Click to Lock budget Dismiss
__ CBSposition Description Units/MHr CE final unit Secondary CB total CE total MHrs C8 total cost B MHrs/Unit
| cost UoM quantrty
U 1 Jub Overhead 0.00 $ 250.000.00 ~
2 Larthwork 128 § 40,00
0 3 Concrete 033 $ 150.00
4 Structural Steel 012 $3N.74

Locking your budget creates an Original and Current Budget based on your Current Estimate values.
Keep in mind that:

¢ Your Original Budget cannot change

e Your Current Budget can only change via approved change orders. For more information, see
Change management overview .

e During project execution, you can compare your actual costs and man-hours to your Original and
Current Budgets to track you progress

In the CBS you can lock the budget by selecting Actions > Lock/unlock budget > Lock Budget or Lock
project budget and price.
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CBS o ACS PAY ITEMS CHANGE REGISTER

Actions ¥ ® M ® 9
The budget is unlocked and only Current estimate can be modified. Click tq Lock budget

Global forecast method.

Set forecast method Description

Time phased forecasting

4.11 Lock Budget

AUDIT LOG View : | Forecasts

$ & vV m B DB

Task details Cosee> t | Forecast | created from Live forec... ¥ B < oee>

- Resource Forecast (T/0) UoM Forecast final Forecast final Forecast final Forecast final
metal bracing quantity man roductivity
; Claim multple CBS quantities hours/Unit actor
16 1.00 Lump Sum $695.00 11.00 11.00 0.00
Budget move and contract adjustment b
| D R 5 1000000 CY $400,000.00 8,000.00 080 0.00
Lock budget
syne » 6 1000000 CY $1,500,000.00 30,000.00 3.00 0.00

Unlock budget

Reverse estimated actuals »
Lock project budget and price

The Budget Lock Status columns then changes to a locked symbol.

Pay item Description Current Price

O number forecast lock
(T/0) gty status
U 001 Earthwork - Lab... 1.00 G
O 002 Concrete - Lab__ 1.00 ™
OJ 003 Steel - Labor & . 1.00 ™

In Pay Items, you can also lock your price and budget for pay items by selecting Actions > Lock/unlock

price>Lock Price or Lock project budget and price.

Actions ¥ @ ®

Lock/unlock price »
Lock price
funlock price P
Sync 4 Curreni
Unlock price
Budget move and contract adjustment P
Lock project budget and price ¢
O 002 Concrete - Lab... — :
0O 003 Steel - Labor & ... 1.00 ™ §1

The Price Lock Status columns then changes to locked.
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Pay item Description Current Price

J number forecast lock
(T/0) gty status
O 001 Earthwork - Lab.. 1.00 G
U 002 Concrete - Lab.. 1.00 ™
O 003 Steel - Labor & ... 1.00 ™

4.11.3 Unlock Budget and Price

Control User Guide

After you lock your budget, in rare instances, it might be necessary to unlock your Original and Current

Budgets, though this is typically not recommended. For example, after initial import of your estimate
into Control, you might need to make further adjustments to your cost breakdown structure to

conform your estimate to the working plan for the project. Normally, unlocking your budget is the

exception, not the rule.

Actions hd @ |__1l’3:’r @

S _
Set forecast method

ription WBS
code
Time phased forecasting
wvorhead 1002
: Claim multiple CBS quantities work 1069
Budget move and contract adjustment P rete 107
! 73
i Lock/unlock budget >
L budge 74
Sync 1]
Unlock budget 05
Reverse estimated actuals » ] ] 0g
Lock project budget and price
84
O 5 1 Earthwork - Materials 1085

In Pay Items, like locking the budget for cost items, you unlock the price from the Actions menu.
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Actions ¥ @ @

Lock/unlock price »

Lock/unleck price

3ync
Unlock price

Budget move and contract adjustment P
Lock project budget and price

002 Concrete - Lab...

l nna Stesl - 1 shar & I 100 [

4.12 ASSIGNED VENDORS

You can assign a vendor to a cost item, and also view the assigned vendors from InEight Contract. A
cost item with a vendor assigned serves two purposes. The first purpose is informative, letting the
product team know a vendor is related to that cost item, either as a material supplier or as a
subcontractor doing the work. The second purpose is functional, as it controls what tasks a vendor can
view when logged into a daily plan in InEight Progress. The vendor will only view tasks related to the
cost items/WBS phase codes with that vendor assigned to them in Control.

If a vendor is assigned via a contract, the vendor name is automatically assigned to a cost item and
cannot be removed.
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Tasks

2 CBS position

| 1

O w2

O 21

O v 22

O 221

O v 23

O v 231

O o231

O 23111
O 23112
O 23113
O 23114
O 23115

Description

Financial Results Analysis

Misc. Rev Internal

Misc. Rev Internal
Escalation/Contingency

General Project Risk

Directs

Direct Labour

Grading Work

Resurface Existing Access road
Maintain Access Road

Clear & Grub Bench B & West Layd...
Type D Excavation LD/PL/CP to E..

Road Subgrade Prep/Place/Finish...

Control User Guide

i l Assigned Vendors

Assigned vendor

Plaza Building Co...

Finance Group Inc.

Mining Grou... Midwest Aviation
Power Cons... Engineering ...
Finance Gro...

Mexico LLC

Canada Inc

Enterprises Inc

Finance Gro...

Censtruction Kiewi...

Infrastructur...

Clicking in an Assigned vendor field lets you add new vendors. Vendors originate from the master data
library for the entire organization.

Page 192 of 632

InEight Inc. | Release 26.5



Control User Guide 4.12 Assigned vendors

Vendor assignment

Vendor ID Vendor name

0000007003 Mining Group Inc.
0000007008 Aviation

0000001013 Management Co.
0000001014 Infrastructure Co.
0ooooo1022 Infrastructure Engineer...
0000001035 Engineering (NC) Co
0000007037 Power Constructors Co.
0000001039 Finance Group Inc.
0000007042 Construction Cie

0000001044 Infrastructure South Co.

0
O
O
O
O
O
a
a
a
O
O
O

0000007049 Building Company
+ [ —

Clear ‘ [ Cancel ]
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CHAPTER 5 — PROGRESS
MEASUREMENT

5.1 Progress measurementworkflow ... ...
5.2 Progress Measurement Overview ...
5.2.1Budgetsvs Estimate ... ..
5.2.2 Earned value managementterms ...
5.2.3 Productivity ... .
5.2.4 Updating Forecast (T/O) Qty ...
5.2.5 Update Forecast (T/O) Qty with Plan components ...................
53DateRange Setup ...
5.4 Manage Actuals ... .
5.5 Actuals by Sync ...l
5.5.1SyncQuantities ...
5.5.2SyncHours and COStS ...
S.5.3AUdItLOg ...
5.6 Actuals by Import ... .
5.7 Actuals by Manual Entry ... .
571 ClaimQuantities ...
5.7.2ClaimMan-hours ...
5.7.3 Claim EquipmentHours ... ..
5. 7.4 Claim CoSt ...l
5.7.5 Add Additional Claiming entries ...
5.7.6 User-Defined Fields ... ... ... ...
5.8 Actuals by APl
5.9 User-definedfields ... .
5.10 Estimated Actuals ...

5.10.2 Estimated Actuals from Progress ..o
5.10.3 Reverse Estimated Actuals ...
S. 1T Actuals History ...
5.12 Progress Control Settings ... ...
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5.13 Vendor Work Hours from Progress ... 251

5.13.1 Vendor MHrs from Progress ... 251
5.14 Track Open/Remaining and Total Committed Costs ... 254
5.15 Committed cost from Contract ... 260

5.1 PROGRESS MEASUREMENT WORKFLOW

Estimate

Historical Benchmarking

Conform Estimate / WBS Structure

Progress - .
orecastin,
Account Code Measurement g

Final Hours and Costs
Management CBS Register

ACS Register Create & Manage Forecast Method Budget/Forecasts

5 Cost Items. Setup Quantities
Define Qty Account
Contribution Codes )
Analyze Planned Live

Forecasts
Earned and Actual Forecast

WS Structure / Budgeted
Quantities & Hours

Approved changes
update Current Budget Revenue Management

I
Billed Revenue
Change Management -
Change Register Pay item Register
Budget Move Create/Manage
Pay ltems
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue

5.2 PROGRESS MEASUREMENT OVERVIEW

Progress measurement plays a key role in tracking how much work has been completed and how it
aligns with contract deliverables. Payment terms are often tied to the value of work performed,
making it essential to measure progress accurately. A clear and consistent approach to progress

tracking helps teams manage performance, support billing, and maintain visibility throughout the life
of the project.

To measure progress effectively, it’s important to understand a few key terms and how they relate to
budget and performance tracking.
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5.2.1 Budgets vs Estimate

In InEight Control, you can maintain an original budget, a current budget, and a current estimate.
These values can be referenced in preset data blocks, or in a custom data block like the one shown
below.

Tasks ¢ | Budgets oo >

v CBS Description WBS phase 0B total cost CB total cost CE total cost % complete
position code

~6 Electrical Systems Installation 1088 $83930.00 $ 86.275.00 §97,537.00 44.03 %
61 Install Electrical Conduit 1089 $37.400.00 $ 37,400.00 $44,880.00 60.00 %
62 Pull Wire 1090 1 $32,160.00 $33,165.00 $26,180.00 40.00 %

6.3 Install Light Fixtures 1091 $10,050.00 $11,390.00 $11,72500 20.00 %

00 0O0Qg o

6.4 Test Electrical Systems 1092 i $4,320.00 $4,320.00 $4752.00 0.00 %

5.2.1.1 Original Budget

The original budget (OB) is a snapshot of the project plan in its original state prior to execution. It is a
baseline used for comparison as the project progresses. You cannot edit your original budget values;
they are read-only in the CBS register, available for reference only. After the original budget is set, it

will not change unless you unlock it.

In the Control CBS register, you can see the OB values for man-hours, quantities, and costs.

Original budget <e> :
OB total cost OB total MHrs OB total gty OB unit cost

$83930.00 2,480.00 1.00 $ 83,930.00

i $ 37,400.00 1,100.00 1,000.00 $ 37.40

i $ 32,160.00 960.00 800.00 $40.20

i $10,050.00 300.00 150.00 $ 67.00

” $4.320.00 120.00 20.00 $216.00

5.2.1.2 Current Budget

The current budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The current budget is therefore the sum of your original budget, plus or
minus any approved changes.
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See Change Management for more details on managing and approving budget changes.

In the CBS register, you can access the Current budget data block and view CB values for planned,
earned and forecasted costs, hours, and productivity.

Current budget < oo >

Bud... CB total CB total MHrs CB total cost CB MHrs/Unit CB units/Mhr

lock quantity

status

a 1.00 2,550.00 $86,275.00 2,550.00 0.00

I & 1,000.00 1,100.00 $37,400.00 110 091
| a 825.00 990.00 $33,165.00 120 0583
” a 170,00 34000 $11,390.00 200 050
! a 2000 120.00 $4,320.00 6.00 017

5.2.1.3 Current Estimate

The current estimate (CE) represents the most up-to-date estimate of your work. You can update your
current estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or workflow.

You can use the current estimate as a sand box to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the current or original budgets.

In the CBS register, you can access the Current estimate data block to view a variety of columns for
measuring and analyzing the progress of your project.

Current estimate { ooe >
CE total MHrs CE total cost CE MHrs/umt CE units/MHr CE unit cost
278329 $97,537.00 278329 0.00 $97,537.00
i 1,275.00 $ 44,880.00 1.06 0.94 $37.40
:: 1,042 65 $36,180.00 116 0.86 $40.20
i 337.90 §11.725.00 1.93 0.52 $67.00
! 127.74 $4,752.00 5.81 017 $216.00
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5.2.2 Earned value management terms

5.2.2.4 Planned Value (PV)
Planned Value (PV) is the costs and hours you have estimated and scheduled for the project. Think of
PV as your approved budget of scheduled items. In Control, your PV includes the following columns:
e CE total Cost
e CE total MHrs
e CB total cost
e CB total MHrs

Planned Value EEEad to [ <o
CE total cost CE total MHrs CB total MHrs CB total cost Start Finish
$97,537.00 2,783.29 2,550.00 $86,275.00 03/01/2025 11/05/2025
:: $ 44,880.00 1,275.00 1,100.00 $37.400.00 07/01/2025 07/31/2025
H $36,180.00 1,042.65 990.00 $33165.00 08/01/2025 08/25/2025
:: $11,725.00 33790 340.00 $11,390.00 08/25/2025 09/15/2025
! §4,752.00 12774 120.00 $4320.00 09/15/2025 09/25/2025

5.2.2.5 Earned Value (EV)

Earned Value (EV) measures the amount of money you merit in return for the work performed up to
that point. You can use EV to measure how much of your planned costs and hours you should have
spent so far, according to the percent of work completed. Earned Value uses formula Planned Value x
% of work completed = Earned Value.

In InEight Control, your EV includes the following columns:
e CE cost earned
e CE MHrs earned
e CB cost earned

e CB MHrs earned
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Earned Value Feee to ]

CE cost earned CE MHrs CB cost earned CB MHrs % complete
earned earned
$ 4374500 1,249.64 §37.984.00 1,124.00 44.03 %
i $26928.00 765.00 §22,440.00 660.00 60.00 %
i $14.472.00 417.06 §13,266.00 396.00 40.00 %
i $2345.00 67.58 $2.278.00 68.00 20.00 %
! $0.00 0.00 $0.00 0.00 0.00 %

5.2.2.6 Schedule Performance Index

Schedule performance index (SPI) measures how close the work is being completed according to the
designated schedule. It is uses the formula CB cost earned = CB planned value (to date).

SPI <ed> H

SPI CB cost earned CB planned
value (to date)

0.60 $37,984.00 $62,978.39

:: 0.74 $ 22,440.00 $30,161.29

:: 0.61 $13,266.00 $21,785.81

:: 0.28 $2,278.00 $8,104.84

| 0.00 $0.00 $ 2,926.45

The SPI calculation uses the time-phased budget values as planned values. To accommodate the time-
phased budget values, the planned value includes the cumulative time-phased budget planned value to
date.

5.2.2.7 Actual Cost (AC)

Actual cost (AC) refers to the costs you incur when you perform the work. You can view AC in the
Actual cost (to date) column.
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Actuals BN to ™

Actual cost (to
date)

$37,680.00
$21,884.00
$13518.00

$2,278.00

$0.00

Actual MHrs
(to date)

1,236.00
740.00
430.00

66.00

0.00

Actual gty (to
date)

{ o0e >

Actual

MHrs/unit (to
date)

0.44

720.00

360.00

35.00

0.00

2,807.39
1.03
1.19
1.89

0.00

CB MHrs G/L
(to date)

-112.00
-80.00
-34.00

2.00

0.00

5.2 Progress Measurement Overview

CB actual cost
G/L (to date)

$304.00
$556.00
($ 252.00)
$0.00

$0.00

5.2.2.8 Variance

Variance is the difference between EV and AC and uses formula Earned Value - Actual Cost = Variance.

Variance indicates if you are performing better or worse than planned up to that point. Control uses
the term Gain/Loss (G/L) rather than variance, shown in the following columns:

¢ CE actual cost G/L (to date)
e CE MHrs G/L (to date)
e CB actual cost G/L (to date)
e CB MHrs G/L (to date)

5.2.2.9 Remaining

Remaining is a general finance term for money that is not yet used. Control uses the formula Planned
Value - Actual Cost = Remaining Value to calculate remaining cost.

In other words, remaining cost is the difference between what you originally planned and what you
have spent so far, to help you understand how much cost or how many man-hours you have left.

The table below summarizes each EVM term with its equivalent term in Control and what it measures.

InEight Control Term What it measures

Planned Value CE total cost Budget of scheduled values
(PV) CE total MHrs

CB total cost

CB total MHrs

CE cost earned
CE MHrs earned
CB cost earned

Earned Value
(EV)

Planned value x percent complete
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InEight Control Term What it measures

CB MHrs earned

Actual Cost (AC) Actual cost (to date) Actual + expended values
Actual MHrs (to date)

Variance CE actual cost G/L (to Difference between earned value and actual
date) cost
CE MHrs G/L (to date)
CB actual cost G/L (to
date)
CB MHrs G/L (to date)

Remaining Remaining qty Difference between planned value and earned
CE remaining cost value
CB remaining cost
CB remaining qty

The following displays planned vs. earned vs. actual values within a custom data block of the CBS
register of InEight Control:

PV -EV-AC <e>

Description WBS phase CB total CB cost Actual cost CB total CB MHrs Actual MHrs CB total CB earned Actual
code cost eamed (to date) MHrs  eame d (to date) quantity aty (to date)

Electrical Systems Installation 1088 $86,275.00 $37,984.00 $37,680.00 2,550.00 1,124.00 1,236.00 1.00 0.44 044
I
i

Install Electrical Conduit 1089 $37.,400.00 $22,440.00 $21,884.00 1,100.00 660.00 740.00 1,000.00 600.00 720,00

Pull Wire 1090 $33,165.00 $13,266.00 $13518.00 990.00 396.00 430.00 825.00 330.00 360.00

Install Light Fixtures 1091 $11,390.00 $2278.00 $2278.00 340.00 68.00 66.00 170.00 34.00 35.00

Test Electrical Systems 1092 H $4,320.00 $0.00 $0.00 120.00 0.00 0.00 20.00 0.00 0.00

5.2.3 Productivity
If you are the contractor building a project, you will need to monitor the performance of your crews,
including how productive they are and how much they are being paid.

Productivity is a measure of effectiveness: the rate of output per unit of input. This can be measured
with the following equation: Productivity = Earned MH + Actual MH.

You can view productivity values in the following columns:
e CB productivity factor

e CE productivity factor
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5.2.3.10 Compensation Factor (CF)

Compensation is the amount of money paid to an employee for their hours worked. Compensation
factor is a numerical value comparing the budgeted compensation to the actual compensation. For
example, if you had budgeted for work to be completed by master electricians, but you actually used
2nd year apprentices (making a lower wage), then that change would be reflected in the compensation
factor. In InEight Control, compensation factor is shown as Compensation factor (to date). You can
calculate compensation factor using formula Compensation Factor = Budgeted MH Cost + Actual MH
Cost.

5.2.3.11 Labor Efficiency Index (LEI)

Labor efficiency index (LEI) is a numerical value assigned to indicate the effectiveness of resource
utilization. In Control, it is shown as LEI (to date). You can calculate LEI using formula LE/ = Productivity
+ Compensation Factor.

If LEl is greater than 1, it means that you are using your resources effectively. If LEIl is lower than 1, it
means your resources are being used poorly.

5.2.4 Updating Forecast (T/O) Qty

The Forecast (T/O) qty represents the total amount of work or materials expected to be completed for
a cost item by the end of the project. This value can be updated as the project progresses and
represents the current estimate of total quantity, comparable to the original or current budget
quantity.

There are a number of ways to update the Forecast (T/O) qty:

1. Direct entry in the CBS
Rolldown from assigned pay item (need to have this setting enabled)
Rolldown from parent cost item (Qty driver is Superior Cl)

Rollup from subordinate cost items (Contribute qty is checked)

a & N

Cost item import
6. Costitem API

When you update the Forecast (T/O) qty, you are prompted to update either the CE unit cost or CE
total cost. You can also choose to update either the CE labor cost/Mhr or CE total MHrs, and either CE
construction equipment cost/hr or CE total equipment hrs (if applicable).
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Proportionally adjust CE unit cost or CE total cost

?

You can modify Forecast T/0 gty by proportionally adjusting CE unit cost or CE total
cost. Specify the value you would like to modify:

(O CE unit cost

O CE total cost

Cancel

Updating the Forecast (T/O) qty adjusts the remaining quantity for a cost item, which in turn updates
the forecast values. Since forecast is calculated as Remaining Quantity x Selected Unit Cost, any change
to the Forecast (T/0) gty directly affects the forecasted cost. This also impacts the % Complete, which
is calculated as Quantity Claimed + Forecast (T/O) Qty. As a result, earned value metrics and forecasted
revenue values are updated to reflect the new progress and cost expectations.

5.2.4.12 Forecast (T/O) - CB qty delta column

The Forecast (T/O) - CB qty delta column shows you the difference between the Forecast (T/O)
qguantity and the current budget total quantity columns.

The calculation for this formula is Forecast (T/0) qty - CB total quantity.

Tasks i @l Task details - LK
3 CBS Description 'WBS phase Forecast Forecast (T/0)
position code (T/0) gty - CB qty delta
G Electrical Systems Installation 1088 1.00 0.00
0 61 Install Electrical Conduit 1089 i 1,200.00 200.00
0 62 Pull Wire 1090 i 900.00 75.00
0 6.3 Install Light Fixtures 1091 H 175.00 5.00
O 6.4 Test Electrical Systems 1092 H 2200 2.00
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You can filter for cost items with a delta greater than 0 when you want to align the Forecast T/O
Quantity and CB total quantity.

Forecast (T/0) UoM Allow as-built
- CB qty delta

{  Show items with value that:

( Equal -
(
0
(
91 AND hd
( Equal v

5.2.5 Update Forecast (T/O) Qty with Plan components

The Plan component total qty column represents the planned quantities defined in InEight Plan —
essentially, what the team expects to install or complete based on the scope and schedule. Based on
details from the field, these planned quantities may differ from the Forecast (T/O) quantity defined in
Control.

You can compare planned quantities with the current forecast in the following columns:

¢ Plan component total gty

This allows you to identify discrepancies and make adjustments as needed.

Task details : B Actuals B to (| Ceoe >

Forecast UoM Actual gty (to Plan Forecast (T/0) Actual
(T/0) qty date) component - Plan MHrs/unit (to
total gty component gty date)
1.00 Ea 0.44 2,807.39
120000 LF i 720.00 1,440.00 -240.00 1.03
90000  LF i 360.00 900.00 0.00 119
n
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In InEight Plan, cost items from Control are associated to more detailed components. Each
component has a planned quantity and can also capture actuals as installed quantities. Multiple
components may roll up to a single cost item.

For example, the Install Conduit cost item is assigned to WBS phase code 1139 in the CBS. In Plan, this
cost item is represented by two components:

e Conduit Material: 150 units

¢ |nstall Conduit: 120 units

Component details
= Name Claiming scheme Quantity WBS
sh
] Road Subgrade Road Subgrade 293.60000 1008
% Conduit material Conduit 150.00000 1139
Install conduit Electrical 120.00000 1139

Together, these total 270 units, which appears in Control as the Plan component total quantity for the

cost item.

% CBS Description WES phase Plan
position code component
total gty
5 Install conduit 1139 270.00

To align the forecast with the planned scope, use the Update Forecast (T/O) qty with Plan component
total qty option under the Actions drop-down menu. This copies the Plan quantity directly into the
Forecast (T/0) qty field.
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Actions = @ |-_|f:’ ®

Time phased forecasting

Update Forecast (T/0) gty with Plan compone...

Claim multiple CBS guantities
i':1 Budget move and contract adjustment >

Lock/unlock budget »

l ; Sync »

. wy
Reverse estimated actuals [ 2
- 1 v v
You can also access this option from the cost item menu.
“ | I | T T e B o ey a2
1Y O _ Earthwork Copy .
o I o paste |
-asie
l Z O _ Structural Steel
Insert copied cost items >
(] 41 Erect Steel - Heavy
4.2 Erect Steel - Light | @ New cost item
o e Bolted Connections @ New subordinate cost item
® Delete cost items(s)
O 51 Earthwork - Materials \
O 52 Concrete - Materials L3 Adjust CBS position |
o 3 Structure Steel - Materials Df Update Forecast (T/0) gty with Plan component total gty
(] _ Electrical Systems Installation
[@ Costitem details
O 6.1 Install Electrical Conduit
O 6.2 Pull Wire Actuals details
M &2 Install | inht Fixtures 5
Change summary
Subtotals 18 (1 rows selected)
4 4
© 2025 InEight Inc. Privacy Statement Terms & Conditions | v2 Cost item dashboard
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5.3 DATE RANGE SETUP

InEight Control gives you flexibility in the form of a Date Range option. The following Step by Step
walks through how the Date Range setup feature works.

Date Range Setup

1. Click the View drop-down to change your view.

View :| ce+ce T
) m B B = Q

2. Select the Progress viewset from the View drop-down list.

View: CcE+cB h
O Ijjf PT view
Cost categories
{ see ) Unsaved (CE + CB)
{Unit CE Units/MHr CE .
coy Live forecast
11.00 0.09 fievenue
Project controls
0.80 1.25
View more »
Forecasts
Progress
view as
Prograss |
20.00 0.05
20.00 0.05
0.00 2,800.00 New view
0.00 0.00

3. Inthe Actuals data block, select the left calendar field on the date range chooser and choose the
first day of this month.
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Actuals 0] 7/3/2018

June 2018 Total cost (to

(todate)  "sy Mo Tu We Th Fr sa ® date)

27 28 29 30 31 1 2 000 $ 0.00
3 4 5 & T 8 9

0.00 $0.00
0 11 12 13 14 15 16
17 18 19 20 21 22 23 0.00 $0.00
24 25 26 27 28 29 30 0.00 $0.00
1 2 3

0.00 $0.00

Tuesday, July 03, 2018

0.00 0.00 0.00 $0.00

¢ To manually select your date range, click into the date cells along the header of the Actuals
data block and select your desired to and from dates

4. Select the right calendar field on the date range chooser and select the last day of this month.

5. Select the calendar icon.

H Actuals |EEESTN +o NIRRT 62 Cooe>

Oty complete MHrs/Unit (to CB MHrs G/L Total cost (to
(to date) date) (to date) date)

0.00 0.00 0.00 50.00

0.00 0.00 0.00 $0.00

6. Select Last month end from the calendar.
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K+ KT

To date

B MHrs/Unit (to Tt
date) d:
Current week
0.00 0.00
Last week end 7]
0.00 0.00
Last week (period)
0.00 0.00
sl | Last month end (2]
0.00 0.00 l

Last month (period)

¢ To select your date range from the pre-set list, click on the calendar icon within the
Actuals data block header and select the desired date option

KO+ KT

To date

B MHrs/Unit (to Tt
date) d:
Current week
0.00 0.00
Last week end (7]
0.00 0.00
Last week (period)
0.00 0.00

Last month end (7]
0.00 0.00 l
Last month (period)

Both week and month end date rules are determined during project setup within the
Fiscal Calendar setting. For more information, see the Fiscal calendar setting topic.
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5.4 MANAGE ACTUALS

In Control, you can choose from four methods for tracking actual values:
¢ Sync — Lets you connect directly with other systems to update data in real time.
¢ Import — Allows you to upload spreadsheet data.
e Manual entry — You can input data directly into the system.
¢ API - Allows you to connect data from external sources, such as an ERP.

These methods help ensure that project records are accurate and up to date. The following topics
provide more details on methods for managing actuals:

e Actuals by Sync

e Actuals by Import

e Actuals by Manual Entry

e Actuals by API

5.5 ACTUALS BY SYNC

Update Control data in real time by connecting with InEight applications and other external systems.

5.5.1 Sync Quantities

A quantities sync lets you to bring actuals from other InEight applications into Control. Quantities are
brought into Control through a Get Quantities sync. The Actual qty (to date) column is updated when
the sync is complete.
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Actual gty (to
date)

07
1.00
0.28
0.53
750.00
200.00
1.00
0.00

Sync operations are accessed from the Actions menu in the CBS.
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Actual
MHrs/unit (to
date)

X1 -1 3l 05/30/2025 R{0) ™9

122,97
0.00
0.00
0.00
0.00
0.00
0.00
0.00

CB MHrs G/L
(to date)

0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00

Control User Guide
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Performing a Get Quantities Sync

1. From the Actions menu, choose Sync > Get quantities.

Actions = @

Y Time phased forecasting - Task details

Update Forecast (T/0) gty with Plan compone... Resources Foret
| (T/0)
Claim multiple CBS quantities
‘_:1 Budget move and contract adjustment » ent Permit ::
- I
Lock/unlock budget y bance Permit i
n
.|
| Sync »  Push CBS structure

Reverse estimated actuals » Push CBS structure and Budget

Push CBS structure and Live forecast

1.7 Bacteria Testing
Push CBS structure and Actual quantities
18 Storm Drain Vid
19 Sewer and Manl Push CBS structure, Budget, Live forecast, and ...
v 1.10 Subcontractorh p, Pay Item
1.10.1 CIP Concrete Su

. Push Billed revenue
1.10.2 Landscaping Su

1103 Rotomill/Pulveri Push Forecast revenue

1.10.4 Striping Sub Mo ., quantities »

1105 Survey Sub Mo

Get Actual cost and MHrs
1.106 QC Testing Sub

1.107 Traffic Control § Get Billed revenue
——— m

]O00 00000000 o

2. Choose the time period for the sync (Through previous pay period or Job to date).

J l.UU  Eacn

i Push Forecast revenue 1.00__Each

2 Get quantities » Through previous pay period
| Get Actual cost and MHrs Job to date

3 Get Billed revenue 100 Each

T — n - -

3. A status message notifies you that the sync has initiated.
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Get to-date quantities sync initiated

ACS PAY ITEMS CHANGE REGISTER

5.56.1.1 Types of Get Quantities Syncs

Depending on your project configurations, the Get Quantities sync can bring in values from InEight
Design, InEight Plan, or InEight Contract. Each of these applications tracks quantities differently,
depending on its role in the project lifecycle.

InEight Design

In InEight Design, engineering deliverables are broken down and tracked as scope items. As work on
scope items is completed, team members can claim partial or total quantity values. Scope items are
linked to cost items through the WBS phase code. As a result of a Get Quantities sync, scope item
guantities update the actual quantity for their associated cost items.

Engineering

CONTROL
Workspaces

Scope items link to
— costitemsviaWBS ——
phase code

WBS Phase
Code Roll-up

1

[ [ | Actual gty (to
date)

Scope Scope Scope
Items Items Items

InEight Plan

Quantities from InEight Plan represent completed progress in the field. Quantities can be captured
directly in the Quantity Tracking module, or they can be captured through approved daily plans from
InEight Progress. Components are linked to cost items through the WBS phase code. As a result of a
Get Quantities sync, component quantities update the actual quantity for their associated cost items.
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PLAN

CONTROL

Workspaces

Quantity Tracking

Components link
—— tocostitemsvia —»
WBS phase code

Actual qty (to

Components
date)

T

Approved daily plans update
component quantities

' PROGRESS

Daily Planning

Installed
quantities

InEight Contract

Quantities from InEight Contract represent completed progress associated with a third-party contract.
Contract line items can be broken down into schedule of value items to track field progress. These SOV
items can be claimed directly in InEight Contract, or they can be claimed as contract components in
InEight Plan. SOV items are linked to cost items through the WBS phase code. As a result of a Get
Quantities sync, SOV quantities update the percent complete and actual quantity for their associated
cost items.
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E

CONTRACT
CONTROL
SOV items link WOI‘kSpaCGS
- —— tocostitemsvia —»
Line items WBS phase code
T % complete ACtu;;Eet)y (to
[ | |
Sov Sov sov
items items items

t

Components link to SOV
items via WBS phase code

PLAN
Quantity Tracking

Contract
components

To update complete from InEight Contract, you must enable the settings for the project in Control >
Project Tracking > Actuals. Switch the Update % complete from Contract toggle to On.

= Y  Road & Bridge Project| 106000 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS
®
@ Actuals
@ Calculate percent complete for individual cost items as a percentage of Cap percent complete at 100%
® Forecast (T/0) gty L Yes .‘
®

. Calculate percent complete for roll-up items such as superior costitems and  Roll-up pereent complete weighted by
® account code by:

Cost - Current Budget v

Calculate man hours eared at the parent level by (1)

@® The summation of man hours eamned from direct child items

O The total man hours multiplied by percent complete

Get actual cost from Contract (i) © Update % complete from Contract (i) ©

Drive committed cost values from Contract (1) @ Caleulate percent complete for individual cost items as a percentage of

After the Update % complete from Contract setting is enabled, select from the Calculate percent
complete for individual cost items as a percentage of drop-down list to define how you want to
calculate the percent complete for cost items.
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Update % complete from Contract @ @

Calculate percent complete for individual cost items as a percentage of

Current budget total cost hd

Current budget total cost
_ | Committed total cost
Forecast total cost

Current estimate total cost

The calculation for this option is: (updated % complete on the cost item) = (SOV unit price) x
(Claimed gty in Contract or Plan) + (Denominator in settings). Actual qty (to date) = % complete
* Forecast (T/O) qty OR CB total gty (depending on settings).

5.5.2 Sync Hours and Costs

If your project uses external systems to capture man-hours and costs, those values can be brought into
Control through a sync. If your project uses an ERP system, you can bring in man-hours and costs by
performing a Get Actual Cost and MHrs sync. If you have values tracked through contracts, you can
enable project settings to bring those values in from InEight Contract. Hours and costs brought into
Control through a sync update which updates the Actual cost (to date) and Actual MHrs (to date)
columns.
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Actuals to IR

Actual cost (to Actual MHrs
date) (to date)
$ 583,998 84 1.935.50
$ 524.328.84 1.824.00
” $0.00 0.00
” $ 104.100.00 0.00
” $12.800.00 0.00
” $ 62.375.00 1.800.00
ERP

Control User Guide

After man-hours and costs are verified in your ERP system, you can initiate a sync to bring those values
into Control. Similar to the Get Quantities sync, the Get Actual Cost and MHrs sync is accessed from
the Actions menu.

Page 218 of 632

InEight Inc. | Release 26.5



Control User Guide

Actions = @

Time phased forecasting
Update Forecast (T/0) gty with Plan compone...

Claim multiple CBS quantities

i':'l Budget move and contract adjustment »
Lock/unlock budget »

A
! Sync »
Reverse estimated actuals »

Pour Concrete

Demob

- Task details

ations

ape and Clean ”

Push CBS structure

Resources

Is

Push CBS structure and Budget

Push CBS structure and Live forecast

Get quantities

Fore

(o

Get Actual cost and MHrs

Get Billed revenue

O 117 Building K&L - §
Push CBS structure and Actual quantities

O 118 Concrete - Build
O 119 Building N&O - ¢ Push CBS structure, Budget, Live forecast, and ...
O 1.1.10 Concrete Found  pyc, pay item
] CFA Piling

. Push Billed revenue
O Building X
O Finegrade Push Forecast revenue
O Formwork
]
]
O

5.5 Actuals by Sync

If your project captures work hours through InEight Progress, those hours and their associated costs
are approved in Progress before being sent to the ERP.

$24
PROGRESS

Daily Planning

Daily Plans

Weekly Time Sheet

Weekly Time Sheets

Hours Costs

Time Cards
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Workspaces

Actual MHrs
(to date)

Actual cost
(to date)
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InEight Contract

InEight Contract can record actual costs in the form of goods receipts, accruals, invoice receipts, or
payment forms. You can configure your project settings to pull these actual costs into Control through
a batch process.

In project settings, under Control > Project Tracking > Actuals, switch the Get actual cost from
Contract toggle to On.

P PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS
® Actuals

A

Calculate percent complete for individual cost items as a percentage of Cap percent complete at 100%

Forecast (T/0) gty v Yes .|

Calculate percent complete for roll-up items such as superior costitems and  Roll-up percent complete weighted by
account code by:

Cost v Current Budget v
Calculate man hours earned at the parent level by @

(® The summation of man hours earned from direct child items
(O The total man hours multiplied by percent complete

Update % complete from Contract (3) &)

Ty
S

Get actual cost from Contract (§)

Drive committed cost values from Contract (§) [S)]

After you enable this setting, Contract values update the actual cost for the associated cost items. Note
that it may take up to 15 minutes for the background batch process to complete.
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CONTROL

CONTRACT

Workspaces

Background
batch process

Goods Actual cost
receipts (to date)

Accruals

Invoice
receipts

Payment
forms

5.5.3 Audit Log

You can check the status of a sync in the Audit Log on the Integration tab.

c8s ACS PAY ITEMS CHANGE REGISTER AUDITLOG
Actions v Y
BuctiD Interface Status Processing details Start Finish Log Handle
cBS

0O 2150 Quantities - Job to date Succeeded 202 10/16/20241215PM 10/16/2024 12:15 PM 3941€926-52ed-461¢-hc23-114805641ch

hes 0 o Budget Failed Failedat1 03/10/202312:33PM 03/10/202312:48 PM €916a4f-5edb-4563-8ed7 Tfe1fa37bida
ez O s cBs Succeeded 4014 03/10/202312:33 PM 03/20/2023 05:30 AM 62200491 -75h8 -4131-8908-a1bfbb1bfid4
_ O 10e Quantities - Job to date Succeeded 2012 02/23/202312:26 PM 02/23/202312:26 PM 30731971-189a-4eeh-b9d5-a1 4ecB76543a
O 1os Quantities - Job to date Succeeded 202 02/23/202312:04 PM 02/23/202312:04PM 43c1d5ec-0321-4357-b70-90edBIT5LT
IR O 104 Quantities - Job to date Succeeded 202 02/23/2023 11:49 AM 02/23/202311:49 AM 51805bed- 8061-45¢1-a269-283a6143742¢
(@] 1661 ActualMHCost InProcess 0of3 12/07/2022 03:26 PM de1ffe21-8ae0-41f1-8399-e93c29a86b56

5.6 ACTUALS BY IMPORT

You can import actual costs, man-hours and quantities by using an Excel or CSV file.

An actuals import is similar to claiming actuals in Control. After you upload a spreadsheet containing
actuals, those values are added to any existing actuals for the specified cost items. Your spreadsheet
values should represent new claiming on a cost item rather than the total sum to date.

From the CBS tab in Control Workspaces, you can access the Import function by clicking the Import
icon, and then selecting Actuals.
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v 1A -
VIEW ° | Progress b

= O $ m T B = Q

Import:

e Cost items ual gty (to Actuz
te) ) MHrs
dat
Actuals ®)
S0.00 0.00
5 0.00 Commitment 0.00
2 0.00 .00

After you add the import file, you can select the matching criteria in the Map columns dialog box. The
Map columns dialog box has a select number of Control fields which pertain to actuals. The table
below shows details of the available fields.

L

WBS phase code The unique WBS phase code. Can be used as the cost item matching
criteria. Required to select this or CBS position as the cost item
matching criteria.

CBS position The position in the CBS hierarchy. Can be used as the cost item
matching criteria. Required to select this or WBS phase code as the
cost item matching criteria.

Posting date Required field. Control will prompt you to specify the date format used
in your import file.

Notes Text field for any notes that pertain to this specific claiming update.

Claimed quantities Quantities in this field will be added to the Actual gty (to date) field for
the specified cost items.

Number of man Values in this field will be added to the Actual MHrs (to date) field for
hours the specified cost items.

Number of equipment Values in this field will be added to the Actual egp hrs (to date) field for
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hours the specified cost items.

Cost Values in this field will be added to the Actual cost (to date) field for the
specified cost items.

Cost categories You can download a list of your project’s cost categories from the
Import actuals data dialog box. The values in the import file must match
the Control values exactly.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate Resource You can specify estimate resources to be included with this claiming
update. Use the resource code for the estimate resource as the value
for this field. This update will be visible from the Actuals Details tab in
Actuals History.

Follow the steps below to import actuals.

Import Actuals

1. Prepare the import file.

2. From the CBS, click Import > Actuals.
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'. VAP -
View - | Progress A

= O §$§ m T B = Q

Import:

U3 02/24/2022 R
cost Costitems o aty (to Actuz
te) ) MHrs

dat
Actuals e)
$0.00 0.00
$0.00 Commitment 0.00
$0.00 0.00

3. Inthe Import actuals data dialog box, add the import file, and then select the cost item matching
criteria.

Road & Bridge Project (106000) / Control

Import actuals data - Actuals Import.csv

mport from Excel (.xIsx, .xIs) or Comma separated value (.csv)

I oo ]
' '
| V
I '
I '
! Drag and drop the file here !
! or browse |
I '
I '
I '
i Browse 1
| 1
I '
| '
1 '
b ________________ a
Options
*Import type () Specify a Match key. Once import file header
A I I - columns are verified, column fields can be mapped.
ctuals values Data from the matched items will be imported. If

match is not found, items will be ignored. If your
Cost item matching criteria document contains actual cost, then you will need to

specify which column contains your cost categories.
WBS Phase Code h Cost category naming in you upload file must match

what is in Control. Download Control's cost category

list to ensure the use of correct naming.
J, Cost categories list

4. Map the Control fields to the file columns.
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Import actuals data - actuals Import.csv

Map columns

Control field

Tasks

*WBS phase code

CBS position

Actuals

*Posting date

Notes

Claimed quantities

Number of man hours
Number of equipment hours

Cost

Unsaved template -
Mapped File columns
Q, WBS phase code

only used if matching

Vg Date

Blank-do not import
" Actual gty (to date)
" MHrs
[V 4 Equipment
[V 4 Cost

»

4
* Required fields

5. Select the date format used in the import file.

Select dat...

MM/DD/YYYY

Choose date format currently
displayed in file. Selected format
will be converted to match user
settings.

[ cancel | [ Back | m

5.6 Actuals by Import

6. The import file will be checked for errors. If the file contains no errors, click Next.

If the import contains errors, download the error file for more information.

7. Click Import now to complete the import.
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You are about to import actuals. You may continue working in
your project while your import is occurring. Please note this may
take several minutes

Visit Cost Item Excel Import for more information on performing an import.

5.7 ACTUALS BY MANUAL ENTRY

In some situations, you may need to enter actuals directly in InEight Control. This can be helpful when
field data is delayed, incomplete, or needs correction. Manual entry also gives you greater flexibility
when tracking progress tied to lump sum or indirect costs, or when values include confidential or
sensitive data.

The steps below outline how to claim actuals by manual entry.
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5.7 Actuals by Manual Entry

Claim Actuals by Manual En

1.

41

8 cC

42

4.3
V5

51

52

5.3

71
7.2
73
74
75
76

Oo0oo0oooooooooooo

7T

O

78

Subtotals 32 (1 rows selected)

EIeCL Sleel - neavy

Erect Steel - Light

Bolted Connections

Materials

Earthwork - Materials

Concrete - Materials

Structure Steel - Materials
Merrill Iron & Steel - Steel Materiz
Site & Demolition

Selective Demolition

Site Demolition - Mobilization
Site Demolition - Building KL
Site Demoliticn - Footings & Foun
Site Demolition - Hard - Building |

Site Demolition - Hard - Building |

I ® @ ®

H

From the CBS, right-click a cost item, and then select Actuals details.

o4

Copy

New cost item

New subordinate cost item

Delete cost items(s)

Adjust CBS position

Update Forecast (T/0) gt...

Cost item details

Site Demolition - Hard - Building |

©

Actuals details

Site Demolition - Driveway Appro:

40—

© 2025 InEight Inc. Privacy Statement

Terms & Conditions v2

[<b

Change summary

Cost item dashboard

2. On the Claim Actuals tab of the slide-out panel, select the type of actuals from the tabs on the

left.

1005
4.2 ErectSteel - Light

CLAIM ACTUALS

ACTUALS HISTORY

QUANTITIES Forecast (T/0) gty
100.00
MAN HOURS
EQUIPMENT HOURS
Claimed quantity
cOsT

Actual qty (to date)

2155

Estimated actuals to be added on claiming:

Total cost

Labor

COMMITMENTS

3. Enter the quantity, hours, or cost to be claimed.

InEight Inc. | Release 26.5
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QUANTITIES
MAN HOURS

EQUIPMENT HOURS

COsT

CLAIM ACTUALS

ACTUALS HISTORY COMMITMENTS

Forecast (T/0) qty

100.00

Actual gty (to date)

21.65

Claimed gquantity

Estimated actuals to be

15.00 Total cost

Posted date

Labor

Construction Equipmen

06/30/2025 £ ENM Rantad Eaninmant
4 G
4. Enter additional details as needed.
CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Labor $000
el Construction Equipment $0.00
06/30/2025 ﬁ FNM Rantad Fnninmant <n ﬂﬂ’ v
Start date Finish date
06/23/2025 = 06/27/2025 =
Area Actuals user defined 4
South
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

5. When finished, click Apply.

5.7.1 Claim Quantities

Control User Guide

Track completed progress progress on a cost item by entering a claim on the Quantities tab in the
Actuals details slide-out panel.

Before claiming quantities for a cost item, make sure the Hide in Plan, Progress, and Design column is
checked. This option prevents conflicts by making the cost item unavailable for claiming outside of

Control.
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. .
Tasks * W Task details (o000 )
w CBS Description WBS Hide in Plan, |s terminal
position phase Progress, and
code Design
O ) Construction 1011 ()]
O v 21 Bridge Work 1012

See the table below for details on the available fields on the Quantities tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES Forecas t (T/0) qty Actual gty (to date)
4,331.00 2,576.45
MAN HOURS
EQUIPMENT HOURS
Claimed quantity Posted date
cosT 07/01/2025 =
Actuals user defined 1 Actuals user defined 2
Actuals user defined 3 Actuals user defined 4
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

Forecast (T/O) qty Shows the forecast takeoff quantity for the cost item.

Actual gty (to date) Shows the actual quantity claimed to date for the cost item.
Claimed quantity Required field. Enter the quantity you wish to claim for this entry.
Posted date Select a posting date for this claiming entry.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined  Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.
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(continued)

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

You can enter negative quantities when claiming in Control.

5.7.1.1 Claim quantities for multiple cost items

Select Claim quantities for multiple cost items to claim actuals for multiple cost items on the same
posting date. The Claim quantities for multiple cost items window shows the same fields that are found
on the Quantities claiming tab in a grid format.

Claim quantities for multiple cost items

O
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Posted date

07/01/2025 i)

Claim multiple actuals:

Action CBS WBS Description CE Forecast CB - Actual Claimed Actt
position phase UoM (T/0) aty total (to datgy quantity defi
code quantity
&) 116 1007 Drainage - System LF 4,331.00 0.00 2576.45 0.00 o
4 [
(® Add cost item

Follow the steps below to complete a manual claim for multiple cost items.

Claim Quantities for Multiple Cost Items

1. From Claim Actuals > Quantities of the Actuals Details slide-out panel, click Claim quantities for
multiple cost items.
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Notes 4000

@ Add claimed quantity @ Claim quantities for multiple cost items

Cancel

2. Select the posting date for this claim.

Claim quantities for multiple cost items

1
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this lst.

Posted date

07/01/2025 i)

s Description cE Forecast cB- Actual
SU MO TU WE TH FR SA S iy oy et & “mﬂg"
e quantity
2 3 4 5 o
T Drainage - System LF 4,331.00 0.00 257645 *
6 7 8 9 M n 12 v

13 14 15 16 17 18 19

20 21 22 23 24 25 26

28 29 30 3
TUESDAY, JULY 1,2025

2

N

3. Click Add cost item to add additional cost items to claim on this posting date.

Claim quantities for multiple cost items

5
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list

Posted date

07/01/2025 ]

Claim multiple actuals

Action cBS WBS Description CE Forecast CB- Actual Claimed Acti
position phase UoM (T/0) aty total (to date quantity defi
code quantity
S 116 1007 Drainage - System LF 4331.00 0.00 2,576.45 0.00 o
4 G »v

® Add costitem
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Control User Guide

4. Click the checkbox to select cost items. When you are finished, click Add.

Add CBS items

Tasks

cBS
(=] position
=] 111
[m] 112
=] 113
[m} 1.1.4
115
(@] 1.7
O 1.1.8
(@] 119
211

<

wBS
phase
code
1002
1003
1004
1005
1006
1008
1009
1010

1013

& Notes : Cost items that cannot be claimed are not displayed in this list

Descrip... CEUoM

Structural So. SF
Walls - SB Ra SF

Structural - S, SF

Traffic Model .. LF
Roadway-Ci..  LF
Landscape - Acre

D16 408 Permit | Each
Geo Report Each

Erect Structur..  Ton

Forecast

(T/0) aty

35.210.00
13,000.00
640.00
2,454.00
3,000.00
1.00
1.00
2.00

1,500.00

CB - total
quantity

0.00

0.00
0.00
0.00
0.00
0.00
0.00

Actual Claimed
qty (to quantity
date)
2915000 0
1300000 0
64000 0
220860 0
255000 0
100 0
1.00 0
200 0
000 0

2 items selected

5. Click inside the Claimed quantity field to enter a quantity for each cost item.

Posted date

07/01/2025

Claim multiple actuals:
Description

Drainage - System
Roadway - Civil Design

Erect Structural Steel for Bridges
<

Claim quantities for multiple cost items

O
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Forecast
(T/0) qty

4,331.00
3,000.00

1,500.00

CB-
total
quantity

(@ Add costitem

Actual
=
2,576.45
2,550.00
0.00

Claimed
quantity

1

Actuals user
defined 1

000.00
500.00

200

==y - |

Actu:
defin

»

<«

6. Enter additional details as necessary.

Page 232 of 632

InEight Inc. | Release 26.5



Control User Guide

5.7 Actuals by Manual Entry

Claim quantities for multiple cost items

.
) el Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Posted date

07/01/2025 [l

Claim multiple actuals

Actuals user Actuals user Actuals user Actuals user Actuals user Estimate
defined 2 defined 3 defined 4 defined 5 defined 6 resource

Notes

Storm event on 6/30

T

(® Add cost item

7. When finished, click Claim.

Note that you can also claim quantities for multiple cost items by selecting the cost items in the CBS

register, and then opening the Actions menu and choosing Claim multiple CBS quantities.

Actions = D/ ®
h 4

Update Forecast (T/0) gty with Plan compone...

Claim multiple CBS guantities

Budget move and contract adjustment »
f:'i Lock/unlock budget » dBridge
Sync | Bound Ramp/Bri...
{ )/Bridge
‘ O 113 " Structural - SB Ramp/Bridge Misc ...
11.4 Traffic Model - Development/Anal...
115 Roadway - Civil Design
116 Drainage - System
d 197 Landscape - SB Ramp/Bridge
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code

1000
1001
1002
1003
1004
1005
1006
1007
1008
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5.7.2 Claim Man-hours

Claim work hours for a specific employee or for a crew on the Man Hours tab in the Actuals details
slide-out panel.

To claim hours for a crew, enter the total number of hours worked in the Number of hours field and
leave the Employee name and Employee ID number fields blank.

See the table below for details on the available fields on the Man Hours tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES CE total MHrs MHrs(to date)
12,000.00 0.00
MAN HOURS
EQUIPMENT HOURS
Number of hours Posted date
cosT 07/01/2025 =
Employee name Employee ID number
Actuals user defined 1 Actuals user defined 2
8 i
Actuals user defined 3 Actuals user defined 4
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

CE total MHrs Shows the Current Estimate total man-hours for the cost item.
MHrs (to date) Shows the actual man-hours claimed to date for the cost item.
Number of hours Required field. Enter the hours you wish to claim for this entry.
Posted date Select a posting date for this claiming entry.

Employee name If entering hours for a single employee, enter the employee name.

Make sure that the entry matches the name in the employee record.

Employee ID If entering hours for a single employee, enter the ID number. Make
sure that the entry matches the ID number in the employee record.
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T T

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.7.3 Claim Equipment Hours

Claim hours for an equipment item on the Equipment Hours tab in the Actuals details slide-out panel.
See the table below for details on the available fields on the Equipment Hours tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES CE total equipment Hrs Equipment Hrs (to date)

1,800.00 0.00
MAN HOURS

EQUIPMENT HOURS
Equipment ID # Posted date

cosT | 07/01/2025 =
Hours used Actuals user defined 1
Actuals user defined 2 Actuals user defined 3
Actuals user defined 4 Actuals user defined 5

Actuals user defined 6 Estimate resource

Notes. 4000

T T

CE total equipment ~ Shows the Current Estimate total man-hours for the cost item.
Hrs
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Equipment Hrs (to Shows the actual equipment hours claimed to date for the cost item.
date)
Equipment ID # You can enter the ID for the equipment item. Make sure that the entry

matches the ID number in the equipment record.
Posted date Select a posting date for this claiming entry.
Hours used Required field. Enter the hours you wish to claim for this entry.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.7.4 Claim Cost

Claim cost for a cost item on the Cost tab in the Actuals details slide-out panel. See the table below for
details on the available fields on the Cost tab.
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CLAIM ACTUALS

QUANTITIES CE total cost

$50,000.00
MAN HOURS
EQUIPMENT HOURS
Claimed cost

CcosT

Posted date

07/01/2025

Actuals user defined 2

Actuals user defined 4

Actuals user defined 6

ACTUALS HISTORY

Actual cost (to date)

§5221.75

COMMITMENTS

Cost category

@

Actuals user defined 1

Actuals user defined 3

Actuals user defined 5

Estimate resource

5.7 Actuals by Manual Entry

Notes

4000

T T

CE total cost

Actual cost (to date)
Claimed cost

Cost category
Posted date

Actuals user defined
1-2

Actuals user defined
3-6

Estimate resource

Notes

InEight Inc. | Release 26.5

Shows the Current Estimate total cost for the cost item.
Shows the actual cost claimed to date for the cost item.
Required field. Enter the cost you wish to claim for this entry.
Required field. Select the cost category for this entry.

Select a posting date for this claiming entry.

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

You can select a resource from the Project library. You can only select
one resource per entry.

Enter any notes pertinent to this claiming entry.

Page 237 of 632



5.7 Actuals by Manual Entry Control User Guide

5.7.5 Add Additional Claiming entries

You can record separate claiming entries for a single cost item from the Actuals Details slide-out panel.
Click the Add icon from the bottom of the slide-out panel to add additional entry fields.

Notes 4000

@ Add claimed quantity @ Claim quantities for multiple cost items

Cancel

5.7.6 User-Defined Fields

There are 6 user-defined fields you can use when you claim actuals in Control. These field labels can be
customized to fit your business practices. Examples of custom labels include “Start Date”, “Area”, or
“Category”. An additional field is available to select a resource from the Project library.

MNumber of hours

Employee name

Posted date

07/01/2025

Employee ID number

Actuals user defined 1

Actuals user defined 3

Actuals user defined 5

Estimate resource

Actuals user defined 2

Actuals user defined 4

Actuals user defined 6

Notes
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Custom labels for the user-defined fields can be set up in Platform > Suite Administration > Custom
labels.

User-defined
field Type Description

Actuals user Date Use this field to enter dates, such as start and finish dates.
defined 1-2

Actuals user Free Use these fields to enter any variable attribute based on your
defined 3-6 text business processes.

Estimate Choice Select a resource from the Project library. You can only select
resource one resource per transaction.

5.8 ACTUALS BY API

Your organization can set up APl integrations to synchronize actuals between InEight Control and an
ERP or other external system. Refer to the Control Integration Specification document for more details.

5.9 USER-DEFINED FIELDS

There are 6 user-defined fields you can use when you claim actuals in Control. An additional field is
available to select a resource from the Project library. The fields are available in Actual Details > Claim
Actuals tab slide-out panels for Quantities, Man Hours, Equipment Hours, and Cost. The following
fields are available:

User defined
field Type Description

Actuals user Date You can use to enter dates such as start and finish dates among
defined 1-2 other entries.

Actuals user Free You can enter any variable attribute based on your business
defined 3-6 text processes.

Estimate Choice  You can select a resource from the Project library. You can only
resource select one resource per transaction.

InEight Inc. | Release 26.5 Page 239 of 632


https://learn.ineight.com/Platform/Content/Categories/CategorySnippets/APIMDocuments/InEight Control Integration Specification.pdf

5.9 User-defined fields

QUANTITIES
MAN HOURS
EQUIPMENT HOURS

COST

CLAIM ACTUALS

Forecast (T/0) gty

3,322.45000000000

Claimed quantity

ACTUALS HISTORY

Actual gty (to date)

1,323.45000000000

COMMITMENTS

Posted date

07/31/2024

Control User Guide

Actuals user defined 1

Actuals user defined 3

Actuals user defined 5

Estimate resource

Actuals user defined 2

Actuals user defined 4

Actuals user defined 6

Notes

4000

You can customize the field labels to fit your business practices in Platform > Suite Administration >

Custom labels. For example, you can name Actuals user defined 3 to Area, and Actuals user defined 4

to Category.

The user-defined fields are available to use in Actions > Claim multiple CBS quantities dialog box. You
can click in a field and enter data, including selecting an Estimate resource in the Estimate resource

field. The fields can also be viewed in Actuals History tab.

You can import claim actuals and use the user-defined fields as mapped fields in the CBS Microsoft

Excel import.
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Import actuals data - inEight Control Columns List (9).xlsx

Map columns

Template Unsaved template A @
Control field Mapped File columns
Cost Blank-do not import -
Cost categories Blank-do not import
Actuals user defined date 1 v Start Date
Actuals user defined date 2 v End Date
Area v Area
Actuals user defined 4 Blank-do not import
q y -

(ot ) (o)

For more information about importing actuals, see Actuals by Import.
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5.10 ESTIMATED ACTUALS

Estimated actuals lets you track costs, quantities, man-hours, and equipment hours on a cost item
before these values are validated through the ERP system. This provides more up-to-date visibility on
progress and increases forecast accuracy. Estimated actuals can be generated in Control through
guantity claims, or brought in from approved daily plans in Progress. After actuals are validated in the
ERP system, you can reverse the estimated actuals and maintain the confirmed actuals.

To view estimated actuals in Control, you must first enable the feature in Control’s project settings. To
enable, go to the Project Tracking tab in settings, and under Estimated actuals, switch the Turn on
estimated actuals toggle to ON, and then select the applicable cost categories under Control and
Progress.

For each cost category, we recommend enabling the setting for either Control or Progress only.
We don’t recommend enabling the setting for both applications at the same time.

Turn on estimated actuals: @)

Enable estimated actuals for:

Actual type
P Control Progress

Labor cost &) @)
Labor man hours @ @
Construction Equipment cost S @)
Construction equipment hours @ @
FOM Rented Equipment cost @

Supplies cost @

Materials cost @

Subcontract cost (@]

Fees cost S)

Allowance cost @

G & A cost @

Undefined cost @

When you enable estimated actuals, you can add relevant columns to a data block to view estimated
actuals.
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Estimated Actuals <e>
Confirmed Confirmed Confirmed Confirmed Estimated Estimated Estimated Estimated Last estimated Last estimated
t actual actual

Last
actual cost actual actual man actual gty actual cost actual qty estimated actual eqp actual man
equipment hours equipment man hours actual cost hours reversal hours reversal

H $0.00 0.00 0.00 0.00 $0.00 0.00 0.00 0.00
§92300.00 0.00 2,030.00 2,150.00 5000 0.00 0.00 0.00
I 10350000 0.00 1,890.00 695.00 5000 000 000 0.00
§76300.00 0.00 1,620.00 0,00 $33,537.35 151.00 58050 0.00
I 5130000 0.00 1,060.00 8000 $26.761.60 120,00 500.00 0.00
§20500.00 0.00 400.00 21.00 $6.054.00 11.00 0.00 0.55  05/14/2025 3 05/14/2025 3135...
I $4,50000 0.00 160,00 4400 §72175 2000 8050 000 05/06/20251

The following table shows columns related to estimated actuals.

Confirmed actual cost The expended cost verified through the ERP system.
Confirmed actual The expended equipment cost verified through the ERP system.
equipment

Confirmed actual man hours The number of labor hours verified through the ERP system.
Confirmed actual gty The cost item quantity verified through the ERP system.

Estimated actual cost Recorded actual cost that has not yet been confirmed through
the ERP system.

Estimated actual Recorded equipment cost that has not yet been confirmed

equipment through the ERP system.

Estimated actual man hours Recorded labor hours that have not yet been confirmed through
the ERP system.

Estimated actual gty Recorded cost item quantity that has not yet been confirmed
through the ERP system.

Last estimated actual cost  The date and time the last Reverse estimated actuals >
reversal Reverse estimated actual cost action was performed.

Last estimated actual man  The date and time the last Reverse estimated actuals >
hours reversal Reverse estimated actual man-hours and labor cost action
was performed.

Last estimated actual eqp The date and time the last Reverse estimated actuals >
hours reversal Reverse estimated actual equipment hours and construction
cost action was performed.
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5.10.1 Claim Estimated Actuals in Control

Claim Estimated Actuals

1. From the CBS, right-click a cost item, and then select Actuals details.

uJ 41 CIECL DLEEl - medvy U4 §o
42 Erect Steel - Light Copy >
O 413 Bolted Connections
0O v 5 Materials
O 51 Earthwork - Materials
O 572 Concrete - Materials
N tit
O 5.3 Structure Steel - Materials @ ew costiem
0 6 Merrill Iron & Steel - Steel Materiz @ New subordinate cost item
O v T Site & Demolition
O 71 Selective Demolition ® Delete cost items(s)
O 7.2 Site Demolition - Mobilization Ly Adjust CBS position
O 73 Site Demolition - Building KL
d 7.4 Site Demolition - Footings & Foun D” Update Forecast (T/0) qt...
Site Di lition - Hard - Building |
O 75 ite Demolition - Har uilding D” Cost item details
O 76 Site Demolition - Hard - Building |
O T Site Demolition - Hard - Building | Actuals details
O 78 Site Demolition - Driveway Appro:

©

Change summary

Subtotals 32 (1 rows selected)

L | |
© 2025 InEight Inc. Privacy Statement Terms & Conditions v2 Cost item dashboard

2. From the Quantities tab, enter a claimed quantity.

Ce e ame e

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
QUANTITIES Forecast (T/0) qty Actual gty (to date)
100.00 21.55
MAN HOURS
EQUIPMENT HOURS
Claimed quantity Estimated actuals to be
COsT 15.00 Total cost
Labor

Posted date Construction Equipmen

06/30/2025 ﬁ ENk Rented Faninmant
L |
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3. When you select Estimated actuals to be added on claiming, cost category values automatically
populate based on the claimed quantity entered using Current Estimate unit rates.

Claimed quantity Estimated actuals to be added on claiming:
15.00 Total cost $375.00 4
Labor $375.00 .
Posted date Construction Equipment $0.00
07/01/2025 i ENM Rented Frinment annn ¥
4 G "

4. Click Apply when you are done.

The estimated values for the cost item can now be viewed in the relevant columns.

Estimated Actuals <e>
Confirmed Confirmed Confirmed Estimated Estimated Estimated Estim
actual cost actual man actual gty actual cost actual actual actu:z
hours equipment man hours
i $0.00 0.00 0.00 $0.00 0.00 0.00
:: $92,300.00 2,030.00 2,150.00 $0.00 0.00 0.00
:: $103,500.00 1,890.00 695.00 $0.00 0.00 0.00
i $0.00 0.00 0.00 $0.00 0.00 0.00
$ 76,300.00 1,620.00 0.00 $ 28,703 85 140.00 610.50
:: $ 51,300.00 1,060.00 80.00 $ 26,761.60 120.00 500.00
:: $20,500.00 400.00 21.00 $1,220.50 0.00 30.00
:: $4,500.00 160.00 44.00 $721.75 20.00 80.50

5.10.2 Estimated Actuals from Progress

With the correct settings enabled, estimated actuals can be brought in from Progress based on
approved daily plans. Estimated labor and equipment hours from Progress are calculated as approved
hours multiplied by the operational rate codes.

This calculation differs from estimated actuals claimed in Control, which are based on claimed
guantities multiplied by the current estimate unit rate.

Note in the example below, prior to the creation of a new daily plan, the estimated actuals for this cost
item have a value of 0.
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Steel Structure Training Job 2| 1

/ Control / Workspaces

Control User Guide

cBS Acs
Actions v ® B ®
A 4
Tasks ¢ [l Estimated Actuals
\ CBS Description WBS Confirmed Confirmed
position phase actual cost actual
code equipment
m] 1 Job Overhead 1002 H $0.00
& [u] 2 Earthwork 1069 I s9230000
o 3 Concrete 1071 I s10350000
[u] 4 Bolted Connections 110 ] $0.00
a] vs Structural Steel 1073 $76,300.00
(m] 51 Erect Steel - Heavy 1074 I ss130000
52 Erect Steel - Light 1005 ' $20500.00
[u] 53 Bolted Connections 1006 ] $4,500.00
a] ve Materials 1084 $604,400.00

PAY ITEMS

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

CHANGE REGISTER

Confirmed
actual man

0.00
2,030.00
1,890.00

0.00
1,620.00
1,060.00

400.00
160.00
0.00

Confirmed

0.00
2,150.00
695.00
0.00
0.00
80.00
21.00
44.00
0.00

AUDIT LOG View : | Unsaved (Progress)
k) m o B
<e>
Estimated Estimated
actual cost actual
equipment
$0.00 0.00 0.00 000
$0.00 0.00 0.00 0.00
$0.00 0.00 0.00 0.00
$0.00 0.00 0.00 0.00
$28703.85 140.00 61050 0.00
$26,761.60 120.00 500.00 0.00
000 000 000 0.00
$721.75 20.00 80.50 0.00
($ 250,000.00) 000 000 0.00

= Q

Last
estimated
actual cost

05/14/2025 2:
05/06/2025 1

In Progress, labor hours and equipment hours are tracked on the Time Sheet tab of a daily plan.

it  Steel Structure Training Job 2| 1.. / Progress / Daily planning

Daily Plans >

OVERVIEW DETAILS

@ @ Add maintenance 1005

Add tasks and

resources @ Clear hours

< :32

© Alejandro Ramirez &
Laborers - Laborer Journeyman
IN8-10023

MH :8

© Maria Popova ®

Iron Worker - Iron Worker (Stru
IN8-10013

MH :8

— ®

Ly Grove-RT880E Crane
MC-10000000

MH -8

Quantities are tracked on the Quantities tab of a daily plan.
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Erect Steel Module 12 - 05/14/2025 (Execution) - Plan ID 63

TIME SHEET

a 11

ST. 8

ST. 8

Operated: 8

QUANTITIES

NOTES / ISSUES
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TIME SHEET QUANTITIES NOTES / ISSUES PRODUCTIVITY SIGN IN/SIGN OUT
= -
o
4 /) Module 12 - F22: Cross Brace Assembly Module 12 - F22: Cross Brace Assembly w E\ @ A
Complete Claim % Step Quantity UoM To date quantity Planned quantity Installed quantity
15 Shakeout/Transport 0.30000 Ton 0 0 0.30000
45  Erect/Bolt Up 0.30000 Ton 0 0 0.30000
30  Final Torque 0.30000 Ton 0 0 0.30000
@] 10 QC Verification 0.30000 Ton 0 0 0
Component total 030000 Ton 0.00000 0.00000 0.27000
» /' Module 12 - E24: Beam Assembly Module 12 - E24: Beam Assembly Tne E @
» 7' Module 12 - E23: Cross Brace Assembly Module 12 - E23: Cross Brace Assembly W E\ @

After the daily plan is submitted and approved in Progress, the estimated actuals values automatically
update in Control.

cBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | Unsaved (Progress) -
Actions v ® B ® D s m T B = Q
0 :
Tasks ¢ [ Estimated Actuals <e>
7 CBS Description WBS Confirmed Confirmed Confirmed Confirmed Estimated Estimated Estimated Estimated Last
il il il fi
a position phase actual cost actual actual man actual gty actual cost actual actual actual gty estimated
code equipment hours equipment man hours actual cost
o 1 Job Overhead 1002 H $0.00 0.00 0.00 0.00 $0.00 0.00 0.00 0.00 =
Earthwork 1069 92,300.00 0.00 2,030.00 2,150.00 0.00 0.00 0.00 0.00
O 2 bos $
Concrete 10N 103,500.00 0.00 1,890.00 695.00 0.00 0.00 0.00 0.00
3 H S $
o 4 Bolted Connections 1110 H $0.00 0.00 0.00 0.00 $0.00 0.00 0.00 0.00
[m] v 5 Structural Steel 1073 $76,300.00 0.00 1,620.00 0.00 $34,24735 151.00 612.50 0.00
[m] 51 Erect Steel - Heavy 1074 H $51,300.00 0.00 1,060.00 80.00 $ 26,761.60 120.00 500.00 0.00
52 Erect Steel - Light 1005 H $20,500.00 0.00 400.00 21.00 | $6,764.00 11.00 32.00 055 |05/14/2025 2:
o 53 Bolted Connections 1006 H $4,500.00 0.00 160.00 44.00 $721.75 20.00 80.50 000 05/06/20251
[m] v 6 Materials 1084 $604,400.00 0.00 0.00 0.00 ($ 250,000.00) 0.00 0.00 0.00

Estimated actuals values are only general estimates. They are not confirmed until synced with an ERP
or an external payroll system.

5.10.3 Reverse Estimated Actuals

After actuals are reviewed and confirmed in your ERP system, they are brought into Control through a
sync. These values are then reflected as “confirmed” actuals. Following this process, you can reverse
the estimated actuals, since the confirmed actuals now reflect the most up-to-date information.

If you keep the estimated values without reversing after syncing with the ERP system, those
values are detected as double values.
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Reverse Estimated ACtuals

1. From the CBS, select the cost items which have recorded estimated actuals.

2. From the Actions menu, select Reverse estimated actuals, and then select the appropriate type
of reversal.

Actions = @ |—_|y ®

Y e _ EStimat

Update Forecast (T/0) gty with Plan compone... WBS Confirmed
| phase actual cost
. . . code
Claim multiple CBS quantities I
1002 i !
i':'i Budget move and contract adjustment 14 1069 H $923
Il
Lock/unlock budget » 107 i $1035
| oas 1110 H !
‘A
| Syne ’ 1073 $763
Reverse estimated actuals » 3
Reverse estimated actual cost E
I
Take snapshots -
Reverse estimated actual MHrs and labor cost .5
U ~ 6 Malerials Reverse estimated actual equip hrs and constr_ 4
O 6.1 Earthwork - Mai 10

3. Click Yes to confirm the reversal.

This action will remove all estimated actual cost entries for the indicated cost items.
Are you sure you want to continue?

4. In the CBS, the estimated values are reset to 0.
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5.11 ACTUALS HISTORY

5.11 Actuals History

Once progress is tracked against a cost item, you can view its actuals claim history. You can view
actuals history of a cost item by right clicking on a cost item and selecting Actuals details from the
menu. On the resulting slide out panel, you can view the history of when actual quantities, costs, and

man-hours were posted by clicking on the Actuals History tab of the cost item.

The Actuals history tab displays and groups the actual claim history by posting date. Within in each
posting date folder you can view as-built progress details of quantity, cost, man-hours, and equipment
hours of the specific cost item selected in the CBS.

I CLAIM ACTUALS ACTUALS HISTORY
ial

Posting date Quantity

O 11/16/2018 0.00

View more

$0.00

40.00

Man hours Equipment hours

0.00

In addition, by clicking on the posting date link, you can view more specific claim history details such as
actuals type, cost category, employee change by, and notes.

CLAIM ACTUALS ACTUALS HISTORY
Posting date o Actuals type

nl
= 11/16/2018 2| Man Hours

Actuals
completed

40.00

Cost category

Changed by

Control - [Paul Bennion]

Notes

View more

5.12 PROGRESS CONTROL SETTINGS

InEight Control integrates with several other programs. Within the tool, a few specific columns allow
you to manage the information that is sent to other InEight applications and to your ERP system. Below
is a table of the key columns and their functions.

Column Name Function

Allow as-built

both, or none.
Once this item receives actual costs, quantities, or man-hours, this

setting cannot be adjusted (changed from All to None).

InEight Inc. | Release 26.5

Allows you to choose whether a cost item accepts actual cost, quantities,

Page 249 of 632



5.12 Progress Control Settings Control User Guide

Column Name Function

As-built lock Once you lock the ERP status, your ERP does not allow the WBS to be
progressed.
Example use cases for locking ERP status:
» Work will not begin for two more years
» Foreman is not allowed to claim more quantity because work is
100% complete

* Work is complete and you do not want people mistakenly charging
cost to completed to cost items

Hide in Plan, Allows the user to choose whether to have a cost item available to use in
Progress, and InEight Plan, InEight Progress, and InEight Design.
Design Example use case for using the hide feature:
« Indirect staff cost codes should not be available for direct labor to
charge.

For more information, see Hide in Plan, Progress, and Design.

The steps below walk you through the various columns and discuss options for changing the settings.

Progress Control Settings

For this step you will need to have a subordinate available to use.
1. On the Control main page CBS tab, select the Progress view.
2. Navigate to the Task Details data block.
3. Select the second Data Panel in the Task Details data block.
4

. Double click in the Allow as-Built field of the subordinate cost item and select the drop-down
arrow.

o

Select All.
6. Navigate to the Third Panel of the Task Detail data block.

7. Select the Hide in Plan, Progress, and Design check box of the cost item.
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5.13 VENDOR WORK HOURS FROM
PROGRESS

5.13.1 Vendor MHrs from Progress

You can see the subcontract man-hours in Control for cost items that derive from InEight Progress.
Subcontract performance can be tracked in Progress with data coming into Control for increased
transparency, improved monitoring, and analysis.

In addition to assigning a vendor to a cost item, and viewing the assigned vendors from InEight
Contract, you can also see the claimed MHrs originating from Progress in Control > Workspaces, upon
approval in Progress.

After the claimed vendor hours are approved in Progress, the Actual vendor MHrs (to date) and Actual
columns populate with the claimed hours. This helps to find and focus on the true causes of any issues
and support the ongoing work in the best way possible.

r 103614| PATH Substation / Control / Workspaces
CBS ACS PAY ITEMS
Actions - \_"‘J
h 4
Tasks s+ B Vendor
w CBS Description Assigned vendor Actual vendaor Actual MHrs
O position MHrs (to date) {to date)
] [ Rowfing Vendor Independent Roofing Co Inc 20.00000000000 0.00000000000

The Actuals Details slide-out panel shows the number of hours worked by the assigned vendor.
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= @ 104487| Solar 975MW / Control / Workspaces (6]
cBS ACS PAY ITEMS GHANGE REGISTER AUDIT LOG View : | unsavec
-
Actions = ® Z ® E 9 $ m I
Copy »
A 1020
1.111.1.1.2 CR- S1 - Soil Stabilization - 12" @ 6%
0 | Y s ==t WESEaes =) Ll CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Posting date Confirmed Vendor man Total man Estimated Confirmed
(m} v Financial Results Analysis 1000 @ Newcostitem 1000 PLS man hours hours hours equipment equipment
[} v DIRECT LABOR 1001 @ Newsubordinate cost item 1000 PLS O osn0/2022 0.0 0.000 0.000 0.000 0.000
a v oL 1002 ® Delete costitems(s) 1000 PLS O osr0g 0.000 33.000 0.000 0.000 0.000
o v 111. GRADING 1003 Ly Adjust CBS position 1000  PLS [ 05/03/2022 0.000 8.000 0.000 0.000 0.000
[m] v COUNTY ROADS 1018 [ costitem details [ 08/08/2020 16500 0.000 16.500 0.000 0.000
[m} V1. COUNTY ROADS, Take me 1023 Actuals details / 9885330  CY 0 08/04/2020 0000 0.000 0.000 0.000 0.000
[} 1. CR- 1 - Subgrade Prep 1024 Change summary 558330 OV O 02012020 0.000 0.000 0.000 0.000 0.000
Cost tem dashboard

In Progress > Daily Plans > Timesheet, the new Vendor tab lets you choose which vendors to include on
your daily time sheet as selected vendors to claim hours.

Daily Plans >  Daily Plan 1 - 05/20/2022 (Awaiting Approval) - Plan ID 1835891
OVERVIEW DETAILS TIME SHEET QUANTITIES NOTES / ISSUES

U

TASK EMPLOYEE EQUIPMENT VENDOR X

ADD TO DAILY PLAN
RECENT

» 0000001013-Kiewit Management Co.

AL % 0000001125-Kiewit Industrial Canada Co
0000007 008-Midwest Aviation

0000001036-Kiewit Infrastructure West Co

Only those vendors that are assigned in Control > Workspaces can claim hours against a timesheet
Progress’s daily plan. In Progress, if a vendor is not assigned to a cost item in Control, the vendor hours
task block is disabled and hours cannot be claimed.
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— At 103614| - PATH Substation / Progress [ Daily pla

Daily Plans  »  Install Roof - 04/07/2022 (Awaiting Approval) - Plan 1D 1835468

U

2002
@ e Install Roof
Add tasks and Clear hours
resources &

Construction

Fie 0000001042 -

:0

®

Independent Roofi... ST 10

/3 0010000758
¥:20

DT 5

Midwest Aviation

Fie 0000001008 l

Z:0

5.13 Vendor Work Hours from Progress

Vendor not
assigned in
Control

oT 5 s

Vendor is
assigned in
Control

Vendor not
assigned in
Control

If a vendor is assigned to a cost item in Control, the vendor can claim actual hours.
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Vendor hours

Task: 2002 - Install Roof

Vendor: 758 Independent Roofing Co Inc

Time calculations Planned

ST

oT

DT

Number of employees

Clear Cancel m

Note that the Actual vendor MHrs (to date) are recorded and reported on separately from the self-
perform work hours that are recorded in the Actual MHrs (to date) fields.

5.14 TRACK OPEN/REMAINING AND TOTAL
COMMITTED COSTS

Additional information about purchase orders and contracts (for any particular task) can be viewed and
updated within CBS columns. This provides users with a more comprehensive data set in one location.

Committed costs are the purchase orders or subcontract commitments that a cost item may have
against it. To determine open and total commitments, look at the agreed or pending purchase order
amounts that are associated to any particular cost item. This information is typically exported from
your ERP or accounting system.

Open/Remaining committed cost: Total committed cost - Actual cost (amount that still needs to be
paid for a cost item).
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Total committed cost: The summation of all purchase order and/or contract obligation amounts
assigned to a cost item.

Open/Remaining committed cost adjustment: A debit or credit to the existing Open
committed/Remaining cost value.

New open committed cost: Open/Remaining committed cost + Open/Remaining committed cost
adjustment.

However, there is also the option to use a generic APl to push committed cost values into InEight
Control. If your organization does not have an ERP system, you can configure the endpoints in APIM
and push over your committed cost values.

Viewing Open/Remaining and Total Committed Costs

1. Onthe CBS register tab, select the Group Columns icon to the right of the page. The icon
will turn yellow when turned on.

PAY ITEMS > View : | Forecasts

o s m & ¢

ere o group oy that column

tails { sone >

¢ Tasks, Task details and Commitments data block need to be present on this screen

¢ If the Commitments data block has not been created, create a custom data block using the
Data Icon and include columns Remaining committed cost, and Total committed cost.
Insert this data block into your view.
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2. Drag the UOM column from the Task details data block, and drop it into the grey bar area

Drag a column header and drop it here to group by that column

Task details LTS i B commi... <e> H
%7 CBS position Descriptii WBS Resource Forecz UoM Open Total
phase (T/0) committed committed
code quanti cost cost
L [ Job overhe 1002 i1e 100 Lump Sum f $0.00 $0.00
O I certhwork 1069 Is 1000 A ©Y it $0.00 $0.00
O P concrete 1071 le 1000000  CY ! 5000 $0.00
O I stuetwals. 1073 100000 | Ton $0.00 $0.00
(] 41 Erect Steel 1074 3 40000 &  Ton i 5000 $0.00
=] 42 Erect Steel 1005 Is 20000 | Ton i $0.00 50.00
¢ Notice how UOM's are now are now visible by groups.
[ 1 v x|
CBS position Descriptis WBS Resource Forecz UoM Open Total
- == o i =
UoM: CY
O N  ceerthvork 1069 Is 1000.. A | cv i $0.00 5000
O [ concrete 1071 Is 10,000.00 | v i $0.00 5000
[m] 51 Heavy Steel 1085 i 10,000.00 | €Y i $0.00 $0.00
o 52 Concrete - 1086 i 10,000.00 | ¥ ' $000 5000
UoM: Fa
(3] 44 Bolted Con... 1006 ie 2,000.00 | Ea ' $0.00 $0.00
UoM: Each
o [ vt 1084 1.00 | Each $0.00 50.00
UoM: Lump Sum
o _ Job Overhe 1002 16 100 | Lump Sum 1 $0.00 $0.00
o _ Equipment 1001 ' 1.00 | Lump Sum ' $0.00 $0.00
O [ Egipment mz i 1.00 | Lump Sum i $0.00 50.00

3. To view a more granular level of information, navigate into the context menu for a cost item,
and select Actuals details.
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Cost type: Subcontracts

L4 11355 Water & Ice Distril Tee
Copy
11356 Trash Remaval
Paste
11322

New cost item

New subordinate cost item
X) Delete cost items(s)
L, Adjust CBS position

Cost item details

Actuals details

4. Once in the Actuals details, navigate to the Commitments tab.

» Here is a more concentrated view of the cost category breakdown of the Open and
Total commitments

« |t's also possible to update information. For example: the below cost item for Water &
Ice Distribution, the New total committed cost is showing that a contract was signed
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for $1,267.87.

1069
1.1.3.5.5 Water & Ice Distribution

Open committed cost

$ 700.00
Cost category

Total
Labor
Construction Equipment
FOM Rented Equipment
Supplies
Materials

Subcontract

CLAIM ACTUALS ACTUALS HISTORY

Total committed cost
$1,267.87

Open committed cost Mew open
adjustment cost

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

Control User Guide

COMMITMENTS

itted Total cost New total committed
adjustment cost

$700.00 $1,267.87
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00

$700.00 $0.00 $1,267 .87

» There is $700.00 left remaining to pay the full $1,267.87 subcontract, as shown in
the New open committed costs column

1069
1.1.3.5.5 Water & lce Distribution

Open committed cost
$ 700.00

Cost category

Total
Labor
Construction Equipment
FOM Rented Equipment
Supplies
Materials

Subcontract
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CLAIM ACTUALS ACTUALS HISTORY

Total committed cost
$1,267.87

Open committed cost Mew open
adjustment cost

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

COMMITMENTS

itted Total itted cost New total committed
adjustment cost

§700.00 $0.00 5126787
$0.00 $0.00 $0.00
$0.00 $0.00 $0.00
$0.00 $0.00 $0.00
$0.00 $0.00 $0.00
$0.00 50.00 50.00

$700.00 $0.00 5126787

InEight Inc. | Release 26.5



Control User Guide 5.14 Track Open/Remaining and Total Committed Costs

« Assuming a bill of $100.00 was just paid, it's possible to update the Open committed
cost adjustment field with this value. Notice how the New open/remaining committed
cost decreases to $600.00, after making an adjustment of $-100.00 to the Open
committed cost adjustment field.

1069
1.1.3.5.5 Water & Ice Distribution
CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Open committed cost Total committed cost
$ 700.00 $1,267.87
Cost category Open committed cost New open itted Total itted cost New total committed
adjustment cost adjustment cost
Total (5100.00) $ 600.00 $100.00 $1,367.87

Labor $0.00 $0.00 $0.00 $0.00
Construction Equipment $0.00 $0.00 $0.00 $0.00
FOM Rented Equipment $0.00 $0.00 $0.00 $0.00
Supplies $0.00 $0.00 $0.00 $0.00
Materials $0.00 $0.00 $0.00 $0.00

Subcontract (5100.00) | eomm— S 600.00 $100.00 $1,367.87

5. Select Apply to apply the above changes.

Tasks Task details C esse > Commi.. <> H
CBS Description Forecast (T/0) Cost type Open Total
position quantity committed committed

cost cost

Cost type: Subcontracts

11322 0OSC - Third Party I... 1054 13.00 MWk Subcontracts $7525.23 $13,000.00
L4 11355 Water & lce Distrib_. 1069 3,48955 DMH Subcontracts $ 600,00 $1,367 .87
1.1.356 Trash Removal 1070 3,489.55 DMH Subcontracts $309.00 $873.24

6. Back on the CBS, you can now see your new updated values for this cost item.

Both the Open/Remaining committed cost and the Total committed cost values can be edited in
the Actuals details slideout > Commitments tab (with the right permissions).
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5.15 COMMITTED COST FROM CONTRACT

When the Drive committed cost values setting is on, your committed cost is then derived from
Contracts.

When the switch is off, your committed cost is driven from the ERP. Regardless of the state of the
switch, you can always manually enter your committed cost directly in the product or via a Microsoft
Excel import.

Forecast

With the setting on, all of your committed cost values initially zero out, and then pull over all of your
committed cost values that exist in InEight Contract.

For example, if you have a cost item that is associated with a contract, those values are pulled over
from Contract and populate the total committed cost and open/remaining committed cost columns.

The calculation is Forecast final cost = your Total committed cost; Forecast remaining cost = your
Open/Remaining Committed Cost.

In a contract on the Line items tab, change your view to Progress. Take note of the WBS phase code
and then view the Gross amount. The gross amount for the cost item is the exact amount for the total
committed cost, which includes your line item amount, plus tax.

Total gross amount is your line item amount plus tax. That is going to be your total committed cost
value. The calculation for that: Total committed cost = Line item amount + Tax (this is also called Gross
amount in Contract)

If you have a cost item that is associated with multiple line items in a single contract or across multiple
contracts, the total committed cost for that cost item is the gross amount for all the line items that
cost item is associated with.
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If the WBS element is associated to three different line items, the sum of those three gross amounts is
the total committed cost value. A best practice is to associate a single cost item to a single line item.

To get your Open/Remaining Committed Cost, calculate what you still have to pay for your remaining
commitments. It is your total committed costs minus what you have already paid. You track payments
in contract in three different ways:

e goods receipts
e accruals
¢ invoices
Invoices are generated in your payment forms.

The calculation is Open/Remaining Committed Cost= Total committed cost - Max(Goods receipt
amount, Invoice amount) - Accrual amount.
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CHAPTER 6 — ACCOUNT CODES

6.1 Account codes workflow ... 263
6.2 Account Code Assignment ... .. 264
6.3 Quantity Contribution ... 264
6.3. 1T ACS Navigation ... 265
6.3.2 Account Code Quantity ... 266
6.3.3 Quantity Contributors ... 267
6.3.4 ACS Unitof Measure Toggle ... 268
6.3.5 Account Code Quantity CONVEersions ... 269
6.3.6 Notes Column ... 271

6.1 ACCOUNT CODES WORKFLOW

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage

Cost ltems
Define Qty Account
Analyze Planned
Earned and Actual

Live
Forecast

Forecasts

WBS Structure / Budgeted
Quantities & Hours

roved changes
ﬂﬁﬁm Currfntgsudggf Revenue Management

Billed Revenue
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6.2 ACCOUNT CODE ASSIGNMENT

Account codes can only be assigned to terminal items. Parents cannot have an account code.

Assign Account Codes to Cost Items

1. From within the Control Workspaces page of a project, select the CBS tab to view your Cost
Breakdown Structure.

2. From the View menu, select the Project Controls view by first selecting View more, if not already
displayed.
3. Within the Task Details data block, click on the right arrow to progress to the Account Code

column.

4. For a cost item you wish to have an Account Code assigned, double click in the Account Code cell
for that cost item.

5. Use the search box to find the account code to assign, then click Select, and then click Assign.

6.3 QUANTITY CONTRIBUTION

At the project level, you can manage account codes under the ACS tab from the Control Workspaces
page. On the ACS tab, you can see the account codes assigned to your cost items, along with the
related parent account codes, with account code details and quantity contributors.

Other budget information is automatically pulled into the ACS Details data block including, Total Cost,
Unit Cost, Unit Rates, Primary and Secondary Quantity Ratios, Quantities Complete, and Account Code
Tags. To access this information, click the right arrow to view the second, third and fourth panels of the
data block.
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cBs AcS PAY ITEMS CHANGE REGISTER AUDIT LOG VIeW - | Unsaved (Quantity Managem..
actions o m E = Q
Y - ) :
ACS : [ ACS details ACS qty contributors
% Account code Deseri... Primary Qty Primary UoM Auto-quantity Notes Forecast total cost Forecast total MHrs. Contribute Contribute
‘.h (Primary) Primary to Primary to
Primary Sccondary
~ 99 Change Order... 1.00000000000 PLS O B $187,829,311.97009908027 3,535,755.04678409978 -
~ 9909 Back charges 0.00000000000 PLS [m] 2 $187,829,311.97999998927 3,535,755.04678499978 [m}
~ 99.00.02 Back charges 1.00000000000 PLS (] = $200,963377.59999999404 3,535,755.04678499978 [m]
99.09.02002 Back charges 1.00000000000 PLS O & $209,963,377.59999999404 3,535,755.04678499978 [m]
~ 990904 Back charges 0.00000000000 PLS O 2 (522,134,065 62000000104) 0.00000000000 [m}
99.09.04.002 Back charges 1.00000000000 PLS [m] = $200.00000000000 000000000000 [m]
A 99.09.06 Back charges .. 0.00000000000 PLS (] B2 $0.00000000000 0.00000000000 O
99.09.06.002 Back charges 1.00000000000 PLS 0 2 $0.00000000000 000000000000 [m]

6.3.1 ACS Navigation

The ACS tree lets you easily navigate up and down your ACS structure and also provides a way to filter
down to a subset in the structure. Open the ACS tree slide-out panel by clicking on the ACS tree icon on
the side toolbar.

< ACS PAY ITEMS CHANGEREGISTER VIEW - Unsaved (Project Controls)
Actions  w o) m_'r E 1= Q
T acst =
ree c
ACS § l ACS details
v Expand all A CD\Iapse all % Account code Description Primary Qty
20 b et v I el Overesd 10 .
51 Grading
. 100
61 Concrete
~ b2 metas IS corcet 1000000
~ £2.03 Structural Steel and Connections _ Metals 0.00
~
62.03.02 Structural Steel Indusrial St(..) A 6203 Structural Steel and Connections 0.00
“ §2.03.02.004 Structural Steel Industria(..)
~ 62.03.02 Structural Steel Industrial Structures 600.00
62.03.02.004.02 Structural Steel Indust(...)
62.03.02.004.06 Structural Steel Indust(_.) ACE RGO  structural Steel Industrial - Erect Steel 600.00
62.03.02.006 Structural Steel Industria(..) 62.03.02.004.02 Structural Steel Industrial - Erect Steel - Li... 200.00
62.03.02.004.06 Structural Steel Industrial - Erect Steel - H... 400.00
_ Structural Steel Industrial - Bolted Connec._ 2,000.00

Similar to the CBS color coded hierarchy, the ACS gives you the option to differentiate your account
codes by color. Click on the ACS data block ellipsis to select this option to help you identify which level
of the hierarchy a specific account code is located.
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CBS ACS PAY TEMS > View - | Unsaved (Project Controls) -
Actions - o) mr E 1= Q
Y - - -
ACS = W ACS details { ooe ) H 10/01/2021
% Account code Description Filter M Auto-quantity Forecast total Fi
1 (Primary) MHrs ct
20 Job Related Overhead Swap indented column Tk 0.00
51 Grading O 8,000.00
&1 Concrete |VCo\cr—coded account code position | 30,000.00
~ B2 Metal 000 Ton (] 4999.10
~ 6203 Structural Steel and Connections 0.00 Ton 4,999.10
~ 62.03.02 Structural Steel Industrial Structures 600.00 Ton O 499910
ENEEZD N Structural Steel Industrial - Erect Steel 600.00 Ton O 4,000.00
62.03.02.004.02 Structural Steel Industrial - Erect Steel - Li. 200.00 Ton 4,000.00
62.03.02.004.06 Structural Steel Industrial - Erect Steel - H... 400.00 Ton O 0.00
NEZSZ00E  Structural Steel Industrial - Bolted Connec 2,000.00 Ea 999.10

6.3.2 Account Code Quantity

There are two methods for defining primary and secondary quantities for your account codes:

e Manual entry in the Primary Qty and Secondary Qty fields

¢ Using the auto-quantity feature to have them automatically inherit the quantities of any cost

items that have the same unit of measure as the assigned account code

Define Account Code Quantity

N o g bk~ e

From the Workspaces page of the Steel Structure Job, select the CE + CB viewset from the View
drop-down list.

In the Current Estimate data block, double click in the Secondary UoM field for a cost item you
assigned an account code to.

Select a Secondary UoM from the drop-down list different than the cost item's primary UoM.
Click the side arrow to navigate to the Secondary Qty column.

Double click in the Secondary Qty field for your cost item and enter a value.

Select the ACS tab.

In the Primary Qty field for the account code assigned to the cost item you just changed and type
in a quantity value.

For your account code, check the Auto-quantity (Primary) check box.
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9. To view what cost items are assigned to the account code, right click on your account code and
select ACS item details.

If you have the account code slideout open and want to open a different account code's item details,
you can select a different account code. The details slideout updates to the current account code's
details. You no longer have to exit out of one ACS item only to right click and select ACS details slide
out to open another.

6.3.3 Quantity Contributors

Within your project, you can specify how primary and secondary quantities contribute to your account
codes. Specifically, you can indicate how:

¢ Cost item primary and secondary quantities contribute to assigned account code primary and
secondary quantities

¢ Child account code primary and secondary quantities contribute to parent account code primary
and secondary quantities

For both cost item and account code contributions you can have quantities roll up:
¢ Primary quantity to primary quantity
¢ Primary quantity to secondary quantity

¢ Secondary quantity to secondary quantity

Account codes will only automatically inherit quantities from cost items/account codes using the
same unit of measure.

6.3.3.1 Contribution Options - Cost Item to Account Code

From the ACS item details slide out panel, you can specify how cost item quantities roll up to the
account code that is assigned to it, by selecting the appropriate checkbox. The total of the contributing
cost item(s)’s quantities will roll up to become the account code quantity.

ACS item details - Structural Steel Industrial - Erect Steel - Light (0-19 Ib/LF)

Description WES CE
position phase st final total
code code (T/0... MHrs cost

42 Erect Steel - Light 1005 Ton 200.00 4000 200,000.00
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6.3.3.2 Contribution Options - Child Account Code to Parent
Account Code

On the ACS page, in the ACS gty contributors data block, you can specify how child account code
quantities will roll up to their parent account codes by selecting the appropriate checkbox.

ACS
Account code
20
51
61
62
62.02
62.03.02
62.03.02.004
62.03.02

62.03.02

Description

Job Related Overhead

Grading

Concrete

Metals

Structural Steel and Connectio.

Structural Steel Industrial Stru

Structural Steel Industrial - Ere...

Structural Steel Industrial - Ere._

Structural Steel Industrial - Ere...

ACS details

Primary
aty

0.000000000.

1.000000000.

70000.00000.

0.000000000..

0.000000000.

0.000000000..

7000.000000..

200.0000000.

800.0000000..

< e )

Primary
Ual
MWk

PLS

cY

=
(Tt

Auto-
quantity
(Primary)

vl

6.3.4 ACS Unit of Measure Toggle

ACS gty contributors
Contribute Contribute
Primary to Primary to
Primary Qty Secondary ...
L
i

Gontribute
Secondary to
secondary Qty

In the ACS register, you can toggle different Unit of Measures. The Unit of Measure toggle has three

different options:

¢ As entered Unit of Measure

e English (Imperial Unit of Measure)

e Metric
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Frapect Controds b
2 m @ = Q

Syslem of measure

3 As-enbered urel ol measre

.;%J-"'] Prirrary
- Py
Ll — .JI
0 Metnc

If you want to display and edit in liters instead of gallons for example, you would select the ruler icon
in the top right corner of the ACS register, and then select Metric. The quantity amount converts in the
browser and displays in the alternate unit of measure.

6.3.5 Account Code Quantity Conversions

Cost items that are tracked in one unit of measure can be tracked in another UoM. For example, cost

items that are tracked in a metric UoM can contribute to account codes tracked in imperial UoM. This
saves time in maintaining account code quantities, as project team members do not have to perform

guantity conversions manually. Data accuracy is also ensured since any manual errors are eliminated

from the conversion process.

In this example, CBS item Asphalt Paving and Break Removal contains a Forecast quantity of 3,000 with
a UoM of Square Meter.
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Tasks  REECEES { osee > :
% CBS position Description Resource Forecast (T/0) UoM
quantity
~ 1112 Removals and De... 100 | PLS
1.1.1.21 Excavate Native t... 3 4200000 m3
11122 Asphalt Paving Br... 3 3,000.00 | Sgquare Meter
~ 11123 Concrete Removal 1.00  PLS

In the ACS, you can display the Primary UoM Alternate System column to see what UoM is needed to
track cost items in, so they contribute to your account codes. The Auto-quantity column is set up so
that quantities are summing up the CBS. The Primary Qty of 3,587.97 is automatically populated. There
is no further action to allow this value to roll up to the account code.

ACS

ACS details & i

% Account code Description Primary Qty Primary UoM Auto-quantity Primary UoM
(Primary) alternate
system of..
~ 50.03.02.002 Paving Removal - ... 3,587.97 Square Yard L4 Square Meter
50.03.02.002.02 Break - Asphalt P.. 322410 Square Meter rd Square Meter
50.03.02.004 Paving Removal - .. 0.00 Square Meter v Square Meter
~ 500312 Concrete Remaoval 0.00 Cubic Meter L Cubic Meter
~ 50.03.12.002 Concrete Removal... 0.00 Cubic Meter td Cubic Meter
50.03.12.002.05 Concrete Removal... 290.82 Cubic Meter Ld Cubic Meter

The system will automatically take the Forecast Qty in the CBS, and convert that number to the value
shown in the Primary Qty field displayed in the ACS. In the above example, the CBS Forecast Qty of
3,000 in square meters is being converted to the 3,587.97 square yards, as shown in the ACS.

3587.97

Square yard

3000

Square meter

1F
ik
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6.3.6 Notes Column

A Notes column is available for you to add to a new or existing data block. The Notes column lets you
add commentary to any of the ACS records.

(=S ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View - | Unsaved (Quantity Managem..
Actions » o o B = Q
- X
ACSdetalls S @] iJ Acs aty contributors Frofectaesoun code notes
% Account code Description Primary Qty Primary UoM iAPum-qu?nhly Notes Contribute Contribute
rimary, rimary to rimary to
ah Primary Secondary
~ 9 Change Orders, Contract Allowan... 1.00000000000 PLS O B \
~ 9909 Back charges 000000000000 PLS [m] S (]
A 99.09.02 Back charges - Incoming 1.00000000000 PLS (] = O
99.00.02.002 Back charges - Incoming - Labor 100000000000 PLS O 2 O
~ 990904 Back charges - Qutgoing Internal 000000000000 PLS [m] S [m] 453
on hold until spec docs are received.
99.09.04.002 Back charges - Qutgoing Internal... 1.00000000000 PLS [m] = [m]
A~ 99.09.06 Back charges - Qutgoing External 0.00000000000 PLS 0 2 O
99.09.06.002 Back charges - Outgoing Externa 1.00000000000 PLS (] 2 [m] m

After notes are added to a record, the Notes column populates with the number of comments that are
currently added to each record.

ACS PAY ITEMS CHANGE REGISTER AUDIT LOG VIEW : | Unsaved (Quantity Managem..

o m B B = Q

X
H ACS details C oon > ¢ | ACS gty contributors Project account code notes
Primary Qf Primary UoM Auto-quanti Notes Contribute Contribute q -
ry ity Y (Primary) By Primary to s On h_old until spec docs are
Primary Secondary received.
1.00000000000 PLS |:| % 3
Primary UOM needs to be
0.00000000000 PLS O & O verified.
1.00000000000 PLS O % O
Change tax rate to 7%
1.00000000000 PLS O & [ 4 .
0.00000000000 PLS ] B [} 500
1.00000000000 PLS O =3 O
0.00000000000 PLS (] % (]
1.00000000000 PLS O & O m
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1. Which of the following are account codes used to track?
a. Quantity
. Budget
. Account Code Tags

b
C
d. Unit Costs
€. a,b,andd
f

. All of the above

2. Manual entry in the Primary Qty and Secondary Qty fields is one of the methods for
defining primary and secondary quantities for ?

a. Change Attribute
b. uoM's

C. Account Codes
d. Unit Rates

€. Total Cost

As a result of this lesson, you can:

¢ Assign account codes to cost items
¢ Define the quantity contribution for each account code

e Review and analyze the audit log
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7.1 FORECASTING WORKFLOW
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Control

Forecasting

CBS Register _ Final Hours and Costs

-

Forecast Method
Setup

Live
Forecasts

Forecast Budget/
Forecasts

Quantities

7.2 FORECASTING OVERVIEW

Forecasting in InEight Control is the process of predicting project costs and progress based on current
data and trends. Accurate forecasting helps project teams stay on budget and make informed
decisions.

Depending on the size of your project, multiple engineers may be involved in forecasting tasks. For
example, a large team might divide responsibilities by discipline, with discipline-specific field engineers
preparing data for the project manager.

Control supports collaborative forecasting by allowing users to create and save their own forecasts
without affecting others’ work. These forecasts can then be shared and combined to build the official
project forecast.

7.2.1 Private forecasts
Private forecasts give you flexibility to explore outcomes without impacting the official project data. In
Control Workspaces, you can create multiple private forecasts to:

e Test different forecasting methods.

¢ Explore what-if scenarios (e.g., changes in labor rates or material costs).

e Compare alternative approaches before sharing with the team.
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Private forecasts are visible only to you until you choose to share them. This makes them ideal for
refining your work before contributing to a shared or live forecast.

7.2.2 Shared forecasts

Shared forecasts allow collaboration among team members. You can create up to five shared forecasts,
which are automatically visible to all members assigned to the project. A shared forecast lets you do
the following:

¢ Joint editing and review of forecast data.
¢ Real-time updates visible to everyone sharing the forecast.
e Preparing a consensus forecast before pushing it to the Live forecast.

Any member with the appropriate permissions can edit a shared forecast.

7.2.3 Live forecast

The Live forecast is the official project forecast used for financial reporting. It is automatically shared
with all project members and managed through its own data block.

¢ Data from private or shared forecasts can be pushed to the Live forecast to keep it current.

e Only users with the appropriate permissions can update the Live forecast.

© Forecast © Forecast & Forecast & Forecast © Forecast ©) Forecast
total cost total MHrs total MHrs/unit total total unit cost method
productivity
H $ 250,000.00 0.00 000 0.00 $250,000.00  Current estimate
! $ 406,300.00 8310.00 083 096 $4063  Current estimate
i $1,499,250.00 29,805.00 298 101 $149.93  Current estimate
$1,056,600.00 21,226.00 21.23 099 $1,05660  Rollup
i $1800,300.00 16,040.00 19.95 1.00 $995.40  Current estimate
H $202,500.00 4,040.00 20.00 0.99 $1,002.48  Current estimate
i $53,800.00 1,146.00 057 087 $2674  Current estimate
$1,749,400.00 0.00 0.00 0.00 $1749.400.00  Rollup
i $250,000.00 0.00 0.00 0.00 $2500  Current budget
i $999,000.00 0.00 0.00 0.00 $99.00  Current budget
! $500,400.00 0.00 0.00 0.00 $500.40  Current budget
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7.3 FORECAST MANAGEMENT

Control uses three data blocks for forecasting:

e Forecast — Enter and adjust forecast values.
e Forecast delta — Compare two forecasts side by side.

» Live forecast — displays the official project forecast.

7.3.1 Forecast data block

All forecasting adjustments are made in the Forecast data block. This block includes a variety of
columns that show cost, man-hours, and productivity, as well as forecast methods.

When you first access the Forecast data block, either by opening the Forecasts view or by adding the
data block to your view, it will show several options for loading a forecast. Select New private forecast
or New shared forecast to load a new forecast based off the Live forecast. You can also select an
existing forecast under Recent.

Forecast H

Create new
(® New private forecast
() New shared forecast

Recent

Name Last Viewed

o  Team Forecast
2

11/20/2025 11:25:50 AM

LK Forecast

15

11/20/202511:14:50 AM

Created from Live forecast 11/20/2025 11:11:35 AM
Z 11/20/202511:11:35 AM

After you make your selection, the data block populates.
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Forecast S created from Live forecast 0. ¥ (L LT C 09/02/2025
£ Forecast £ Forecast #2 Forecast 2 Forecast # Forecast #2 Forecast #2 Forecast
total cost total MHrs total MHrs/unit total total unit cost remaining cost method
productivity
}: $ 250,000.00 0.00 0.00 0.00 $ 250,000.00 $250,000.00 Current estimate
}: $ 406,200.00 8,310.00 0.83 0.96 $40.63 $314,000.00  Current estimate
}: $1,499,250.00 29,805.00 298 1.01 $149.93 $1,395,750.00  Current estimate
$1,150,300.00 23,100.00 23.10 0.91 $1,150.30 $1,074,000.00  Rollup
}: $ 896,300.00 17,960.00 19.96 0.89 $995.89 $845,000.00  Current estimate
}: $ 200.500.00 4,000.00 20.00 1.00 $1.002.50 $180,000.00  Current estimate
}: $53,500.00 1,140.00 0.57 088 $2675 $49,000.00 = Current estimate
$1,749,400.00 0.00 0.00 0.00 $1.749,400.00 $1,145,000.00  Rollup
}: $ 250,000.00 0.00 0.00 0.00 $25.00 $150,000.00  Current budget
}: $999,000.00 0.00 0.00 0.00 $99.90 $650,000.00 Current budget
}: $ 500,400.00 0.00 0.00 0.00 $500.40 $345,000.00  Current budget

You can adjust the forecast by entering values directly into the data block cells.

Forecast £ Created from Live fore.. ¥
2 Forecast 2 Forecast 2|
total cost total MHrs tota

i $250,000.00 0.00

i $ 406,300.00 8310.00

i $1,499,250.00 29,805.00

$331,141.02 6,686.00

i $74,841.02 1500.00 @

i $202,500.00 4040

! 4 53800 00 114600

To view or adjust cost categories for a cost item, click the View cost categories icon inside a cell. This
opens the Cost Categories tab of the cost item details slide-out panel.

1005
Erect Steel - Light
WBS CURRENT ESTIMATE
phase DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
code e,
1002 -
%complete () Live forecast method Latest actuals in forecast
1060 values
Forecast 2 Createf o 9.90% Current estimate v C 100152025
2 Forecast 2F
total cost total 1073
Total Pe it
; sram00 o otal  Per uni
I
i $20250000 em—]p 1005 Cost category Current budget Actual cost (to date)  Current estimate 2 Forecast 2 Forecast Billing rate markup
i 06 remaining cost amount
acnonnan 1
1084 A Total $200,000.00 $20500.00 $202,000.00 $202500.00 $182,000.00 $000 o
1085 ™ Labor $200,000.00 $20500.00 $202,000.00 $202500.00 $182,000.00 $0.00
1086 ™ Construction $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
1087 ~ FOM Rented $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
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The drop-down menu in the Forecast data block gives you options for managing your forecasts. The
image and table below show the option details.

Forecast <2 Created from Live forecast 1.. ¥

2 Forecast F t £ Forecast
total cost orecastname total MHrs/u

i §2500  Created from Live forecas
$400,0
Sharing
$1,500,0
$3371 L9 shared
]
i $256 [ Open
$2492 )
New from Live >
$623

R O

S
$1.750,0 ave as

$2500

Q

Refresh from live

$1,0000

]

Send a copy
$500,0

” ! @ Push to Live forecast...

I AAAR PPN

oo |,

Forecast name Enter a name for the current forecast.

Sharing Click to select Shared or Private access to this forecast. You can also
send a copy of this forecast to team members.

Open Load a saved or shared forecast. You can also delete saved forecasts.

New from Live Create a new private or shared forecast from the Live forecast.

Save as Save a copy of this forecast.

Refresh from live Overwrite forecast values with the Live forecast values on selected
cost items.

Send a copy Send a snapshot of this forecast to specific users.

Push to Shared Overwrite values in a shared forecast with values from this forecast for

forecast selected cost items. See below for more details.

Push to Live forecast Overwrite Live forecast values with values from this forecast for
selected cost items. See Push to Live forecast for more details.
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7.3.2 Push to shared forecast

Changes made to a private forecast can be pushed to a shared forecast.

Push to shared forecast

1. From the private forecast data block, select the cost items with updated values.

2. Open the data block drop-down menu, and then select Push to Shared forecast.

.
Tasks H Forecast £ LKForecast”
¥ CBS Description WBS 2 Forecast 2
v position phase et Forecast name
code
(] 1 Job Overhead 1002 }: $2500 LK Forecast
n
f:‘i 0O @ Earthwork 1069 i $4063 Sharing
(m] 3 Concrete 107 }: $1.499.2
2 Private
(m} v 4 Structural Steel 1073 $10628
41 Erect Steel - Heavy 1074 }: $7484 [ Open
(1 1005 H
42 Erect Steel - Light i $2606 D New from Live N
O 43 Bolted Connections 1006 }: $538
@ Save as
O v 5 Materials 1084 $1,7494
0 51 Earthwork - Materials 1085 i $250,0
N [}
(m] 52 Concrete - Materials 1086 i $999,0 Senda copy
O 53 Structure Steel - Materials 1087 }: $5004
f £8  Push to Shared forecast
O 6 Merrill Iron & Steel - Steel Material 1088 i

@ Push to Live forecast...

3. Adialog box opens where you can review the changes. Select a shared forecast from the drop-
down menu.

Push these values to the selected shared forecast?
Please review the changes below, and then click 'Yes'if you wish to push these values to the selected shared forecast.

£2 Shared Forecast 2 v 2 LKForecast

cBS Description WBS phase 2 Forecast 2 Forecast MHrs

position code Shared Forecast 2 total cost total MHrs  difference difference

41 Erect Steel - H.. 1074 Shared Forecast 1 §748,410.22 15,000.00 ($51,889.78) -1,040.00

42 Erect Steel - Li.. 1005 $202,500.00 404000 $260643 56 5200.00 $58,143.56 1,160.00
$1,002,800.00 2008000  $1,009.053.79 20,200.00 $6,253.79 $120.00

4. Review the changes, and then click Yes to finish. The updated values now show in the shared
forecast.
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Forecast 52 shared Forecast1 ~

2 Forecast #2 Forecast #2. Forecast
total cost total MHrs total MHrs/unit
i $ 250,000.00 0.00 0.00
i $ 406,300.00 8.310.00 0.83
1 $1.499,250.00 29,805.00 2.98
4 1,062,853.79 21,346.00 21.35
i $ 74841022 1500000 ® 18.66
i $ 260,643.56 5.200.00 ® 25.74
i $ 53,800.00 1,146.00 0.57

7.3.3 Compare forecasts

You can compare forecasts by adding the Forecast delta data block to your view and then selecting two
forecasts in the data block header to compare.

Forecast delta /A [Q}Y ¥Rd — @) Livn

Forecast total Fo ) & cast total Forecas
cost MI © Live Forecast ) 5/unit roduct

ctor
”SD.OU 0. f2 Shared Forecast... 0.00
”SD.OU 0. 2 LK Forecast 0.00
”3 0.00 0. “ Shared Forecast.. 0.00
$6,253.79 12 © October 2025 -0.01
1($ 51,889.78) 1, © September 2025 ) 0.07

L J

13 58,143.56 1,160°00 578 -0.22

The Forecast delta data block displays any deltas between the selected forecasts.
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¢ Values in black indicate equal values between the selected forecasts.
e Values in green indicate a higher value than the corresponding value in the other forecast.

e Values in red indicate a lower value than the corresponding value in the other forecast.

N [ ]
Forecast delta /A [CYTEWRA — [ ]0 e C oo > C 1ons/205  §
Forecast total Forecast total Forecast total Forecast total Forecast total Forecast
cost MHrs MHrs/unit productivity unit cost remaining cost
factor
Is0.00 0.00 0.00 0.00 $0.00 $0.00
is0.00 0.00 0.00 0.00 $0.00 $0.00
Is0.00 0.00 0.00 0.00 $0.00 $0.00
$6,253.79 120.00 012 -0.01 $6.25 $6,253.79
lis 51,889.78) -1,040.00 -1.29 0.07 (5 64.54) ($ 51,889.78)
15 5814356 1,160.00 574 022 $287.84 $58,143.56
Is0.00 0.00 0.00 0.00 $0.00 $0.00

7.3.4 Live forecast data block

Access the Live forecast data block to view official project forecast values. Users with the correct
permissions can make updates directly in the data block.

Live forecast | &) Current live forecast ¥ C o09/02/2025 §
© Forecast © Forecast @ Forecast © Forecast © Forecast @ Forecast
total cost total MHrs total MHrs/unit total total unit cost method
productivity
! $31250 0.00 0.00 0.00 $312.50  Current estimate
H $ 406,300.00 8,310.00 083 0.96 $40.63  Current estimate
i $1,499,250.00 29,805.00 298 1.01 $149.93  Current estimate
$ 475,850.00 9,560.00 9.56 2.20 $47585  Rollup
H $ 346,300.00 6,960.00 19.89 230 $989.43  Current estimate
~
H $125,050.00 2,440.00 20.00 1.64 $1,025.00  Average performan...
i $4,500.00 160.00 4.00 6.25 $112.50  Current estimate
$1,749,400.00 0.00 0.00 0.00 $1,749,400.00  Rollup

Additionally, you can access previous Live forecast snapshots from the drop-down menu.
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Live forecast @) current live forecast ~ '

fft:f'éﬁcs?m & Current live forecast = :I?I?:}unit
8 D-Uﬂl Take live snapshot | 2176,
$0.00 © October 2025 2176.
$000 © September 2025 0
$000 © August2025 0.
$0.00 @ July 2025 0.
i $000 VRV - 0.

7.4 FISCAL CALENDAR

Control has built-in settings that automatically set the actuals in the forecasting-related data blocks to
match your company’s month end calendar.

@ CXYZ / Settings

» HOME PAGE GLOBAL OPTIONS FISCAL CALENDAR DOCUMENT TYPES CUSTOM LIS >
o
=
@ +Week ending day » Financial year start month
[') Saturday v January v
@
® Period end

* Month end day Last weekday

g
Last day of the month v

« Financial period closing day «Month end plus days

Same as Month End Plus Days v 7

®

« Financial period closing time » Closing time zone

23:30 [C) (UTC-06:00) Central Time (US and Canada) v

The fiscal calendar settings include a suspended period for you to finalize your forecast numbers

without incurring any new actuals.
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Period end
= Month end day Last weekday

Last day of the month - Select one -
+ Financial period closing day = Month end plus days

Same as Month End Plus Days - 8
+ Financial period closing time * Closing time zone

23:30 G) (UTC-06-00) Central Time (US and Canada) -

During the suspended period, your numbers are frozen, allowing you to finish month end reporting
without worrying about the numbers changing. Any new actuals accumulated during the suspended
period will populate once the suspended period is over.

The Live forecast data block contains a Current live forecast label in its header. The Current live
forecast label reminds you that the values in the Live forecast data block are only for the current
period, as defined in the organization settings.

Live forecast | &€ current live forecast ~ S eseoe > C o9/02/2025 &

© Forecast & Forecast @ Forecast € Forecast & Forecast @ Forecast

total cost total MHrs total MHrs/unit total total unit cost method

productivity
i $312.50 0.00 0.00 0.00 $31250  Current estimate
i $ 406,300.00 8,310.00 0.83 0.96 $4062  Current estimate
i $1,499,250.00 29,805.00 208 101 $149.93  Current estimate
$ 475,850.00 9,560.00 956 220 $47585  Rollup

i $ 346,300.00 6.960.00 19.89 230 $989.43  Current estimate
H $125,050.00 244000 20.00 164 $1,025.00 Average performan.

Fiscal calendar settings are configured in your organization settings. See the following table for details
on fiscal calendar options.

Week ending day Determines which day of the week is the final day.

Financial year start Allows the financial year-end to be different from the calendar year-
month end.

Page 284 of 632 InEight Inc. | Release 26.5



Control User Guide 7.5 Forecast Methods

Month end day Determines what the final day of the month is.

Last weekday Sets the day for the above setting.

Financial period Allows you to set the financial period to end on the same day or allow a
closing day period to close out the finances.

Month end plus days  Sets the number of closing days.

Financial period Sets the time when the forecast actuals will be reset to the next period.
closing time
Closing time zone Sets the closing time zone.

Project fiscal calendar Enable this setting to allow different fiscal calendar settings at the
settings project level.

7.5 FORECAST METHODS

The Forecast Method establishes the appropriate forecast unit cost, which is used to calculate the total
forecast cost. The Forecast Method applies to individual cost items and can be changed at any time.

You can use several forecast production methods to calculate the cost of the remaining work
associated with a cost item. This enables the control of forecasting on a cost item by cost item basis by
controlling the calculation of the cost of the remaining work. The different methods available for
forecasting are:

Forecast Methods

Current Budget Actual Total cost + (Current budget unit cost * Quantity Terminal or
(CB) remaining) superior
cost items

Current Estimate  Actual Total cost + (Current estimate unit cost * Quantity ~ Terminal or

(CE) remaining) superior
cost items

Average Actual Total cost + (Actual unit cost * Quantity remaining) Terminal or

Performance superior
cost items
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Forecast Methods (continued)

Manual Manually entered forecast value Terminal or
Superior
cost items

Rollup The sum of subordinate forecast values Superior
cost items

Committed Cost Actual Total cost + Open/Remaining committed cost Terminal or
superior
cost items

None The Forecast total cost will be 0 Terminal or
superior
cost items

Contract Line item gross amount + Draft vendor change order Terminal or

amount + Remaining to buy (value allocated to the first superior
line item in the contract) cost items

Detailed ETC Actual Total cost + sum (Forecast remaining cost) forall ~ Terminal

assigned forecast resources. cost items

Static manual time The sum of the manually distributed time phased forecast Terminal or

phased cost. superior

forecasting (TPF) cost items

Custom (customer Calculation specified by customer. Terminal or

specified) superior cost
items

7.5.1 Forecast Method Assignment

There are three different ways to assign a forecast method:
¢ Globally to all cost items in the project
e Selection of multiple cost items

¢ |ndividual cost item
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7.5.1.1 Global Forecast Method
From the Actions menu, you can set the forecast method globally for all the cost items within the

project.

The Global forecast method only applies to the forecasted items of the user who performs the
function. It does not apply to other users in the project.

The following steps walk you through applying a global Forecast Method.

Set Global Forecast Method

From the CBS tab register, select the View menu.
Select the Project Controls viewset.
Click on the Actions drop-down menu and select Global Forecast Method.

Select the Current Budget Forecast Method.

o~ 0N~

Click Apply.

Only terminal cost items will adjust per the global Forecast Method selected. The parent
item Forecast Method will stay as Rollup.

6. Click Yes on the prompt that appears.

7.5.1.2 Forecast Method for Selected Items

You can also set the forecast method for selected cost items, as shown in the steps below.
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Set the Forecast Method for Selected Iltems

1. In the Tasks data block, select the check box next to the desired tasks.

=IMENU Control & Q

75100000 - PKS Inc

~ Steel Structure Training Job View : | Forecasts v D 4 ® &

Actions v cBs Acs PAY ITEMS CHANGE REGISTER AUDITLOG Q
Tasks H Task Det.. < eses > H Forecast | Created from Live foreca. * = Cooed H Forecast | Created from Live foreca. ~ =
c8s Description wBs Foreca UM Forecast Final Forecast Final Forecast Final Forecast Final PF Forecast Final Forecast Method Forecast Final Forecast Final Forecast |
) Position Phase stT0 Cost MH Man Hour/Unit Unit Cost Cost MH Man Hour
Code aty
_ Job Overhead I 1000 100 Lump Su. 1 $250,000.00 0.00 0.00 0.00 $250,000.00  Current estimate i $250,000.00 0.00
I oo ! w002 1000000 ov ! sius000000 3000000 200 100 $15000  Cument estimate ! sius000000 3000000
) _ — s | raoon | Ton p— - o0 0300 | o p— —

“ Bolted Connections I 1005 200000 i $50,000.00 0.00 000 0.00 $2500  Current estimate I $50,000.00 0.00

o I oo 1007 100 | Each $1.750000.00 000 000 000 §175000000 | Rollup $1.750000.00 000

o BRI e vaterials ! o 1000000 cv ! szs000000 000 000 000 $2500  Current estimate ! s2s000000 000

o [ corcrete - Materiats ! 009 1000000 oY ! s100000000 000 000 000 10000 Curent estimate ! $1.00000000 000

o [EI swewesee-vaeris | 1010 100000 Ton | ssooo0000 000 000 000 $50000  Cument estimate | ssooo0000 000

Subtotals n $4,950,000.00 58,000.00 $4,950,000.00 58,000.00
‘ ,
©2017 InEight Inc Privacy and Terms | & €8 2.0.6352.34 INEIGHT )

2. Select the Actions drop-down menu and select Set Forecast Method.

@)  Steel Structure Job (105091)

Actions = G—) BT ®

Glohal forecast method..

I Set forecast method .

Claim multiple CBS guantities g

Budget move & contract adjustment »

Unlock budget co

Sync 4 St
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3. On the resulting slide out panel, select your desired Forecast Method and click Apply.

Actions = ® = )

Set forecast method I

This will apply a single forecast method to selected costitems
with an allow as-built selection for which this forecast method
is enabled in settings

(O Current budget
(O Current estimate
(O Average performance

(O Committed cost

Cancel

7.5.1.3 Forecast Method for Individual Items

You may need to change the forecast method for a single cost item. The following Step by Step walks
you through how to do so.

Set the Forecast Method for Individual ltems

1. In the Forecast data block, locate the Forecast Method column.

2. Double click on the Forecast Method field for the your desired cost item.
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¢ A dropdown menu appears where you can select your Forecast Method from a list

CBS Description inal Forecast Final Forecast Final Forecast Final Forecast Final Forecast Method Fu
Posi MH Man-Hours/Unit Productivity Unit Cost C
tion Factor

1 Job Qverhead 50,000.00 0.00 0.00 0.00 $250,000.00 Current budget 5t

2 Earthwork 00,000.00 8,000.00 0.80 1.00 $40.00 | Current budget v St

3 Concrete 100,000.00 30,000.00 3.00 1.00 5150.00 | o, 8t

Current budget
4 Structural Steel 83,768 50 19,977.80 1998 1.00 $108377 §C
Current estimate

Erect Steel - Heavy 34,158 50 15,985 60 1998 1.00 $1,167.70 Average performance S0

None
Module 01 - Erect Steel Heavy 00,000.00 0.00 0.00 0.00 $1,000.00 St

7.5.1.4 Average Performance Forecast Method

The average performance forecast method lets you use actuals for a specific time frame range to
determine the unit cost and rate for the remaining work when calculating the remaining forecast.
Forecasting using average performance lets you forecast the remainder of work based off completed
work.

When Average performance is selected as the forecast method in the CBS, you can click the value in
the Average performance settings column and select a date range to use for the actual rate of
completion for the remainder of work.

This feature lets you identify a length of time you want to utilize a cost item's hours and quantities to
determine the install rates for the remaining work.

Click an Average Performance Settings CBS record to access the Average Performance Settings
window.

T g T g s

Calculate average performance over all The average performance for the cost item
dates takes all the dates into account when
calculating its average performance.

Calculate average performance based on You can determine how many weeks or

most recent months to calculate the average performance
for a cost item. For example, you determine
that the last 2 weeks performance best
represents how to progress, then you would
calculate two weeks of average performance.
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Calculate average performance over a Selecting a date range uses only the specified

specified range time range for calculating the average
performance.

Calculate average performance from date You can select a specific date to calculate

average performance. After the learning period
for the selected cost item is complete, you can
use the average performance for a specific
date and onward.

Average performance settings

@ Calculate average performance over all dates
This will be up to date through the
O Calculate average performance based on most recent: (@ P g

most recent week ending date

-

O Calculate average performance over a specified range:
From (= To &=
O Calculate average performance from date:

&

The average performance settings can also be accessed in the cost item details slide-out panel.
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Tasks

3 CBS position Description

Subtotals 151 (1 rows selected)

e [ Actuals TS \
- il Resurface Existing Access road
Actual to
e DETAILS

Description (

Resurface Existing Access rog

CE total MHrs

2 103.20

CE MHr/Unit
0.0z

* Allow as-built

All

« Forecast T/0 qty 1
CE total cost
i $5803.84

As-built lock

[] Hidein Plan, Progress, aui/

O 1 Financial Results .
U W Misc. Rev Internal
o 2.1 Misc. Rev Internal
o V22 Escalation/Contin...
(W 2.2.1 General Project Ri..
O v 23 Directs

o ~ 231 Direct Labour

O v 2311 Grading work
23101 Resurface Existin...
o 23112 Maintain Access ..
(W 23113 Clear & Grub Benc..
o 23114 Type D Excavatio...
o 23115 Road Subgrade Pr...
o 23116 Culverts & Riprap ...
O 23117 Rock / Boulder Ex...
O 23118 Sump Excavation ...
(W v 2312 PreCast Blocks &
O 23.1.21 Set / Place Pre-C..
U 23122 Drill / Install / Gro._.
(W 23123 Build & Move Anc...
=] 23124 Test Anchors

o 23125 Relocate Existing ..
o 2.3.1.26 Anchor Re-Tensio...
(W 23127 Anchor Block Re-l...

Control User Guide

NT ESTIMATE

SOURCES FORECAST RESOURCES
* Cost source
Detail -

& Live forecast method

Average performance -

Average performance settings

(O Calculate average performance over all
dates

(O Calculate average performance based on
most recent: (@)

(@ Calculate average performance over a
specified range:

From |11/22/2018 [
To 01/10/2023 [

(O Calculate average performance from date:

[T}

To date v

As an example, if you choose to calculate the average performance based on the most recent three

weeks, the Forecast remaining cost and Forecast remaining MHrs change based off the cost item’s

performance from the last three weeks.

Actions = ® = (]

Tasks
% CBS position Description
O 1 Financial
O ~ 2111 Site .
21111 Site

The Forecast method and Average performance settings changes are also shown in the cost item

details slide-out panel.
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CHANGE REGISTER

/

AUDIT LOG

= O

$

{ ooen > C 12092022 §

& Forecast ) Forecast & Average £ Forecast £ Forecast
total cost remaining performance remaining cost method
rs
5000 0000 5000  Current estimate
$2,469,443.93 -2.409 ($101.66) Rollup
/ 2 | $2,452434.31 0000 Last3weeks | 5000 Average performan.. |

\
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O §$§ m T B 1 Q

X
1396
Site Maintenance Crew
CURRENT ESTIMATE
| F ASTR
DETAILS RESOURCES ORECAST RESOURCES
Forecast T/O qty UaM CBS position
75,181.000 MH 21.1.1.0
Last changed on Last
12/16/2022 09:54 AM
Description + Cost source
Site Maintenance Detail -
= Forecast T/0 gty ( & Live forecast method
Average performance -
CE total cost Average performance settings
Last 3 weeks -
CE total MHrs CE labor cost/MHrs

7.5.1.5 Committed Cost Forecast Method

Committed Costs are obligations made for contract work or purchase orders that you have agreed to
pay for. The Committed Cost forecast method provides you with the ability to use committed cost
information to forecast your cost at completion.
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Forecast final

Forecast

Forecast

Control User Guide

unit cost remaining cost method
($120,539,221.43) ($122907,115.92) = Rollup
($142,040,228.20) (5142,445305.28)  Rollup
($12,535.89) (5129212.48)  Rollup
$118.05 $10,805.00 | Committed cost
54388 $8,676.00 Q,
918 S0.00 | cyrrent budget
($14,869.35) (5148,693.48) | Currentestimate
Average performance
$0.00 $0.00

None

$0.00 $0.00 5

Forecasting cost items can be done in the live or private forecast, and can be forecasted at the parent
or terminal levels. The Committed Cost Forecast method can only be used when cost items have an
Allow as-built of All or Costs. When the Allow as-built values are set to None or Quantities, this forecast
method cannot be used because cost and committed costs cannot be claimed.

The Committed Cost forecast is mostly utilized on cost items that are driven from purchase orders or
contracts. It is not used when you're claiming quantities. For example, this forecast method isn't
suitable for direct labor items where quantities are claimed to generate progress and crew
performance. This forecast method works well for cost items that are tied to a contract or PO.

When Open/Remaining Committed Cost values are being entered, these values will also update the
forecast values in the CBS. There is also an integration available that allows you to import committed
cost data from your ERP, instead of manually entering in the data. For more information on
Commitment Costs, visit subject Track Open/Remaining and Total Committed Costs within this topic3.3
Cost Items on page 99

The following columns will help you view the Committed Cost forecast method:

Forecast total cost: Forecast cost at completion which is equal to the Open/Remaining committed cost
plus any Actual cost to date.

Forecast remaining cost: This is the amount of money that remaining to be paid out. This column is
equal to the Open/Remaining Committed Cost.

¥ CBS Description As-built lock Allow as-built
position

@‘ O oaroo/ze20  §
F
cost

‘orecast
method

1111 Permits All 1.00 $11,805.00 232300 00 $11805 $10,80500 Committed cost
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The Committed cost forecast method is most commonly used for costs that are associated to a
purchase order tracked through an ERP system. This method doesn't focus on quantities or percent
complete, but rather the progression of costs paid towards the final agreed upon PO value.”

7.5.1.6 Contract Forecast Method

Using this forecast method, you can forecast by Contract values. This forecast method is only available
in the forecast drop down for cost items that are assigned to a Contract.

Any modifications that you make in Contract automatically updates and comes into Control.

C 02/15/2022 =

Forecast

L

tk:&

m o

m

Contract -

| Q
Current estimate .
Average performan
Mone
Committed cost

Contract

When a cost item is assigned to a contract, you have the option of adding the read-only column
Number of contracts to your CBS. This column is an integer value that counts the number of contracts

a particular cost item is associated to. You have to go into Contracts to see which Contract your cost
item is associated to.
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Number of contracts
Number of associated contracts
in the Contract application

Number of Fc
contracts meth

36.00 1 Contr

If the Number of contracts column is set to zero, the Contract Forecast Method becomes unavailable
from the Live Forecast, Private Forecast, and the Cost Item Details slideout drop down for Live Forecast
Method on the Details tab.

Contract Forecast Method pulls the cost that is associated to a specific cost item from Contracts. Cost
items can be associated to the following if using Contract Forecast Method:

» Many different Contracts
» Many different line items across different Contracts

The cost item's Forecast Final Cost value sums up the line item amounts of all cost that is associated to
a cost item from Contract.

Unapproved Contract Line Items

The line item price is included in the associated cost item's Contract forecast method when creating
new line items in a Contract vendor change order.

After a new line item is saved, a batch process is initiated in the background that sends the line item’s
net price over to Control.
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Actions v @

Add existing line item |
] o Line item Il | Add new line item m = Cost:
D Ne Add new line item

Contracts > 7400007066 - contract1 >} [ Cancel J Save and new J 2%

Line item details / Quantity & pricing
Type = Quantity * UoM = Unit price * Per
Material 1000 | Each v $ 400.00 1.000 gach
Description
! Is taxable
Pricing Value §

The net price from Contract shows in Control’s forecast total cost column, which also includes the tax
from draft pending vendor change orders.

Contracts > T400007066 > 2-2 CADS contract
et Remaining amount to allocate / tesponsible party Vendor CO status Approval status
v Draft - Not applicable
$0.00 $0.00 /
e : @ = Clear all filters LU z [:J L<; _j @ Q
< e = Total revis:
1 = Costcenter =| WBScode = |GL account = =  Unitprice = [ MNetprice = fax == = s
Te 1102 - Gen 521320 - Supplies-C. ) $ 400,00 5 400.C $0.00 .
— $400.00 \ $0.00 $0.00
+

mieths

1
Description WBS phase code I
1000

Financial Results Analysis / Current estimate 50

New 1 1139 Rollup 50

New 2 1140 None $0

Misc. Rev Internal 1103 / 1 Rollup $2.402829

Misc. Rev Intemnal 104 ' Manual (EAC) Th

Escalation/Contingency nm Rollup <100 Forecast total cost

General Project Risk 102 / 52 Contract ‘ was pre\“ous[y
$600

7.5.1.7 Custom Forecast Method

The Custom forecast method lets you specify a calculation for a forecast cost and manhours. For more
information, refer to Project Control settings where Custom forecast methods can be configured.
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7.6 Manual Forecasting

y Scheduling i Custom Forecast method calculations

~ Administration
> Account Code Structure (ACS)

~ Control Settings
Roles & Permissions

Project Settings

Custom forecast method calculations

Southeast

ORG_CALC double check

To create a custom Forecast Method, click Add custom farecast method, and then enter the Farecast Method Mame, Forecast Total Cost and

Forecast Total Mhrs calculations. You can create a maximum of 10 custom organization and project level forecast methods each at one time.

Select the Formula icon to choose fields to include in your forecast formula.

New custom forecast method

=

7.6 MANUAL FORECASTING

Scenario

You can create custom forecast methods at both the project and organization levels by configuring your own calculations.

Control User Guide

Froject Iracking (organization & project
level)

Tasks
Actuals
Estimated Actuals
Enabling actusls for Progress
Enabling actuals for Cantrol
Estimated actuals process overview
Reversing estimates
Reversing Estimated Actuals
Time Phasing budget

Forecast (organization & project level)
Time Phasing

Forecast

Custom Forecast method
calculations

Enable Forecast methods based on
Allow as-built selections

Estimate Resources (organization &
project level)
Schedule (organization & project level)
Revenue (project level)

Revenue and Cost Timing

Billing method default eamings
rules

Pay item forecast takeoff quantity
rollups

Pay item forecast takeoff quantity
rall down

Markup
SyneIntegrations (project level)
Others (project level)
Required Cost Items
Decimal Precision
Others (org level)

Dvrsiend Fock Bomme

Assume you have a structural steel installation code being performed by a subcontractor. They
have notified the project team that the material cost of the steel has gone up due to a change of
thickness of some of the column base plates. You will need to forecast an increase in the total

subcontract cost of the code to reflect this change.

You also receive an update from the concrete superintendent that the code for a concrete
pouring operation will now be using journeymen instead of apprentice concrete finishers. He has
provided the total and you will update the total cost and the labor cost per man-hour.

7.6.1 EACvs. ETC

You can manually enter forecast values for both your Estimate at Completion (EAC) and Estimate to

Completion (ETC) values.
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Control uses different descriptions than EAC and ETC as indicated below.

Control Term What it measures

Estimate at Completion Forecast Final Cost As-built + (Forecast Unit Cost x Quantity
(EAC) Forecast Final MHrs Remaining)
Estimate to Completion Forecast Remaining Forecast Unit Cost x Quantity Remaining
(ETC) Cost

Forecast Remaining

Man Hour

The image below illustrates what EAC and ETC measure:

Estimate at Completion (EAC)
Forecast Final Cost/MH

-
As-Built + (Forecast Unit x Remaining Quantity)
\. v
Estimate to Completion (ETC)
Forecast Remaining Cost/MH

7.6.2 Manual EAC (Estimate at Complete) Forecast

You can use the Manual (Estimate at Completion) Forecast Method to make a simple, quick adjustment
to the calculated forecast numbers, or to forecast the cost of the work remaining, while ignoring actual
costs in the calculation of the forecast.

When you enter a forecast cost at the total level, you can have forecast costs:

¢ Distributed to the cost categories, or

¢ Back calculated if forecast man-hours are adjusted
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To set the forecast total or EAC forecast, type a value into one of the following cells within the
forecasting data block:

e Forecast final cost

¢ Forecast final MHrs
e Forecast Final Man-hours per Unit
e Forecast Productivity Factor

Forecast Final Cost per Unit

The next two Step by Steps walk you through how to define the Manual (EAC) forecast by adjusting the
Forecast Final Cost and the Forecast Final Man-Hours.

Manually Adjust Forecast Final Cost

1. In the Forecast data block, double click the Forecast Final Cost cell for a cost item.

¢ This will allow you to edit the dollar value manually

=IMENU Control Lo CY

¥5100000 - PKS Inc:

~ Steel Structure Training Job View : |Forecasts v D &K ® B
Actions v CcBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG Q
ces Description wes Foreca vom c:
Position Phase  stTO ost
Code ay
Job Overhead I too 100 wmpse |} 52000000 ) 000 000 525000 I 2000000 000
earthwor ! tom 100000 oy ! ss000000 800000 080 100 ! ss000000 800000
Conerete ! w0z 1000000 v 1 3000000 200 100 ] 2000000
Structural Steel 1003 100000  Ton 2000000 2000 1.00 2000000
rect seel - Heavy | oo+ soo0  Ton I sw000000 1600000 2000 100 1600000
rect Stee - Light I 1005 | 20000 Ton ! 520000000 400000 2000 100 400000
Bolted Comnections | oo 200000 e | s000 000 000 000 000
Materials 1007 100 Each 000 000 000 000
Earthwork - Materials ! o 10m000  ov ! 000000 000 ) 000 $2500  cure ! 000000 000
| 10w 100000 oy ! 000 000 000 $10000 | Curent est ! s100000000 000
L] | 100 100000 Ton 000 000 000 $50000  Current estimate 1 $500000.00 000
Subtotals n $4900,000.00 5800000 $4950000.00 5500000
©2017 InEight Inc Privacy and Terms INEIGHT (B

2. Change this value to 125,000.
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=im

Control f o Y

75100000 - PKS Inc

+ Steel Structure Training Job View : | Forecasts v D &H ® B &
Actions v cBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG Q
Tasks : [ TaskDet. <oeeed> ¢ [l Forecast | Created from Live foreca. ~ = Coned 3 [ Forecast | Created from Live foreca. ~

Description wes Foreca uom Forecast Final Forecast Final Forecast Final Forecast Final PF Forecast Final Forecast Method Forecast Final Forecast Final Forecast |

Position Phase stT0 Cost MH Man Hour/Unit nit Cost MH Man Hour
Code aty

Job Overhead I 1om 100 Lmpsu. | $25000000 ) 000 000 $25000000 | Curent estimate | sas000000 000

Earthwork | oo 00000 ov | 000000 800000 080 100 $4000 | currentbudget | sewo00000 800000

concrete | 00z 000000 ov | sis0000000 3000000 a0 100 $15000 | Currentestimate | sis0000000 2000000

Stiuctural teel 1003 100000 Ton $1,000,000.00 2000000 2000 100 $100000  Rollup 20000.00
Erect Steel - Heavy | 1004 s0000  Ton ! $800,000.00 16,000.00 2000 100 $100000  Current budget ! 16000.00
rect steel - Light | o5 20000 Ton I 000000 40000 2000 100 $1.00000 | Curent udget 1 szoo0000 400000
Bolted Connections I 1006 200000 Ea i $0.00 0.00 0.00 0.00 $000  Average performan. i $50,000.00 0.00
Materials 1007 100 Each $1750000.00 000 000 000 $1.75000000 | Rollup $1.750000.00 000
Carthwork - Materils ! i 1000000 ov 1 s 000 0o 000 52500 curentestimate | | 525000000 000
concrete - Materils ! w00 1000000 ov 1 si0000000 0 00 000 10000 | Cumentestimate | | 5100000000 000

L] Structure Steel - Materials I 1010 100000 Ton 125000 1 0.00 000 0.00 $50000  Current estimate i $500,000.00 000

Subtotals. n $4900,000.00 58,000.00 $4,950,000.00 58,000.00

< 3

©2017 Inight Inc Privacy and Terms INEIGHT @

To revert to the original value when manually typing into the cell, press the Escape (Esc)
key.

All other cost categories proportionally adjust automatically once the labor is adjusted.

In the Forecast data block, blue dots indicate what the forecast driver is. A forecast driver
is the manually edited value that the Forecast Final Cost is based off.
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Forecast | Created

Forecast Final
Cost

H $250,000.00
H $400,000.00
I

i 51,500,000.00

$1,000,000.00

H $800,000.00
H $200,000.00
I

i 50.00

$1,375,000.00

i $250,000.00

i $1,000,000.00

H $125,000.00®

In the *Live forecast data block, orange triangles will appear in the top right-hand corner
of the cell. These indicate what the forecast driver is and give a detail of the change when
hovered over.
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% Live forecast _

7.6 Manual Forecasting

Forecast Final PF Forecast Forecast Method
Remaining Cost

Forecast Final

Forecast Final Forecast Final
ost MH Man Hour/Unit
$250,000.00 0.00 0.00 0.00 $250,000.00  Current estimate
e Most recent change to this item
$1,500,000.00 5 E + E el ¢ Eo 2
revious Forecast  Forecastfinal cost  Previous Forec
CBS Column Previous value New Value e e final MH
$1,000,000.00
2 - Earthwork FerecastMethod Current budget Current estimate $0.00 $360,000.00 0
$800,000.00
200000 00 4000 10 20 00 100 890000000 Current hudaet

3. Hover over the Forecast Final Cost cell of the value you entered and select the View cost

categories pop-up.

Forecast

Forecast Fina... Forecast Fina..

120008 ﬁ.-r[nl'ew cost cateqories I

¢ You can see the adjustments that were made by cost category

7.6.2.1 Proportional Adjustment

As you make changes, you may receive a prompt asking you how you would like to adjust other values
affected by your change. For example, when you change your Forecast Final Cost, this will affect either:

¢ Forecast Final MH or

e Forecast Final S/MH

InEight Inc. | Release 26.5

Page 303 of 632



7.6 Manual Forecasting Control User Guide

Proportionally adjust Forecast Final MH or Forecast Final $/MH ?

The Forecast Final Cost can be medified by proportionally adjusting Forecast Final MH
or Forecast Final 5/MH. Specify the value you would like to modify:

Forecast Final MH

Forecast Final 5/MH

While one of those values will remain constant, the other will adjust as indicated in the table below:

Forecasting - Proportional Adjustment Example

Action Result

Original Forecasted Values Forecast Final Cost = $1000
Forecast Final MH = 100
Forecast Final $/MH =10

Manually adjust Forecast Forecast Final Cost changes from $1000 to $2000
Final Cost

Resulting adjustment Forecast Final Cost / Original Forecast Final $/MH = Adjusted
Option 1: Forecast Final MH

Adjust Forecast Final MH $2000/ 10 =200 MH

Resulting adjustment Forecast Final Cost / Original Forecast Final MH =

Option 2: Adjusted Forecast Final $/MH

Adjust Forecast Final $/MH  $2000/ 100 = 20/MH
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7.6.3 Manual ETC (Estimate to Completion) Forecast

The Manual ETC (Estimate to Completion) forecast method can be used to make an adjustment to
forecast the unit cost of the work remaining and adding it to the as-built costs in the calculation of the
forecast.

To set the forecast remaining or ETC (Estimate to Complete) forecast, type a value into one of the
following cells within the forecasting data block:

e Forecast Remaining Labor Cost/MHr

¢ Forecast Remaining Labor Cost

¢ Forecast Remaining Man-hours per Unit
e Forecast Remaining Productivity Factor
¢ Forecast Remaining Cost per Unit

This will set the unit cost and man hour factors. When applied to the remaining gty to deliver and
added to the existing actuals this will equal your total forecast amounts.

7.6.3.2 Detailed ETC FC Method

The Detailed ETC (estimate to completion) method lets you modify the crew makeup and production
rates that drive the remaining forecast values (based on remaining quantities and hours).

For example, if you started your project and you used apprentices, and now you prefer to use
journeymen, you can swap out resources for your forecast resources and use journeymen instead of
apprentices.

In Control settings > Project Tracking, you can now enable forecast methods for terminal cost items
when the allow-as built is set to all or cost for Detailed ETC. When the Detailed ETC forecast method is
enabled, all existing Current Estimate Resources for that cost item are copied to the Forecast
Resources tab in the CBS > Cost Item Details slide-out panel.
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Terminal cost items A

When Allow as-built is set to Allor Cost
Enable the following Forecast methods for terminal cost items when Allow as-built is set to AVor Cost

Current estimate ) Manual (ETC) =)
Current budget %] Manual (EAC) %]
Average performance ) MNone ()
Committed cost ) Contract %]
Detailed ETC &

Default Forecast method for terminal cost items when Allow as-built is set to AV or Cost

Current estimate -

When Allow as-built is et to JQuantity
Enable the following Forecast methods for terminal cost items when Allow as-built is set to Quantity

Current estimate =) Manual (ETC) =)
Current budget ) Manual (EAC) ()
Average performance =) Mone )

Default Forecast method for terminal cost items when Allow as-built is set to Quantity

Current estimate -

When Allow as-built is set to None
Enable the following Forecast methods for terminal cost items when Allow as-built is set to Mone

Mone )
Default Forecast method for terminal cost items when Allow as-built is set to Nome

Mone

When the Detailed ETC setting is enabled, a new tab is available in Cost Item Details called Forecast
Resources. This new tab is almost identical to the Current Estimate Resources tab, with the major
difference being that the Forecast Resources tab contains forecast information. You can edit these
resources and values separately from the current estimate resources for a cost item.
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CBS ACS PAY TEMS CHANGE REGISTER AUDIT LOG Unsaved (Forecasts) -

T I A B2 O $ m 0 B = Q

3/ 0BS _ Description WBS phase P - BUTES T CATECORIES CURRENT ESTIMATE
# Jadid DETAILS ATTRIBUTES COST CATEGORIES i

8
a0 O

Job Overhead 1002
Earthwork 1069 Forecast details v
Concrete 107

Resources v
v Structural Steel 1073

41 Erect Steel - Heavy 1074 Productivity and overall settings e

Erect Steel - Light 1005

43 Bolted Connections 1006 Bescourceldetalls e

~

v & Materials 1084

7.7 TIME PHASED FORECASTING

Projects are typically overwhelmed by escalating forecast values as the project progresses. What the
business thought they were going to spend doesn't end up being very accurate at the end of a project.

One way to mitigate this is to take the forecast and break it down into more consumable, estimate
related time blocks/periods, as shown in the screenshot below. This prompts the project engineers to
think about what activities, bills, and costs are going to occur in smaller more mentally digestible time
periods.

CBS Description
Forecasted position
CBS item
Sep '19 cost Oct '19 cost Mov "19 cost Dec '19 cost Jan '20 cost Feb '20 cost
Time blocks
$1.166.65853658536 $1.129.02439024390 $1,166.09803008050 $112.90243902439 $ 300.00000000000 ® $ 500.00000000000 @

Projects need to spread their estimate by periods to verify forecast accuracy vs. the actuals spent
within that period. One of the key goals of time phased forecasting is to see when you are forecasting
to spend allocated budget. You can then determine how accurate your forecast was versus the actuals
spent within that period. Based on forecast accuracy, this gives you the opportunity to make manual
adjustments within the Time phased forecasting register. It also provides the ability to have the system
automatically distribute the forecast for you based upon certain criteria.

TPF gives you visibility into when you are going to spend dollars associated to a cost item in monthly
time periods. TPF also helps with cash flow, enabling customers to provide more insight into how much
money they need to pay employees and other bills.

After selecting a cost item from the CBS, TPF can be accessed from Control > Workspaces > Actions >
Time phased forecasting. This is only if the project settings for TPF is enabled under the Forecast
section.
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CBS

Actions W= @ BT ®

- Task details

Description Resource

Global forecast method..

Set forecast method

Time phased forecasting

Claim multiple CBS quantities Financial Results A_.

Budget move and contract adjustment P ) ) :
g ! Basic Design Servi...

Unlock budget

Indirects
Sync »

Contingency 1

The table below shows the columns from the Time Phased Forecasting page.

Overview - Time phased forecast

- Resource Description

1 Auto Distribute This will automatically distribute remaining forecast based on the
remaining forecast cost curve being used, in addition to the Start and Finish dates.
based on cost
curve and start/end

dates
CE
2 CBS position The CBS position identifier number.
3 Description The description of the CBS.
4 WBS Phase code = Work Breakdown Structure code number.
5 Start This is the scheduled start date for the cost item.
6 Finish This is the scheduled finish date for the cost item.
7 Cost Curve This is a graph/calculation of the costs of production as a function

of total quantity produced. Cost curves can be created, viewed
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Overview - Time phased forecast (continued)

- Resource Description

and maintained in Settings > Control > Schedule, in the Cost
Curves section on the page.

8 Forecast method Forecast methods include: Current Budget, Current Estimate,
Average Performance, Manual (EAC), None, and Rollup.

9 Forecast remaining This is the unsettled balance of forecast. Cost that is projected to
cost still be required to be paid out (varies depending on forecast
method).

10 Forecastfinal cost Total cost to date + Forecast remaining cost, cost item projected
total cost at completion.

11 Phased Forecast  This is the remaining forecasted cost that has not yet been
Remaining Cost allocated to a monthly period. It is the difference between the
Delta Forecast remaining cost and the sum of forecasted cost currently
represented in all remaining months on the TPF window.

12 Load more This will load additional month columns to view in the TPF
window.
13 <date> cost The forecasted cost projected to be incurred during that individual
month.
o. = = " " B
gsssmon 9 Desnnpnone EE%Q o Start e Flmshe g:,s\:e o Fmoel"ehc:dst :Ff:é‘:‘ci:‘srt“ 5§§cnt @ Eel:'ﬁzle"d‘::r:::tsi m % Jul "19 cost @ Aug '19 cost rAeumgn:ngmgcost
1 a 1000 06/19/2019  12/31/2019 Linea Rollup $15038,381.26 $15,038,381.26 ($15,038381.26 $35544.88 $116,944.26

1025 06/19/2019  12/31/2019 | Lin Rollup $1.41050662  $1.410,506.62 (§1.410,506.62 $984.78 $5507.29

111 G &AExpense (7... 1026 06/19/2019  06/19/2019  Linear Currentestimate ~ $1,090,208.12  $1,090,208.12 ($1,090,20812

112 P&P Bond (0.40.. 1027 06/19/2019  06/19/2019  Linear Current estimate $67.82891 $67.82891 ($67.828.91 $0.00 $0.00

There is a Load More column that exists in the middle/top of the page. When selected,
additional monthly time buckets will be added to the page.
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Forecast method

Current estimate

7.7.1 TPF Register

Load more

Control User Guide

Jan '19 cost

The Time phased forecasting register allows you to time phase auto spread forecast remaining costs,
which are based on cost curves, and start/end dates. You can also manually override specific months

and change the distribution costs.

For example: you have $250,000 to spend on a cost item (Forecast remaining cost). You can use Time
Phased Forecasting to spread your dollars into monthly allocation buckets. This can be done by
automatically spreading the $250,000 forecast, or by manually overriding the forecast and entering

your own values into the monthly buckets.

CBS > TimePhased Foreca.

CE Descript WE Start Finist Cos

po ph aun
col

1 Job Overhead | 1002 06/11/2019  11/25/2019  Linear

2 Earthwork 1069 11/26/2019  05/11/2020  Linear

3 Concrete 07 05/12/2020  10/26/2020  Linear

4 Structural Steel | 1073 10/27/2020  04/12/2021  Linear

7.7.2 Auto Distribute

I Auto spread forecast I I Manual override I

Forecast Phasec
final cost remain
delta

Sep 19 remaining
cost

N\
Oct 19 cus\

\
Nov'19 cost \ Dec 19 cost Jan ‘20

$250,000.00 000.00

$:800,000.00

$ 3,000,000.0(

$1,050,000.0(

$0.00

$0.00

$0.00

$ 60,000.00

$0.00

$0.00

$25,000.00 ® $ 48,000.00

$0.00 $28,571.43

$0.00 $0.00

The Auto distribute icon allows you to have the system automatically allocate remaining forecast as
determined by your Actual Start date, Actual Finish date, and Cost Curve.
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CBS > Time Phased Foreca..
] Auto distribute remaining forecast based on
=2a cost curve and start/end dates
CBS "Dm Load m. Jul '19 cost
positio
- 1.1 Ba: 1001 03 09 L Roll 10,0 1,092,364,798. 677
L4 111 Indi 1002 03 09 L Roll 121 1,092,364,798. 677
T4 111 Con 1003 07/ 09/ L Curr.. 126, 19,187,552.694
1112 Job 1009 06/ 09/ F Curr usD USD 21,497 584.087
1113 Desi.. 1006 07/. O07F/. L Curr.. 6,5 (136,936.199)
1.1.1.4 Job 1004 03 12 B Roll (21 961,605.565
1.1.1.41 Desi.. 1005 03/.. 08/.. L Curr.. 301 (86,894.355)

Aug '19 cost

12,310,649,399.471

12,310,649,399.471

1,641,816.243

USD 11,845,050,361.155

3116

(1,068,557.342)

(253,032.894)

7.7 Time Phased Forecasting

Aug '19
remaining cost

12,567,815,504.198
12,567,815,504.198
102,472,320.000

USD 12,345,678,901.123
0.000

(1,535622.827)

30,158.730

The Auto distribute icon allows you to automatically distribute dollars into monthly allocation buckets.
In this case, the allocating of dollars will begin on the Start date of May 2020 and stop allocating on

Finish date month of October of 2020.

Descript WBS Start Finisk Cos' Fo Forec Phased
phase cun me rema forecast
code cost remaining...

Concrete 1071 05/12/2020 10/26/2020 | Linear Curr.. $3,000,00..

7.7.3 Manual Time Phased Forecast

Sep "20 cost

$0.00

Oct '20 cost

$535714.29

4]
o]

3,571.43

&
S

Using the same example, it’s also possible to manually forecast the allotted $3,000 into your desired
monthly buckets. By manually entering in $400,000.00 into the Oct 2020 bucket, your Phased forecast
remaining cost delta changes to $135,714.29. This represents the remaining amount of dollars to still

be forecasted.

oa
G
Descript WBS Start Finisk Cos Fo Forec Phased Aug '20 cost
phase cury me rema forecast
code cost remaining...
Concrete 1071 05/12/2020  10/26/2020  Linear Curr. $3,000,00 ($135,714.29) 3535714.29 $553571.43

Sep "20 cost Oct '20 cost

$ 400,000.00

$ 55357143

On the right side of the screen, a blue circle displays by the forecast quantity when a manual override
to the forecast quantity is performed. If you hover over the blue circle, it shows a description of the

manual override.
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Sep '19 cost Oct '19 cost Mov '19 cost
$238,134.05 $22191098 51,266,
$10,723.09 57625474 $3.
5000 5 500.00 h
$ 0.00 Manual Override:

Changed by: paul trippi
Change date: 08/05/2019 04:29 PM

$0.00 WValue before: § 0.00

On the left side of the screen, a manual override to the forecast amount shows a warning symbol by
the cost curve. Hovering over the warning sign shows that the cost item contains a manual change to
the time phased months, and thus, the cost curve is no longer accurate.

CBS Description ist Cost Forec Fo
position curve meth ret
co
1 Financial Results... 31/2019 | Linear Rollup S
1.1 Commercial Cost [31/2019 | Linear Rollup §
1.1.1 G & A Expense (7. 19/2019 Linear Current es._.. §
P
lag®
112 P &P Bond (0.40.. 19/2 Costitem contains manual time

phased months

L e | Ol men! Tliale lee AN AN N I S e e o b e

7.7.3.1 Proportional Man Hours and Quantity

In addition to Cost, Man hours and Quantity displays on the Time phased forecast grid. If you manually
adjusted the cost for one of the months in the grid, a dialog box appears asking to proportionally
adjust Man hours and the Quantity.
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Propartionally adjust MHrs and/or Qty ?

The man hours and quantity can be modified proportionally for
this fiscal pemod
Wan haurs
A
B Quantity
Die Ahwes Tor all cost items and don show this message
again

This omlog can be ne-enacded trom e Sethngs menu |} ) mihe

If for example you doubled your cost in the Time phased forecast, it would also proportionally double
your Man hours or Quantity. You can view the values that the man hours and quantity would
proportionally adjust to in the read only cells.

If you manually adjusted Man hours or Quantity in the Time phased forecast grid, a dialog box appears
asking to proportionally adjust cost and man hours .
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Propartionally adjust Cost and/for MHrs 7

The cost and man hours can be modified proportionally for this
fiscal period

B Cass
I han hours

D this Tar &ll cost items and don show this message
again
This dialog can be re-enatled from the Settings menu (£3) i the

ool bar

| Cance| | Ik

Control User Guide

Both dialog boxes have the option to adjust proportionally without showing the message again. If you
selected this option and want to revert settings back to see the dialog again, in the Time phased

forecast grid, go to the Settings icon and select Enable dialogs.

o show upo
Cost, Oty or MH

0 B I ) I B I
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In the Time phase forecast grid, you can also select to export to Excel.

Publizh

St
Hovember 2010 w December 2020 Exooit
At
oty Cast Mhrs Oty Cost thrs

-0.14 (S 10)000.00) = oo = 1.00 = § 254237 0.00
1.0 33113.H ma LI 5322480 LR ]
1.0d 100000 = L = 1 = 50000 1.0
J.Ue) B L) (LRI g J. 0
Jid . Joahy’ W bal » INE. F e FER TS
Selecting this exports everything that is in your view to an Excel spreadsheet.

A B 5 ] E B G H | il K L M N (o] L Q R 5
BS stlli-_DescripLiu WBS phas Start Finish Forecast nCost curve Forecast r-Forecast r Qty remai Phased fo Phased fo Phased fo March 202 March 20: March 202 April 2020 April 2020 April 20201
1L1.1.1.1 MAINTAIN 1348 HHHHEEER SRS Manual (E Linear 10000 100 1 -12627.1 100 1.262712 o 0 a o 0 a
1.1.1.1.2 FUEL AND 1017 SH8EEHEE saaEE Manual (E Bell Shape 10000 100 -99 0.001005 900 99 o 0 0 a
1.1.1.1.3 GAS&DIE 1018 HEHEEHEH #@EEEE Manual (E Front Loac 10000 100 -220 1000 -100 220 o 0 a o 0 a
1.1.1.1.4 FUELHOSI 1474 HEHEHERH d@EEaEEE Manual (E Back Load 10000 100 1 -1.7E-05 -100 4] o 0 a o 0 a
L1.1.1.5 Maintenal 1476 fHBHREHH #istaiie Manual (E Linear 10000 100 1 -535.826 -5.35826 0.01142 0 0 a o 0 a

7.7.4 Static manual time phased forecasting (TPF)

Static manual TPF lets you distribute a time phased forecast in the future without causing a
redistribution. All values entered in the TPF are constant, and any deltas based on current month
actuals that do not equal what was forecasted for that month, must be spread manually.

To enable the static manual forecast method, the Forecasting and Push time phased forecast to Live
forecast toggles must be set to On in Settings > Control > Forecast.

103961 Settings

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE

5 / .
® Time phasing _
)

Enable time phasing for the following:
) :

Forecasting (3) ©
0

Push Time phased forecast to Live forecast @

commitments (3) © /
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The static manual forecast can be enabled on the Time phased forecasting page by first making a
change to any of the distribution fields. After you click the Publish button, the Push these values to the
Live forecast dialog box opens. When the Do not redistribute manual spread check box is selected, the

values entered in whole months remain as-entered and are not automatically redistributed when

actuals are incurred or months close.

Push these values to the Live forecast?

Please review the changes below, and then click "Yes' if you wish 1o push these values to the live forecast

Current live forecast values

Time 5
ces Description Tivafo Livefo Forecast remaining | Forecast remaining
remaining Gost remaining cost manhours
manhours.

3 FWCB/C $17500 o $22500

Do not redistribute manual spread (7)

The forecast method for the CBS record automatically changes to static manual TPF, and the forecast
remaining cost and forecast total cost changes based on the distribution amount adjusted in TPF.

Tasks
 CBS
O - |position
O v 3

31

H : : > nay
¢ J Live forecast | & | @ current live forecast ~ C oan1/2023 §
Description © Forecast & Forecast & Forecast € Forecast € Forecast
remaining cost total cost remaining remaining umit method
MHrs cost
|
Misc. Rev External $2375.00 $245042 96 7500 $9,50000 Rollup
000 $45000 Static manual TRF_ € Static Manual TPF (estimate

Al
FWCB/C $225.00 $325.00
at completion)

“

If costs are claimed for the CBS item, the forecast total cost remains the same, but the forecast

remaining cost is reduced from the claimed actual quantity.

Page 316 of 632

InEight Inc. | Release 26.5



Control User Guide 7.7 Time Phased Forecasting

/ CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

Tasks g —_—
- CBS Description CE fatal cost Actual cost (to date)
(] position

5 100.00 5 100,00
O w3l Misc. Rev External
an FWC B/C Clasmed cost Cost calegory
5 333333 =
L w312 Vaniage Dewaten
O 3121 Craft Labos
Posted date
O 31.22  Equipment 04/21/2023 B

T Live forecast IEI € cument live

Descnption & Forecast o Forecast
remaining cost total cosd

0 0O

w31 Misc. Rev External / §2325.00 § 24504296

a

3 FWC B/C / | $175.00 §325.00 I

In TPF, the claimed amount now shows the phased forecast remaining cost, which represents the

remaining amount that still needs to be spread. The phased forecast remaining cost now must be
deducted somewhere from the TPF distribution.

CBS Description ‘orecast Forecast Remaining gty
] pesition ...

O 311 PWC B/C

7.7.5 Time Phased Forecast Settings

Time phased forecast can be turned on in Settings > Control > Project Settings, in the Forecast section
of the page.

If the setting is turned off, you will not see the Time phased forecasting option in the Actions drop-
down, CBS tab, in the Control > Workspaces page.
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7.7.5.2 Enable Time Phased Forecasting

TI me phaSing Time phased forecasting provides the ability to

spread forecast remaining values into the projects
fiscal periods. Mavigate to Project details to set the
Start and End dates which define the earliest and
Enable time phasing for the following:| latest project periods.

Forecasting (i) @)

Push Time phased forecast to Live forecast )

7.7.5.3 Cost Curves

Cost curves determine the proportion of money to be expended in a certain period of time. In the case
of Time phased forecasting, the type of cost curve being used determines how forecast will be spread
across the monthly forecasting buckets.

In addition, the fiscal calendar also influences how the forecast is spread.

Cost Curves are found in Settings > Control > Schedule, in the Cost Curves section of the page.

Cost curves

Customize cost curve tables

®
Description Data points
Linear 20
Front Loaded 2
Back Loaded 2
Bell Shaped 21

By selecting a Cost Curve and selecting the View icon, you can view its default distribution.
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® [®

Description

+ Linear

In this case, the Linear Cost Curve settings displays the cost curve durations and values.

Description Number of points
Linear 20
From duration % To duration % Value %
0.00% 5.00% 5.00%
5.00% 10.00% 5.00%
10.00% 15.00% 5.00%
15.00% 20.00% 5.00%
20.00% 25.00% 5.00%

Total 100.00%

For example, using a Linear Cost curve, with a Start Date of 05/12/2020, the Forecast Remaining cost is
$3,000,000.00, with a Phased forecast remaining cost delta of $O. This means that you are forecasting
to spend $3,000,000.00, and your Phased Forecast Remaining Delta is zero because your Time Phased
Forecast is now fully met (you have fully forecasted $3,000.000.00).

CE Descript WE Start Finish Cos' Fo Forecast Forecast Phased forecast

pc phi cury me¢ remainin final cost remaining cost
cot cost delta
3 Concrete 1071 05/12/2020 10/26/2020 Linear Curr.. | $3,000,000.00 $ 3,000,000.00 $0.00

Since your scheduled Start date is 05/12/2020, the system will start forecasting money on this cost
item in May. Based on the Linear Cost curve and the fiscal calendar it will stop forecasting money in
October 2020. This is based off your scheduled Finish date of 10/26/2020. Over the period of 6
months, your spend is totaling 3,000.000.00.

May '20 cost Jun "20 cost Jul '20 cost Aug '20 cost Sep '20 cost Oct '20 cost

$339,285.M1 $ 500,000.00 $ 500,000.00 $ 625,000.00 $ 500,000.00 $535714.29
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7.7.6 Time Phased Forecast Prerequisites

There are certain requirements for a cost item to be eligible for time phased forecasting.
1. The Schedule data block must have a Start and Finish date.

2. The Schedule data block must have a Cost curve association.

7.7.7 Time Phased Forecast View

You may want to create a View in your Control Workspace similar to this one showing a Time Phased
Forecast in comparison with the Live forecast. This shows the hours you are forecasting to spend
money (TPF) vs. the Live forecast.

3 Descrif WBS Start Finish Cost Forecast Forecas Forecast Forecast Forecast Forecast Forecast final
poi phas curve remaining method final cost final man final MHrs final unit cost
code cost hours/Unit productiv...
1 JobOverh 1002 06/11/2019  11/25/2019  Linear $ 250,000.00 ($0.00) Current esti $250,000.00 0.00 0.00 000 $ 250,000.00
2 Earthwork 1069 11/26/2019  05/11/2020 Linear $ 800,000.00 ($0.00) Current esti $800,000.00 1.60 16,000.00 1.00 $80.00
3 Concrete 1071 05/12/2020  10/26/2020  Linear $3,000,000.00 $320,000.00 Current esti $3,000,000.00 6.00 60,000.00 1.00 $300.00
4 Structural 1073 10/27/2020  04/12/2021  Linear $1,050,000.00 ($1,050,000.00) Rollup $1,050,000.00 21.00 21,000.00 1.00 $1,050.00
Erect Steel.. 1074 Linear $ 800,000.00 ($800,000.00) Current esti $800,000.00 20.00 16,000.00 1.00 $1,000.00
Erect Steel.. 1005 Linear $ 200,000.00 ($200,000.00) Current esti $200,000.00 20.00 4,000.00 1.00 $1,000.00
Bolted Con 1006 Linear $50,000.00 ($50,000.00) Current esti $50,000.00 050 1,000.00 1.00 $25.00
5 Materials 1084 Linear $1,750,000.00 ($1,750,000.00) Rollup $1,750,000.00 0.00 0.00 0.00 $1,750,000.00
Earthwork 1085 Linear $ 250,000.00 ($250,000.00) Current esti $250,000.00 0.00 0.00 000 $25.00
Concrete - 1086 Linear $1,000,000.00 ($1.000,000.00) Current esti $1,000,000.00 0.00 0.00 0.00 $100.00
Structure 1087 Linear $500,000.00 ($500,000.00) Current esti $500,000.00 0.00 0.00 0.00 $500.00
Subtotals 11 $6,850,000.00 $6,850,000.00 97,000.00

The following steps walk you through how to plan Time phased forecasting.

Time Phased Forecast Planning

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.
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Tasks ¢ l Schedule
GBS position Description Scheduled Schedule ID E:cgdule plug Plug days
2 1 Job Overhead v HD.0000003 0.00
2 2 Earthwork v HD.0000019 90.91
2 3 Concrete v HD.0000044 375.00
2 4 Structural Steel v HD.0000046 v 262.50
2 41 Erect Steel - Heavy HD.0000064 200.00
2 4.2 Erect Steel - Light HD.0000105 50.00

2. Select Time phased forecasting from the Actions menu.

Actions w BT ®

Global forecast method.. . .
Fiscal calendar settings have beer

Set forecast method

Time phased forecasting |
Claim multiple CBS quantities R
Budget move and contract adjustment P

Job Overhead
Unlock budget

Earthwork
Sync »

- = Concrete

¢ This action opens the Time Phased Forecast window, where you can see the CBS on the
left side of the screen, and its associated forecasting monthly allocation cost buckets on
the right

CBS > Time Phased Foreca..

Publish
CE Descript Wi st Finish Cor Fo  Forecast Forecast Phased| Toadm . Jul'19cost Aug ‘19 cost Aug'19 Sep 19 cost Oct 19 cost
po ph cur me remaining final cost remain| remaining cost
co cost delta

1 Job Overhead | 1002 06/.. 11/25/2019  Lin curr. $250000.00 $250,000.00 $0.00 $18,000.00 $18,000.00 $62,000.00

2 Earthwork 1069 11/.  05/11/2020  Lin curr. $800,000.00 $800,000.00 $0.00 $0.00 $0.00 $0.00

3 Concrete 1071 05/ 10/26/2020  Lin. Curr..| $300000000  $3000,000.00 $0.00 soo0e $0.00

41 Erect Steel - . | 1074 Lin. curr. $800,000.00 $800,000.00 $ 0.0 $000 $0.00 $000

42 ErectSteel - . | 1005 Lin curr $200000.00 $200,000.00 $0.00 $0.00 $0.00 $0.00

4 Structural St.. | 1073 10/..  04/12/2021 | Lin. Roll. | $1.05000000  $1,050,000.00 $0.00 $000 $0.00 $0.00

3. For one of your cost items, type in $500 in one of the monthly bucket fields.
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Feb "20 cost Mar '20 cost Apr '20 cost
$0.00 $0.00 $0.00 $0.00
147,619.05 514761905 5138,095 V 5147,619.05
$0.00 $0.00 S50000 @ 50.00

S 0.00 S 0.00 S 0.00 S 0.00
S0C 5 0.0 5 0.0 5 0.0

» Notice how the field now has a blue circle next to the $500.00. If you hover over it, you see
the value before, after, and the date the change was made

$ 500 oq%

Manual Override:

£

I

Changed by: paul trippi
Change date: 08/06/2019 08:25 AM
Value before: § 0.00

Fes

&0 AN
2 0.00

¢ Because of the manual adjustment, a warning sign appears on the Cost curve for this cost
item. The cost curve is not being changed to manual, but the system records that this cost
item is no longer linear, because it has been overridden

CE Descript wi Sti Finish Cost

po ph curve
co

1 Job Overhead = 1002 06/ 11/25/2019  Linear

2 Earthwork 1068 11/ 05/11/2020  Linear

3 Concrete 1071 09/ 10/26/2020  Linear D
¢ The override made to this cost item is no longer needed, and you now decide you want to

revert to its original setting, and have the system Auto distribute the forecast

4. Make sure your cost item is checked, then select the Auto distribute icon.
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CBS > Time Phased Foreca..

Auto distribute remaining forecast based on
%lm cost curve and start/end dates
CE Descripr’

we stan s Cost
po ph: curve
col

< 3 Concrete 1071 05/12/2020 10/26/2020  Linear

¢ This action will revert the time phase values back to the same numbers as they were prior

to any manual adjustments, plus:
a. It will erase any manual adjustments

b. It will distribute the remaining forecast values based on cost curve and start/end
dates of that specific cost item, as determined by the fiscal calendar

¢ The result of selecting the Auto distribute icon starts its forecasting spread on the cost
item’s Start date of 05/12/20, and will Finish its schedule on 10/26/20

[-I]
=8 -

—
Descript WBS Start Finist Cos' Fo Forec Phased ig '20 cost Sep "20 cost Oct '20 cost
phase cury me rema forecast
code cost remaining...

Concrete 1071 05/12/2020  10/26/2020 Linear Curr $ 3,000,00 $0.00 $55357143 §553571.43 $535714.29

It is important to remember the purpose of utilizing Time Phase Forecasting is to see how
you are forecasting to spend money over a period of time. The expectation is to get the
forecast adjusted to where it should be, and update costs as needed.

7.7.8 Time Phased Forecast Microsoft Excel import

You can import a Microsoft Excel file to update the values in Time Phased Forecast by selecting Import
on the Time Phased Forecast page to download the time phased template. To import time phased
forecast values, you can download a template as shown in number 2 in the image below to use as a
guide to import your new time phased forecast values. The same format provided in the download
template is required for the import to be successful.
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CBS Time phased forecasting o
/ Nov 2023 - May 2024 - £3 G
CBS Description WES S “scember 2023 w
[ position phase — rars
= Remaining m... Qty RN Gty Cost
0O J o = 0.00 50
[
Import time phased values
L mpart from Excel (xlsx, xis) or Comma separated vahee [ csv)
0 0.00 50
0 ' 0.00 0

=1
2]

Downloa . I 2 only the cod and
L. Download time phased template e only the columns and

) ©

I Wi,
nn header names. Only
populated fields will be imported. Blanks will
be ignored and proportional adjustments will
not oocur

Cancel

INEIGHT @

The Excel file includes the cost items that are in your current Time Phased Forecast view. Columns in
orange are required, columns in yellow are optional to change, and columns in grey are ignored and
cannot be changed. When you are finished making your Excel changes, you can then import the Excel
file into Control to update the Time Phased Forecast with your new values. Column header names are
ignored if changed.

A A B C D E L L N o

Required /
Yellow | Optional
| Ignored

1

2

3

4

s 92 Phased forecast rema Phased forecast rema Novembe Novembe Noi
&

7

8

1 Financial Results Analysis 1000 Cu 1] -1 [} [
) Misc. Rev Internal 103 1/1/2024 3/31/2024 0 -0.000956353 0 0
2.3 Directs 001 1/1/2024 3/31/202 56 [ 9.1€-09 [} 0
9 23114 Type D Excavation LD/ PL/CP to Embankm 1007 LY 1] a 0 (1]
102.3.1.1.5 Road Subgrade Prep/PlacefFinish (1600 1008 Ci 0 o [ 0
11 2.3.1.18 Sump El(ah’a‘llnﬂ&EatkfIH‘CONDlTlONA'loll / o [1) o 0 1]

1

Updates are made when you select Publish. Excel imports are shown in the Import History Audit Log,
where you can download the Excel file to see a list of errors if the process fails.
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Time phased forecast Microsoft Excel import

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.

] -
Tasks N BEEGEES
= CBS Description Forecast (T/0) UoM Actual MHrs
position gty (to date)
1 Financial Results ... 100 PLS 0.00
v 2 Misc. Rev Internal 100 PLS 7,030.50
2.1 Misc. Rev Internal 100 PLS 0.00
v 23 Directs 100 PLS 3821.00
v 231 Direct Labour 100 PLS 3,067.00

2. Select Time phased forecasting from the Actions menu.

Actions = BT ®

Global forecast method.. . .
Fiscal calendar settings have beer

Set forecast method

Time phased forecasting |
Description

Claim multiple CBS quantities

Budget move and contract adjustment P

Job Overhead
Unlock budget
Earthwork
Sync »
- = Concrete
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3. Select the Import icon.

CBS *  Time phased forecasting

Dec 2023- Jun 2024~ £33 G

CBS( Description W;PS February 2024 «
[]  positien gﬂg:e Mhrs Qty Cost
5000 0.00 0.00 $0.
3000 0.00 0.00 S0

NN NN

4. Click Download time phased template.

Import time phased values
Import fram Excel ( xlsx, xls) or Comma separated value (_csv)

Browse

S}

Template will include only the columns and
rows currently in your view.

Do not change column header names. Only
populated fields will be imported. Blanks wi
be ignored and proportional adjustments will
not occur.

Cancel

J. Download time phased template

@

5. Adjustment any of the fields under the yellow columns. For example, for CBS position 2.3,
change the February 2024 Cost from 13.62637329 to 9, then save your changes.
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T1 - S
A B S | T u | \4 \ X Y

1 Required

2 Optional

3 Ignored

4

5 February 2024 Cost February 2024 Mhrs February 2024 Qty March 2024 Cost March 2024 Mhrs March 2024 Qty
6 1 Financial Results Analysis 0 0 0 0 0 0 1]
77’2 Misc. Rev Internal 0 13.62637329 10 0.000614656 12.74725243 10 0.000575001
8 2.1 Misc. Rev Internal 0 0 0 0 0 0 0
97 2.3 Directs 0.001413 13.62637329 10 0.001990392 12.74725243 10 0.00186198
107 231 Direct Labour 0 13.62p37329 10 0 12.74725243 10 0

Financial Results Analysis
Misc. Rev Internal

Misc. Rev Internal
Directs

Diract Labour

6. Select the Import icon again.

0.001413

0 13.62637329

@ | [T

Dec 2023 - Jun 2024 -

IF;

7. Select Browse, and then navigate to th

Import time phased values

Import from Excel (xsx, xis) or Comma separated value (csv)

Drag and drop the file here

L Download time phased template ©  Template willinclude only the columns and

fows currently in your view.

e Excel file you just saved, then select Open.

@® Do not change column header names. Only
populated fields will be imported. Blanks will
be ignored and proportional acjustments will
notoccur
Cancel
@ Open X
1 ¥ > ThisPC > Downloads v 0 O Search Downloads
Organize ~  New folder = m @
¥ Downloads ~  Name Date modified Type Size 1
b Music + Today @
= Pictures B Time phased templatexisx 1/23/2024 10:34 AM Microsoft Excel Work. 11K
8 videos £ receipt.paf 1/23/2024 821 AM Adobe Acrobat Docu 50 K8
v < >
File name: |Time phased templatexisx ~| A Fites ) v
[Com | o

8. Select Import.
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Import time phased values - Time phased template xIsx

Import from Excel (. xIsx, .xIs) or Comma separated value (.csv)

Drag and drop the file here

or browse

Browse

\L Download time phased template () Template will include only the columns and
- rows currently in your view.
() Do not change column header names. Only
populated fields will be imported. Blanks will
be ignored and proportional adjustments will

not oceur.
Cancel Import

7.7.9 Column Chooser

When you open the Time phase forecast, a column chooser has been added to the grid.

X

Column options

Avallable columng Selected columng
Account code - < - T
Actual fimich
L3 o
Actual start [::'.\I‘ WES phase code
Allere Ae -l Start
Bs-built lock Finish
CBS contribute quantity Forecast methad
CBS tag1 Cost curve
CBS tag 10 Farecast remaining cost
CHS tag 11 Farecast remaining man hour
CBSLag 12 bl Oy remaining bl
Cancel

After you choose which columns to show, the left side of the grid updates with your selection.
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On the right of the grid, you can also adjust your view for each month's Cost, Man hours, and Quantity.
This can be done using the drop down next to the month and deselecting the options you do not want
to see on your grid.

Nevensber 2020 .-1':"‘| December Z0Z0 -
[ M Cost Fhis Oty
-
- -0.26 § 254237 0.00
Cast 1AL SaddeHd L]
1AL S L |
Wan hours o 600 o
L L h P XS
Ouantity o

Apply 10 Al Msnhs

If you select cost from past dates, the data is read only.

7.7.10 Audit Log

All changes made within TPF are captured in the Audit log within Control Workspaces. The Audit log
captures changes based on any changes made to a forecasted CBS item.

In the example, it shows that a forecasting value was changed on 08/13/19 for Audit ID 232. The
forecasting value had been changed from 89.36 to 100.00 for the Aug '10 remaining cost time period.

Audit Data type Item Descripti WBS Attribute Change Changed Value Value
CBS D type by date before after
ACS 232 | Time phased forecast | Cost item Job Overhead 1002 Paul trippi 08/13/2019 0. 89.36 100.00
Pay items 225 Current Estimate Estimate r C01.04-Concr Resource employed Paul trippi 08/13/20191. Resource e
Integration 224 Current Estimate Estimate r E.01.05-Earth Resource employed Paul trippi 08/13/20191. Resource e
Import history 223 Current Estimate Estimate r C01.04-Concr Resource employed Paul trippi 08/13/20191. Resource e

7.8 PUSH TO LIVE FORECASTS

As mentioned above, the Live Forecast is the official forecast used for financial reporting and shared
with all members of the project.
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You can push forecasts entered in the Forecast data block to the Live Forecast either individually or by
selection. This allows you to send only the items that you choose from your forecast to the Live
Forecast.

The Live Forecast can only be updated if the user is assigned the appropriate role with the associated
permissions. Project Admin or Power User can edit the Live Forecast directly.

Forecast changes made in the Forecast data block WILL NOT be pushed to the Live Forecast
without an additional action detailed in the Step by Step below.

Changes made to your Forecast are only seen by you, unless you share them with someone else
(see topic 9.4 Forecast Management) or update them to the Live Forecast.

Push Live Forecast by Selection in the CBS Tab

1. From the CBS tab with the Forecast data block in the view, select a group of cost items, by
clicking the row header check boxes.

2. Click on the drop-down arrow in the center of the Forecast data block.

3. Select Push to Live Forecast.
The Push to Live Forecast option is disabled until you select one or more cost items.

4. After review, select Yes and your forecast values will push to the Live Forecast.

7.8.1 Time phased forecast push to live

The time phased forecast feature lets you make edits in your time phased forecast. You are then able
to push those edits to your live forecast.

You can edit your total forecast remaining cost and forecast remaining hour values in the Time phased
forecast window. It would then override your forecast remaining cost and your forecast remaining man
hour if there is a change.

The Time phasing Forecasting option must be enabled first in order to have the Push Time phased
forecast to Live option available to be enabled. Enabling only the Forecasting option does not
automatically enable both.
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Time phasing

Enable time phasing for the following:

Py

Forecasting (i) [

®_ | Budget @ @
bo

Push Time phased forecast to Live forecast

Forecast

% Complete value at which delta from straight line calculation utilizes
average performance

6

The Time phasing section can be located in the Project Settings of Control under the Project tracking
tab.

When you have enabled both options under the Time phasing section click save. Then go back to the
CBS tab.

Follow these step by steps to use a time phased forecast push to live.

Time phased forecast push to live forecast

1. Select cost items from the CBS tab with a Forecast remaining cost to use in the push to live
feature.

Make sure the cost items you selected have start and end dates. Otherwise you cannot
edit them in the Time phased forecasting window.

2. From Control's CBS tab, select the Actions tab. Then select the Time phased forecasting
option.

3. In the third data block where it has the Month and Year, scroll to the Remaining cost. Now move
the scroll bar over to January of 2021.
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CBS ’  Time phased forecasting
o
O |t = | T | oEm e
e an hour remaining Remaining c... Mhrs Remaining m... aty Remaining qty Cos
(] $5,000.00 0.00 10,000.00
] §318.77 0.00 1.28
January 2021 w February
iining qty Cost Mhrs Qty Cost Mhrs
10,000.00 I 0 0.00 0.00 $0.00
1.28 $ 366.00 0.00 1.46 $402.01

4. If you believe the line item could take up more time and money, you can adjust the Cost and
Man hours for the following month. These changes will then be added to the phased forecast
remaining columns once you push to live.

ng thased FPhased FPhased January 2021 w Februar
forecast forecast forecast o
remaining remaining remaining gty jimng gty Cost Mhrs aty Cost Mhrs
< $1,00000 @ 10000 & 000 e $0.00
1.28 $ 366.00 0.00 146 $402.01

Quantity will show as changed with a delta next to the column. Currently, you cannot
push quantity updates to live.

5. When you have made all the changes you need, select the cost items you want to push to live.
You can either select one or all.

CBS >  Time phased forecasting

g3

a 'ﬁ &

cas Description |ng Phased Phased Phased 5 February 2021 v
() | position ! forecast
T ‘remaining remaining remaining qty Qty Cost Mhrs aty Cost

) 10000 ® 000 ® $0.00 0.00 100 ®

0.00 146 $10201 ® 0.00 041 ®

6. Dialog appears asking if you want to push these values to the Live forecast. Select Yes to
continue. The Cost and Man hours difference shows in the orange columns.
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Push these values to the Live forecast?
Please review the changes below, and then click "Yes' if you wish to push these values to the live forecast.

ces Description Live forecast remaining Live forecast remaining Forecast remaining cost Forecast remaining Cost. M

—— e erence Hrence
1.2 Fiber optic cable-1 $5,000.00 0.00 $6,000.00 100.00 $1,000.00 100.00
1.4 CCTV devices §1,500.00 0.00 $1,200.00 0.00 ($300.00) 0.00

7. When this is pushed to live, your Forecast remaining cost and Forecast remaining man hour
should update in the Live forecast. Your Forecast Method will then change to Manual ETC.
Manual ETC will have a green dot indicator that states it was pushed from Time phased forecast
when you hover over the item.

Live forecast < senee > O 12/09/2020 8
w F w Fore
rem met .'!
$36975.68 500.00 500.00 0.80 $3697568  Rollup
$25,000.00 300.00 0.03 1.00 §2.50 | Current estimate
$6.000.00 100.00 0.01 0.0 Updated by push from Time phased forecast
$5,000.00 100.00 0.01 1.00 §0.25 | Current estimate
$ 97568 | 0.00 0.00 0.00 $162.61 | Manual (ETC) °

The Forecast remaining cost and Forecast remaining man hour columns will have an orange
wedge indicator that shows you which values have been updated manually changed when you
hover over the indicator.

3 CBS position Deseription WBS phase Total * Forec * Forecas * F * Forecas * F st *

(m] code committed "
cost " U ; iv t

[m} v Electrical devices 1000 500.00 §5,000.00 $36975.68 500.00 500.00 0.80 $3697568  Rollup o
[m} 1 Install conduit 1002 25000 $150.00 $25,000.00 30000 003 1.00 $250  Current estimate
O 12 Fiber optic cable-1 10011 25000 $150.00 s 50000 wo@ 0.01 0.00 $060 Manual (ETC) . |
[m] 13 Most recent change to this item
m} 14
o 5 cBs Column Previous value New value Previous Forecastfina..  Forecast finalcostnew  Previous Forecast final..  New Forecast final MH..  Changed by Changed date
[} 6 1.2- Fiber optic cable-1  F 100 200 $6,000.00 $7000.00 100.00 200.00 Danielle Shovel  12/9/2020
O v

7.9 LIVE FORECAST SNAPSHOT

A Live Forecast Snapshot captures the forecast values for a project at a specific point in time.
Snapshots can be used for reporting and historical comparison. Each month, a snapshot is created
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either manually, by syncing the live forecast on a specific date, or automatically at the end of the plus-
days period. The most recent sync for the month becomes the snapshot for that month.

Snapshots contain all live forecast values at the time of capture, along with actuals for the current
month. If actuals are posted during plus days with a posting date within the current period, they are
included in the snapshot. However, actuals posted with next-period dates do not show until plus days
are complete.

7.9.1 Snapshot settings

You can configure snapshot settings in Project settings > Control > Project tracking.

06000 / Settings

> PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS

@ Tasks

*Maintain CRS.S =~in.CRS Struct

WBS Phase code generation method WBS Phase codes start value

Continue numbering from the last generated number -

Enable manual snapshots  (3) @ Default CE values to be updated from CB values  (§) S)

Allow syncs to replace manual snapshots () €}

¢ Enable manual snapshots - When enabled, snapshots are captured only when a user with
permission takes a monthly snapshot. When disabled, snapshots are captured automatically
when Push to Live Forecast and Push Forecast Revenue syncs are run.

¢ Allow Syncs to Replace Manual Snapshots - When enabled, a manual snapshot is replaced if Push
to Live Forecast or Push Forecast Revenue is synced. When disabled, syncs do not overwrite
manual snapshots.

7.9.2 Manage shapshots

You can manage your snapshots from the drop-down menu in the Live forecast data block.

If manual snapshots are enabled, click Take live snapshot to capture a snapshot of the current Live
forecast values.
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Live forecast | &) current live forecast = q

fﬁ:f;gs' & Current live forecast ~ :I?I?:}unit
s D,D(ll Take live snapshot || 2176
$0.00 © October 2025 2176
H $0.00 O September 2025 0.
i $0.00 © August 2025 0.
i $0.00 ® July 2025 0.
! $0.00 oo 0.

Select a previous snapshot to view read-only values from that month.

Live forecast | (® September2025 ~ A { es0e )

@ Forecast ® Forecast ® Forecast ® Forecast

total cost total MHrs total MHrs/unit total
productivity

You can also load snapshots in the Forecast delta data block.

Forecast delta /A [CES Tad H O Liv.. ~

Forecast total Forecast total Forecast total Forecast total
cost MHrs MHrs/unit roductivity
actor

s 0.00 0.00 0.00 0.00

s 0.00 0.00 0.00 0.00

s 0.00 0.00 0.00 0.00
$93,700.00 1,874.00 1.87 -0.08

s 96,000.00 1,.920.00 0.01 011

Snapshots only capture Live forecast values. If you add a column to your view that does not
relate to Live forecast values (such as Committed remaining cost and Committed total cost),

those columns show as blank and disabled.
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CHAPTER 8 — CHANGE
MANAGEMENT

8.1 CHANGE MANAGEMENT WORKFLOW

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress

Measurement Forecasting

Account Code
Management

Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage

Cost Items
Define Qty Account
Analyze Planned
Earned and Actual

Live
Farecast

Forecasts

W8S Structure / Budgeted
Quantities & Hours

roved changes
iﬁﬁa:e cﬂ(rgntggudgff Revenue Management

Billed Revenue

Change Management Ll
Change Register Pay Item Register
Budget Move

Create/Manage
Pay ltems
Budget
Plan Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue

8.2 CHANGE MANAGEMENT OVERVIEW

During any phase of a project there are multiple ways you can manage changes to items such as
guantities, design, schedule, and cost. In Control, you can manage changes to quantities, man-hours,
and costs through a controlled approval process. You can make records of items such as budget moves,
qguantity and man-hour adjustments, and change orders by filling out forms.

You can access these change management forms from the Actions menu.
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= {2t  Steel Structure Training Job 2| 105092 / Control / Workspaces

CBs

Actions = ®

Y
Global forecast mgthod.. .
H Task details { eooe >

| Set forecast method Resources Forecast (T/0) UoM
aty
Update Forecast (T/0) qtywyith Plan compone...
1.00  Lum
‘_:_ Claim multiple CBS quantities
- 0000 CY
Budget move and contract adjustment »
Budget move
| Lock/unlock budget » poo.oo ¢y
Budget quantity and man hour adjustment
syne » _ 000.00  Ton
Contract adjustment
= a1 ErecTsTeer="Hej 350.00 Ton

After you fill out and save the applicable changes, Control stores these changes in the Change Register
tab, where the project budget is managed.

( ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions  w S Y [IFj 1= Q
] Description cco Crea.. Issue Last Last Notes Status Total Total Total Type
date # cha.. changed on budget budget contract
by cost MH price

220 Contingency Draw - Buildi. CD-001 01/12/2023 AJ Waters 03/19/2023 % o @ Approved $0.00 0.00 $000 Budgetm ]
21.0 Fiber Office Connections €0220831 08/31/2022 13 AJ Waters 08/31/2022 % o @ CCO-Approved $55,000.00 0.00 $57,20000 Contract
20.0 New Cabinet Hardware CCO0-0015 09/21/2020 9 Jordan Ca 10/22/2020 % @ CCO-Approved $3,500.00 0.00 $350000 Contract
19.0 Flooding and material was CCO-004 02/10/2020 6 Austin Wil 03/10/2023 % @ CCO-Approved $0.00 0.00 $10,00000 Contract
18.0 Extra Surveying 0019A 02/10/2020 19-1 Chris Hohl 04/21/2021 % 2 Draft $15,000.00 0.00 $19,500.00 Contract
17.0 Increase in Scope 002 01/18/2020 002 Mike Paul 02/05/2020 % @ Approved $22,000.00 0.00 $50,00000 Contract
16.0 Change in Scope col 01/18/2020 001 Paul Benni 04/24/2020 % @ Approved $0.00 0.00 $000 BudgetQ
15.0 11/13/2019 John Upton 04/12/2022 B () Approved $000 0.00 $000 Budgetm
14.0 traslado de dinero dentro 10/21/2019 oM Elia Burgu 03/19/2023 Cj Pending $0.00 50.00 $000 Budgetm
13.0 Traslado de dinero dentro 09/16/2019 013 Elia Burgu 03/19/2023 E% Cj Pending $000 0.00 $000 Budgetm
120 CC00002 09/15/2019 003 Mike Paul 03/19/2023 % Cj Pending $000 0.00 $000 Budgetm
11 Flood control on haul road CCO-0002 03/22/2021 4 Chris Hohl 03/22/2021 % 2 cco-Draft $9,000.00 0.00 $000 Contract

. N A

Subtotals $12,115,309. 64,222.00 $ 290,200.00

In the Change Register you can review each change individually and approve changes as needed. When
a change is approved, it updates the current budget values in the CBS and is given a status of Approved
in the Change Register. Otherwise, the change is only documented in the Change Register with a status
of Draft or Pending and has no effect on the current budget.

To manage changes, you must have applicable permissions.
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The table below provides a brief description of the three types of changes you can record in Control.

Budget move Reallocate costs from one area of the budget to another. When making a
budget move, the result must be net zero, neither adding nor removing costs
from the budget. The move can include reallocation of man-hours and
quantities as well.

Budget Make modifications to budgeted man-hours and/or quantities without making
quantity and changes to overall budgeted costs.

man hour

adjustment

Contract Make a change to the scope of your budget and contract, via the addition or

adjustment revision of cost items and pay items, which results in a change to the project’s
budgeted costs and pricing. Also commonly referred to as a change order.

When you perform a budget move, contract adjustment, or budget quantity and man-hour
adjustment, you can select a maximum total of 250 cost items or 100 pay items. When you
exceed the maximum, the Budget move and contract adjustment option in the Actions menu
drop-down becomes unavailable. This improves the speed, reliability, and performance of the
change order.

8.2.1 Managing changes using the InEight Suite

For a more holistic approach to managing changes within your organization, your company might
choose to follow a change management process that integrates with other InEight applications that
can include:

¢ InEight Change

¢ InEight Document
¢ InEight Schedule
¢ InEight Progress

For more information on how to use the InEight suite of applications to manage change orders, see
Change Order Management.
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8.2.2 InEight Change integration with Control

The InEight Change application is designed to manage project changes through a detailed, organized
process, tracking changes from issue to executed change order. When executed in InEight Change,
change orders can automatically become contract adjustments within InEight Control via an
integration between the two applications. If your company is using both Change and Control for
managing change orders, consult the Contract adjustment from InEight Change overview topic for
more information on this process.

Budget moves can also be initiated in InEight Change and integrate with InEight Control to show up in
the Control Change Register. For more information about managing budget moves using Change and
Control, see Budget Moves in InEight Change.

8.3 ASSOCIATED BUDGET MOVE

During a project, you might need to move costs from one area of the budget to another to account for
project changes, without changing the total budget amount. In Control, you can manage budget moves
via a controlled approval process.

To launch a budget move in Control, from the CBS tab of the Workspaces module, select Actions >
Budget move & contract adjustment > Budget move. This opens a Budget move record with the option
to fill out the record following one of two workflows.

Changeregister >  Budget Move
oDetai\s =l

Choose your Budget move workflow

Associated ) o N
@ Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated
Define budget moves freely to provide the most flexibility

The following table provides information about each budget move workflow.

Budget move

workflow Description Cons

Associated Links each » Clear audit trail — » More steps required —
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Budget move
workflow Description Cons

source cost item
to a target cost
item as a single
transfer
transaction.

Treats each
adjustment
(debit or credit)
as a standalone
action, without
explicitly linking
the source and
destination.

Non-
associated

InEight Inc. | Release 26.5

Shows both the
source and
destination of the
funds in a single
transaction,
improving
transparency.

 Traceability — Easily

see where the
budget came from
and where it went.

» Reporting clarity —
Helps financial and
project controls
teams track budget
changes as
purposeful
reallocations rather
than isolated
changes.

Flexibility — Can make
quick, one-sided
adjustments without
needing to define where
the funds are coming
from or going to.

Faster entry — Useful
when you're adjusting

budgets over time and the

counterbalance to the
move is handled later or
separately.
Auto-calculate — Only
non-associated budget

moves contain the feature

to automatically generate

Typically involves
selecting both a “from”
and “to” item, with extra
steps for assigning
amounts and adjusting
cost categories, which
can be more time-
consuming than a non-
associated move.

» Requires clear
planning — You must
know both ends of the
move when performing
it, which might not
always be the case.

Lack of traceability — Harder
to tell where money came
from or where it went, which
complicates reviews and
audits.

Potential for confusion —
Canleadto
misunderstanding or
misreporting of why certain
budget changes occurred.
Reduced accountability —
Without links, it’s easier to
lose the rationale for the
budget changes, especially
over a long project timeline.
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Budget move

workflow Description Cons

CB budget adjustments
from CE values and CE
values from CB budget
adjustments.

The following are considerations when performing a budget move using the Associated workflow
option:

e Current Budget cost and man-hours are only maintained at the terminal level. You cannot move
cost to or from a parent cost item.

* You can move costs between multiple cost items at the same time.

e You can automatically update Current Estimate (CE) values from Current Budget (CB) values only
in a non-associated budget move or a contract adjustment.

Perform an associated budget move

1. Select Actions > Budget move & contract adjustment > Budget move.

— fat  Steel Structure Training Job 2 | 105092 / Control / Workspaces

Actions = ®

Y Global forecast mgthod.. .
Task details C eooe >
Set forecast method == Forecast (T/0)
4 aty
Update Forecast (T/0) qtyNyith Plan compone...
1.00  Lum|
‘_:1 Claim multiple CBS guantities
B L 000.00 CY
Budget move and contract adjustment
Budget move
000.00 CY

7 Lock/unlock budget
Budget quantity and man hour adjustment

sync ) 000.00 Ton
Contract adjustment

= a TETECT STEeT=Hej - ) 35000  Ton

The Budget Move wizard opens to the step 1, Details.

2. Select the Associatedoption and add budget move details as needed, and then click Next.
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a Details

Choose your Budget move workflow

Associated
@ Define budget moves with a From and To process to provide ultimate traceability of budget moves.

Non-Associated
Define budget moves freely to provide the most flexibility.

Budget move details
Description 453

Move budget from light steel erection to heavy.

cco 60

Issue # 57
056

Discipline 484

Structural Steel

The Budget move wizard opens step 2, Select from & to items.

3. From the From section on the left, select the cost items you need to move budget from and from
the To (for net zero moves) section on the right, select the cost items you need to move budget
to.
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Changeregister >  Budget Move

o Select from & to items =
From To (for net zero moves)
o GBS position Description WES phase code 0 CBS position Description WBS phase code
] 318 £ Building N&O - Scrape. 1099 a O 3le fi  Building N&O - Scrape 1009 a
O ws £ Structural Steel 1073 0 «a £ Structural Steel 1073
] 41 ) Erect Steel - Heavy 1074 | 41 (§  Erect Steel - Heavy 1074 |
42 {y  ErectsSteel - Light 1005 | O 42 £y Erect Steel - Light 1005
[m] 43 £ Bolted Connections 1006 | 43 £y Bolted Connections 1006 |
] 44 £ Labor 1088 O 44 i Labor 1088
] 15 £ Equipment 1089 O 45 fi  Equipment 1089
] 46 £ 3dParty 1090 O 46 £ 3rdParty 1090
O w5 £ Materials 1084 0 «s 5 Materials 1084
] 51 £ Earthwork - Materials 1085 O 5.1 £ Earthwork - Materials 1085
a 52 ) Concrete - Materials 1086 O 52 f;  Concrete - Materials 1086
[m] 53 £ Stucture Steel - Mate.. 1087 a 53 £ Structure Steel - Mate.. 1087
v v
1 items selected 2 items selected

EEEREENREE -

4. Click Next. The Budget move wizard opens to step 3, Define relationships.
5. For each cost item listed under the From section, select Define to do one of the following:

¢ Select Cost category, Qty or MHr adjustment only to modify only the cost category,
guantity or man-hours of the cost item (not the cost item’s cost).

e Select the cost item or items to move budget to that includes costs. You can click Select All
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to select all the listed cost items.

o Define relationships

From:
4.2 [1005] Erect Steel - Light [ Define | ]
CB total cost Pending budget cost CB total MHrs CB total quantity
$200,000.00 @ $0.00 4, [ Cost category, Qty or MHr adjustment only

Budget move with Cost category, Qty or MHr
adjustment to

4.1 [1074] Erect Steel - Heavy
1 4.3 [1006] Bolted Connections

Select All “

8.3 Associated Budget Move

To:

4.1 [1074] Erect Steel - Heavy
4.2[1005] %

4.3 [1006] Bolted Connections

4.2[1005] %

[ Cancel ] [ Draft ] [ Back ]

6. Click OK to close the Define window. Now, for each cost item under the To section, it shows the

cost items you associate to it from the From section.

7. Click Next. The Budget move wizard opens to step 4, Assign amounts.

8. In Assign amounts, you can move costs, quantities, and man-hours.

¢ You can move costs and man-hours by entering values in the CB total cost and CB total

MHrs fields under the To section. This automatically deducts the amounts from the

assigned cost items under the From section.
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o Assign amounts
From: To:
4.2 [1005] Erect Steel - Light 4.1 [1074] Erect Steel - Heavy
CB total cost Pending budget cost CB total MHrs CB total quantity CB total cost CB total MHrs CB total quantity
$200,000.00 $0.00 4,000.00 200.00 $ 800,000.00 16,000.00 800.00
$11,000.00 200.00 0.00 10000.00 200.00 0
= $189,000.00 3,800.00 200.00 = $ 810,000.00 16,200.00 800.00
4.3 [1006] Bolted Connections
CB total cost CB total MHrs CB total quantity
$ 50,000.00 1,000.00 2,000.00
1000.00 0 0
Advanced options Cancel Draft Back m

¢ You can enter CB Total Quantity values on the To section. They do not automatically
deduct from the From section because you could be moving between cost items with
differing units of measure.

¢ You may need to add more or fewer man-hours than you deduct. To allow this, select
Advanced options and switch the Adjust MHrs (not net zero) to On. The CB total MHrs of
your From cost items will no longer automatically deduct when you make adjustments to
your To cost items.

Click Next. The Budget move wizard opens to step 5, Adjust cost categories.

10. In Adjust cost categories, you can assign your pending budget changes to existing and new cost
categories of your cost item. For each cost item under the To section, click the Add cost category
button to reassign costs to different cost categories.

o Adjust cost categories
From To:

4.2 [1005] Erect Steel - Light Alsilable Eox 4.1 [1074] Erect Steel - Heavy R —

CB total cost Pending New total CB total cost Pending New total
Labor $200,000.00 11,000.00 $189,000.00 Labor $ 800,000.00 8 $ 808,000.00
Totals $200,000.00 $11,000.00 $189,000.00 Materials $000 $2,000.00
= Totals $800,000.00 $10,000.00 $810,000.00

(@ Add cost category

4.3 [1006] Bolted Connections Available: $0.00

©B total cost Pending New total
Labo $50,000.00 5100000
= Totals $50,000.00 $1,000.00 $51,000.00

(@ Add cost category

11. On the Add cost categories window, select a cost category, then click OK.
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Add cost categories

Total :2 Selected

Labor

Construction Equipment
FOM Rented Equipment
Supplies

8000

Materials
Subcontract
Fees
Allowance

G&A

J0 000

I Indafinard

12. In the Pending fields, adjust the cost category amounts as needed.

To:
4.1 [1074] Erect Steel - Heavy Available:
CB total cost Pending
Labor: $ 800,000.00 8,000.00
Materials: 50.00 2,000.00
= Totals $ 800,000.00 $10,000.00

(¥) Add cost category

After making your adjustments, the Available amount should equal $0.00.

13. Click Next. The Budget move wizard opens to step 4, Summary.
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»

v

$0.00

New total

$ 808,000.00

$ 2,000.00
$ 810,000.00
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14. In Summary, review your proposed changes, and then click Submit to send the budget move for

approval.
Change Register >  Budget Move Q
e Summary
From: To:

4.2 Erect Steel - Light 4.4 Modluel 01 - Erect Steel Heavy
CB total cost CB total MHrs CB total quantity CB total cost CB total MHrs CB total quantity
Before: $ 200,000.00 4,000.00 200.00 Before: $0.00 0.00 0.00
Pending ($10,000.00) -100.00 -20.00 Pending $ 10,000.00 100.00 20.00
$ 190,000.00 3,900.00 180.00 $10,000.00 100.00 20.00

[ Cancel } [ Draft J [ Back ]

Select Draft if the budget move is not ready to be submitted and needs to be saved for
later.

8.3.1 Associated Budget Move - Single Cost Item

At times, you might encounter changes that require you to make budget changes within the cost
categories of a single cost item. For example, you may find that some items that you estimated to be
self-performed work may be faster and cheaper if they were subcontracted out. Therefore, you can
perform a budget move for a single cost item to redistribute the budgeted cost between different cost
categories.
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Perform an associated budget move within a single cost item

1. Select Actions > Budget move & contract adjustment > Budget move.

Steel Structure Training Job 2| 105092 / Control / Workspaces

Actions ®

Y Global forecast mgthod.. 1
Task details { eeee >
Set forecast method Resources Forecast (T/0) UoM
aty
Update Forecast (T/0) gtyNyith Plan compone...
100 Lumy
‘_:1 Claim multiple CBS guantities
B L 000.00 CY
Budget move and contract adjustment »
Budget move
| Lock/unlock budget poooo | cy
Budget quantity and man hour adjustment
syne ) 000.00 Ton
Contract adjustment
= a1 TETECT STeer="Hei - ) 350.00  Ton

The Budget Move wizard opens to the step 1, Details.

2. In Details, select the Associatedoption and add budget move details as needed, and then click
Next.
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° Details

Choose your Budget move workflow

Associated
© Define budget moves with a From and To process to provide ultimate traceability of budget moves.

Non-Associated
Define budget moves freely to provide the most flexibility.

Budget move details
Description 453

Move budget from light steel erection to heavy.

cco 60

Issue # 57
056

Discipline 484

Structural Steel

The Budget move wizard opens step 2, Select from & to items.

3. In Select from & to items, select the same cost item under both the From and To sections, and
then click Next.

Change Register > Budget Move [®))
o Select From & To Items
From: To (for net zero moves):
GBS position Description WBS phase code CBS position Description WBS phase code
1 Job Overhead 1002 1 Job Overhead 1002
2 Earthwork 1069 2 Earthwork 1069
3 Concrete 107 3 Concrete 1071
4 Structural Steel 1073 4 Structural Steel 1073
41 Erect Steel - Heavy 1074 41 Erect Steel - Heavy 1074
42 Erect Steel - Light 1005 42 Erect Steel - Light 1005
v 43 Bolted Connections 1006 v 43 Bolted Connections 1006
44 Modluel 01 - Erect Steel Heavy 1087 44 Modluel 01 - Erect Steel Heavy 1087
5 Materials 1084 5 Materials 1084
51 Earthwork - Materials 1085 - 5.1 Earthwork - Materials 1085 -
1 items selected 1 items selected

ENEINEEE -

The Budget Move wizard opens to the step 3, Define relationships.
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4. In Define relationships, click the Define button, and then select Cost category, Qty, or MHr
adjustment only.

Change Register >  Budget Move Q

o Define relationships

From To:

4.3 Bolted Connections Define ] 4.3 Bolted Connections

CB total cost Pending change ¥ Cost category, Qty or MHr adjustment only

$50,000.00 0 $0.00 0

4.3 Adjustonly X

Selecting the Cost category, Qty, or MHr adjustment only option lets you move budgeted
cost category values within a single cost item.

5. Click OK to close the Define window, and then Next. The Budget move wizard opens to step 4,
Assign amounts.

6. In Assign amounts, click Next to skip the Assign amounts step because we are not changing the
man-hours or quantities. The Budget move wizard opens to step 5, Adjust cost categories.

7. Click the Add cost category button to assign your pending budget changes to existing and new
cost categories of your cost item.

Change Register >  Budget Move Q

o Adjust Cost Categories

From: To:
4.3 Bolted Connections Available $0.00
CB total cost Pending New total
Labor $50,000.00 000 $50,000.00
Totals $50,000.00 50.00 $50,000.00

(¥) Add cost category

(v ] (oo ] [ | (D
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8. On the Add cost categories window, select the cost categories to include in the adjustment, and
then click OK.

Add cost categories

Total :2 Selected

¥ Subcontract .

l Cancel ]

9. Make adjustments in the cost category Pending fields as needed.

Fees

¢ The values shown in the Available and New total fields will automatically adjust based on
the values entered in the To Pending fields

e The amount in the Available field must be $0.00 to proceed to the next step.

To:
4 3 Bolted Connections Available: $0.00
CE total cost Pending New total
Labor: $ 50,000.00 -50,000.00 50.00
Subcontract: 5000 50,000.00 3 50,000.00
= Totals 5 50,000.00 $0.00 5 50,000.00
FTY B dd cnnt cndaman:

10. Click Next. The Budget move wizard opens to step 4, Summary.

11. In Summary, review your proposed changes, then click Submit to send the budget move for
approval.

The budget move will now be listed in the project’s Change Register with a status of Pending.

8.4 NON-ASSOCIATED BUDGET MOVE

During a project, you might need to move costs from one area of the budget to another to account for
project changes, without changing the total budget amount. In Control, you can manage budget moves
via a controlled approval process.
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8.4 Non-Associated Budget Move

To launch a budget move in Control, from the CBS tab of the Workspaces module, select Actions >

Budget move & contract adjustment > Budget move. This opens a Budget move record with the option
to fill out the record following one of two workflows.

Change register > Budget Move

o Details

Choose your Budget move workflow

Associated

Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated

Define budget moves freely to provide the most flexibility.

The following table provides information about each budget move workflow.

Budget move
workflow

Description

Cons

Associated

Links each
source cost item
to a target cost
item as a single
transfer
transaction.

InEight Inc. | Release 26.5

 Clear audit trail —
Shows both the
source and
destination of the
funds in a single
transaction,
improving
transparency.

 Traceability — Easily
see where the
budget came from
and where it went.

» Reporting clarity —

Helps financial and
project controls
teams track budget
changes as
purposeful
reallocations rather
than isolated
changes.

» More steps required —

Typically involves
selecting both a “from”
and “to” item, with extra
steps for assigning
amounts and adjusting
cost categories, which
can be more time-
consuming than a non-
associated move.
Requires clear
planning — You must
know both ends of the
move when performing
it, which might not
always be the case.
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Budget move
workflow Description Cons

Non- Treats each Flexibility — Can make Lack of traceability — Harder
associated adjustment quick, one-sided to tell where money came
(debit or credit) adjustments without from or where it went, which
as astandalone  needing to define where complicates reviews and
action, without the funds are coming audits.
explicitly linking  from or going to. Potential for confusion —
the source and Faster entry — Useful Canlead to
destination. when you're adjusting misunderstanding or
budgets over time and the misreporting of why certain
counterbalance to the budget changes occurred.
move is handled lateror =~ Reduced accountability —
separately. Without links, it's easier to
Auto-calculate — Only lose the rationale for the
non-associated budget budget changes, especially

moves contain the feature over a long project timeline.
to automatically generate

CB budget adjustments

from CE values and CE

values from CB budget

adjustments.

Performing a non-associated move makes cost adjustments at the total cost and cost category levels.
In addition to cost adjustments, adjustments to man-hours and quantities can also be made.

With the applicable permissions, you can approve budget moves. When you approve a budget move, a

message shows confirming the budget move is approved.

Change order # 1.0 approved. successfully.
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Perform a non-associated budget move

1. Select Actions > Budget move & contract adjustment > Budget move.

Steel Structure Training Job 2| 105092 / Control / Workspaces

Actions ®

Y Global forecast mgthod.. 1
Task details { wooe )
Set forecast method Resources Forecast (T/0) UoM
aty
Update Forecast (T/0) gtyNyith Plan compone...
100 Lumy
‘_:1 Claim multiple CBS guantities
L 000.00 CY

Budget move and contract adjustment

Budget move

| Lock/unlock budget poo.oo | cY
Budget quantity and man hour adjustment
syne 000.00  Ton
Contract adjustment
=TT a1 TTETECTSTEeT="Hei - ) 35000 Ton

The Budget Move wizard opens to step 1, Details.

2. In Details, select the Non-Associated option and add budget move details as needed, and then
click Next.
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oDetalls

Choose your Budget move workflow

Control User Guide

Associated
Define budget moves with a From and To process to provide ultimate traceability of budget moves.

® Non-Associated

Define budget moves freely to provide the most flexibility.

Budget move details
Description

Move budget from light steel erection to heavy.
cco

Issue #

056

Discipline

Structural Steel

The Budget move wizard opens step 2, Select Assign amounts.

453

60

57

484

3. In Assign amounts, click the Add cost item icon to select the applicable cost items.

Change register >

€85 position

Subtotals 0

Budget Move
o Assign amounts $ 1=
Description wBS CB total cost Adjusted CB CB total MHrs Adjusted CB CB total Adjusted CB
phase cost MHrs quantity aty
code

$0.00 $0.00 0.00 0.00

Cancel Back

4. Select the cost items, and then click Add.
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Change register > BudgetMove >  Select costitems

CBS position Description WBS
(m} phase
code
m) 1 Job Overhead 1002
(] 2 Earthwork 1069
] 3 Concrete 1071
] ~ 4 Structural Steel 1073
41 Erect Steel - Heavy 1074
42 Erect Steel - Light 1005
43 Bolted Connections 1006
(m} ~ 5 Materials 1084
] 51 Earthwork - Materials 1085

Subtotals 32 (3 items selected)

8.4 Non-Associated Budget Move

i Search

cance‘ ‘

5. Enter adjustment amounts for each cost item. You can enter positive or negative adjustments
into any of the fields labeled Adjusted, including Adjusted CB cost, Adjusted CB MHrs, and
Adjusted CB qty. See the following adjustment examples:

¢ Moving from one cost item to another:

Changeregister >  Budget Move

(©]

O a
a 42

O a3

Subtotals 3

Approve

CBS position

Description

Erect Steel - Heavy
Erect Steel - Light

Bolted Connections

wBsS
phase
code

CB total cost

§ 800,000.00
$ 200,000.00

$50,000.00

$1,050,000.00

° Assign amounts

Adjusted CB
cost

CB total MHrs

($ 5,000.00)

$5.000.00

$0.00

$0.00

¢ Moving one cost item to multiple cost items:

InEight Inc. | Release 26.5

Adjusted CB CB total
MHrs quantity
16,000.00 20000
4,000.00 200,00
1,000.00 0.00
21,000.00 0.00
Cancel Draft

$ = B
Adjusted CB
qty
80000 000’
200.00 0.00
2000.00 0.00
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Change register >  Budget Move

©] 88 o/\ss\gn amounts s 1= G

CBS position Description WBS CB total cost Adjusted CB CB total MHrs Adjusted CB CB total Adjusted CB

phase cost MHrs quantity qty

code
41 Erect Steel - Heavy $ 800,000.00 ($ 5,000.00) 16,000.00 200.00 £00.00 000 "
42 Erect Steel - Light % 200,000.00 $4,000,00 4,00000 20000 200,00 0.00
43 Bolted Connections 1 $50,000.00 $1.000.00 1.000.00 0.00 2,000.00 0.00

Subtotals 3 $1.,050.000.00 $0.00 21.000.00 000

Approve Cancel Draft Back m

e Make cost adjustments at the CB cost category level using any of the Adjusted CB cost
category columns:

o Assign amounts
ce

Description WBS CB labor total Adjusted CB Adjusted CB CB FOM rented Adjusted CB

phase cost labor cost construction FOM rented

code equipment to... equipment c... total cost equipment c...
Erect Steel - Heavy d $800,000.00 ($ 4,000.00) $0.00 ($1,000.00) $000 ($ 500.00)
Erect Steel - Light 1005 $200,000.00 $3,000.00 $0.00 $1,000.00 $0.00 $500.00
Bolted Connections $50,000.00 $1,000.00 $0.00 $000 $000 $0.00

° The Adjusted CB total cost must equal zero to submit.

° The Adjusted CB cost will automatically calculate as the total of all cost category
values.

° Costs entered directly in the Adjusted CB cost field are automatically allocated to the
appropriate CB cost categories (for example, Adjusted CB labor cost, Adjusted CB
material cost) based on where costs were originally allocated on the cost item.

¢ Assign amounts at the cost category level by right-clicking on the cost item, and then
selecting Cost category.
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Change reqister 2

® ® &8
0 CBS position
L 4
4.2
O 43

Budget Move

8.4 Non-Associated Budget Move

Description WBS
phase
code

Erect Steel - Heavy 1074

-

Erect Steel - Ligh~

@ Cost category
Bolted Connectic

This gives you a view that makes it easy to see the pending adjustments of all your
categories in a slide-out register and how they contribute to the total.

After making adjustments, click the Close icon at the top right corner to close the Cost

category slide-out.

o Assign amounts

1005

4.2 Erect Steel - Light
CB total cost

L $200,000.00

Cost category

A Total
™ Labor
 Construction Equipment
~ FOM Rented Equipment
“ Supplies
~ Materials
™ Subcontract
~ Fees
Vv Allowance

G&A

1 lndnfinad

Pending budget cost
($ 10,000.00)

CB total MHrs CB total quantity
4,000.00 200.00
CB total cost Pending
$200,000.00 ($100000)
$200,000.00 $0.00
$0.00 $0.00
5000 $0.00
$0.00 $0.00
$0.00 ($1,000.00)
$0.00 §0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00

ennn ¥

The Adjusted CB cost subtotal must equal zero to submit. In other words, the cost

adjustments must be net-zero to proceed.

InEight Inc. | Release 26.5
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6. Review your proposed changes, and then click Submit to send the budget move for approval.
Click Draft if the budget move is not ready to be submitted and needs to be saved for later.

The hours and quantities subtotals do not need to equal zero to submit.

8.4.1 Auto-Calculate budget move values

Non-Associated budget moves include a time-saving feature that auto-calculates values when
performing the following tasks:

¢ Update CB from CE — Automatically generates CB adjustments in the non-associated budget
move record to match existing current estimate values of the cost items selected.

e Update CE from CB - When approved, automatically updates current estimate values in the CBS
based on adjustment values defined on the non-associated budget move.

8.4.1.1 Update current budget (CB) adjustments from current
estimate (CE)

Prior to generating a budget move record for approval, a common best practice to help you work
through project changes and have traceability should questions arise, is to make your budget move
adjustments directly in the CE fields of your cost items on the CBS tab.

When the time comes to get approval, you can create a non-associated budget move and use the
Auto-calculate feature to generate the CB adjustments on your budget move record automatically.

Perform a budget move using Auto-calculate > Update CB from CE

These steps assume budget move adjustments have already been made in the Current Estimate.

1. Select Actions > Budget move & contract adjustment > Budget move. The Budget Move wizard
opens to step 1, Details.

2. In Details, select the Non-Associated option and add budget move details as needed, and then
click Next. The Budget Move wizard opens to step 2, Assign amounts.

Page 360 of 632 InEight Inc. | Release 26.5



Control User Guide 8.4 Non-Associated Budget Move

3. In Assign amounts, click the Add button to select the cost items that are part of the budget
move.

4. Click the Auto-calculate icon, and then select Update CB from CE.

5. . Select the values to auto-calculate, and then click Apply.

Change register > Budget Move

® ® © -sionomouns $ = [
CBS positiof ' scription mﬂait CB total cost :;2‘1‘3‘2“ CB CB total MHrs: ﬁd‘.‘:‘gd CcB gfnl:ﬁ::' :w\lgled CB u. gz
&
41 Update CE from B ect Stebhg Heavy 1074 $200,000.00 $000 16,000.00 0.00 80000 000  Ton 5
42 Building I&J - Bridge O 1005 $200,000.00 $0.00 4,000.00 0.00 200.00 000 CY
43 concrete - Building K&L 1006 $50,000.00 $000 1,000.00 0.00 2,000.00 000 Lumps.
\
Y %

Auto calculate

Match current budget values with current estimate values
® selectall
& Cost
@ Quantity

© Man hours

Cancel m

« CE— > v

Subtotals 3 (3 rows selected) $1,050,000.00 $0.00 21,000.00 0.00

[ Cancel ] [ Draft ] [ Back ]

6. Click Yes when prompted to confirm.

7. Click Submit to submit the budget move for approval. Click Draft if the budget move is not ready
to be submitted and needs to be saved for later.

8.4.1.2 Update Current Estimate from Adjusted Current Budget
You can update your current estimate values based on the adjusted current budget values for contract
non-associated budget moves.

To view adjusted current budget values in relation to current estimate values, add the following
columns to your view:

e Cost source

e Update CE total cost

e Update CE total MHrs

e Update forecast (T/0O) qty

e CE total cost
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e CE total MHrs

e Forecast T/O qty

e New CE total cost
e New CE total MHrs

¢ New forecast (T/O) qty

Control User Guide

To add these columns, initiate a non-associated budget move, go to the Assign Amounts step, click the

Column chooser icon, and then select your columns.

e Assign amounts

Adjusted CB CB total MHrs
cost

CB total cost CB total

Adjusted CB
MHrs quantity

Adjusted CB
qty

1=

No results found

4 G

CE total cost

CE total MHrs

Forecast T/0 qty

(] CE labar total cost

[C] CE construction equipment total cost
[C] CE rented equipment total cost
[J CE supplies total cost

() CE materials total cost

[ CE subcontract total cost

] CE fees total cost

[J CE contingency total cost

[J CE general and admin total cost
(] CE undefined total cost

[] New CB total cost

[C] New CB total MHrs

] New CB total gty

Cost source

Update CE total cost

Update CE total MHrs

Update forecast (T/0) gty

New CE total cost

Mew CE total MHrs

New forecast (T/0) qty
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8.4.1.3 Select cost items to update

The check boxes under the Update CE total cost, Update CE total MHrs, and Update forecast (T/O) qty
allows you to update the current estimate based on what is adjusted in the current budget after the
budget move is approved.

CBS position Cost source Update CE Update CE Update

[l total cost total MHrs forecast

(T/0) aty
#~ Unassigned cost items |
O 117
O e | Plug
0O s Plug
L 11000 | Plug

F .|

Subtotals 4 |

The Update CE total cost and Update CE total MHrs check boxes are active for plug cost source only.
The Update CE total cost and Update CE total MHrs check boxes cannot be edited for Detail cost items
because cost is driven by your associated resources.

For example, if the Update CE total cost box is checked, the Adjust CB cost is added to the CE total cost
after the contract adjustment is approved. You can preview the results in the New CE total cost, New
CE total MHrs, and New forecast (T/O) gty columns.

8.4.1.4 Select automatic updates for multiple cost items

You can select automatic updates for multiple cost items to save you time from selecting check boxes
manually for each cost item.

The Auto-calculate tool automatically checks the adjustment boxes for all the cost items that you
select.

To use the Auto-calculate feature select the cost items you wish to update. Click the Auto-calculate
icon, and then select Update CE from CB. In the Auto calculate dialog box, select whether to update
Cost, Quanty, Man hours, or Select all for the selected cost items, and then click Apply.

InEight Inc. | Release 26.5 Page 363 of 632



8.4 Non-Associated Budget Move Control User Guide

Change register  *  Budget Move

® ® o Assign amounts
CBS positi scripti WBS CB total cost Adjusted CB CB total MH Adjusted CB cl
positio)| Upda[e CB from CE Sl.'.l'lptIDI'I pha!e al i m;{ & {r] rs Mdrs (o o

code
1074 $800,000.00 $0.00 16,000.00 0.00

(<]

41 Update CE from CB

<]

42 Building 1&J - Bridge C_ 1005 $200,000.00 5000 4,000 00 000

(<]

$ 50,000.00 $0.00 1,000.00 0.00

N

43 Concrete - Building K&L

Auto calculate

Match current budget values with current estimate values
™ Selectall
= Cost
& Quantity

& Man hours

The applicable check boxes are now automatically selected to adjust your current estimate values for
the selected cost items.

8.4.1.5 Set setting for default current estimate update

You can have the current estimate cost, man-hours, and quantity check boxes selected by default to be
updated with adjusted current budget cost, man-hours, and quantity values when doing change
orders.

In Settings > Control > Project Tracking, you can switch the Default CE values to be updated from CB
values toggle to ON. When enabled, all applicable check boxes are selected by default. This is a quick
way to keep CE and CB values in sync without having to double enter values.
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» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS

= 'y

| Tasks

Maintain CBS Structure at a specific level? Level to Maintain CBS Structure at

() Generate WBS phase code automatically?

- 0

'WBS Phase code generation method WBS Phase codes start value

Continue numbering from the last generated number -

Enable manual snapshots (1) &) Default CE values to be updated from CB values (i) ©

Allow syncs to replace manual snapshots @

For more information, see the Default CE values to be updated from CB values section in Project
Tracking, Tasks settings.

8.5 BUDGET MOVE FROM INEIGHT CHANGE

You can initiate a budget move in InEight Change, which ultimately creates a budget move in InEight
Control.

8.5.1 Budget move in Change

A budget move in Change is made by indicating the cost items and their cost adjustments on the
Pricing tab of an issue record.
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Steel Structure Training Job 2 | 105092 / Change

Change management > Issue >  3-Cracked weld

Current value  Cost Billing markup  Markup  Markup %  Deductions  Net value Issuestatus Pricing status Proposal status

$ 800.00 $800.00 $0.00 $0.00 0.00% $0.00 $800.00 In Review v In process v Submittedto .. v

PRICING SUPPORTING ]
i PRICING

Actions ¥ DETAILS SUMMARY  DOCUMENTS cancel ‘

® ms) =2 +% = Clear all filters B 0 > I= ¥ ¥ 5}
() Costitem description WBS phase code Adjusted CB Qty Adjusted MHrs Pay item Adjusted billable amou..  Adjusted cost Bil
O Erect Steel - Light 1005 10.00 200.00 003 - Steel - Labor & $10,600.00 $10,600.00
[m] Erect Steel - Heavy 1074 -10.00 -200.00 003 - Steel - Labor & .. (5 10,600.00) ($10.600.00)

For more information about managing budget moves in Change, see Budget Moves.

8.5.2 Budget Move Integration Between Change and Control

When you create a budget move in Change, Change directs you to the Change Register in Control,
where a new budget move record is automatically created with a status of Issue-Draft.

= fit  Steel Structure Training Job 2 | 105092 / Control / Workspaces

< ACS PAY ITEMS CHANGE REGISTER AUDIT LO
Actions w
ID Description cco Crea.. Issue Last Last Notes Status
date # cha... cha..
by oh
7.0 Cracked weld 06/26/2025 3 Paul benni..  06/26/2025 =) 2 Issue-Draft
ca et e A An nnn ar tar nanc | 1 et bt e 1e nane | =1 [ N,

After the record is created in Control, the budget move can be reviewed, revised, and submitted just
like any other budget move in Control.

8.6 BUDGET QUANTITY / MAN-HOUR
ADJUSTMENT

During the course of a project, it is typical to have scope modifications that warrant changes to
guantities or labor hours.

It is important to remember that changing man-hours or quantities will affect budgeted values of
MH/QTY, QTY/MH, and Unit-Costs, but will not change the overall dollar value of your budget.

Page 366 of 632 InEight Inc. | Release 26.5


https://learn.ineight.com/Change/Content/CHNG20.5 4/4 xx Budget moves.htm

Control User Guide 8.6 Budget Quantity / Man-Hour Adjustment

Within InEight Control, you can perform budget quantity and man-hour adjustments using a controlled
approval process.

Perform a Budget Quantity / Man-Hour Adjustment

1. Select Actions > Budget move & contract adjustment > Budget quantity and man hour
adjustment.

= fr  Steel Structure Training Job 2| 105092 / Control / Workspaces

=] o

Y Global forecast method.. 1
Task details < o00e >
Set forecast method Resources Forecast (T/0) UoM
| aty
Update Forecast (T/0) gty with Plan compone...
100 Lum
‘_:1 Claim multiple CBS quantities
- 000.00 CY
| Budget move and contract adjustment » |
| Budget move
]
| Lock/unlock budget » poneo | cv
| Budget quantity and man hour adjustment
sync 000.00  Ton
Contract adjustment
[ a7 ETECT STEer="Hei 35000  Ton

The budget adjustment wizard opens to step 1, Details.

2. In Details, add details as needed, and then click Next.
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Change Register >  Budget quantity and ...

o Details

Issue # cco

002XX 002XX

Description 21
Tonnage increase due to material ch :mge(

Discipline 500

Change Management tag 1 Change Management tag 2 Change Management tag 3

- - -

The budget adjustment wizard opens to step 2, Select Items.

3. In Select Items, select a cost item from the list.

Change Register > Budget quantity and ..
o Select Items
©BS position Description WBS phase code

3 Conerete 107

4 Structural Steel 1073

41 Erect Steel - Heavy 1074

42 Erect Steel - Light 1005

43 Bolted Connections 1006

v 4.4 Module 01 - Erect Steel Heavy 1087

You can select more than one cost item to adjust; however, these changes will be grouped
as a single line item in the Change Register.

4. Click Next. The budget adjustment wizard opens to step 3, Assign amounts.

5. In Assign Amounts, enter the change to the man-hours or quantities into the applicable field, and
then click Next.
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Change Register >  Budget quantity and ...

o Assign Amounts

4.4 Module 01 - Erect Steel Heavy

MHrs Quantity
Original: 0.00 0.00
Pending 5,000.00
New total: 0.00 5,000.00

The budget adjustment wizard opens to step 4, Summary.

6. In Summary, review your proposed changes, and then click Submit to send the budget move for
approval.

Change Register > Budget quantity and ...

o Summary

4.4 Module 01 - Erect Steel Heavy

MHrs Quantity
Before: 0.00 0.00
Pending: 0.00 5,000.00
After: No change 5,000.00

(owe ) (o) (oo ) [N

You can select Draft if the budget move is not ready to be submitted and needs to be saved for

later. With applicable permissions, you can select Approve to approve the budget move.

8.7 CONTRACT ADJUSTMENT — CONTROL
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8.8 CONTRACT ADJUSTMENT IN CONTROL
OVERVIEW

A contract adjustment, often referred to as a change order, represents a change to the scope of the
contract that results in a change to the project’s budgeted costs, man-hours, and contract price. These
adjustments typically involve adding or revising cost and pay items to accurately estimate the financial
and labor impacts of the change.

A contract adjustment, often referred to as a Change Order, represents a change to the total project
budget. If you are a contractor this also results in a change to total contract price.

8.8.1 Pay Iltem vs. Cost Item

Contract adjustments involve changes to both your contract price (pay items) and your budget (cost
items). The following table reviews the purpose and function of pay items and cost items.

Pay For contractors, a pay item represents a project deliverable, including the pay quantity
Item defined by the owner and the contracted unit price you will be paid for completion of
the work. Pay item prices include your overhead and profit.
For owners, a pay item can be used in a variety of ways or may even be ignored. One
way it can be used is to represent funding sources and total funded amounts. It can
also be used to bill internal or external partners.

Cost The individual cost-related activities required to complete the deliverables of the
Item project. Cost items represent the costs your budget needs to complete the work and
therefore do not include profit.

8.8.2 Contract adjustment options

In Control, you can initiate a contract adjustment in the Workspaces module, by creating a new
contract adjustment record. Go to Actions > Budget move and contract adjustment > Contract
adjustment.
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u Task details < eooe

Resour Forecast (/0)
aty

o3, Claim muliple CBS quaniities

Budget move and contract adjustment

| «
udget move
«
Contract adjustment

=} 3T Bunang &=

»
Lock/unlock budget »
»

The contract adjustment record progresses through various steps that walk you through creating the
adjustment. The steps to complete the contract adjustment depend on the workflow you select. You
can start the workflow by selecting cost items or pay items.

Changeregister >  Contract adjustment

Net budget Net quantity Net man hour Markup Fee Net contract Approval probability
change change change change
$0.00 N; 0.00 $0.00 $0.00 $0.00 -

o
o Details

Choose your Contract adjustment workflow

Start with Cost items
@ Enter markup and fees on cost items to generate pay item price

Start with Pay items
Adjust pay item price before adjusting cost item budgets

The contract adjustment in InEight Control can be performed using the multiple options for a
controlled approval process, including:

e Start with cost items
o Start with pay items

e Auto-calculate

8.8.3 Contract adjustment header

For cost item and pay item contract adjustment workflows, as you progress through the adjustments,
the record’s header provides a summary of the contract adjustment’s net budget (cost) and contract
(price) change amounts, and the net man-hour change. The Start with Cost items workflow also
includes a summary of the markup and fee for the adjustment as well.
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Net budget Net quantity Net man hour Markup Fee Net contract Approval probability
change change change change
$ 225,000.00 No 2,900.00 $20,900.00 $5,000.00 § 250,900.00 -

Both workflows include an option to define the contract adjustment’s approval probability. For more
information on this feature, see Revenue Forecast Probability.

8.9 START WITH COST ITEMS CONTRACT
ADJUSTMENT

The Start with Cost items workflow lets you begin by entering cost items with their adjustments and
clearly defining a separate markup and fee. Through the assignment of your cost items to pay items,
these adjustments, markups, and fees then roll up to the pricing of your pay items.

This workflow of starting with costs and markups to build up to the change in contract price is typically
the preferred approach and recommended best practice, because of the visibility and ease of use it

provides in working out the adjustment.

Contract adjustment starting with cost items

1. Click Actions > Budget and contract adjustment > Contract adjustment. The Contract adjustment
wizard opens to step 1, Details.

2. On Details, select the Start with Cost items workflow option, and then add contract adjustment

details as needed.
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Change register >  Contract adjustment

Net budget Net quantity Net man hour Markup  Fee Net contract Approval probability
change change change change
$0.00 No 0.00 5000 5000 | S000 -
o Details =
Choose your Contract adjustment workflow -

Start with Cost items
@  Enter markup and fees on cost items to generate pay item price

Start with Pay items
Adjust pay item price before adjusting cost item budgets

Contract adjustment details

Description 500
cco 60
Issue # 60

Discipline 500

Change management tag 1 Change management tag 2 Change management tag 3

- - -

Change management user defined 1 Change management user defined 2 Change management user defined 3

3. Click Next. The Contract adjustment wizard opens to step 2, Cost items. On Cost items, add the
cost items involved in the contract adjustment and enter their adjustment amounts. Click the
Add cost item icon to add cost items. To remove a cost item, click the Remove cost item icon.

4. On Cost items, add the cost items involved in the contract adjustment and enter their
adjustment amounts. Click the Add cost item icon to add cost items. To remove a cost item, click
the Remove cost item icon.

Change register > Contract adjustment

Net budget Net quantity Net man hour M
change change change ‘
$0.00 No 0.00 S

e Cost items

® S Assign costto ¥

CBS position Description WBS CB total cost
O phase
code
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5. Click Add cost item. The Select cost items list opens. Select the cost items related to the
contract adjustment, and then click Add.

Change register >  Contractadjustment >  Select cost items

i Search

CBS position Description WBS
phase
code

~ 4 Structural Steel 1073

41 Erect Steel - Heavy 1074
42 Erect Steel - Light 1005
43 Bolted Connections 1006
A5 Materials 1084

5.1 Earthwork - Materials 1085

5.2 Concrete - Materials 1086

53 Structure Steel - Materials 1087

6 £ Merrill Iron & Steel - Steel Mater 1088

Subtotals 32 (4 items selected)

Cancel Add

If the contract adjustment requires a new cost item to be added to the budget, this must be
added to the Cost Breakdown Structure on the Workspaces CBS tab before creating the contract
adjustment.

In the example above, a new cost item was added in the CBS for additional steel material (Merrill
Iron & Steel — Steel Material) prior to creating the contract adjustment, so it is available to select.

When adding a new cost item to your locked budget, it will initially be unlocked and will
therefore not be part of the Current Budget. A common practice is to keep the new
change order-related cost item unlocked while working through the contract adjustment.
If the contract adjustment becomes approved, the cost item will automatically become
locked, and its costs and man-hours will become part of the Current Budget.

After your cost items are added to the page, you can enter adjustment values (positive or
negative) to any of the following columns:

¢ Adjusted CB cost
e Adjusted CB MHrs
¢ Adjusted CB qty
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¢ Any of the Adjusted CB cost categories (for example, labor, construction equipment,
supplies, subcontract, etc.)

Contract adjustment with adjustment amounts added - The following image is an
example of a contract adjustment with adjustment amounts added.

Change register > Contract adjustment

Net budget Net quantity Net man hour Markup  Fee Net contract Approval probability
change change change change

§225000.00 No 2.900.00

o Costitems

$000 S000 | $14500000 -

D ® & ssign costto ¥
® ® = Assign costto

CBS position Description wes B total cost Adyusted CB New CB total Billing Markup Markup Fee B total MHrs Adusted C8
cost cost rate MHrs

markup

A\ Unassigned cost items

6 (5} $ 80,000.00

A Payitem 003 - Steel - Labor & Matera s

== $145,000.00 $0.00  Override Marku §000 | Payitem Fe
4 s §100,000.00 2,000.00

$40,000.00 800.00

43 ted Con $5.000.00 5 100.00

Assigning costs to pay items depends on the circumstances of your adjustment. There are
multiple scenarios for assigning cost items to pay items.

a. Cost item already assigned to pay item scenario - If the contract adjustment affects
cost items that already exist in your budget, they will likely already be assigned to
pay items. As you adjust the cost items, including adding markup and fees, the
record will calculate the adjusted current price for the pay items the cost items are
assigned to.

In the example below, costs are being adjusted on three existing cost items that are
already assigned to the Steel — Labor & Material pay item. The Adjusted current
price reflects the cost adjustments and markups of the assigned cost items, although
a markup and fee have not yet been added.

® Assign costto ¥

CBS position Description was CB total cost Adjusted CB New CB total Billing Markup Markup Fee
phase cost eost rate %
code markup

A\ Unassigned cost items

6 a8 ] $80,000.00

Gt STiEEGo00 $145,00000 $0.00  Override Marku $000 | Payitem Fee

/N Pay item 003 - Steel - Labor & Material
41 t $100,000.00
42 $40,000.00

43 $5,000.00

b. Unassigned Cost Assigned to New Pay Item scenario - If the change order requires
a significant scope change, the owner may want to delineate it as a new pay item in
the contract. Within the budget, the contractor will likely add a new cost item to
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represent the new work and assign it to the new pay item. This assignment can be
made prior to the contract adjustment but can also be done within the contract
adjustment record.

Assigning a pay item within a contract adjustment is temporary. It will not
update the Pay item assignment in the CBS. It is used in the contract
adjustment only to help drive the adjusted price for that contract adjustment
only.

In the example below, the additional steel material is not yet assigned to a pay item.

@ ] Assigncostio ¥
CBS position Description WBS CB total cost Adjusted CB New CB total
phase cost cost
code
. Unassigned cost items
0O s B Merrilllron & Steel - Steel M... 1088 $0. $ 80,000.00 $ 80,000.00

Adjusted current price:

/~  Pay item 003 - Steel - Labor & Material $ 145,000.00

$145,000.00

] 41 Erect Steel - Heavy 1074 $ 800,000.00 $100,000.00 $900,000.00

To assign an unassigned cost item to a new pay item, select the cost item, then
select Assign cost to > Assign to new pay item.

@ ® E Assign cost to v/

CBS iti WBS CB total cost Adjusted CB New CB total
position Assign to new pay item phase al cosf cui‘ljs e c\:swt ota
code
A Unassigned cost items @ Assign to existing pay item
6 IM... 1088 $0.00 $80,000.00 $80,000.00
A AmeAAA Mol Bbeod mEaeoio Adjusted current price: A1 acnannn

The Create new pay item window opens. Add pay item details as needed. In this
case, the adjusted cost amount is added in the Current price field, since markup and
fees have not yet been considered.
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Create new pay item

+Pay item number =

4

Description

Additional steel work

*UoM (Unit of measure)

Ton A

Current price

$80,000.00

8.9 Start with cost items contract adjustment

Line number

4

*Current billing method

Unit price

Current pay qty

Sales order
A4
479
Current forecast (T/0) gty
hd 100

Current unit price

100.00 a

Click Apply when finished. The new cost item is now assigned to the new pay item.
The Adjusted current price is currently the amount you entered in the pay item

details.
Net budget Net quantity Net man hour Markup Fee Net contract
change change change change
$225,000.00 No 2,900.00 $0.00 $0.00 $ 225,000.00
° Cost items
® EH Assigncostto ¥
CBS position Description WBS CB total cost Adjusted CB New CB total
O phase cost cost
code
B . Adjusted current price:
/N Pay item 003 - Steel - Labor & Material $ 145,000.00 $145,000.00
] 41 Erect Steel - Heavy 074 800,000.00 $100,000.00 $ 900,000.0
O 42 Erect Steel - Light 00 $200,000.00 $40,000.00 $ 240,000.0¢
O 43 Bolted Connections 100¢ $50,000.00 $5,000.00
A | Pay item 4 - Additional steel work () Ad’"“"’dsc;';::z’u'_’gb $80,000.00
O 6 E| Merrill Iron & Steel - Steel M... 1088 $0.00 $80,000.00 $ 80,000.0¢

The unlocked icons indicate the pay item and cost item are currently unlocked
(not yet part of the Current Budget).

Unassigned cost assigned to existing pay item scenario - There may be times when
the change order requires a new cost item for the budget, but that cost item will
pertain to an existing pay item. For those cases, you can select Assign cost to >
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Assign to existing pay item.

@ ® 88 Assign cost to v/

CBS position Assign to new pay item mBaie CB total cost g:é\'lsted CB zl::: CB total
code

A Unassigned cost items @ Assign to existing pay item

6 IM_. 1088 $0.00 $80,000.00 $ 80,000.00

Adjusted current price: &1 ac AnA A

You can add individual markup percentages for each cost item assigned to a pay

® g Assigncostto ¥
_ cBS position Description wes CB total cost Adjusted CB New CB total Billing Markup Markup
phase cost cost rate %
code markup
A Pay item 003 - Steel - Labor & Material Acjusted ;“]’;’;'f,s’g; $145,000.00 $0.00 |Override Marku $12750.00
O 41 74 8 $100,000.00 ! 8.00%
O a2 15t t 2 $40,000.00 24 10.00%
0O a3 Bolt $5,000.00 $ 15.00 %

Alternatively, you can add markup at the pay item level, and it will override the
markup for all the assigned cost items.

(CBS position Description WBS CB total cost Adjusted CB New CB total Billing Markup Markup
phase cost cost rate %

code markup
Adjusted current price:

/N Pay item 003 - Steel - Labor & Material $150,500.00 $145,000.00 $0.00 | 10.00 % I $14.500.00

0O 4 Erect St F y 4 $100,000.00 1000%
O 42 t h 5 §40,000.00 10.00%
0O a3 E 5 $5,000.00 10.00%

You can also add a flat fee (for example, for permits, extra administration, or
supervision). Fees are added only at the pay item level. The sum of your markup and
fee is your planned profit.

CBS position Description WBS CB total cost Adjusted CB New CB total Billing Markup Markup Fee
( phase cost cost rate %
code markup
N\ Payitem 003 - Steel - Labor & Material Adusnd ;“1’5";:;5;0 $ 145,000.00 $000 10.00 % $ 14,500 .00 | $5,000.00 I
0 41 8 $100,000.00 10,00 % 1
0O a2 t $ $40,000.00 1000 %
0O a3 Bolt t $5,000.00 10.00 %

6. After adjustments, markup and fees are added, and pay item assignments made, click Next. The
Contract adjustment wizard opens to step 3, Pay items. On Pay items, you can review the pay
items related to the contract adjustment and make further adjustments to the current price and
guantities as needed.
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o Pay items

Pay item Description Adjusted Current price Adjusted
number current price current unit
price
4 £ Additional steel work $80,000.00 ® soo00 @ $800.00
003 Steel - Labor & Material $164,500.00 ® $1,821,092.28 ﬂ $0.00

Adjusted current price indicators show next to the values in the Adjusted current price column. A
colored dot indicates the source of your adjusted current price values.

¢ Green dot - Indicates the Adjusted current price was calculated automatically from the
Adjusted current cost + total markup + total fee. You can view the calculation when you

hover over the dot.

Description Adjusted Current price Adjusted Current unit
current price current unit price
price
Additional steel work $ 80,000.00 ® ¢nnn . Q & ann nn enng
. . System-generated value ‘
Sizs) Lebord s $164,500.00 Adjusted current price = adjusted budget + total markup + total fee :

¢ Blue dot - Indicates the value was manually overridden. You can hover over the dot to
view what the value was before.

Description Adjusted Current price Adjustec
current price clirrent |
- . Manual override
Additional steel work $ 80,000.00 value before: $ 86,400.00
Steel - Lahor & Material $164,500.00 ® $1,821,09228 | &

This example shows that because the cost item was assigned to a new pay item, the
current price was added manually when filling out the new pay item’s details.

7. Click the Auto-calculate button to adjust costs, markup, and fees after selecting the applicable
pay items.
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o Pay items
®

Pay item Description Adjusted Current price Adjusted
O number current price current unit
price
4 E| Additional steel work $80,000.00 ® $0.00 ﬂ $800.00
] 003 Steel - Labor & Material $164,500.00 ® $1,821,092.28 & $0.00

When prompted, if you are sure you want to revert back to system-generated values, select Yes.
The Adjusted current price updates to the current pricing information calculated by the system

from the Cost items step.

®

Pay item Description Adjusted
UJ number current price
4 (5 Additional steel work I $ 86,400.00 ®
OUJ 003 Steel - Labor & Material $164,500.00 ®

8. After making any necessary adjustments, click Next. The Contract adjustment wizard opens to
step 4, Summary.

9. In Summary, you can review the cost items and pay items summary involved in the contract
adjustment with their adjusted values for a final review. Click Submit to send it to the Change
Register for review and approval. With the applicable permissions, you can approve the contract
adjustment directly from the record’s Summary step by clicking the Approve button.
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Change register > 3.0 - Contract adjust.—
Net budget Net quanti Net man hour Markup Fee Net contract I probabil
change” change LJ change change B
$225,000.00 No 2,900.00 $2090000 $5,000.00 $250,900.00 -
Q-
~ Costitems
CBS position Description WBS Adjusted CB Adjusted CB Adjusted CB Adjusted CB. Adjusted CB Adjusted CB Adjusted CB Adjusted CB.
phase cost MHrs aty Inbor cost construction FOM rented supplies cost materials cost
code equipment cost. equipment...
$100,000.00 2,000.00 §100,000.00
$40,000.00 800.00 §40,000.00
$5,000.00 100.00 $5,000.00
6 ™ 0 teel M $80,000.00
«
Subtotals 4 $225000.00 2,900.00 $145,000.00 $000 $000 $0.00 $0.00
~ Payitems
Pay item Description Adjusted Current price Adjusted Current unit Adjusted Current pay Current u- Current billing Sales order
number current price current unit price current pay aty aty forecast (1/0) method
price aty
4 £ Additional steel work 8640000 $80000 108.00
003 Steel - Labor & Material $164500.00 1 $0.00 21,0022 009
Subtotals 2 $250900.00 §1,821,00228 $800.00 $1,821,00228

At any time during the development of the contract adjustment you can use any of the following
buttons:

e Back - Use this button to move back a step in the contract adjustment workflow.

¢ Draft - If the contract adjustment is not yet complete or ready for review, select Draft to save it
for later. This will save the adjustment as a draft in the Change Register. At any time, you can
edit the adjustment by selecting the Edit icon for the record on the Change Register.

CBS ACS PAY ITEMS CHANGE REGISTER
Actions =
ID Description cco Crea... Issue Last Last Notes Status Cha... Cha...
date # cha.. cha.. man... man...

by on tag 1 tag 2

30 Additional Steel Work 06/25/2025 079 Paul benni. 06/25/2025 %

e Cancel - Select to close the contract adjustment without saving any changes.

8.10 START WITH PAY ITEMS CONTRACT
ADJUSTMENT

While less commonly used, if you prefer to begin your calculation of a contract change by adjusting pay
items and then the related cost items, you can select the Start with Pay items workflow.
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Keep in mind that when using this workflow, you will need to know in advance the pending prices you
plan to adjust to for your pay items, including markup and fees, since there is no step to define costs,
markups and fees before pay item pricing.

Starting with pay items contract adjustment

1. Click Actions > Budget and contract adjustment > Contract adjustment. The Contract adjustment
wizard opens to step 1, Details.

2. On Details, select the Start with Pay items workflow option, and then add contract adjustment
details as needed.

Change register > Contract adjustment
Net bud Net quanti Net man hour Net contract Approval probabili
change = hange 5 change change pprovEe &
$0.00 No 000 $0.00 -
0 Details
Choose your Contract adjustment workflow -
Start with Cost items
Enter markup and fees on cost items to generate pay item price
Start with Pay items
Adjust pay item price before adjusting cost item budgets
Contract adjustment details
Description 500
cco 60
Issue # 60
Discipline 500
Change management tag 1 Change management tag 2 Change management tag 3
- - -
Change management user defined 1 Change management user defined 2 Change management user defined 3
v
e

3. Click Next. The Contract adjustment wizard opens to step 2, Select Pay items. On this step, a list
is provided of pay items already under the project’s contract.
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Change register >  Contract adjustment

Pay item number

[
] 002
O o003

@ Add pay item

1 items selected

Net budget Net quantity
change change
$0.00 No

o Select Pay items

Description Current pay gty

Earthwork - Labor & Material
Concrete - Labor & Material

Steel - Labor & Material

Net man hour
change

0.00

1.00
1.00

1.00

Net contract
change

$1,000.00

Each

Each

Each

8.10 Start with pay items contract adjustment

Approval probability

Search

Current unit price Is billed

759,887 .01
2,919,020.71

1,821,092.28

R - |

If you need to add a new pay item to the contract for the change order, select Add pay itemat
the bottom left of the list of pay items.

4. You can select existing pay items from the list, and then click Next. to go to Step 3, Adjust pay
item. If you need to add new pay items click Add pay item at the bottom left of the list of pay
items. This open a new Add pay item workflow which becomes step 2, and the Select pay items
step becomes step 3. In Add pay item, add the details of the new pay item.
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Change register  *  Contract adjustment

Net budget Net quantity Netmanhour  Net contract Approval probability
change change change change
$0.00 No 0.00 $000 -
o Add pay item
+Pay item number (2 Line number a
5 5
Row number
Description 479
Additional steel work
+UoM (unit of measure) ~Current billing method
Ton ~ Unit price -
Current forecast (T/0) gty
Proposal details
Enter any two values and the third will aute-calculate. bbnnn3
Current price
$800,00000
Current unit price Current pay qty
$80000 y @ v
[ Cancel ] [ Draft ] [ Back ] Next

a. Inthe Proposal details section, enter Current price and Current unit price. The Current pay

gty is auto-calculated.

b. Click Next. The Contract adjustment wizard opens to step 3, Select Pay items. The new pay
item shows in Select Pay items.
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Changeregister > 4.0 - Contract adjust...

Net budget Net quantity Net man hour Net contract Approval probability
change change change change
$0.00 No 0.00 $1,600,000.00 -
05?\?ci!‘ayuems >
Search
[y Payitem number Description Current pay gty UoM Current unit price Is billed
i a
6 3 Additional steel work 000  Ton 0.00
5 G Additional steel work 000 Ton 0.00
001 {5 Earthwork - Labor & Material 1.00 Each 759,887.01
O o0z £ Concrete - Labor & Material 100 | Each 2,919,020.71
J  oo3 5 Steel - Labor & Material 100 Ea 1,821,092.28

(@ Add pay item

3 items selected

The pay item is unlocked, and the quantity and price are zero when the contract
adjustment has not been approved. When the contract adjustment is approved, the
pay item will lock and officially become part of the contract price.

5. After selecting or adding pay items in Select Pay items, click Next. The Contract adjustment
wizard opens to step 4, Adjust pay item. On Adjust pay item, for each pay item, you can enter
the adjustment amounts under Current price and Current pay qty fields in the Pending row.

003 - Steel -

The locked cell auto-calculates based on the formula:
Current price = Current unit price * Current pay qty Current unit price Current pay qty
To edit cell, click on the lock and choose a new field to lock.

$1,821,092.28 1.00
Pending (@ 164,000.00 164,000.00 p
New value $1,985,002.28 $1,985,092.28 1.00

You may need to change which field to lock in order to calculate your unit price and
quantities correctly.

6. Click Next after defining pending prices of your pay items. The Contract adjustment wizard opens
to step 5, Select CBS items. On Select CBS items, select the cost items that pertain to the
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contract adjustment from the list.

O CBS position Description

O -4 Structural Steel

41 Erect Steel - Heavy

4.2 Erect Steel - Light

43 Bolted Connections

O 5 Materials

O 5.1 Earthwork - Materials

O 52 Concrete - Materials

O 53 Structure Steel - Materials

6 5 Menill Iron & Steel - Steel Material

Similar to a contract adjustment that starts with cost items, if the contract adjustment requires a
new cost item to be added to the budget, this must be added to the Cost Breakdown Structure
on the Workspaces CBS tab before creating the contract adjustment.

In this example, a new cost item was added in the CBS for additional steel material (Merrill Iron
& Steel — Steel Material) prior to creating the contract adjustment, so it is available to select.

7. Click Next after selecting CBS items. The Contract adjustment wizard opens to step 6, Assign
amounts. On Assign amounts, add the adjustment amounts for current budget, man-hours and
guantities in the applicable pending fields.

Nt :;:Iuel Net :;:nnty Net e hour  Net :;.rmaa Approval probability
$ 225,000.00 Yes 2.900.00 $ 244.000.00 -
[ Y
4.1 Erect Steel - Heavy
Current budget MHrs Total quantity
Original $800,000.00 16,000.00 800.00
Pending
New total: $900,000.00 18,000.00 900.00
4.2 Erect Steel - Light
Current budget MHrs Total quantity
Original $200,000.00 4,000.00 200,00
[ Pending 40,000.00 £00.00 4 I
New total $ 240,000.00 4,800.00 240.00

4.3 Bolted Connections
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8. Click Next after making your adjustments. The Contract adjustment wizard opens to step 8,
Summary. On Summary, you can do a final review the cost items and pay items involved in the
contract adjustment with their adjusted values. Click Submit to send it to the Change Register for
review and approval.

Pay Items Net contract change: § 244

5 - Additional steel work &
Current price Current unit price Current pay qty Current forecast (T/0) qty UoM Current billing method
Original $0.00 $0.00 0.00 000 Ton Unit price

Pending $ ) $ Ton Unit price

New value $80,000.00 $ 800.00 100.00 100.00 No change No change
003 - Steel - Labor & Material
Current price Current unit price Current pay gty Current forecast (T/0) qty UoM Current billing method
Original $1,821,092.28 $1.821,002.28 1.00 1.00 Each Unit price

Pending 164,000 §$164 0.00 000 Each Unit price

New value §1,985,092.28 $1,985,092.28 1.00 1.00 No change No change

Unlike the Start with Cost items workflow, in the Start with Pay items workflow, the adjusted
(pending) values defined for your cost items have no direct influence on your pay items’ pending
values. In the Start with Cost items workflow, the system directly calculates the adjusted current
price from the assigned cost items automatically. In the Start with Pay items workflow this is not
the case. Instead, the pending current prices are manually determined, independent from the
pending values you enter for the related cost items.

At any time during the development of the contract adjustment you can use any of the following
buttons:

e Back - Use this button to move back a step in the contract adjustment workflow.

e Draft - If the contract adjustment is not yet complete or ready for review, select Draft to save it
for later. This will save the adjustment as a draft in the Change Register. At any time, you can
edit the adjustment by selecting the Edit icon for the record on the Change Register.

CBS ACS PAY ITEMS CHANGE REGISTER
Actions w
ID Description cco Crea... Issue Last Last Notes Status Cha... Cha...
date # cha.. cha.. man... man...
by on tag 1 tag 2
3.0 Additional Steel Work 06/25/2025 079 Paul benni.. 06/25/2025 % Q Draft

e Cancel - Select to close the contract adjustment without saving any changes.
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8.11 AUTO-CALCULATE CONTRACT
ADJUSTMENT VALUES

When managing project changes, as best practice, your organization might want to keep the current
estimate (CE) up to date with potential changes so the project team can include those potential
changes in their forecast even before the changes have been approved. The following sections cover
two ways the system can help you keep the current estimate in sync with the latest pending changes.

8.11.1 Update Current Budget (CB) Adjustments from Current
Estimate (CE)

When project issues arise and changes are considered, the CE can be used to estimate the scope and
impact of changes before they are approved and added to the CB. As mentioned above, the CE
changes can be used by the project team in their forecasts to forecast the project more accurately.

Your organization might prefer to add or revise cost items in the CE with changes as they arise, even
before creating contract adjustments, so that they can be part of the project forecast right away. For
this approach, when you create contract adjustments for those cost items, you can have the system
automatically update the CB adjustment fields (costs, man-hours, quantities) with your CE values. This
saves you the work of manually rethinking and reentering the changes on the contract adjustment that
were already defined in the CE.

8.11.1.1 Auto-calculate current budget adjustments on the Start
with Cost items workflow

When using the Start with Cost items workflow on a contract adjustment record, you can automatically
update your CB adjustment values from the Cost items step. From step 2, Cost items window, click
Auto-calculate, then select Update CB from CE.
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Change register >

o ® [=

Budget Move

Building I&J - Bridge T3

Concrete - Building K&L

Subtotals 3 (3 rows selected)

8.11 Auto-calculate contract adjustment values

°Ass\gnamoums $
CB total cost Adjusted CB B total MHrs Adjusted CB CB total Adjusted CB
cost MFirs quantity aty
§800,000.00 $0.00 16,000.00 0.00 800.00 0.00
$200,000.00 $0.00 4,000.00 0.00 200.00 0.00
$50,000.00 $0.00 1,000.00 0.00 2,000.00 0.00
= X
Auto calculate
Match current budget values with current estimate values
Select all
B Cost
@ Quantity
© Man hours
=3
4 GEEE———
$1,050,000.00 $0.00 21,000.00 0.00
[ Cancel ] [ Draft ] [ Back ]

= D

Ton
&Y

Lumps.

On the Auto-calculate dialog box, you can select which values you want to update (costs, quantities,

man-hours, or all).

Click Apply after selecting your values. Your Adjusted CB fields update automatically with your CE

values.
e Cost items
® g8 Assign costto ¥
CBS position Description WBS CB total cost " Adjusted CB
] phase cost
code
. . Adjusted current price:
« Pay item 003 - Steel - Labor & Material $ 164,500.00 $ 145,000.00
O 41 Erect Steel - Heavy 1074 $800,000.00 $100,000.00
O 4.2 Erect Steel - Light 1005 $ 200,000.00 $40,000.00
O 4.3 Bolted Connections 1006 $50,000.00 $ 5,000.00

8.11.1.2 Auto-Calculate Current Budget Adjustments on the Start
with Pay Items Workflow

Similarly, when making a contract adjustment using the Start with Pay items workflow, you can auto-
calculate the pending Current Budget values. This is done from the Assign amounts step, by selecting

Advanced options.
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4.1 Erect Steel - Heavy

4.2 Erect Steel - Light

Advanced options

Original
Pending

New total:

Original

Current budget

Current budget

$ 800,000.00

0.00

$ 800,000.00

$200,000.00

Control User Guide

o Assign amounts

MHrs

MHrs

On the Auto calculate dialog box, select which values to update (costs, quantities, man-hours, or all).

Once selected, click Apply.

The Pending fields under Current budget, Mhrs, and Total quantity update with your Current Estimate

values.

4.1 Erect Steel - Heavy

Original

Current budget

§ 800,000.00

o Assign amounts

16.000.00

Total quantity

800.00

Pending

100,000.00

2,000.00

New total:

4.2 Erect Steel - Light

Original

$900,000.00

Current budget

$ 200,000.00

MHrs

18,000.00

4,000.00

900.00

Total quantity

200.00

Pending

40,000.00

200

New total:

$ 240,000.00

4,200.00

240.00

8.11.2 Update Current Estimate from Adjusted Current Budget

In some instances, you may not be able to forecast a change in the CE until you know the change will

be approved. Or your organization may prefer to handle changes exclusively via contract adjustment

records until changes are approved. When approved, the CE will then update with the changes
automatically. In any case, if CB adjustments are first recorded on a contract adjustment record, you

can use auto-calculate to update the CE with those adjustments.
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The Update CE from CB auto-calculate feature is only available on the Start with Cost items
workflow.

When a contract adjustment is revised, the Current Estimate values do not get updated or
backed out.

When doing a contract adjustment using the Start with Cost items workflow, on the Cost items step,
you can add the following columns from the Column chooser that show how the Current Estimate
values are based on the adjusted current budget values:

e Cost source

Update CE total cost

e Update CE total MHrs

e Update forecast (T/0O) qty
e CE total cost

e CE total MHrs

¢ Forecast T/O qty

e New CE total cost

e New CE total MHrs

* New forecast (T/O) qty

The check boxes under the Update CE total cost, Update CE total MHrs, and Update forecast (T/O) gty
lets you select to update the CE based on what is adjusted in the CB after the contract adjustment is
approved.

Net budget Het quantity Net man hous Markup  Fee Net contract Approval probability
change change change change

$0.00 Ho 0.00 §000 $0.00 $0.00 -

e- ost items =

CBS position Description WBS fjusted CB fees Cost source Update CE total cost Update CE total MHrs Update forecast (T/0) aty CB allowance Adj
phase o5t total cost allo
code

Adjusted current price:

A\ Pay item 002 - Concrete - Labor & Materisl () $0.00

3 l

] 7 >

Subtotals 2 $0.00 $0.00
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In other words, when the contract adjustment is approved, the adjustment values update the CB, and
the values that are checked also update the CE.

In a contract adjustment, the Update CE total cost and Update CE total MHrs check boxes are
active for Plug cost source only. They cannot be edited for Detail cost items because cost is
driven by your associated resources.

8.11.2.3 Select automatic updates for multiple cost items

You can select automatic updates for multiple cost items to save you time from selecting check boxes
manually for each cost item.

The Auto-calculate tool automatically checks the adjustment boxes for all the cost items that you
select.

To use the Auto-calculate feature select the cost items you wish to update. Click the Auto-calculate
icon, and then select Update CE from CB. In the Auto calculate dialog box, select whether to update
Cost, Quanty, Man hours, or Select all for the selected cost items, and then click Apply.

Change register >  Budget Move

® ® o Assign amounts

CBS positi Escripti WBS CB total cost Adjusted CB CE total MH Adjusted CB cl
positiol Update CB from GE scription e &l o cuét e to rs Ml!lrs e a

code

<]

a

41 Update CE from CB 1074 $800,000.00 $0.00 16,000.00 0.00

(<]

42 Building I1&J - Bridge C»_ 1005 $200,000.00 $0.00 4,000.00 0.00

<]

43 Goncrete - Building K&L 5 50,000.00 5000 1,000.00 0.00

RN

Auto calculate

Match current budget values with current estimate values
® Select all
M Cost
4 Quantity

4 Man hours

The applicable check boxes are now automatically selected to adjust your current estimate values for
the selected cost items.
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8.11.2.4 Set setting for default current estimate update

You can have the current estimate cost, man-hours, and quantity check boxes selected by default to be
updated with adjusted current budget cost, man-hours, and quantity values when doing change
orders.

In Settings > Control > Project Tracking, you can switch the Default CE values to be updated from CB
values toggle to ON. When enabled, all applicable check boxes are selected by default. This is a quick
way to keep CE and CB values in sync without having to double enter values.

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS
-

@ a

|@ Tasks

)
Maintain CBS Structure at a specific level? Level to Maintain CBS Structure at
-

Generate WBS phase code automatically?

-
'WBS Phase code generation method WBS Phase codes start value
Continue numbering from the last generated number -
Enable manual snapshots (7)) [S) Default CE values to be updated from CB values (i) ©

Allow syncs to replace manual snapshots @

For more information, see the Default CE values to be updated from CB values section in Project
Tracking, Tasks settings.

8.12 CONTRACT ADJUSTMENT — INEIGHT
CHANGE
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8.13 CONTRACT ADJUSTMENT FROM INEIGHT
CHANGE OVERVIEW

A contract adjustment, often referred to as a change order, represents a change to the scope of the
contract that results in a change to the project’s budgeted costs, man-hours, and contract price. These
adjustments typically involve adding or revising cost and pay items to accurately estimate the financial
and labor impacts of the change.

When you integrate InEight Change with InEight Control, you can track project changes using a more
robust, transparent, and auditable process than using just the Control application.

8.14 CONTRACT ADJUSTMENT FROM INEIGHT
CHANGE OVERVIEW

A contract adjustment, often referred to as a change order, represents a change to the scope of the
contract that results in a change to the project’s budgeted costs, man-hours, and contract price. These
adjustments typically involve adding or revising cost and pay items to accurately estimate the financial
and labor impacts of the change.

When you integrate InEight Change with InEight Control, you can track project changes using a more
robust, transparent, and auditable process than using just the Control application.

8.15 MANAGING CHANGES IN INEIGHT
CHANGE

The Change application provides a streamlined process for logging issues and managing their
development as they progress through the change management process to become potential and
possibly executed change orders. This includes producing detailed records for collecting relevant
information, determining pricing, and managing correspondence with external stakeholders. It also
includes configurable workflows for multi-level review and approval of change orders. For more
information on using InEight Change for managing changes, see Change Order Management and
InEight Change Knowledge Library home page.
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8.15.1 InEight Change Integration with InEight Control

Contract adjustments can be made within the Change application and are visible in the Change
Register of the Control application. After an Issue is created in Change, and becomes an executed
change order, it appears as a pending contract adjustment in Control with a status of CCO-Draft.

< ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions v s Y D) 1=
] Description cco Crea... Issue Last Last Notes Status Total budget Total budget Total contract
date # cha... cha... cost price
by on adjustment adjustment adjustment
|5.0 Additional steel work CCo-001 06/26/2025 4 Paul benni.. 06/26/2025 % 2 CCO-Draft $317.500.00 11,000.00 sN 2.500.00'
ArmEmARE  ATA Pedbeme: Ariacianae =1 A A ane ann nn nannnan A annnn nn

an A ik el b ed Wbk

For more information on executing the change order in Change, see Execute the Change Order.

On the CCO-Draft contract adjustment register, the cost items with their quantity, cost, and man-hour
adjustments, along with any associated pay items show up on the adjustment record.

=  (» Steel Structure Training Job2|1.. / Control / Workspaces

Change register > 1.1 - Contract adjust...
CCO total CCOunassigned  Net budget Net quantity Net man hour Billing rate CCOmarkup  CCO unassigned  Fee Net contract €GO agreed cCoun:
budget budget change change change markup markup change price price
$160,000.00 $0.00 $160,000.00 Yes 2,000.00 $0.00 $2631938  ($0563) $0.00 $186319.38 $186319.38 $0.00

o Cost items
[©) os Assign costto ¥
CBS position Description WBS CB total cost Adjusted CB New CB total Billing cco cco
O phase cost cost rate markup markup
code markup %
B N Adjusted current price: o
/N Pay item 003 - Steel - Labor & Material §122,272.50 $105,000.00 $0.00 16.45% $17,272.50
O 4 $105,000.00 5, 16.45 %
Adjusted ntp...
/N Pay item CCO-001 - Additional Steel Work 6 e ;;2347?50 $ 55,000.00 $0.00 16.45 % $9,047.50
0O s 6 m $50,00000 5 16.45%
0O 44 a Renta 1089 s $5,000.00 16.45%

8.15.2 Creating new cost items from Change executed change
orders

When adding pricing to an issue in Change, this can include adding new cost items that are not yet part

of the budget.
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5 Managing Changes in InEight Change

= @  Steel Structure Training Job 2| 105092 / Change
Change management > Issue > 1-Steel alignment issue
Current value Cost Billing markup  Markup Markup % Deduc
$1,000.00 $1,000.00 $0.00 $0.00 0.00% $0.00
Actions v DETAILS PRICING
IR
Add existing cost items ) .
WBS phase code Adjusted CB Qty Adjusted MHrs
Add from template Y M
i Add Unassigned pricing item 1074 1.00

Control User Guide

Depending on the nature and timing of the issue, the scope and details of the cost item may already be
known, or the new cost item can be added as a placeholder until further information becomes

available.
PRICING SUPPORTING
i DETAILS PRICING
Actions ¥ SUMMARY  DOCUMENTS
@® = i +% — Clear all filters
[J  Costitem description WBS phase code Adjusted CB Qty Adjusted MHrs Adjusted billable amou...
O Erect Steel - Heavy 1074 1.00 20.00 $1,000.00
O | New Cost ltem New 1.00 0.00 $10,000.00 |

When the issue becomes an executed change order and triggers a new CCO-Draft contract adjustment
in Control, details can be added to the cost item as the contract adjustment is reviewed and revised.

Change

egicter 180 - Contract adju—

ceototal CCOunassigned  Net bud Nt quant Netmenhow | Biingreie CCOmmup CCOunsssigned Fee Netcontrsct  CCOagreed C0 unassigned ul probabi
Budget R A Tt e i > g change A ] o ey
$70208 5000 570208 Yes 1 soo s000 sam sooo | s000 570209 s 70209
o Cost items =
® 1o Q
€8s positian Description wes CBtotal cost Adjusted CB New €8 total Blling cco cco Fee <8 totalMHes Adjusted CB Hew €8 totel €8 toal Adjusts
) shaze o cost e markin markup firs Firs Guantry aty
Eode mariuo E
A Unassigned costtems
5138 ]
2311 Prior to this step, an executed CCO s e
was created in Change with a new
costitem.



Control User Guide 8.15 Managing Changes in InEight Change
This includes being able to specify within the contract adjustment under which parent to place the
newly created cost item upon approval. Otherwise, the cost item is added as the last record in the Cost

Breakdown Structure on the Workspaces CBS tab.

Tasks : B Task details < evee > H

4 EDBSSmD" Description Resources :?yrwast (T/0) UoM ﬁ:;al qty (to m::;l’unﬂ fto
L 4132 Not in Use 1.00 Wk 0.00 )
L 4133 Not in Use 100 Wk 0.00
] 414 Not in Use 100 PLS 0.00
O v 415 Not in Use 100  Gal 0.00
O 4151 Not in Use 100 | Gal 0.00
O 4152 Not in Use 100  Gal 0.00
O 5 New cost item 100 | Mile 0.00

Subtotals 35

8.15.3 Pay item associations from InEight Change executed change
orders

When adding new cost items to price out issues in Change, you can associate a pay item to the cost
item.

Actions v DETAILS PRICING
a
® @B ® = e
B Costitem description WBS phase code Pay item Adjusted CB Qty Adjusted MHr
Ad Ad Ad Ad
O Erect Steel - Heavy 1074 003 - Steel - Labor & .. 1.00
r New Cost Item New Steel - Labor & Material 1 1.00

If the issue becomes an executed change order, this association will carry over when it becomes a
contract adjustment in Control, as seen on the Cost items step of the contract adjustment record.
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= {2t  Steel Structure Training J.. / Control / Workspaces

Changeregister > 6.0 - Contract adjust...

CCO total CCO unassigned  Net budget Net quantity Net man hour Billing rate CCOmarkup CCO unassi
budget budget change change change ‘ markup markup
$11,000.00 $0.00 $11,000.00 Yes 20.00 $0.00 $0.00 $0.00

o Cost items

® g8 Assign costto ¥
CBS position Description WBS CB total cost Adjusted CB
phase cost
code

Adjusted current price:
$11,000.00

/N | Pay item 003 - Steel - Labor & Material $11,000.00

] 4.1 \ Erect Steel - Heavy 1074 $ 800,000.00 $1,000.00

O New Cost Item $0.00 $10,000.00

8.15.4 Markup from InEight Change executed change orders

Markups defined in the executed change order’s pricing in Change also carry over to the Draft-CCO
contract adjustment in Control. On the contract adjustment record, Billing rate markup, CCO markup,
and CCO unassigned markup are all contract adjustment header fields that can help you make more
informed decisions on how to adjust the Adjusted current price.

Change register
/ atal CCOunassigned  Met budget Net quantity Net man hour Billing rate CCO markup  CCO unassigned | Fee / robability
budget change change change markup markup ‘
$0.00 $1,060.00 Yes 1,000.00 $0.00 56413 $64.13 $0.00 51 ute. w

o Pay rtems /

NN

®
— Pay item Adjusted Current price Adjusted Current unit Adjusted Current pay Curref.
L] number current price current unit price current pay qty aty forecast ,
price aty
1 | sl $1001.00 & §1.00 1,060.00 f/

8.15.5 Revising a CCO-Draft contract adjustment

When the status of a Client Change Order (CCO) is changed to Executed and submitted, the change
becomes a change record in the Change Register in Control. From the Change Register, the CCO-Draft
contract adjustment can be reviewed and submitted for final approval.
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For detailed steps on how to revise and submit for approval a contract adjustment that comes from
InEight Change, see Approve Contract Adjustment.

8.16 CONTRACT ADJUSTMENT HEADER

When revising a contract adjustment from Change, the contract adjustment’s header provides key
information to track the total cost, man-hours, and price of the adjustment.

CCO total CCO unassigned  Net budget Net quantity Net man hour Billing rate CCO markup CCO unassigned Fee Net contract CCO agreed CCO unassigned
budget budget change change change markup markup change ce price

$ 259,000.00 $0.00 $ 259,000.00 Yes 3,000.00 $0.00 $25900.00 $ 25900.00 $0.00 $ 259,000.00 $284,900.00 $ 25,900.00

In the example below, the contract adjustment header shows budget values prior to making any
revisions. Note the following:

CCO total CCO unassigned Net budget Net quantity Net man hour
budget budget change change change
$ 259,000.00 $0.00 $ 259,000.00 Yes 3,000.00

Header

category Description
CCO total The total cost adjustment coming from the executed CCO in Change.
budget
CCO Costs within the change order coming from the CCO in Change that are not
unassigned already assigned to a cost item.
budget

Net budget The total cost adjustment on the contract. In this case, it matches the CCO
change total budget because the cost items with their adjustments came over from the
executed CCO to the contract adjustment record.

Net quantity = The sum of the Adjusted CB gty column of the contract adjustment in control.
change

Net man hour The sum of the Adjusted CB Mhrs column of the contract adjustment in
change control.
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8.16 Contract adjustment header Control User Guide

Billing rate CCO markup CCO unassigned Fee
markup markup
$0.00 $25900.00 $25500.00 S0.00

Header
category Description

Bilingrate = The markup amount related to billing rates. This will only have a value if billing

markup rate markups are being used. For more information on billing rates, see Billing
methods.

CCO The markup value defined on the executed CCO.

markup

CCO The markup coming from the executed CCO that has not yet been assigned on

unassigned the contract adjustment record in Control. In this case, because the markup has

markup not yet been assigned, the Net contract change only reflects the adjusted costs

from the contract adjustment cost items.

Fee The sum of lump sum fee amounts defined at the pay item level of the pay
items on the Cost items step of the contract adjustment.

Net contract CCO agreed CCO unassigned
change price price
$ 259,000.00 $284,900.00 $ 25,900.00

Header
category Description

Net contract The total amount assigned to pay items on the contract adjustment record. This

change must equal the CCO agreed price in order to submit the contract adjustment for
approval.

CCoO The final agreed upon price per the executed CCO.

agreed

price

CCO The amount that still needs to be assigned for the net contract change to equal

unassigned the CCO agreed price.

price
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Note that after adding a 10% markup on the Cost items step of the contract adjustment, the Net
contract change matches the CCO agreed price, and the contract adjustment can be submitted.

Net budget Net quantity Net man hour Billing rate CCOmarkup CCO unassigned Fee Net contract CCO agreed cco ig
hang hang hang ‘ markup markup change price price >
$ 259,000.00 Yes 3,000.00 $0.00 $25900.00 $0.00 $0.00 $284,900.00 $284,900.00 $0.00
o Cost items L?_\'
ostto ¥ Q
Description WBS CB total cost Adjusted CB New CB total Billing cco cco
phase cost cost rate markup markup
code markup %
. Adjusted current price: o
wial $ 284,900.00 $ 259,000.00 $0.00 10.00 % $25,900.00
Concrete 1071 $1,500,000.00 $159,000.00 $1,659,000.00 10.00 % $15,900.00
Concrete - Materials 1086 $1,000,000.00 $100,000.00 $1,100,000.00 10.00 % $10,000.00

8.17 CHANGE APPROVAL PROCESS

After budget moves are submitted, they must be reviewed and approved before their values are added
to the current budget. The Change Register allows users with applicable permissions to review the
details of contract adjustments, budget moves, and quantity or man-hour adjustments. They can
revise, reject, or approve the changes.

To access the Change Register in Control Workspaces, select the Change Register tab.

fr  Steel Structure Training Job 2| 1.. / Control / Workspaces %) ®

ces ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions S Y B T = Q
0 Description cco Crea... Issue Last Last Notes Status Type
date # cha... changed cost MH price
by on
80 Concrete issue €Co-003 07/01/2025 2 Paul benni 07/01/2025 =) ("J cCO-Pending $259,000.00 3,000.00 $28490000  Contract adjustmen *
70 Cracked weld 06/26/2025 3 Paul benni 07/01/2025 =) 2 ssue-Draft $0.00 0.00 $000  Budget move
60 Steel alignment issue €C0-002 06/26/2025 1 Paul benni 06/30/2025 2@ 2 ccoput $11,000.00 20.00 $100000  Contract adjustmen
1 Additional Steel Work €C0-001 07/01/2025 079 Paul benni.. 07/03/2025 5 2 Dt §225,000.00 2900.00 $250900.00  Contract adjustmen
30 Additional Steel Work 06/25/2025 079 Paul benni.. 07/01/2025 5 ? Revised $ 225.000.00 2900.00 $250900.00  Contract adjustmen
20 Structural steel budget move 06/19/2025 Paul benni 07/01/2025 & () Approved $0.00 0.00 $000 Budget move
10 Erect steel budget move 06/18/2025 Paul benni 07/03/2025 5} (JPending $0.00 0.00 $000  Budget move

The Change Register includes the following columns:

Column
HETN ) Description

ID Auto-assigned by the system to uniquely identify each change entry. When a
submitted change is revised, a duplicate record is created with the ID
indicating a new version of the original. For example, if the original change has

InEight Inc. | Release 26.5 Page 401 of 632



8.17 Change Approval Process Control User Guide

Column
name Description

an ID of 2.0, the new revision entry will have an ID of 2.1.
Description  The description entered on the Detail step of the change’s record.

CCO Text field for entering a change order number. Contract adjustments
generated from InEight Change will automatically have this filled with the
number defined in the executed CCO. This is only editable within the CCO in

Change.

Creation The date the change record was created in the Change Register.

date

Issue # Text field for entering the issue number. Change records generated in InEight
Change will automatically contain the number as defined on the
issue/PPO/CCO in Change. This is only editable within the CCO in Change.

Last Indicates the user who last made a change to the record.

changed by

Last changed Indicates the date when the last change was made.

on

Notes Clicking on the icon in this field opens a slide out panel where notes can be
entered and reviewed in a “text feed” format.

Status Indicates the state of the change record (for example draft, pending,
approved). More information about statuses is covered in a separate table
below.

Total budget Indicates the total amount of adjusted cost estimated on the change record.
cost
adjustment

Total budget Indicates the total adjusted man-hours estimated on the change record.
MH

adjustment

Total Indicates the total contracted price adjustment estimated on the change
contract record.

price

adjustment
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Column
name Description

Type Indicates whether the change record is a Budget move, Budget Qty & MH
adjustment, or Contract adjustment.

Entries in the Change Register will have different statuses depending on what step of the process they

are in and where the change was created (for example, Change or Control). The following table lists the
possible statuses and what they indicate.

T

Draft A change record that is not yet submitted. This allows a change record to be
started and saved for later, until it is ready to submit. A change record that came

from Change is indicated as Issue-Draft for budget moves or CCO-Draft for
executed change orders.

Pending A change record that has been submitted but not yet approved. A change record
that came from Change is indicated as Issue-Pending for budget moves or CCO-
Pending for executed change orders.

Approved A change record that has been approved by someone with the appropriate
permissions. An approved change makes the proposed budget cost and contract
price adjustments final, updating the Current Budget accordingly. An approved
change record that came from Change is indicated as Issue-Approved for budget
moves or CCO-Approved for executed change orders.

Rejected A change record that has been rejected by someone with the appropriate
permissions. Rejecting a change ends the change process and prevents the
proposed changes from updating cost items and pay items in the Current
Budget. A rejected change record that came from Change is indicated as Issue-
Rejected for budget moves or CCO-Rejected for executed change orders.

Revised An approved change record that has been revised. Revising an approved record
results in a new version of the change record with a new version number. For
example, if an original change record has an ID of 2.0 and has its status changed
to Revised, it results in a new change record being created automatically with an
ID of 2.1 and a status of Draft. A revised change record that originally came from

Change is indicated as Issue-Revised for budget moves or CCO-Revised for
executed change orders.
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8.17.1 Managing changes in the Change Register

With the applicable permissions, you can review project changes as they are recorded as entries in the

Change Register and either approve, reject, or revise them as needed. The Change Register includes

both change records that are in progress (status of Draft) and changes that have been submitted

(status of Pending).

To review a change record, click within the row representing the change. A slide-out panel opens that

summarizes the details of the change. The options available on the slide-out panel depend on the

change record’s status.

8.17.1.1 Draft changes review

On the slide-out panel for Draft changes, you can select Review, Delete, or Revise.

ACS PAY ITEMS

CHANGE REGISTER

3.1
Additional Steel Work

Type Status

Originated on

AUDIT LOG

Originated by

) 4 B [ =

>

Contract adjustment (Cost ite 2 Draft 07/01/2025 Paul bennion
Last changed on Last changed by Approved on Approved by Approval probability
07/02/2025 Paul bennion N/A N/A N/A
Pay item details

Pay item Description Current billing Adjusted Adjusted Adjusted Locked date

number method current price current unit current pay qty

price
003 Steel - Labor & Material Unit price $164,500.00 $0.00 0.09
4 6 Additional steel work Unit price $ 86,400.00 $800.00 108.00
L]
$250,900.00 $800.00

Cost item details

CBS position Description WBS Adjusted CB Adjusted CB Adjusted CB Locked date

pha... cost MHrs aty

[ Review | [ etete | m

* Review - Opens the change record in a read-only state. All the steps of the change can be

reviewed, but no changes can be made. This may be a helpful option to give users permission to

review changes without having the access to approve or reject them.

¢ Delete - Permanently deletes the draft. When clicking Delete, a prompt comes up to make sure

you want to delete the record.
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¢ Revise - Opens the change record with full functionality to edit the record. After editing, if the

record is ready for approval, on the Summary step you can click Submit. If the record is still not
ready, you can select Draft to save it for future editing.

8.17.1.2 Pending changes review

On the slide-out panel for changes with a Pending status, you can select Review, Reject, Revise, or

Approve.

ACS PAY ITEMS

1.0

Erect steel budget move

Type

Budget move (Associated)

Last changed on
07/03/2025

From/To CBS position
From 4.2
To 41
From 4.2
To 4.3

CHANGE REGISTER

Status

(" Pending
Last changed by
Paul bennion
Description W...
ph...
co...
Erect Steel - Light 1005
Erect Steel - Heavy 1074
Erect Steel - Light 1005
Bolted Connections 1006

AUDIT LOG

Originated on

06/

18/2025

Approved on

n/a

Adjusted CB
cost

($10,000.00)
$10,000.00
($1,000.00)

$1,000.00

$ Y B T = Q

Originated by
Paul bennion
Approved by
n/a
Adjusted CB Adjusted CB Locked
Hrs qty
-200.00 0.00 a
+200.00 0.00
0.00 0.00
0.00 0.00
L 28 4

$0.00

[ Review } [ Reject ] [ Revise }

* Reject - Changes the status of the change record to Rejected, ending the change process and

preventing the proposed change from updating cost items or pay items. From that point on, the

change record is read-only. Once rejected, the change cannot be revised.

¢ Approve - Changes the status of the change to Approved, making the proposed changes final

and updating the Current Budget and contract price with the changes. Once approved, you can

review or revise the change.

* Revise - Opens the change record with full functionality to edit the record. If you revise a

Pending record, you can resubmit maintaining the Pending status, or select Draft to save with a

status of Draft.
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If you revise an approved record, the status of the record will change to Revised and become
read only, and a new draft of the record will be created with a new version number.

21 Cracked foundations 07/03/2025 Paul benni... 07/03/2025 % ﬁ Draft

20 Cracked foundations 07/01/2025 Paul benni... 07/03/2025 =) 2 Revised

Revising an approved record will back out all approved budget, quantity, man-hour, and pay item
amounts from the Current Budget. A revising warning message shows to confirm that you want
to proceed.

X

Revising will back out previously approved

amounts from current budget.
All approved budgets, quantities, man hours and pay items will be
reverted back to it's original, pre-approved state. Are you sure you

want to continue?

8.17.2 Group By option

You can activate the Group by icon to show certain change columns in groups of like information. Like

the CBS, you can activate the Group By icon to categorize certain columns in the Change Register.

Steel Structure Training Job 2| 1. / Control / Workspaces

CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Jrra— T 4 G o=
Description cco Crea... Issue Last Last Notes Status Total budget Total budget Total contract Type
date H cha... changed cost MH price
by on

Conrete issue ©C0-003 07/01/2025 2 Paul benni 07/01/2025 =) (J cco-Pending $259,000.00 3,000.00 $284900.00  Contract adjustment
Cracked weld 06/26/2025 3 Paul benni 07/01/2025 @ ﬁ Issue-Draft $000 000 $000 Budget move

Steel alignment issue €CO-002 06/26/2025 1 Paul benni 06/30/2025 B £ cco-Draft $11,000.00 20.00 $1.000.00 Contract adjustment
Additional Steel Work €CO-001 07/01/2025 079 Paul benni 07/03/2025 2 2 Draft $225,000.00 2.900.00 §250,900.00 Contract adjustment
Additional Steel Work 06/25/2025 079 Paul benni 07/01/2025 5} £ Revised $225,000.00 2,900.00 $250900.00 ~ Contract adjustment
Structural steel budget move 06/19/2025 Paul benni 07/01/2025 =) (©) Approved $0.00 0.00 $000 Budget move

Erect steel budget move 06/18/2025 Paul benni.. 07/03/2025 B (© Rejected $0.00 0.00 $000  Budgetmove
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Select a column header, drag it into the gray section above the column headers, and then drop it.

Multiple column headers can be placed in the Group By field.

CBS
cco Crea...
date
CC0-003 07/01/2025
06/26/2025
CCO-002 06/26/2025
CCO-001 07/01/2025
06/25/2025
06/19/2025
06/18/2025

ACS

Issue
#

079

079

Last
cha..
by

Paul benni...

Paul benni...

Paul benni.

Paul benni.

Paul benni.

Paul benni.

Paul benni...

PAY ITEMS

Drag a column header and drop it here

Last
changed
on

07/01/2025
07/01/2025
06/30/2025
07/03/2025
07/01/2025
07/01/2025

07/03/2025

CHANGE REGISTER

g ogn g g g g

: T
+ Status
Notes Status

(5 cCo-Pending
ﬁ Issue-Draft
£ CCO-Draft
ﬁ Draft

" Revised

@ Approved

@ Rejected

AUDIT LOG

Total budget
cost
adjustment

$259,000.00
$0.00
$11,000.00
$225,000.00
$225,000.00
$0.00

$0.00

Total budget
MH

adjustment

3,000.00

0.00

20.00

2900.00

2900.00

0.00

0.00

Total contract
price
adjustment

$284,900.00
$0.00
$1,000.00
$250,900.00
$250,900.00
$0.00

$0.00

After the Group by icon is activated, and one or more columns are grouped, such as the Status column,

you can see all the change records in their respective groupings. You can also see a subtotal for each of

the groupings (if applicable).

Actions
[+ omn I
1D Description

a Status:Pending(Count:6)

8.0

7.0

6.0

5.0

40

21 3
Count:6

3.0

Count:1
4 Status:Revised(Count:1)
20 3

Count:1

<
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PAY ITEMS

Creation

late

CHANGE REGISTER

Issue
#

09/23/2021
09/23/2021
09/23/2021
09/23/2021
09/23/2021

09/23/2021 3

07/26/2021 5

01/19/2021 3

Last

cha..

by

Paul trippi
Paul trippi
Paul trippi
Paul trippi
Paul trippi

Paul trippi

Paul trippi

Paul trippi

AUDIT LOG
S 4

Last Net Stat...
cha... Qty
on cha...
09/23/2021 0.00 Cj Pend..
09/23/2021 10,000.00 fj Pend..
09/23/2021 0.00 Cj Pend..
09/23/2021 000  ( JPend
09/23/2021 0.00 fj Pend..
09/23/2021 0.00 Cj Pend..
07/26/2021 100.00 ¢ Draft
09/23/2021 0.00 £ Revis

Notes

@A @ g @

@

Cha..

man..
tag 1

B = Q
Cha..
Y
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CHAPTER 9 — REVENUE
MANAGEMENT

9.1 REVENUE MANAGEMENT WORKFLOW

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage
Cost Items

Account

Live
Forecast

Analyze Planned
Earned and Actual

Forecasts

WBS Structure / Budgeted
Quantities & Hours

ed ch
?ﬁﬁc’,‘ie” cU:,:,,n;g;jdggf Revenue Management

Billed Revenue

Change Management |

Change Register Pay Item Register

Budget Move te/Manage
Pay Items
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue
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9.2 PAY ITEMS

VIDEO | Pay Item Details

Pay items distribute the cost calculated in the Cost Breakdown Structure along with all markups, fees
and contingencies calculated in the pay items. You can manage pay items on the Pay Items tab. For
more information, see the Pay Items section in Workspaces

9.3 PAY ITEM DETAILS

Open and manage the details of a pay item by clicking the ellipses next to the pay item description. The
pay item options that show are:

¢ Insert pay item
¢ Delete pay item(s)
¢ Pay item details
* Billed revenue details
Click Pay item details to open the Pay item details slide-out panel.
< PAY ITEMS CHANGE REGISTER AUDITLOG Revenue -

Actions = ® ® & Move to h 4 B B 1= Q

Revenue snapshot: Current revenueforecast + | Billed date:  10/01/2015 1o 06/30/2025 [

27 Pay item Pay item Description Forecast total Fore... Un... Rev... Current billing Is Billed Bi
] position number revenue reve... rev... fore... method billed reve... at
unit met...
a
1 001 Earthwork - Labor & Ma(enalH $ 650,000.00 $0.00 Earned Cost plus O $0.00
O 2 002 Concrete - Labor & Material ’ T $000 Default Unit price O $0.00
(®)\Insert pay item
[m] 3 003 Steel - Labor & Material . $0.00 Default Unit price 0O $0.00
(X) Deletg pay item(s)
[@ Payitem details I o
Subtotals 3 (1 pay items selected) g Billed revenue details §0.00 $0.00

You can also right-click on a pay item to open the slide-out panel to manage the pay item. The pay
item’s right-click menu includes two additional options:

¢ Bill multiple pay items

e Actual revenue details
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< ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View © Revenue -
Actions = ® ® & Move to b 4 B B 1= Q

Revenue snapshot: Currentrevenue forecast v | Billed date: 10/01/2005 to 06/30/2025 [

Drag a column header and drop it here to group by that column

7 Pay item Pay item Description Forecast total Fore... Un.. Rev... Current billing Is Billed Billed Rev...
pasition number revenue reve.. rev.. fore.. method billed reve... aty eamn...
unit met...
a
(]} 1 001 Earthwork - Labor & Material $ 650,000.00 $000 Earmed Cost plus D $0.00 000 $0
2 002 Concrete - Labor & Material 200 $0.00 Default Unit price (] $0.00 000 $0
(® Insert pay item
o 3 003 Steel - Labor & Material $0.00 Default Unit price (] $000 000 50
() Delete pay item(s)
[@ Pay item details
B silled revenue details
&, sill multiple pay items
&, Actual revenue details
< LI J
Subtotals 3 (1 pay items selected) $650,000.00 $0.00 $0.00 S0l

Select Pay item details to open the pay item slide-out panel.

9.3.1 Pay item details slide-out panel

You can find pay item details in the following tabs:
¢ Details
e Attributes
e Change orders
* Cost items

¢ Cost categories

2-002
Concrete - Labor & Material
Pay item position Current price Current pay qty Current unit price Current billing method
2 $2919020.71 1.00 $20919,020.71 Unit price
DETAILS ATTRIBUTES CHANGE ORDERS COSTITEMS COST CATEGORIES

* Pay ltem number Line number Sales order

ooz 2 -
Description 473

Concrete - Labor & Material
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9.3.2 Details Tab

The Details tab is the first tab in the Pay item details. This is where you can view the details for the pay
item such as Total Price, Pay Quantity, and Unit Price. You can also make changes to fields, such as Pay
Iltem number, Line number, and Description.

X
1-1
Concrete
Pay item position Current price Current pay gty Current unit price Current billing method
1 $ 100,000.00 1.00 $100,000.00 Fixed final price
| DETAILS | ATTRIBUTES CHANGE ORDERS COSTITEMS COST CATEGORIES

* Pay Item number Line number Sales order

1 1 -
Description 492

Concrete
Original billing method Current billing method

Fixed final price Fixed final price

9.3.3 Attributes Tab

In the Attributes tab, you can associate specific tags to the pay item or define field values. With the
applicable permissions, you can change the label names and configure drop-down list values in InEight
Platform.
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Pay item tag 1

Pay item tag 4

Pay item tag 7

Pay item tag 10

Pay item user defined 3

Pay item user defined 6

Pay item user defined 9

DETAILS

InEight Inc. | Release 26.5

ATTRIBUTES

Pay item tag 2

Pay item tag 5

Pay itern tag 8

Pay item user defined 1

Pay item user defined 4

Pay item user defined 7

Pay item user defined 10

inside a field in the Custom label column to rename the label.

CHANGE ORDERS COST ITEMS

Pay item tag 3

Pay item tag 6

Pay item tag 9

Pay item user defined 2

Pay item user defined 5

Pay item user defined 8

COST CATEGORIES

9.3 Pay ltem details

To update the label names, go to Main menu > Suite administration > Custom labels, and then click
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= fat  Suite administration / Custom labels

Enable custom labels |2 F 0 ©® Q

Field name | Custom label - EN Custom label - ES Custom ]|

Pay item user defined 9 Pay ifem user defined 9 Pay item user defined 9 Pay ite
Pay item user defined 8 Pay item user defined 8 Pay ite

Pay item user defined 7

Pay item user defined 6

Pay item user defined 5
Pay item user defined 4

Pay item user defined 3

Pay item user defined 2

Pay item user defined 10

Pay item user defined 1

8 000000 0DOO0OD

Pay item tag 9 ‘ | Pay iter

Pay item tag 8

Pay item tag 7

Pay item tag 6

Pay item tag 5

Pay item tag 4
Pay item tag 3
Pay item tag 2

Pay item tag 10

Oo0o0ooooooao

Pay item tag 1

|

To update the label values, in the project, go to Settings > Custom Lists, and then click the Field values
link. In the Field value slide-out panel, enter the custom field values, and then click the Add icon.
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@ Steel Structure Training Job 3| 105093 / Settings

9.3 Pay ltem details

List name
cBStag19
castag 2l
cas1ag 22
CcBS1ag23
CBStag24
€8S 1ag 25

CBSURL1
CBSURL2
] | CBSURL3
] | CBSURL4
] | CBSURLS
] | CBSURLG
CBSURLT
CBSURLB
c8Stag13
cBStag14

cBstag3

o
(m]

(m]

O

O

() | Estimating resources
(J | Estimating resources
(O | Estimating resources
O | Payitemtagl

[ | Payitemtag2

Pay item tag 3

Pay item tag 4

Pay item tag 5

Pay item tag 6

Pay item tag 7

([ | Payitemtags

Pay itemtag 9

O | Payitemtagio

GLOBAL OPTIONS HOME PAGE c:&ﬁ;‘;n
Label name Associsted entity Field values
CcBStag19 Cost breakdown structure Nene
cestag21 Cost breakdown structure Nene
CBStag 22 Cost breakdown structure None
CBstag23 Cost breakdown structure None
CBStag 24 Cost breakdown structure None
CBStag 25 Cost breakdown structure Nene
CBSURL1 Cost breakdown structure URL
CBSURL2 Cost breakdown structure URL
CBSURL 3 Cost breakdown structure URL
CBSURL Cost breakdown structure URL
CBSURLS Cost breakdown structure URL
CBSURLG Cost breakdown structure URL
CBSURLT Cost breakdown structure URL
CBSURL & Cost breakdown structure URL
CBStag13 Cost breakdown structure MNone
CBStag 14 Cost breakdown structure MNone
CBStag3 Cost breakdown structure MNene
Estimating fesources Estimating resources MNone
Estimating fesources Estimating resources Nene
Estimating resources Estimating resources Nene
Pay item tag 1 Pay item None
Pay item tag 2 Pay item Nene
Pay item tag 3 Pay item None
Pay item tag 4 Pay ltem None
Pay item tag § Pay ltem MNone
Pay item tag 6 Pay ltem MNone
Pay itemtag 7 Pay ltem MNone
Pay item tag 8 Pay ltem MNene
Discipline Pay Item None.
Pay item 1ag 10 Pay Item

Click Save to save the list.

9.3.4 Change Orders

FUEL TYPES

CUSTOM LISTS

Inherited from parent org

MENU OPTIONS

o
Pay item tag 9 field values
» Description
@ Concrete
O Design engineering ®

The Change Orders tab shows all change orders associated with the selected pay item.

4-4

Design

Pay item position
4

Change

order

number
281
280

271

270

Current price
$ 44,783,000.00

DETAILS
cco Issue #
1184 179
1184 179
11ze 89
11ze 89

InEight Inc. | Release 26.5

Current pay qty
44,783,000 00

ATTRIBUTES

CHANGE ORDERS

Current unit price Current billing method
$1.00 Unit price
COST ITEMS COST CATEGORIES

Total price
change

Total unit price

change

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

Total pay qty Approval Adj
change probability for
rev
a

100.00 %

0.00 %

100.00 %

0.00%
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9.3.5 Cost Items

The Cost Items tab shows the cost items that are assigned to the selected pay item. In this example
there are multiple cost items assigned to the 2-002 Concrete — Labor & Material pay item.

X
2-002
Concrete - Labor & Material
Pay item position Current price Current pay qty Current unit price Current billing method
2 $2919,020.71 1.00 5$2919,020.71 Unit price
DETAILS ATTRIBUTES CHANGE ORDERS COST ITEMS COST CATEGORIES
Earnings amounts based on: Forecast (T/0) qty CE total cost [# Update earing rules
CBS Position Description WBS Phase Earning % Earning Amount
Code (Forecast)

In Cost Items, you can view and update the earning rules for all associated cost items. Click the Update
earning rules button at the top right of the tab to open the earning rules window. You can adjust the
earning rules by Earning % and Earnings Timing. For more information, see Earning Rules.

9.3.6 Cost Categories

The Cost Categories tab shows a cost category-level breakdown of costs for cost items assigned to that
pay item, along with related forecast, earned, and billed revenue information. The Cost Categories tab
is a quick way to see where you have cost and revenue as well as where you have revenue at the pay

item level for the pay item at the cost category level. The different fields represent the different billing

methods that are available currently.

Page 416 of 632 InEight Inc. | Release 26.5



Control User Guide 9.4 Creating and locking pay items

ATTRIBUTES CHANGE ORDERS COST ITEMS COST CATEGORIES
Cost category Forecast final revenue Revenue eamed Billed revenue Markup amount Total cost (to date)
~ Tota 515 875 G & 1,000.0C S 900.00
W 0 O
v Construct £0.00 £0.00
w Re $0.00
v 5 $0.00 $0.00
v Maternials $0.00 S0.00
v Subcontract b $0.00 $500.00
v Fees $0.00 $ 300.00
v Allowance $0.00 $0.00
GE&A $0.00 $0.00

Forecast final revenue, Revenue earned, and Markup amount columns only show at the totals level of
the cost categories.

Forecast final revenue and Revenue earned columns show the information that is pulled from the pay
item's register.

The Total cost (to date) column refers to the costs you incur when you perform the work and breaks
down the information from the cost items assigned to the pay based on where you claimed the cost for
those items.

The Markup amount column calculates the difference between your total price and your agreed upon
current budget cost for those assigned cost items. The markup amount uses the calculation Total price
on the pay item - sum of the CB total cost on the assigned cost items.

9.4 CREATING AND LOCKING PAY ITEMS

When setting up your project, you can manually create pay items or quickly import your pay items by
uploading them from a Microsoft Excel spreadsheet.

Upload pay items from a Microsoft Excel spreadsheet

1. In the Actions menu, select the upload icon to upload the Excel spreadsheet.
2. Drag and drop your Microsoft Excel spreadsheet or select browse to upload it.

3. Select the New import option.
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4. After the spreadsheet is uploaded, choose the columns you want to see.

9.4.0.1 Adding Pay Item details

Because the project has not started, pricing is unlocked. This means you can:
e Add new pay items
e Enter price and quantity for each item.

When you are done adding details, your pay items show the current values that were entered.

9.4.0.2 Locking in your pricing

After you are done with your list and ready to move forward, lock in your pricing. To lock pricing select

Actions > Lock/unlock price > Lock price. This saves the changes as the original pricing for the project. If
you are not ready to lock all items, you can also select the individual pay items and lock or unlock them
from the Actions menu.

After the pricing is locked on a pay item, the pay item's price can only be edited through a contract
adjustment.

Partial locking is available. When set, you can add pay items at any time during the project life cycle,
and you can lock each pay item individually after you enter the price is entered for that pay item.
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9.5 BILLING METHODS

There are three billing methods to choose from:
¢ Fixed final price
e Unit price

e Cost Plus

.‘ PAY ITEMS CHAMNGE REGISTER AUDIT LOG VIEW | Price -
Actions ¥ Y [‘J D’ 1= Q
Revenue snapshot: | Current revenue forecast v Billed date: | 10/01/20.. | to 03/07/20.. m
agacold
)

3-003
1 Steel - Labor & Material
2 Pay ite Turre__ Pay item position Current price Current pay qty Current unit price Current billing method
L WEC...
) 3 $1821,092.28 1.00 §1.821,092.28 Cost plus
O 1 14,00
0O 2 DETAILS ATTRIBUTES CHANGE ORDERS COST ITEMS COST CATEGORIES
-
3 + Pay Item number Line number Sales order
003 3 -
Description 476
! Steel - Labor & Material
\ Original billing method Current billing method
Cost plus -
Fixed final price
Original price
< s Unit price
Cost plus
] Original pay gty Current pay gty
1.00
\ Original unit price Current unit price
]
Original forecast (T/0) gty Current forecast (T/0) gty
0.00
UoM (Unit of measure) [ Is billed
Subtotals 3 (1 pay it T
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9.5.1 Fixed final price

The fixed final price method is a lump sum billing method, which is a price agreed upon by a contractor
and a client. The fixed final price can change only with a contract change order.

The Forecast total revenue for fixed final price is calculated as Current Price + [sum of Unapproved
changes x Approval probability %.

9.5.2 Unit price

The unit price method is the default billing method which bills per unit. The price method multiplies
the unit price by the pay quantity to calculate the total price. For example, you can submit an estimate
where 44,000 units of an item are needed to complete the job. At the completion of the job, you are
paid per unit installed. If only 40,000 units of that item are actually installed, you only get paid for
40,000 units of that item.

The Forecast total revenue for unit price is calculated as Unit Price x Forecast (T/0) qty.

9.5.3 Cost Plus

With the cost plus billing method, the contractor is paid based on an hourly billing rate agreed upon
with the client, consisting of labor, equipment, or material costs, plus markup. In addition, you can
include a markup on top of the billing rate if needed. Cost Plus billing method adds flexibility
throughout the project since change orders are not required when you need to change markup,
resource rates, quantities, and hours as the job progresses. You do not have a contractual agreement
to be paid a certain lump sum.

The InEight Estimate pay items designated with the time and expense pay method become cost
plus pay items in Control when the estimate is published to Control.

In the Project library, you can define the billing rate (that includes a markup) and/or a charge rate (that
adds an additional markup) to an estimate resource on the Resource Rates tab. The billing and charge
rate markup are used only when the Cost Plus billing method is used in a pay item.

Cost Plus pay items are mostly resource driven.
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Edit labor estimate resource
* Code = Description 1000
1.C.01.1.05 Laborer
SETUP RESOURCE RATES
o
~  Allowance $ 000 5000 $0.00
G&A $0.00 50.00 $0.00
Undefined $0.00 50.00 $0.00
Billing rate $35.00 §30.00 $40.00
Billing rate markup $0.00 $0.00 $0.00
Billing rate markup % 0.00% 0.00% 0.00%
Charge rate 53850 §30.00 $40.00
Markup amount §3.50 50.00 5000
Markup % 10.00% 0.00% 0.00%
] [
=

 Billing rate - Rates agreed upon with the client.

¢ Charge rate - Add additional markup to your pay items. The charge rates are not visible to the
client.

You can setup markup percentage values at the project level in the project settings Markup section of
the Revenue tab for Cost categories and Current estimate resources.

InEight Inc. | Release 26.5 Page 421 of 632



9.5 Billing methods

1t  Steel Structure Training Job 3| 105093 / Settings

Control User Guide

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS
@ .
@ Markup
)
o~ Default markup percent
®) 14.00%
®
Cost categories Markup percent Current estimate resources Markup percent
Labor 14.00 % Labor 14.00%
Censtruction Equipment 14.00 % Construction equipment 14.00 %
FOM Rented Equipment 14.00 % Rented construction equipment 14.00 %
Supplies 14.00 % Installed material 14.00 %
Materials 14.00 % Installed equipment 14.00 %
Subcontract 14.00 % supplies 14.00 %
Fees 14.00 %
Allowance 14.00 % '
G&A 14.00 %
Undefined 14.00 %

Markups are used only when Cost Plus is selected as the billing method, which drives your revenue.

When other billing methods are selected, you only see rates applied to the cost categories that drive

your cost.

Markup values are not visible to the client.

You can use the two tables in the Markup section of the Revenue tab to enter markup percentages

against cost category levels and resource levels. The revenue amounts automatically calculate.

¢ Cost category level markups — These markups are for plug cost items that are not resource
driven. You can view and edit the billing rate in the Cost item details slide-out, under the Cost
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categories tab.

1071
Concrete
DETAILS
% complete b Live forecast method
100.00 % Current estimate -
Cost category Current estimate
~ Total $1,500,000.00
~ Labor $1,500,000.00
~ Construction... $0.00
“ FOM Rented ... §0.00
~ Supplies $0.00
~ Materials $0.00
~ Subcontract $0.00
v Fees $0.00
~ Allowance $0.00
GEA $0.00

ATTRIBUTES

COST CATEGORIES

Latest actuals in forecast
values

C 02/28/2025

Billing rate markup
amount

5$000

5$000

5000

$000

5000

5000

5000

5$000

5$000

5000

Total  Perunit

CE billable amount

$1,500,000.00

$1,500,000.00

5$0.00

$0.00

5$0.00

5000

5$0.00

5$0.00

§0.00

5$0.00

Markup %

CURRENT ESTIMATE
RESOURCES

0.00%

0.00%

0.00%

0.00%

0.00%

0.00%

0.00%

0.00%

0.00%

0.00%

Markup

9.5 Billing methods

X
FORECAST RESOURCES
CE
5000 $1,500,000.00
5$0.00 $1,500,000.00
5000 5$0.00
$0.00 $0.00
5000 5$0.00
5000 $0.00
5000 5$0.00
5000 5$0.00
5$0.00 5$0.00
5000 5$0.00

-

3

¢ Resource category level markups — These markups are for cost items with a cost source of

Detail. You can view the billing rates in the Cost item details slide-out panel, Current Estimate

Resources or Forecast Resources (depending on your project setup). In the Current estimate
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resources section, select a resource, and then open the Resource details section.

X
1091
Bolted Connections
CURRENT ESTIMATE
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
When updating the quantity of duration driven labor resources
@ Proportionally update Units\Man hours
) Proportionally update Hours
Resource details A
1.C.05.1.04
Ironworker Apprentice
Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost
~ Total 54500 $45.00 §60.00
Billing rate $45.00 $45.00 $60.00
Billing rate markup $0.00 5000 $0.00
Billing rate markup % 0.00 % I}D.UU % 0.00 %
Charge rate 54500 54500 56000
Markup amount $0.00 $0.00 $0.00
Markup % 0.00 % 0.00% 0.00 %

At the pay item level, you can see the total revenue for the pay item, based on the resource billing
rates and markup of the cost items that are assigned to each pay item.
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{ Acs PAY ITEMS CHANGE REGISTER AUDIT LOG View - | Revenue -
Actions ® % Y E; D 1= Q
Revenue snapshot: Current revenue forecast Billed date: 02/26/2025 to 03/19/2025 m
Drag a column header and drop it here to group by that column
% Pay item position Pay item Forecast total Forecast Unapproved Revenue Current Is Billed Billed P
number revenue revenue revenue forecast billing billed revenue aty €
unit cost method method
U.. $ 100.00000000000 $100.00 -
O 1 LNTP1 Part 1 L. $100.00000000000 $100.00 $10000  Billed Cost plus $0.00  0.0000000..
m 2 005.006 $0.00000000000 $0.00 Default Fixed final price $10.00 0.0000000...
O 3 005.0678 $0.00000000000 $0.00 Default Fixed final price $720.00 0.0000000.
O 4 005678 $0.00000000000 $0.00 Default Fixed final price $30.00 0.0000000.
O 5 LMTPTPart1.. L. $0.00000000000 $0.00 $0.00  Billed Cost plus D $0.00  0.0000000..
O 6 LNTP1 Part 2 L. $0.00000000000 $0.00 $0.00  Billed Cost plus D $0.00  0.0000000..
O T 4 B.. $100.00000000000 $100.00 $4,253292.55 | Billed Cost plus $100.00 0.0000000..
4 LIS
Subtotals 7 $ 300.00000000000 § 4,253 492.55 $160.00

The rates can be updated in the Cost item details slide-out, in the Cost categories tab, and in the
Current Estimate Resources or Forecast Resources (depending on your project setup) in the CBS.

9.6 BULK IMPORT PAY ITEMS

You can import pay items in mass directly into the Pay Item and Proposal register, similar to how cost
items can be imported directly into the CBS.

You can access the Excel import feature by clicking on the Import icon on the far right toolbar of
Control > Workspaces > Pay Items.

Billed date: 06/21/20. to 03/20/20. & ¥ &1 1= Q

Pay Pay Pay Pay Pay Pay Pay
rtem 1hem item item ihem Ttem Tteam
tag 8 tag 9 tag 10 user user user user
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When you click on the Import icon within the Pay Items tab of the Workspaces page, the Import Pay
Iltems window is shown.

Overview - Import Pay ltems window

1 Import from
Excel

2 Import Type

3 Information

You can either drag and drop or browse to the file to import. Microsoft
Excel files (.xIsx,, .xIs) and Comma Separated Value (.csv) files can
be imported.

You can add new pay items into the Pay ltem and Proposal register.

Explains that once an import file is specified, the next step will allow

message you to match the columns in your spreadsheet to the appropriate
columns in Control.
Import Pay items o

Import from Excel (.xlsx, .xIs) or Comma separated value (_.csv)

Drag and drop the file here

or browse

Browse

Options
* Import type @ The import file is read and field mapping can
Pay | be specified. Mapping uses row 1 headers
ay ltems from the source document
@® New import
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Clicking Next brings you to the Map columns window, where you can map your Excel columns to the
applicable column in Control.

Overview - Map Columns Window

1 Template  After you map the import file columns to the Pay Item columns in Control,
you can save your settings as a template for future use. This is helpful when
you need to make scope changes or updates on a regular basis.

2 Control The names of the column headers in Control that you can map your data to.
field

3 Mapped A green checkmark indicates the column in your import file is mapped

correctly to the Pay Item's column. The Green key indicates the matching
code you specified is locked.

4 File The names of the column headers in your import file that you can map to the
columns pay item columns in Control.
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Import Pay items - payltems csv

Map columns

1)

Template Unsaved template

Control User Guide

=

Control field e

Pay items

Current billing method
Current forecast t/o gty
Current pay qty
Current price

Current unit price
Description

Line number

* Pay item number

Pay item tag 1

Mapped e

File columns

Blank-do not import
Current forecast (T/0) gty

Blank-do not import

Current price

Blank-do not import

Description

Blank-do not import

Pay item number

Blank-do not import

(4)

4

* Reguired fields

9.6.1 Spreadsheet Rules

(o ] (o ] (N

For the import to work correctly, the items in your Excel spreadsheet need to be formatted in a certain
way so that Control can recognize them. The following table indicates important spreadsheet rules to
follow to make sure your data imports successfully:

N =

Import Reads the first worksheet within the referenced workbook.

function

the data to be imported is required.

Stops the import process when a blank row is encountered, so consolidating

Firstrowof  This is the header row of the data.

data This becomes the titles that are referenced during the mapping process.
During import, headers are not read if a blank header cell is encountered.
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T S

Numbers Need to be the actual number, not the summation of cells.
Cannot contain the $ or other currency symbol.

Secondrow This is the first row of data import.
of data

If you make changes in the spreadsheet, you must save the spreadsheet before importing. Only
saved data are imported.

After clicking the Next button, the system reads your Excel file and attempts to import pay items. A
successful import shows a message stating the number of files to be imported.

Document contains No errors
1 record(s) ready for import

Select next to continue with import steps.

If the import is not successful, a message is shown stating that errors exist. An error file is provided for
you to download, review, make corrections to your Excel file, then eventually continue with the pay
item import again.
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1 of 1 records contain errors

No Pay ltems were imported. Multiple errors found in pay item import.

Download the error file to review and resolve errors.
0Once all errors have been resolved, reattempt import.

Download Error File

The import error download file shows exactly where the error(s) exist within the Excel file.

PayItem from External System
File Import attempted on: 8/20/2021 7:43:46 PM

The following errors were detected while attempting to import pay item
values into control.

Review the errors below, once all the errors have been resolved,
reattempt the import to Control.

Error 1: Current unit price must be a numeric value for pay item number
5. (this error has 1/1 total rows affected)

Pay Item Number: 5
Row: 1

9.7 MARKUP PERCENT

In your project you can apply markup percentages to current estimate values of specific types of work
and have the revenue amount automatically calculated.
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There are two tables under the Revenue tab of Control project settings where you can enter the
markup percentages against cost categories and Estimate resource types. For more information, see
Markup in Settings.

The markup percent applies a percentage to the current estimate rates to arrive at markup amounts,
and the CE revenue amount takes into consideration all markups. Control then calculates an estimated
revenue amount for the cost items. This is possible whether that cost item uses resources or plug
values to calculate the current estimate values.

The revenue amounts update the Forecast final revenue for Cost plus type pay items. Then, the Cost
plus type pay items are used to calculate the values for the following columns in the CBS:

¢ Forecast total revenue

¢ Forecast remaining revenue
e Forecast revenue earned

¢ Forecast revenue unit cost
¢ Forecast total margin

e Forecast % margin

The pay item calculations are only applicable when the cost items are associated to a Cost Plus type of
pay item.

The default markup percentages populate columns in the Estimate resource library and the Control
CBS, such as the columns in the following table:

Column location Column name

Estimate resources Resource markup %
Resource markup amount
Charge rate

CBS - Cost item details slide out - Cost categories tab Markup %
Markup amount

CE revenue amount

You can view this information from Markup columns such as Billing rate markup amount, CE billable
amount, Markup %, Markup amount, and CE revenue amount.
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— 3}  Steel Structure Training Job | 10.. / Control / Workspaces

ces ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | Cost categories -
o
atos v @ B ® B O §$§ m O B 1= Q
X
M Tasks H REELCERS iy 1002
- Job Overhead
% CBS Description Resources Forecast (1 CURRENT ESTIMATE
a position aty DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
1 Job Overhead % complete Live torecast method Latest actuals in forecast
i values
o 2 Earthwork 5 000% Current estimate v C 03241200
[m} 3 Concrete 5
Total  Perunit
a v Structural Steel
Cost cat Current budget Actual cost (to date)  Current estimate Live forecast 3 Forecast Billing rate markup
[m] 41 Erect Steel - Heavy 5 agory < remaining cost :mmlgn!

a 42 Erect Steel - Light 5 ~ Total $000 $250,000.00 $2s04 Forecast remaining cost

Billing rate markup amount

o 43 Bolted Connections 5  Labor $0.00 50.(]
CE billable amount
a V5 Materials ¥ Construction. $000 $0.00
Markup %
[m] 51 Earthwork - Mater. 1  FOM Rented $0.00 $0.00 Markup amount
[m] 52 Concrete - Materi 1 ~ Supplies $0.00 5000 CE revenue amount

[ Committed remaining cost
Subtotals 12 (1 rows selected)

[J Committed total cost

The following table shows markup column information in the Cost categories tab of the Cost item
details slide out.

CE Current estimate amount + your Billing rate markup amount = CE billable
billable amount
amount

Markup Markup percent x your current estimate = markup amount - The Billing rate

amount markup amount for plug cost items is always set to zero because you can only
have a billing rate on resources. When this is a detailed cost item, this will shows
your billing rate markup amount for all those resources.

CE CE billable amount + your Markup amount = CE revenue amount - The CE

revenue revenue amountis how much revenue a cost item can have. This is only

amount applicable for cost plus pay items. You can apply markups on cost items, and they
do not affect the revenue on those cost items. The markups affect the revenue for
cost plus pay items and any cost items that are assigned to cost plus pay items.

9.7.1 Markup % column

The Markup % column is available in the CBS register to quickly manage markup percentages for cost
items associated to pay items that use the billing methods Cost plus and Time and Material. In the
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Markup % column, you can:

e Enter markup percentages directly into the field.
¢ Update individual or multiple cost items.
¢ Copy and paste values across multiple rows.
RELEVANT LINKS
Link 1
Link 2
Link 3

Link 4
Link 5

9.8 EARNING RULES

On the Cost Items tab the Update earning rules icon updates the earning rules for all associated cost
items. For each cost item associated to a pay item, you can adjust the earning rules by Earning % and
Earnings Timing. The Earnings timing indicates when you can earn revenue for a specific cost item
associated to a pay item. You can select from the following earnings timing options:

e Percent complete — You will earn revenue based on the % complete of the cost item
e Start —You will earn all the revenue when the work of the cost item is started (e.g., Mobilization)

¢ Finish — You will not earn any revenue for the cost item until all the work is completed (e.g., QC

item)
Pay item ID Description Total Price
002 Concrete - Labor & Material $2,919,020.M

CBS Position Description Earning % Earning Amount Earnings Timing WBS Phase Code

{Forecast)
52 Concrete - Materials 25.00 % 5$729755.18 | Percentcomplete | 1086
3 Concrete 75.00 % $2189265.53 | O\ 1071
Percent complete
100.00 % $2,919,020.71

Start

Finish

«#| Default Earning Rules

Cancel

i
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In this case for your Structural Steel Project, cost item 3 has an earning rule that equals 75% of the
Earning Amount (Forecast) of the pay item’s final revenue. Respectively, cost item 5.2 has an earning
rule of 25% of the Earning Amount (Forecast).

Since the Total Price of this pay item is $2,919,020.71, it is expected that cost item 3 will earn 75% of
this amount, and cost item 5.2 will earn 25%.

Pay item ID Description Total Price
002 Concrete - Labor & Material $2919,020.71

CBS Pasition Description Eamning % Eaming Amount Eamings Timing WBS Phase Code
(Forecast)

52 Concrete - Materials 25.00% §729755.1 plete ¥ 1086
3 Concrete 75.00 % $2189,265.53  Percent complete 1071
100.00% $2,919,020.71
|#) Default Earning Rules

Billing method of Cost plus

When the billing method of the pay item is set to Cost Plus, then the Update earnings rules
option will be disabled. Therefore, the associated cost items of the pay item will earn revenue
based on the assigned estimate resources’ billing rates and the % complete of the cost item.

Adjusting Pay Item Earning Rules

On the Pay ltems tab, select a pay item.

Hover over to the right of the Description and click on the three black dots.
Select Pay item details.

Select the Cost Items tab.

Click the Update earning rules icon.

Change the Earning % percentages for each associated cost item so the total will equal 100%..

N o g b~ e bdh =

Click Save.
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9.9 BILLED REVENUE

You can track revenue for your cost items in the Billed revenue details panel. The timing and basis for
billing revenue varies depending on your contractual agreement. Options include billing by a time
period or milestone, or based on a schedule.

The Billed revenue details slide-out panel records and tracks billed revenue.

002
Concrete - Labor & Material
BILLED RETENTION BILLED HISTORY
Pending hillable gty Pending billable revenue Retainage %
01e $ 530,386.06 0.00 %
Billed revenue Cost category
0 Undefined -
Billed quantity + Billed date
O 07/08/2025 |
Cost item
-
Change order
v
Notes 250

® Addbilled

Cancel

In the Billed revenue details slide-out panel you can navigate to the following tabs:
 Billed

e Retention
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¢ Billed History

Control User Guide

To open the Billed revenue details slide-out panel, from the Pay Items register, click the ellipses next

to the pay item description, and then select Billed revenue details. The Billed revenue details slide-out

panel opens, where you can record and track what you bill to the client.

@ Steel Structure Training Job2| 1050 / Control / Workspaces

cas acs PAY ITEMS GHANGE REGISTER AUDIT 10G Unsaved (Revenue) -
Actions ® @ & Mo A4 OB = Q
Revenue snapshot: Current revenue forecast v Billed date: 10/01/2015 to 070872025 )
 Pay Pay Deseription Forecast Forceast Revenue Curent Is Billed Biled Revenue Pending Pending Net
itern = tal revenve evenve forecast biling billed revenue aty eamed billable billable oty billed
positior wmber it cost method meihod revenve reven.
Unspproved revenue $93,159.69 C
001 Earthwork - Labor & Material $759,887.01 $759887.01  Default Unit price (m} $0.00 0.00 $21744437 029 $217,44437 029 $0.00
00 Concrete - Labor & Material E 5221902071 $2919020.71  Default Unit (m] $0.00 0.00 $530,386.06 018 §530,386.06 0.8 $000
Insert pay item
003 Steel - Labor & Material @ e 109228 Default Unit D $0.00 0.00 $321.0830 018 §308301 018 $000
) Delete pay itemis)
[@ Poyitem details
2 Billed revenue details
Sublotals 3 (1 pay ftems selected) §5593159.69 $000 $1069013.45 $1069013.45 5000

The Billed Revenue Details slide-out panel opens by default to the Billed tab.

9.10 BILLED TAB

On the Billed tab, you can enter information to create a record about what to bill your customer, and

view pending billable quantity, and pending billable revenue based on the progress of the cost items

associated and their earnings rules. You can also view the retainage percentage associated with the

pay item.
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X
002
Concrete - Labor & Material
BILLED RETENTION BILLED HISTORY
Pending billable gty Pending billable revenue Retainage %
018 $ 530,386.06 0.00 %
Billed revenue Cost category
] Undefined -
Billed quantity + Billed date
0O 07/08/2025 =
Cost item
A
Change order
-
Notes 250

@ Add billed

Cancel

9.10.1 Unit price proportional billing

When you bill revenue or quantity for unit price pay items, the billed quantity or revenue automatically
adjusts proportionally to the entered billed value to match the unit price.

For example, if the current unit price is $5,000.00 and the billed quantity is 0.50, then the billed
revenue automatically calculates at $2,500.00.
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ces ACS PAY ITEMS
Actions ¥ ® ® & Move to
+ Pay item Pay item Deseription Forecast total Forecast ui cu
(] position number revenue revenue. unit price
unit cost
362 PS04-033 PS04-033 SOCAL FPO So000 $0.00 $1.00
513 CO-263 CO-263 YARD LIGHTIN. $0.00 $0.00 $ 5,000.00
u] 513 co-263 ©0-263 YARD LIGHTIN $0.00 000 $5.000.00
a7 co-183 C0-183 M&O FLOORIN. $0.00 $0.00 $1.00
a7 C0-183 €0-183 M&O FLOORIN.. $000 §0.00 §1.00
418 co-233 ©0-233 CATG ADAPTO. $0.00 §0.00 $1.00
O 478 €0-233 C0-233 CATG ADAPTO. 5000 §0.00 §1.00
488 PS07-045 PS07-045 STRIPING C. $0.00 §0.00 $1.00
488 PS07-045 PS07-045 STRIPING C. $000 $0.00 $1.00
(] 204 PSO7-021 INSTALL AC @ MFs-D. $0.00 5000 $1.00
D 204 Ps07-021 INSTALL AC @ MHs-D. $000 $0.00 $1.00
.
Subtotals 1068 (1 pay items selected) §474481475 s1

9.10.1.1 Change Orders

CHANGE REGISTER

Revenue snapshot:  Current revenue forecast

C0-263
€0-263 YARD LIGHTING MATERIAL PROCUREMENT

AUDIT LOG

A 4

.

BILLED RETENTION BILLED HISTORY
-

Pending billable aty Pending billable revenue Retainage %
-0.50 (8 2.500.00) 000%
Billed revenue Cost category
| $2500.00 o Undefined A
B\H(-Imanmy  Billed date

0.50 ] 07/09/2025 B
Costitem

-

Change order

VIEW © Unsaved (Revenue) -

Billed date: 05/

Control User Guide

T G = Q
1412005 to 07002025 [

X

{ Cancel J

You can associate and view change order cost information on a pay item and additional cost items.

When creating a bill in the Billed revenue details slide-out panel or from the Bill multiple pay items

option, you can select a change order to assign the billed amount. For more information about using

change orders, see Change orders.

Bill for revenue earned

1. On the Pay Items tab, click the ellipses next to the pay item description, and then select Billed

revenue details. The Billed revenue details slide-out opens.

2. On the Billed tab, enter any applicable information such as the billed revenue, billed quantity,

cost category, cost item, change order, and notes.

3. On the Retention tab, select to release withheld retention.

On the Billed History tab, you can review the net billed revenue for the pay item and

other pay item history details.

4. Click Apply.

You cannot delete a pay item that is billed.
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For information about billing multiple pay items, see Pay item revenue billing in bulk.

9.11 RETENTION TAB

On the retention tab, you can release a pay item’s full retention amounts. The retention amount shows
under Retention withheld at the top of the tab.

X
1000
Removal of Underground Storage Tanks
BILLED RETENTION BILLED HISTORY

Retention withheld Retention released (to date)

$937.50 5000

Retention released * Retention released date

O 07/10/2025 &=
Notes 250

Cancel

To release the retention for a pay item, click the Retention release check box. The retention amount
populates automatically in the Retention released field.
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X
1000
Removal of Underground Storage Tanks
BILLED RETENTION BILLED HISTORY

Retention withheld Retention released (to date)

5000 5000

Retention released + Retention released date

$937.50 07/10/2025 =
Notes Click to release all retention 250

You can also select a retention release date and add notes about the transaction.

For more information about retention, see Revenue and cost timing in Control Settings.

9.12 BILLED HISTORY TAB

The Billed History tab shows all billed revenue records for a pay item. You can view billed revenue
details such as billed amount, billed date, billed quantity, notes, and change order information under
each respective column. You can view, but you cannot edit or delete any information.
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Unit price - CE earnings rules

Billed
date

05/14/2025

05/14/2025

05/14/2025

4 G

BILLED

Billed gty

5.00

3333

-33.33

Billed

RETENTION

$750.00

$ 5,000.00

($ 5,000.00)

BILLED HISTORY

Net billed
revenue

$ 500.00

$ 5,000.00

($ 5,000.00)

Retention
withheld

5000

$000

$0.00

Revenue
received

9.13 Billed revenue columns

You can also view the same billed history details in the Pay Items register in columns such as Billed

revenue, Revenue earned, Billed quantity, and Quantity earned.

9.13 BILLED REVENUE COLUMNS

After you have billed and applied billed revenue and quantities in the Billed revenue details slide-out

panel, columns in the Pay Items register are populated with billed revenue values.

The pending amount fields are derived from the quantity earned and revenue earned amounts.
Furthermore, the pending amount fields help you identify what has been billed versus what is left to
be billed based on what has been completed for your cost items. The Is billed check box shows

selected when a pay item has been billed.

You can view the billed revenue data in the following columns:
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< ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | unsaved (Revenue) -
o “ = -
Actions ® A h § B G = Q
Revenue snapshot: | Current revenue forecast v Billed date: 10/01/2015 to  (07/09/2025 ﬁ
Drag a column header and drop it here to group by that column
+ Pay Pay Descriptio Forecast  Revenue Current Is Billed Billed Pending Pending Revenue Quantity
O item item revenue forecast billing billed aty revenue billable aty billable eamed eamed
positi number unit cost method method rever
a
Unapproved revenue
1 001 Earthwork - Labor & M... §750887.01  Default Unit price 0 000 5000 029 | S$21744437  $217.44437 0.29
2 002 Conerete - Labor &Mat.. | $2919020.71  Default Unit price (m} 000 $000 018  $530386.06  $530,386.06 018
3 003 Steel - Labor & Material $1,821,09228  Default Unit price O 000 5000 018 | 32118301  §321,183.01 018
L] >v
Subtotals 3 $0.00 $1,069013..  §7,069013...
Column Description
Is billed Wh lected, a billi dhasb ted
S Dille en selectedq, a pilling record nas peen created.

Billed quantity = This value is based on your pay quantities and depends on the unit of
measure and how you want to bill the quantity.

Billed revenue @ What has been billed to the client.

Pending The quantity that you have earned but has not yet been billed.
billable

quantity

Pending billable The revenue you have earned but has not yet been billed.
revenue

Revenue Total earned revenue of all cost items.
earned

Quantity earned The earned quantity which varies depending on billing method.

The revenue in the CBS is updated after you apply billed revenue against it.

9.14 PAY ITEM REVENUE BILLING IN BULK

Revenue billing often includes multiple pay items. For that reason, Control also lets you claim billed
guantities and revenue for multiple pay items at a time using the Pay Items register. This is in lieu of
using the Billed revenue details slide-out panel to bill one item at a time.

In the Pay Items register you can select the pay items you want to bill in bulk.
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Pay item Description
number

v 01.02

v 01.03

v 11.1

FIELD OFFICES AND SHEDS

FIELD SUPERVISION, ADMIN & MAINTENANCE

FPOXY COATED STEEL SHEET PILE

9.14 Pay item revenue billing in bulk

In the example below for pay item 11.1, the revenue earned represents the total amount earned to

date. Revenue earned is based on the cost items associated with this pay item. As cost items are being

claimed, revenue earned is generated. For pay item 11.1, the Revenue earned columns shows
$365,924.12 has been earned to date. The Billed revenue column shows that $20,966.00 has been
billed thus far. The difference between the revenue earned and the billed revenue is the pending

billable revenue which shows under the Pending billable revenue column as $344,958.12. This is the

amount that you can bill the customer.

ﬁs%ibt::n Description

01.02 FIELD SUPERVISION, ADMIN & MAINTENANCE
01.03 FIELD OFFICES AND SHEDS

03.04 STRUCTURAL STEEL

1.1 EPOXY COATED STEEL SHEET PILE

Bille:
quar

21,027.00

21,921.00

21,072.55

21,417.00

Typically, when it is time to bill a customer,

Pending billable revenue column.

Total price Unit price Pay

nnnnn quantity

FIELD SUPE. $3,220,000.00 $70000.00

FIELD OFFI $1,610000.00 $3500000

STRUCTUR 19 $1,737,000.00 $9,00000

EPOXY COA. 72

$1,090,000.00 5200 545

Forecast
/0 aty

4600

4600

193.00

00000

4600

19300 T

54500000 U

Billed

revenue

$26,311.00

52157400

$21,061.00

Pending
billable
quantity

-21,004.55

-21,809.60

-21,030.66

$ 20,966.00

161,545.06

Pendin: Quanti

IJiIIabIeg earnedty

revenue

$1,545122.64 2245
$377,555.84 11.40
$ 355,983.32 41.89
$ 34495812 182,962.06

Revenue
earned

$1,571,433.64

$399,129.84

$377,044.32

$ 36592412

you can select the pay items with positive values in the

4600 Mo

Is billed

[<BN<BN<]

Billing Billed
methods quantity

Unit price 21,027.00

Unit price 21,921.00
Unit price 207255

Unit price 241700

Billed
$26311.00
$2157400
$21,061.00

$20966.00

Pending billable
quantity

-21,00455

-21,900.60

-21,03066

161,545.06

37755584

$35598332

$344958.12

2245  §157143364
1140 $399129.84
4189 $377044.32

18296206 $365924.12

A negative value in the Pending billable quantity or Pending billable revenue fields signifies an

over billing to the customer.

When you are ready to bill a customer, select the check box for the pay items. Right-click a selected
pay item, and then select Bill multiple pay items.
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Pay item
number

01.02

01.03

03.04

11.1

Danielle test _.

PAY ITEM 1

02.01

Control User Guide

Descriptic Line
number
FIELD SUPE.. 2

o ) fet
Gf) Delete pay item(s)

&

Bill multiple pay items

The New Bill Request register shows a list of billing related fields to potentially be billed to the

customer.

m | * NewBill Request

nnnnnn
STRUCTURAL STEEL

01.02 FIELD SUPERVISION, ADMIN & MAINTEN,
01.03 FIELD OFFICES AND SHEDS

11 EPOXY COATED STEEL SHEET PILE

Billing method

£ § § S

=3
Billed date:| 02/11/2020 4 [}

Pending billable Pending billable Billed revenue Billed quantity Unitof Costitem
revenue quantity

35598332 2103066 To Undefined

154512264 -21,00455 Mo Undefined

377555.84 2190960 Mo Undefined

34495812 16154506 Lb Undefined

The Pending billable quantity and Pending billable revenue columns show zero because their values

have been moved to the Billed Revenue and Billed quantity fields, to be billed as part of the overall

transaction. The Billed revenue and Billed quantity values in the New bill request register match the

Pending billable revenue and Pending billable quantity values in the Pay items tab.

In the New Bill Request, the values in the Billed quantity and Billed revenue fields are the amounts that

are to be billed to the customer. The Billed Revenue and Billed Quantity columns show the same

amounts that exist in the Pay Item register under the Pending billable quantity and Pending billable

revenue columns.

You also have the option to change the Billed Revenue amount in the New Bill Request register. For

example, if there's remaining work to be completed, and shows that it is not 100% complete, you can

change the Billed revenue to a different amount. Using the example below for Pay item 11.1, you can
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partially bill the pending billed revenue of $344,958.12. By changing the billed revenue amount to
$300,000.00, the remaining $44,958.00 shows under the Pending billable revenue column.

Now, you can see that if you bill for $300,000.00, then you still have $44,958.00 available to bill.

Payliem > | New Bill Request cance | ()

S] Billed date:| 0271212020 [ [3)
Payitem Description Billing method Pending billable Pending billable Billed revenue Billed quantity Unitof Cost category Cost item
nnnnnnnnnnnn quantity meas...

03.04 STRUCTURAL STEEL Unit Price 0.00000000000 0.00000000000 355,983.31699820043 -21,030.66092730624  Ton Undefined
01.02 FIELD SUPERVISION, ADMIN & MAINTEN. Unit Price 0.00000000000 0.00000000000 1,545,122 64433237491 -21004 55094793810 | Mo Undefined
01.03 FIELD OFFICES AND SHEDS Unit Price 0.00000000000 0. 377,555.84 049 -21909.59629021248 Mo Undefined

@ EPOXY COATED STEEL SHEET PILE Unit Price [J 300,000 161545 b Undefined

You can assign the bill request to a Cost category and a Cost item. Each billed revenue transaction
requires a cost category to be selected. The default value in the Cost category field is Undefined.

Poyttem | [ New B0 Requen m

© Billed date: | 021127200 4 [}
Payitem Description pending illale Cme Billed revenue Billed quantity. wnitof Gost category Costitem Notes
0304 STRUCTURAL STEEL. $0.00000000000 0.00000000000 $355,983.31699820043 -21,030.66092730624 | Ton Undefined =
01.02 FIELD SUPERVISION, ADMIN & MAINTEN $0.00000000000 0.00000000000  §1545,122.64433237491 -21,004 55004793810 Mo Undefined =
0103 FIELD OFFICES AND SHEDS so 0.00000000¢ §377,555 -21.909.59629021248 Mo Undefined =

w

AR EPOXY COATED STEEL SHEET PILE $44,958.12199933658 0.00000000000 $300,000.00000000000 161545.06099966829  Lb Installed Materials 1,611 [1163] Pioneering- Shest Pile

In the Notes column, you can select to enter and save any information specific to the bill request. Click
the Notes icon in the Notes column to open the form field.

Billed date: 07/11/20 B 3
Cost category Cost item Change order Notes
-
Undefined =
Undefined Q\‘
X
Notes

151

Billing customer for $300,000.00 on
02/11/2025, and will submit the remaining
$44,958.12 in April |

Cance‘ m

After you select the Submit button in the New Bill Request register, the billed transaction shows in the
Billed History tab in the Billed Revenue Details slide-out tab.
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BILLED HISTORY

002
Concrete - Labor & Material
BILLED RETENTION
Billed Billed gty Billed Met billed
date TEevVenue
07/11/2025 0.8 $ 530,386.06 $530,386.06

4

Retention
withheld

Revenue
received

$0.00

Notes:

Billing customer for $300,000.00 on 02/11/2025, and will submit the remaining $44,958.12 in April.

In the Pay Items register, the following columns are updated:

¢ Billed revenue
e Billed gty
¢ Pending billable revenue

¢ Pending billable qty

* Forecast total revenue and Forecast unit revenue (when Cost plus billing method)

Submitting the new bill request also creates new audit log entries in the Pay Item's audit log. The

entries include the pay item that was changed, fields that show before and after values, and the user

that made the change.
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cas ACS PAY ITEMS CHANGE REGISTER AUDIT LOG

Actions w A 4 G . Q
s Audit 1D Data type tem type: Descripti.. Payitem... Atibute Changed... Changed.. Value be.- Value aft.. Current . Current .
rcs 85 Paytem Paytem Steel-Labor&.. 003 Billedquantity  Julio 07711202512 000 016 Sienps2ze 5182109228 g
84 Pay Item Pay Item Congcrete - Lab. 002 Billed quantity Julio 07/11/202512. 0.00 0.18 $2,919,020.71 $291902071 a
. S Payltem Payltem Steel - Labor&.. 003 Billedrevenue  Julio 0711200512 000 205859.10 162109228 $1821,09228
e 82 Faytem Payltem Concrete - Lab.. 002 Billedrevenve  Julio 0711202512 000 530.386.06 5291902071 5291902071
80 Pay item Pay Item Additional stee. 4 Pay item numb. Paul 07/01/2025 01 Pending Approved $0.00 $86,400.00
i Paytem Paytem Steel - Labor&.. 003 Payitemnumb_  Paul 07/01/202501_  Pending approved §182109228  $1985592.28
7 Pay Item Pay Item Steel - Labor & 003 ‘Sales Order Paul 04/15/2025 01 $0-003 $1,82109228 $1,821,09228
i Payitem Payitem Concrate-Lab_. 002 Sales Order Paul 04715/202501 $0-002 5201902071 5291902071
73 Pay Item Pay Item Earthwork - La. 001 Sales Order Laur; 04/15/2025 01 Sales Order 1 $0-001 $759,887.01 $759,887.01
7 Payltem Payltem Earthwork -La. 001 Sales Order Lauri 04/08/202512 Sales Order 1 $750887.01 §750887.01
n Paytem Payitem Earthwork - La.. 001 Is billed Lauri 03/31/20502.  True False $750887.01 §750867.01
70 Pay Item Pay Item Earthwork - La. 001 Is billed Paul 03/31/2025 02, False True $750887 01 $759.887.01
60 Pay tem Paytem Steel - Labor&.. 003 Price lock status  Paul 09/02/202210_  Price unlocked  Price locked
4 >

Bill for multiple pay items

1. On the Pay Items tab, select multiple pay items.

2. Right-click on a selected pay item, and then select Bill multiple pay itemsfrom the list.

< PAY ITEMS CHANGE REGISTER AUDITL > VIEW © Unsaved (Revenue) -
Actions ® ® & Move to A 4 F B = Q
Revenue snapshot: Currentrevenueforecast w = Billed date: 10/01/2015 to  07/10/2025 m
Drag a column header and dropit here to group by that column
¥ Pay Pay Description Forecast Forecast Revenue Current Is Billed Billed
O item item total revenue forecast billing billed qty revenue
position number revenue unit cost method
a
Unapproved revenue $93,159.69
1 001 Earthwork - Labor & M §75088701  $759867.01 Default Unit price ] 000 $0.00
2 & - Labor & Mat $2919,020.71 $291902071  Default Unit price 0O 0.00 $0.00
() Delete pay item(s)
[m] 3 .abor & Material $182100228  §182109228  Default Unit price 0 000 $0.00
L) > v
S, Actual revenue details
Subtotals 3 (2 pay items serevey $5,593,150.60 $0.00

The New Bill Request register opens. You can verify that the billed revenue matches the pending
billable revenue in the Pay Item register.
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BILLED RETENTION

5000

Subtotals 2 (1 ows selected) S000

In the Retention tab, you can view any retention amounts from previous transactions,
such as retention withheld, released (to date), and amount released, similar to the
Retention tab in the Billed revenue details slide-out panel.

3. In the Billed revenue column, enter the amount to bill. In the following example, half of the
forecasted total revenue is billed, and the other half shows in the Pending billable revenue

column.

v T B = Q

t v | Bileddate 10012015 to 07102025 [

acs PAY ITEMS CHANGE REGISTER AUDITLOG

BILLED RETENTION

Billing Pending Pending Biled Retainage Retention Netbil Biledaty oM
revenue by theld

$5000000

p2sooo)

Subtotals 2 (1 rows selected) ($375000.00) $37500000

4. In the Cost category column, you can assigh a cost category to the new bill request.

5. Inthe Notes column, you can enter a note for each pay item, such as “Billing half the amount the

customer now and will bill the other half when job is complete”.

6. Click Submit.

You can view the entry created for this transaction in the Billed History tab for the pay item just

updated.
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9.15 SYNC BILLED REVENUE DETAILS

When work is progressed on cost items that are associated to pay items, the quantity earned, revenue
earned, pending billable quantity, and pending billable revenue fields are populated with the
applicable values. When a bill is processed, the billed quantity and billed revenue fields automatically
update, and the pending billable quantity and pending billable revenue fields also update (minus the
new billed amounts). The quantity earned and revenue earned columns are not affected by billing.

9.15.1 Sync billed revenue

You can sync billed revenue with your integrated billing system. To update a pay item’s billed revenue
to your integrated billing system, go to Actions > Sync, and then select Push Billed revenue. To update
billed revenue in Control, select the Get Billed revenue option.

4 PAY ITEMS
Actions ¥ @ é:;
Lock/unlock price 2 Rey
sSync b |
Push Pay Item
Budget move and contract adjustment P -
Push Billed revenue Forecz
revi
Take snapshots
Get Billed revenue
Fush Forecast revenue
O 2 257
4 GEEEN
Subtotals 2
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9.16 ACTUALIZING REVENUE

In Pay Items, after a bill is sent to a client, you can log revenue you receive so that you can track
received revenue.

In the Pay Items register, when you select the Claim Revenue icon, it shows all transactions for all pay
items that contain billed revenue that has not been logged as received.

= fat 103961 | Ten Mile Slide - Phase 2 (Carrying) / Control / Workspaces

: @

Actions  w ® =
2 Pay item position Pay item Descript... Line
number NUM..

Alternatively, you can right-click on one or more pay items and select Actual revenue details.
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fat 103961 | Ten Mile Slide - Phase 2 (Carrying) / Control /

Actions ® ® % Move to

= Pay item position Pay item Descript...
| numhber
1 1 1
2
() Delete pay item(s) ]
A

I% Bill multiple pay items

Actual revenue details

e

The Actual revenue details form opens and shows all the selected pay item billed transactions. In the
Revenue received column, you can enter the amount of money received by a client. The Revenue

received date lets you enter the date the money is received.

Actunl revenue detada

)
28

Pay item Pay tem Descripon Billed date Bulled ty o
pramstaan e revene -y - - [—
e
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You can select from the billed transactions, and then click the Auto Calculate icon to match the total

revenue received values with the billed revenue values (everything that has been billed has been
received in total).

Payitem >  Actual revenue details

" Pay item Pay item
position number
2 2
2 2
2 2

The revenue is also updated on the Billed History tab in Billed Revenue Details, for a pay item.

x

1

1
g Y Peyitemposition BILLED RETENTION BILLED HISTORY

y Billed Net billed Retention Revenue Revenue
1 revenue withheld received received

date
0 2 0.00 $100.00 $100.00 $0.00 $10000 | 04/07/2022
0 3 0.00 $900.00 $900.00 $0.00 $90000 | 04/07/2022
0 4 0.00 $900.00 $900.00 $0.00 $90000 | 04/07/2022
0.00 $1,000.00 $1,000.00 $0.00 $1,000.00 = 04/01/2022

After the Actual revenue details form is submitted, the Revenue received (to date) column on the Pay
Iltems form shows the pay item amount received.
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 Pay item position

1
2
3
4

9.17 CHANGE ORDERS

Pay item Descript...
number

1 1

2 2

3 3

4 2

Curr... Curr...
price unit
price
$100,0.. $100,000....
$30,00... 520000
$10,00.. $1,000.00
$2,500... $ 2,500.00

9.17 Change orders
Curr... Revenue
pay received (to
qty date)
1.00 $ 2,900.00
150.00 $ 3,200.00
10.00 $100.00
1.00 § 600.00

You can associate and view change order cost information on a pay item and additional cost items to
provide better visibility on the progress of a project and the breakdown of costs.

When creating a bill in the Billed revenue details slide-out panel, or from the Bill multiple pay items

option, you can select a change order to assign the billed amount to. This allows you to select which
approved change order to assign to the bill.

cBS ACS

Price Current price

lock

status
6 750,887.01
] $2919,02371
=] $1,821,002.28

§5,500,003.00

InEight Inc. | Release 26.5

Original
unit price

5$2919,020.71
$1,821,092.28

PAY TEMS CHANGE REGISTER
Original Unapproved Original pay
price revenue aty
§2919,02371 $7,000.00
$1821,092.28 $204,030.00
§4740,115.99 § 45,804,250.60

1
1

AUDIT LOG

Revenue snapshot: | Current revenue forecast v

002

Concrete - Labor & Material

BILLED

Pending billable quantity
-55.00

Billed revenue

$2,500.00

Billed quantity

55.00

Cost item

3[1071] Concrete

-

-

Y G B = Q
Billed date:  02/11/2020 to | 1201572021 [
X

BILLED HISTORY

Pending billable revenue
(52500.00)

Cost category

Installed Equipment -

= Billed date
12/15/2021

[

Change order

758.00

Notes

Associated to change order 758,

(®) Add billed

219

o
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In the Billed History tab, the selected change order is associated with the bill after the bill is submitted.

0 203 Aelease 1 and Chang erder 4 reloace T

g marn Py . i e o [ [P o [ &

[T [ [ [ [ T—

In the Pay Items register, you can view Change order details in the following columns.

¢ Change order — Shows the Change order number which can be used to associate with the
correct change order or contract adjustment.

¢ Total change order amount — Shows the total change order amounts for the pay item. This is a
summary of all the approved change orders that are attributed to a pay item.

¢ Billed change order amount — Shows how much money has been billed to the customer against
a change order.

Rev... Quantity Pen... Pending Net Change Billed Total
earn... earned billa... billable qty billed order change change
reve.. revenue order order
$0.00 ($ 750.00) $ 500.00 $0.00 $16,000.00 ;
$0.00 $0.00 $0.00 @ (@) $0.00  $10,060.00
$0.00 0.00 $0.00 0.00 $0.00 @(2) $0.00 $10,000.00
$0.00 0.00 $0.00 0.00 $0.00 @ (12) $0.00 $2,000.00
$0.00 0.00 5000 0.00 $0.00 @(16) $0.00 $2,000.00
$0.00 0.00 $0.00 0.00 $0.00 @ (3) $0.00 $1,000.00
$0.00 0.00 $0.00 -0.50 soo © M $0.00 $1,000.00
$0.00 0.00 $000 0.00 $0.00 @(2) $0.00 $ 60.00
$0.00 0.00 $0.00 0.00 $0.00 @ (1) $0.00 $ 60.00
$000 S 8100 N0y $210000 5000 sr,nnn. .
$ 60.00 (5 8,790.0... $ 8,600.00 $0.00 $ 44,760.00
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9.18 REVENUE FORECASTING

Revenue forecasting is used to determine the projected revenue a contractor will receive for
completing a project or scope of work. The amount of revenue earned compared to the total cost
spent determines how much profit and % margin is made. Therefore, understanding projected revenue
is critical to determine the profitability and health of a project.

It is often necessary to compare forecasted cost to expected revenue at a cost item level. Within
Control, you can view this comparison using the revenue columns available in the CBS. The revenue
fields in the CBS auto calculate based on the billing method of each line item or can be overridden by
manually entering a revenue forecast.

9.18.1 Pay Item Position Code Column

The Pay Item tab contains a Pay Item Position column that lets you view, sort, and group pay items in a
hierarchical manner much like you can in the CBS. This feature lets you expand and collapse pay items
by clicking the down-arrow, while also letting you group scopes of work together into a hierarchy.

- Pay item position Pay itemn Descri... Line Row Curr... Curr... Curr...
[ number num... num... price umnit pay
price
m vl Pay 1 Pay 1 1 26 $ 80,20
[ w2 16Pay 2 Pay 2 17 15 $0.000
[ w3 17Pay 3 Pay 3 18 16 $0.000
[ 4 Testpay Set new pay 37 27 $0.000 $1.50000 0.0000000

Adjusting the pay item position code column lets you see the parent-child rollup relationship between
pay items, terminal pay items, and the revenue forecast method, in addition to any other price and
revenue columns. This lets you see how the values for the child pay items all roll up to its parent pay
item, then see the totals at a parent pay item level.
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O

O a7

0 A

0 11
112
113

0 114

(] A 115

0 116

0 2
1.21
1.22

% Pay item position

Pay item
niumber

Pay 1

Pay 1.1

3Pay1.1.1

4Pay1.1.2

SPay 1.1.3

6Pay1.1.4

TPay 1.1.5

9Pay 1.1.5.1

10Pay 1.1.5.2

8Pay1.1.6

MPay 1.2

T4Pay 1.2.1

15Pay1.2.2

Descri.-

Pay 1

Pay 1.1

Pay1.1.1

Pay1.1.2

Pay1.1.3

Pay1.1.4

Pay1.1.5

Pay 1.1.5.1

Pay1.1,5.2

Pay1.1.6

Pay 1.2

Pay 1.2

Pay1.2.2

Line
AL

Is
term...

o ;M s W R
< < M < B < RS R

R < B <

< I < R

Row
FILIT...

9.18.2 Cost Item Revenue View

Current price

5 80.200.00000000010

§ 79,300.00000000010

$§ 55,300.00000000000

§ 11,000.00000000010

5 9.000.00000000000

5 1,000.00000000000

$ 3,000.00000000000

$ 3.000.00000000000

$ 0.00000000000

$ 0.00000000000

$ 900.00000000000

$ 900.00000000000

$ 0.00000000000

Control User Guide

Revenue
forecast
method
Rollup
Rollup
Manual
Manual
Default
Billed
Rollup
Default
Default
Default
Rollup

Default

Default

It’s important to see forecasted cost and forecasted revenue side by side, in order to compare the

costs and revenue on individual cost items as a subtotal of the overall project.

In Control, you can create a custom revenue data block containing six revenue-related columns.

Permissions can be established to limit who may view these Revenue columns. You can view this data

block within the same view as a forecasted costs data block for a side-by-side comparison.

H i

T
T — —

mmmmm I ——
mmmmm e T I I e
mmmmm T — e

The Revenue columns can only be populated if the associated cost items have an assigned pay item. In

the example below, cost item 1 Job Overhead, does not have a corresponding pay item assignment,
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therefore the Revenue columns are not populated. The opposite is true for Cost item 2 which has a
corresponding pay item assignment.

2 CBS Description 'WBS phase 'WES phase Pay item CBS contribute Forecast Forecast total Forecast total Forecast % Forecast Forecast Forecast _
[m] position code code assignment aty total cost margin revenue margin remaining revenue earned revenue unit
revenue co

O 1 Job Overhead 1002 1002 $250,000.00 $0.00 50,00 000% $000 50.00 $000

2 Earthwork 1069 1069 _b | $40000000  $2057500211613  § 2057540211613 10000%  $2057540211613 $0.00 $ 46762278 |

9.18.3 Cost item revenue calculation by allows as-built

For parent cost items where the allow as-built is not equal to None, where cost or quantities are being
tracked, revenue values are now being calculated at the parent cost item level rather than always
rolling up children revenue values to the parent. If the costs or quantities are being tracked at the
terminal cost items, then those revenue values are calculated at the terminal cost items and roll up to
the parent.

Tasks t @ Task details 1 | Revenue <o H

ey De-- WBS phase Change status Aa-built lock ‘Allow aa-bunlt Forecant Forecast tatal Forecast total Farecant Forecast Forecast %
O position code revenue unit margin revenue reenaneng reverue earmed margin

cont revenue

O 1 Financi. 1000 Al 50 5 50 50 o %
O w2 Misc R 1103 C None (3435295644980, $54560550000000 5000083358262  SSASEMEETAITIO  -7.976896345380
u] 21 Misc R 1104 Al $0.00000000000 |  $0000000DOCO0  SOO0000O00000D 5000000000000  §0.00000000000  0.0000000GIC0%
() w 2.2 Escalati nm Costs $ 0.00000000000 $ 8 6618330000C $ 9.66183200000 $ 0.00000000000 £ 8.66183200000 100.00000000000 %
o 221 General . 1102 Ouantities $000000000000 | §45270445800000  $45£30449800000 000000000000  § 4530443800000 1000000000000
(] v 13 Durects 100 m} None $0.00000000000 $ 0.00000000000 S0 00000 $ 0.0000000¢ 0.

9.19 REVENUE FORECASTING COLUMNS

The revenue forecasting data exists in the CBS and Pay Item registers as shown in the following images:

e CBS register revenue columns:

Revenue
& Forecast Forecast total Forecast total Forecast % Forecast Forecast Forecast
total cost margin revenue margin remaining revenue earned revenue unit
TEVEnue cost
$ 250,000.00 50.00 50.00 0.00 % 50.00 50.00 50.00
$ 400,000.00 $20,575,002116.13 $20575402116.13 100.00 % $20,575402116.13 50.00 $ 46762278
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¢ Pay Iltem register revenue columns:

«
bl
82
=
El

© e o= B
g
g

Payitem Description Forecast total Forecas t Revenue forecast
number revenue

nue forec Billed Gurrent billing Forecast t% Forecast total Forecas t Revenue
total cost method revenue method margin i 2

001 Earthwork - Labor. § 33,435,028,440 00 $650,00000  Default $000  Unit price 10000%  $33,434,378,440 00 §759,887.01 $0.00

Concrete - Labor .. $0.00 $1,850,000.00  Default $000  Unit price 0.00% ($1,850,000.00) $000 $0.00

o o o o

003 Steel - Labor & M. $T02,800.00 $700,00000  Earned $000 | Costplus 0.40 % $2:800.00 $0.00 $0.00

The following table shows an overview of the revenue forecasting columns.

Overview - Revenue Forecasting columns

Forecast CBS and This is your expected final revenue at completion. The calculations
total Pay Items vary by assigned billing method. This value is based on the Pay
revenue item’s final revenue * a percentage that can be earned by the cost
item.

Forecast CBSand Total cost (to date) + Forecast remaining cost.
total cost Pay

ltems
Revenue Pay Items For Fixed Final Price, you can select Default and Manual. For Cost
forecast Plus, you can select from Earned, Billed, and Manual.
method The roll-up revenue forecast method is automatically assigned for

parent pay items, and not editable, as all forecast revenue for child
pay items rolls up to the parent pay item.

Billed Pay Amount billed to the client for a single pay item.
revenue ltems

Fixed final = Payltems Lump sum billing method (price agreed upon by a contractor and a
price client does not change without a contract order).

Forecast % CBSand Forecastfinal margin/forecast final revenue.

margin Pay
ltems
Forecast CBS and Forecast final revenue - Forecast final cost. This is the total profit

total margin Pay Items you’re forecasting to make at completion of the job.

Forecast CBS Forecast final revenue - Forecast revenue earned, revenue
remaining remaining to earn.
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Overview - Revenue Forecasting columns (continued)

revenue

Forecast CBS and Forecast final revenue / Forecast take-off quantity, amount of
revenue unit Pay Items revenue earned per quantity.

cost

Forecast CBS % complete * Forecast final revenue. This is revenue that is earned
revenue based on completion of work.

earned

9.20 REVENUE CALCULATIONS

The revenue calculations are based on the following:
¢ Pay items assigned billing method.
e Pay items assigned revenue forecast method.

Control calculates revenue in the CBS and Pay Item registers based on the billing and revenue forecast
methods.

9.20.1 Cost Breakdown Structure (CBS) register revenue
Calculations

The following tables show how the different types of revenue are calculated in the CBS.

Forecast total revenue

Revenue

Billing forecast

method method Calculation
Fixed final Default Earnings % x Assigned pay item’s Forecast total revenue.
price
Unit price
Unit price  Default Earnings % x Assigned pay item’s Forecast total revenue.
Costplus Earned IF Cost source = Detail
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Revenue

Billing forecast
method method

Control User Guide

Forecast total revenue (continued)

Calculation

(Current
estimate)

Earned
(Forecast
cost)

Billed

Page 460 of 632

THEN

Forecast final revenue (labor resource) + Forecast final revenue
(construction equipment resource) + Forecast final revenue (all
other resources)

ELSE

Forecast final revenue (plug)

WHERE

Forecast final revenue (labor resource) = Work hours x Scale 1 % x
Scale 1 Charge rate + Work hours x Scale 2 % x Scale 2 Charge
rate + Work hours x Scale 3 % x Scale 3 Charge rate.

Forecast final revenue (construction equipment resource) = Work
hours x Charge rate.

Forecast final revenue (all other resources) = Resource quantity x
Charge rate

Forecast final revenue (plug) = CE revenue amount.

Forecast remaining revenue + Sum for each cost category [Actual
cost category cost (to date) x (1 + Cost category markup % from
settings)]

IF Forecast method = Rollup

THEN

Sum (children's Forecast final revenue)

ELSE

IF Forecast method is disabled

THEN 0.

IF all of the Billed revenue is assigned to cost item(s)

THEN

Forecast remaining revenue + Billed Revenue assigned to the cost
item

ELSE

Forecast remaining revenue + (Billed Revenue of the pay item
unassigned to a cost item x (CE final cost of the cost item + CE final
cost of all cost items assigned to the pay item) + Billed Revenue
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Forecast total revenue (continued)

Revenue

Billing forecast
method method Calculation

assigned to the cost item.

Time & Earned Forecast total revenue = Pay item forecast total revenue x (Cost
Material item Forecast total cost + sum of all assigned cost items' Forecast
total cost excluding Rollup method and disabled forecasts).

Billed IF all of the Billed revenue is assigned to cost item(s)
THEN
Forecast remaining revenue + Billed Revenue assigned to the cost
item
ELSE
Forecast remaining revenue + (Billed Revenue of the pay item
unassigned to a cost item x (CE final 202cost of the cost item + CE
final cost of all cost items assigned to the pay item) + Billed
Revenue assigned to the cost item.

All Manual Forecast final revenue of the pay item x (CE final cost of the cost
methods item + CE final cost of all cost items assigned to the pay item).

Forecast remaining revenue

Revenue
Billing forecast
method method Calculation
Fixed final Forecast final revenue of the pay item x (CE final cost of the cost
price item + CE final cost of all cost items assigned to the pay item)
Unit price
Cost plus Earned Forecast total revenue - Forecast revenue earned.
(Current
estimate)
Earned IF Cost source = Detail

(Forecast THEN
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Forecast remaining revenue (continued)

Revenue

Billing forecast
method method Calculation

cost) Forecast remaining revenue (labor resource) + Forecast remaining
revenue (construction equipment resource) + Forecast remaining
revenue (all other resources) {Using resources in the Forecast
resources tab only}
ELSE
Forecast remaining revenue (plug)
WHERE
Forecast remaining revenue (labor resource) = [Remaining work
hours x Scale 1 % x Scale 1 Billable rate + Remaining work hours x
Scale 2 % x Scale 2 Billable rate + Remaining work hours x Scale 3
% % Scale 3 Billable rate] x [1 + Labor resource markup % from
settings]
Forecast remaining revenue (construction equipment resource) =
Remaining work hours x Billable rate x 41[1 + Construction
equipment resource markup % from settings].
Forecast remaining revenue (all other resources) = Resource
remaining quantity x Billable rate x [1 + Resource markup % from
settings]
Forecast remaining revenue (plug) = Sum for each cost category
[Forecast cost category remaining cost x (1 + Cost category markup
% from settings)]
IF Forecast method = Rollup
THEN
sum (children's Forecast remaining revenue)
ELSE
IF Forecast method is disabled
THEN 0.

Billed IF Cost source = Detail
THEN
Forecast remaining revenue (labor resource) + Forecast remaining
revenue (construction equipment resource) + Forecast remaining
revenue (all other resources)
ELSE
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Forecast remaining revenue (continued)

Revenue

Billing forecast
method method Calculation

Forecast remaining revenue (plug)

WHERE

Forecast remaining revenue (labor resource) = (1 - % complete) x
Work hours x Scale 1 % x Scale 1 Charge rate + (1 - % complete) x
Work hours x Scale 2 % x Scale 2 Charge rate + (1 - % complete) x
Work hours x Scale 3 % x Scale 3 Charge rate

Forecast remaining revenue (construction equipment resource) =
(1 - % complete) x Work hours x Charge rate

Forecast remaining revenue (all other resources) = (1 - %
complete) x Resource quantity x Charge rate

Forecast remaining revenue (plug) = (1 - % complete) x CE
revenue amount.

Time & IF Cost source = Detail

Material THEN
Forecast remaining revenue (labor resource) + Forecast remaining
revenue (construction equipment resource) + Forecast remaining
revenue (all other resources) {Using resources in the Forecast
resources tab only}
ELSE
Forecast remaining revenue (plug)
WHERE
Forecast remaining revenue (labor resource) = [Remaining work
hours x Scale 1 % x Scale 1 Billable rate + Remaining work hours x
Scale 2 % x Scale 2 Billable rate + Remaining work hours x Scale 3
% x Scale 3 Billable rate] x [1 + Labor resource markup % from
settings]
Forecast remaining revenue (construction equipment resource) =
Remaining work hours x Billable rate x [1 + Construction equipment
resource markup % from settings]
Forecast remaining revenue (all other resources) = Resource
remaining quantity x Billable rate x [1 + Resource markup % from
settings]
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Forecast remaining revenue (continued)

Revenue

Billing forecast
method method Calculation

Forecast remaining revenue (plug) = Sum for each cost category
[Forecast cost category remaining cost x (1 + Cost category
markup % from settings)]

IF Forecast method = Rollup

THEN

sum (children's Forecast remaining revenue)

ELSE

IF Forecast method is disabled

THEN 0.

All Manual Forecast total revenue - Forecast revenue earned.
methods

Forecast revenue earned

Revenue
Billing forecast
method method Calculation
Time & All methods WHEN the Revenue is considered earned when a LEM is setting
Material is set to Pending
THEN

Sum of all BillAmount values where BatchType = LEM AND
DocumentStatus <> Cancelled

ELSE

WHEN the Revenue is considered earned when a LEM is setting
is set to Approved

THEN

Sum of all BillAmount values where BatchType = LEM AND
DocumentStatus <> Cancelled OR Pending approval.

All other All methods Forecast total revenue x % complete.
methods
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9.20 Revenue calculations

9.20.2 Pay Items register calculations

The following tables show how the different types of revenue are calculated in the Pay Items register.

Revenue

Billing forecast

Forecast total revenue

method method

Fixed final Default
price

Unit price

Cost plus Earned

Billed

Time & Billed
Material

Earned

InEight Inc. | Release 26.5

Calculation

Current price.

Current unit price x Current forecast (T/O) qty.

Sum of assigned cost items’ Forecast total revenue excluding Rollup
values.

Billed revenue + sum of assigned cost items’ Forecast remaining
revenue.

Billed revenue + sum for all assigned cost items {(1-% complete) x
sum for all cost categories[Forecast total cost x (1+Markup % from
cost category settings)]}.

IF the Revenue is considered earned when a LEM is setting is set to
Pending

THEN

= Revenue earned + sum for all assigned cost items {(1-% complete)
x sum for all cost categories[Forecast total cost x (1+Markup % from
cost category settings)]}

ELSE

IF the Revenue is considered earned when a LEM is setting is set to
Approved

THEN

= Revenue earned + Pending LEMs + sum for all assigned cost items
{(1-% complete) x sum for all cost categories [Forecast total cost x
(1+Markup % from cost category settings)]} Forecast final margin +
forecast final revenue.
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Revenue

Forecast revenue earned

Billing method

Time & Material

All other
methods

Calculation

WHEN the Revenue is considered earned
when a LEM is setting is set to Pending
THEN

sum of 'BillAmount' values where
'‘BatchType' = LEM AND DocumentStatus <>
Cancelled OR Pending removal

ELSE

WHEN the Revenue is considered earned
when a LEM is setting is set to Approved
THEN sum of all 'BillAmount' values where
'‘BatchType' = LEM AND DocumentStatus <>
Cancelled OR Pending approval OR
Pending removal.

Sum of assigned cost items’ Forecast
revenue earned.

9.21 COST PLUS REVENUE FORECAST

METHODS

Another phrase for the Cost plus billing method is Time and Material or Time and Expenses. Instead of
having a contractual agreement of being paid a certain lump sum, you are reimbursed for your time,
labor, and equipment hours and any materials that you purchased as well. With Cost plus, a markup
value is typically included. You submit time cards each week to get paid for your labor hours,
equipment hours, and any materials or supplies that you purchased plus any markup value that had

been agreed upon.

The Cost plus Revenue Forecast Methods are only applicable to pay items that have a billing method of
Cost plus. These forecast methods include:

» Billed
e Earned
e Manual
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9.21 Cost plus revenue forecast methods

The following image and table show details for the revenue forecast methods.

Actans i

Pay itam
mrmiber

Pay 2
90909190
TEST!
TEST2
danielle test 2
Payl

LALA
1234567850
£33

AT

Pay110

PayTETE
kuinal
a3

Road 82

Forecast

Electrical dev,

method
Billed

Earned

Manual
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GRS AL A TEMS CHAMGE REGISTER AUDIT LOG
® ® Billed date. D/0&/Z01T to 100017202
1
Description Total price Uniit Pay Fare... Liabl s Billing Cha.. Rav... Faracast final
price QuA... TIO billed mel... order fore.. rEyamuE
Oy et
Pay 2 $ 5656610006  § 565650 100.00194 000000 SBUOMS Unit price Default £0.00000
Q09090 $1234560000  §123000. 1003 TOT 000000 -DOSETES Cost plus Billed 5 AT BE6 BEEET
Cost plus test] $10000000  § 10 DODOD 1000000 10,000 00 new_bug Cost phis Rilled %71 A09 00000
Danielie Nixed final price £10000000  § 100,000 1 DI000 100000 PLS Fied final Dfanile 5 100 00000
cost plus 2 £ 1000000 10 00000 100000 -DOSSTEES ] Cost plus | Billed 5 20850 00000
1§ 000000 300000 2000000 BISATESS v Fixed final Default (5 50.00000)
nn i 10,0000 100000 10000000  MP_Testid Fixed final Default 51000000000
5 1000000 1.00000 10000000 Agre Unit price Default $1,000.00000
ca § 220,000 163636 2200000 TESTSBU Unit price Default 5 484000000
AN 5 70.00000 1.00040 TO0ODD  -DOSBTES Unitprice e (8] e §490.00000
Pay110 5 70.00000 1.00000 TO00U0  -DOSS8TES v] Unit price Q 5 B0B15000
5 70.00000 1.00000 TO0DUD  -DOSATES = Cost plus i 100.00000
52000000 & 10.00000 200000 10.00000  -DOYETES Unit price = o $ 100.00000
§ 23 00000 §3.00000 TERBGT 12200000 Asie Unit price gy (o | Earned % 369.00000
Road #2 $400000.00000  § 200.000 20000000 2,000,000 Fi Unit price €3 (6] % 400,000.00000
Electrical devices $800000.00000  § 400,000 2.00000 0.00000  PLS (] Cost plus 9 @) [iled £0.00000
a1
Description

All of your forecast remaining revenue that is driven off your cost items. Meaning
this method's calculation is the following: 1 - % complete x Work Hours x Billing
Rate. This gives you your Forecast Remaining revenue which is your Remaining
revenue you need to earn on the cost item. For the pay item, the revenue sums up
all of those remaining revenues at the cost item level. It then adds anything that
has been billed which is the Remaining revenue at the cost item level plus any
revenue that has been billed to the pay item.

Similar to the Billed Revenue except it uses the Forecast remaining revenue. The
Earned Revenue calculation is your forecast remaining revenue at the cost item
level summed up for all the cost items assigned to that pay item plus your earned
revenue. The earned revenue is also driven by the cost items. To summarize, itis
the forecast remaining revenue plus anything that you earned. This is also the
calculation for your percent complete as well.

manually forecasts your final revenue on that pay item with you entering in a
value.
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9.22 PUSH FORECAST REVENUE

The Push Forecast revenue syncs all of your revenue details from the Pay Items tab to an ERP system.
In the CBS register, go to Actions > Sync > Push Forecast revenue to start the sync.

CBS

Actions  w @

Y
Global forecast method.. .
H Task details < sone >

Set forecast method Reamres Forecast (T/0)
4 qty
Update Forecast (T/0) gty with Plan compone...
1.00
;:1 Claim multiple CBS quantities
) 5 10,000.00
Budget move and contract adjustment 3
|
! Lock/unlock budget » 2 10,000.00
Sync p  Push CBS structure 0
L - —precrsmeer=we; - Ush CBS structure and Budget 0
| Push CBS structure and Live forecast
L] 43 Erect Steel - Lig D
Push CBS structure and Actual quantities
O 4.3 Bolted Connecti D
Push CBS structure, Budget, Live forecast, and ..
OJ 4.4 Labor D
Push Pay Item
i ; 1]
O 45 Equipment Push Billed revenue
O 46 3rd Party Push Forecast revenue 0
O v 5 Materials Get quantities » D
0 51 Earthwork - Mat 0¢t Actual cost and MHrs 0
Get Billed revenue
O 5.2 Concrete - Mate - ) 0
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9.22.1 Revenue Snapshots

Revenue snapshots capture pay item information and cost item revenue information using the sync
Push Forecast revenue. When a project forecast revenue is pushed, it generates a revenue snapshot.

When the project month rolls over, the last push revenue forecast sync before month-end is recorded.
If a sync has not run during the month, then the system automatically takes the revenue forecast
snapshot based on the date and time.

After the revenue snapshot has been recorded, you can look at past snapshots to view previous values.
For example, in the pay items register you can view current and previous Revenue snapshots using the
Revenue snapshots in the drop-down menu.

4 PAY ITEMS CHANGE REGISTER >

@
=
Revenue snapshot: Current revenue forecast =

ik

Current revenue forecast

March 2025
Pay item Descri... Forecast Lh
number revem February 2025 -

January 2025
001 Earthwaork - :

December 2024
ooz Concrete - .

Movember 2024

v

0oz Steel - Labo... 7 UL S RPRTI

If you view a past snapshot, the data that loads is read-only. You cannot edit any of the fields.
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ces ACS PAY ITEMS CHANGE REGISTER AUDIT LOG Revenue -

Y O & = Q

®
4
ke

Revenue snapshot: March 2025 - Billed date: to

+ Pay item position Pay item Descri.. Forecast total Fore... Un.. Rev... Curr... Is Billed Billed Rev... Quantity Pen... Pending
number revenue reve.. rev.. fore... billing billed reve... aty eam... earned billa._. billable qty
unit met.. met... reve..
a

Subtotals 3 $ 650,000.00 $0.00 5000 §0.00 5000

The billed date shows the earliest build of the project when the snapshot was taken and includes any
pay items in the pay item register. The snapshot might not include back-dated bills or newly created
pay items. The snapshot might include deleted pay items.

rewly reated oav -._..... 5 and it mav in ide HI”E‘[' [I<.[!1

LV

For example, February has ended and the snapshot was taken it is now March and you backdated a
bill, such as billed revenue or billed quantity into February. The backdated bill is not included in
February's snapshot because the snapshot had already been taken.

The snapshot is automatically recorded by month and year. Whenever the month ends, the monthly
Revenue snapshot shows in the revenue snapshot drop-down list.

The snapshot records the revenue columns for pay items. The columns are the following:

¢ Forecast final revenue

Forecast remaining revenue

Forecast revenue earned

Forecast unit revenue

Percent margin

Forecast final margin

The snapshot records the information automatically based on your fiscal calendar settings.
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9.23 Revenue Forecast Probability

9.23 REVENUE FORECAST PROBABILITY

Revenue can come from Control or Change. Only Contract Adjustments have revenue. You can also
adjust your pay item values in a Contract Adjustment. For example a drop down field called Approval
Probability is a drop down of all your revenue categories and their associated probability. This drop

down field displays the Approval probability by percentage and associated name.

Change register  *  Comtract adjustment

Mot Budget change et Quantity change  NetMan hourchange  Markup
S0.00 Na 000 50000

°Du|\u|:,

Choose your Contract adjustment workflow

@ Start with Cost items

Ervter markup and fees on cost items to generate pay item pric

@

Fre
50,00

et Comtract change Approval probability
5000
1.00% - quesn
23.23% - TERMB
23.23% - NAME

34.34% - INEIGHT-AEDIT

100.00% - Executed Change Order

Start with Pay items
Adjust pay ilem piice before adjusting cost iter

Contract adjustment details

Issue &

Follow the steps below to select an approval probability.

Approval Probability

Select the Actions drop down menu.

Enter a value into the Adjusted total price text box.

o 0 bk w0 N o=

on status changes.
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CCo

123 45%, - INFIGKT-55555505555

Hover over Budget move and contract adjustment, then click Contract Adjustment.
In the Approval probability drop down, select the percentage and associated name.

In step 3, select the add icon to add either new or existing pay items.

Either save as Draft or select the Submit button. Now it shows the selected approval probability
in the Change Register. It also displays in the line item slideout. This updates automatically based
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7. If your line item is approved, it has a 100.00% in the Approval Probability column.

8. If a Contract Adjustment has been revised or rejected, then the line item has a 0.00% in the
Approval Probability column.

That Contract Adjustment's revenue is never going to be earned or added to the pay items
because a new Contract Adjustment has been created.

9. If your line item is in a Draft or Pending state, the Approval Probability column displays the
approval probability you selected for that line item.

If you don't select an approval probability, the Approval Probability column is blank.

Your Approval Probability drives the price you include in your Forecast Final Revenue. For this next
example, we are going to include the Unapproved Revenue into the Forecast Final Revenue. In the Pay
Iltems Register, the Unapproved Revenue column calculates all the Contract Adjustments. The column
adds up all Contract Adjustments that include the pay item and the adjusted price that has not yet
been approved. The Unapproved Revenue column calculates anything that is in a Draft or Pending
state.

CBRS -

itam % .. ov... Quantity Panding
....... ber Inem revenue Mar.. reve. qu fora eam eamed revenn billakle

In Pay Item Details, the Change Orders, you can view the following details:
» Total price change
« Total unit price change
» Total pay quantity change
« Approval probability
» Adjusted forecast final revenue

e Status
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12345
12345
Total Price
s A 00000
Issue ¥ Tatal price
changa

o

Pay Quaniity
]

DETAILS

ATTRIBUTES

Tolal unit price

changa change

50000
50000 % 3,000.00)

50000 S 3000.00)

3, 00000 5300000

CHANGE ORDERS

Totad pay gty

9.23 Revenue Forecast Probability

X

Unit Price

§3.,000.00
COET ITEMS

&djusted Statrs

forecast fimal
FRVEMTE

i Dl
.l':J Fending
0o = & 000 Acwsed

':-_r.’_,: hpproved

The Forecast Final Revenue is the sum of all the Adjusted Forecast final revenue. Calculating the
Unapproved Revenue with the Forecast Final Revenue provides you with a more accurate look at the

revenue you will see when the Contract Adjustment is approved. Nothing is added into the Total Pay

Iltem Price until it is approved.

Approval Probability drop down is only available in the Contract Adjustment. Everywhere else it is read
only. To manually adjust the Contract Adjustment, go to the Change Register. Then right click the line
item you want to change and select Revise. The Contract Adjustment can also automatically change

based on status changes.

The Revenue Category Name and probability percentage drives the Approval Probability. The Revenue
Category Name draws from the Revenue Categories in the Master Data libraries.

Master data libraries

English

REVENUS CAIBgOnY RAMA

Revenua change S1atus name

Frbability percentage

Esparial ES-MX

Revenus Category name Reweniss change 1418 Nama

sdsad

New Demo STZEN English

Arv_eng

Check 1_eng

The Revenue Categories show the Revenue category name and probability percentage for only active

revenue.

InEight Inc. | Release 26.5

Page 473 of 632



9.24 Time-phased budget Control User Guide

9.24 TIME-PHASED BUDGET

Time-phased budget lets you plan out where to spend money in the months of the active fiscal
calendar for the project.

The point of being able to time phase your budget is so that you can plan out your budget cost per cost
item. You are spreading out your budget over the course of the project for each cost item.

9.24.1 Budget organization setting

The time-phased budget feature includes an organization setting located in the Project tracking tab of
the Control settings. The organization setting sets the default for all the projects within that
organization.

You can also change the budget setting at the project level. If you are starting new projects in your
organization, you need to have Time phasing budget switched on.

By default all the projects that are created under that organization also have the time phased budget
enabled. This is the same for when budget is disabled.

Time phasing

Enable time phasing for the following:

Budget (i) ® Edit past Time phased budget values (&)

9.24.2 Edit Past Time-Phased Budget Values

The Edit past Time phased budget values toggle lets you edit past fiscal period time phased budget
values.
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Time phasing

Enable time phasing for the following:

Budget (3) (&) Edit past Time phased budget values ()]

When this setting is enabled, you can edit your past time phased budget values via a budget move or a
contract adjustment in the time phased budget step, with the proper permissions.

Changeregister >  Contract adjustment

Net budget change  Net quantity change  Net man hour change
$0.00 No 0.00

Markup Fee
$0.00 5000

o Time phased budget

Net contract change  Approval probability
$0.00

(=5 Description was Start Finish cc January 2022 February 2022
sition hase
O il Eude Cost Adjusted cost Cost Adjusted cost

[ (521233) e 521233 e

[ $0.00 $0.00

Selecting the new Rebaseline icon resets the cost item's time-phased budget distribution based on the
Start and Finish dates against that cost item. Rebaselining lets you amend your time-phased budget
distribution costs for a cost item.

You can also edit any of the Adjusted cost values manually for past months.

g8 e
CcBs Description Start Finish April 2022 May 2022
] position = -
- Adjusted cost Cost Adjusted cost
|l 5000 $0.00
5471.92 $975.31

At the project level, the time-phased budget inherits the organization settings, but still lets you switch
the budget setting On or Off at the project level. For example, you can have time phased budget
turned on at the organization level and you can turn it off at the project level.

9.24.3 Switching off time-phasing budget
If the Time phasing budget is switched on, that means there is time-phasing budget data in the

database. If you turn it off time phasing budget at the project level, it gives you the following warning
message:
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X

Are you sure you want to delete Time phased budget? %
Turning off time phased budget will delete all existing time phased budget
data for the project.

_| By selecting this checkbox and accepting these conditions, |
understand that all time phased budget data will be deleted for this

project.

All of your time-phased budget data is going to be deleted if you switch time phased budget off.
You must select the check box in the warning dialog acknowledging that you understand and

accept these conditions.

If you still want to turn off the time phasing budget, you can select Yes and then click Save. This will
delete the time-phasing budget data from the database.

9.24 .4 Switching on the time-phasing budget

If you want to turn on time phased budget, the following dialog box appears if there are any missing

start or end dates:
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Cost items are missing start and end dates.
How would you like to populate the missing cost item start and end dates?

@ Default all budget to current fiscal period
(O Default to project start and end dates

(O Go back and populate the missing dates

Every cost item in your project needs the start and finish date entered to use that data in the time-
phase budget.

When time-phased budget data is calculated, the calculation is based off of the data in the current
budget and total cost for the cost item. Then, the cost is distributed to the cost items start date, finish
date, and cost curve.

Time phased budget <o) :
CB total cost Start Finish Cost curve Eﬁ;g;ntg:; =
$48,790.00 | 01/01/2020 03/31/2022 Linear $150.00
$25,020.00 @ 01/01/2020 07/30/2021 Back Loaded ($ 5,060.00)
$5,050.00 12/30/2020 12/31/2020 Front Loaded $4,640.00
$5120.00 01/01/2021 05/31/2021 Linear $ 540.00
$1,600.00  12/01/2020 03/31/2021 Custom curve 1 $10.00
$1,000.00 12/01/2020 05/15/2021 Bell Shaped $10.00
$11,000.00 12/01/2020 03/31/2022 Custom curve 2 $10.00

9.24.4.1 Default all budget to current fiscal period

The first option you have is to default all of the budget to the current fiscal period. Then, all cost items
that don't have defined start and finish dates have the current budget going to the current fiscal
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period.

For example, if you look at WBS phase code 1007, you would have $100,000 put into December 2020.

3 CBS position Description WBS phase CB total cost Start Finish Cost curve Pending

O code budget cost
O v Electrical devices 1000 $48,790.00 01/01/2020 03/31/2022 Linear $150.00
O 1.1 Install conduit 1002 $25020.00 01/01/2020 07/30/2021 Back Loaded (5 5,060.00)
a 1.2 Fiber optic cable-1 10011 $5,050.00 12/30/2020 12/31/2020 Front Loaded $ 4,640.00
O 13 Pull cable 1003 $5120.00 01/01/2021 05/31/2021 Linear $540.00
a 1.4 CCTV devices 1004 $1,600.00 12/01/2020 03/31/2021 Custom curve 1 $10.00
a 15 Terminations 1005 $1,000.00 12/01/2020 05/15/2021 Bell Shaped $10.00
(] 16 Light poles 1006 $11,000.00 12/01/2020 03/31/2022 Custom curve 2 $10.00
O v Indirects 1008 $305,000.00 Linear $0.00
a v 2] Staff 100 $ 305,000.00 Linear $0.00
- 211 PM 1007 3 100,000.03: Linear $0.00
] 212 PE 1009 $85,000.00 Linear $0.00
a 213 Super 10m $120,000.00 Linear $0.00
O 3 Staff training 1012 $5,500.00 Linear $0.00
O 4 Craft training 1013 $17,500.00 Linear $0.00
O 5 ST&S 1014 $ 45,000.00 Linear 5000
Subtotals 64 $ 431,790.00 $150.00

9.24.4.2 Default to project start and end dates

The next option is to default to the start and end dates. On the project details page you define all the
project start and end dates. After those are defined, then we can default all of those missing start and
end dates to just the project start and end dates.

9.24.4.3 Populate missing dates manually

You can also return to the Time phased budget step and manually populate the missing dates. If you
choose this option, the budget setting turns off again (if it wasn't already turned off and on again in
previous sections). You then have to go into the CBS and manually enter all the start and finish dates.
Then, you could turn the budget setting back on and it should distribute the budget.

Time-phased budget data currently can only be seen in the CBS contract adjustment.

For more information about settings for tim- phasing budget, see Time-phasing.

9.24.5 Time-phased budget in contract adjustment

From the CBS, select cost items to adjust in the contract adjustment.
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3 CBS position Description WBS phase CB total cost Start Finish Cost curve Pending
code budget cost

O v Electrical devices 1000 §$48,790.00  01/01/2020 03/31/2022 Linear §150.00
1.1 Install conduit 1002 $2502000 01/01/2020 07/30/2021 Back Loaded ($ 5,060.00)
1.2 Fiber optic cable-1 10011 $§505000 12/30/2020 12/31/2020 Front Loaded $ 4,640.00
1.3 Pull cable 1003 $5,12000 01/01/2021 05/31/201 Linear $540.00
q\ 1.4 CCTV devices 1004 $1,60000 12/01/2020 03/31/2021 Custom curve 1 $10.00

Then select the Actions drop-down, hover over the budget move and contract adjustment and then
select Contract adjustment.

Actions = ‘2; ®

v
' ybal forecast method

Set forecast method Description WBS phase
- | code

Time phased forecasting

Electrical devices 1000

. Claim multiple CBS quantities Install conduit 1002
n

Budget move and contract adjustment »
Budget move

; Unlock budget
Budget quantity and man hour adjustment

Sync » _
Contract adjustment @

In the contract adjustment, there is an area called Change order attributes. This area lets you set your
change orders/contract adjustment to the following:

o Start date
¢ Finish date

e Costcurve
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o Details

Choose your Contract adjustment workflow

Start with Cost items
@ Enter markup and fees on cost items to generate pay item price

Start with Pay items
Adjust pay item price before adjusting cost item budgets

Change order attributes
Start date Finish date Cost curve

2020 hd December 2020 hd December Linear hd

Contract adjustment details
Issue # cco

Cost Curve can be adjusted in many ways. If you select Bell Shaped the cost adjustments increase
during the summer months and then decreases in the winter months.
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Cost curve

Linear b

Linear
Front Loaded

Back Loaded

Bell Shaped @

Custom curve 1

Custom curve 2
ﬁ
In step 3 of the contract adjustment, the Time phased budget step can be used for both Start with Cost

items work flow and the Start with Pay items work flow. You can adjust your time phased budget in
either contract adjustment work flow.

The only time your time-phased budget should change is when you get change orders and you
have to change your overall budget amount.

For the Start dates, you cannot put budget in the past. If you try to select a month that has already
passed, you will get an error stating Start date must be in an open fiscal period.
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Change order attributes

Start date Finish date Cost curve

2020 hd 2021 v December ¥ Linear v

Start date must be in an open fiscal period

Finish date has to be greater than your start date otherwise you get the following error.

Finish date Cost curve

2020 - December * Linear -

Finish date cannot be earlier than start date

Move onto step 2 Cost Items. You can add Adjusted CB total cost. In this example we are adding $100
to each cost item.

e Cost items

@ ® E Assign costto ¥

CBS position Description WBS CB total cost Adjusted CB Markup
l phase total cost %
code

/ Unassigned cost items

O 12 $100.00
0O stall conduit 81

O 13 T P
0O 14 $100.00
0O 15 Terminations 1005 $100.00
16 Light poles 1006 $11,000.00 $100.00

In the Time phased budget step, the 100 dollars now has to be distributed. Scroll over to the
Distribution type column.

In step 3, only TERMINAL cost items will be brought into that grid. Non-terminal cost items do
not show on the Cost items grid of the contract adjustment.
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. cBS Description
[ position

° Time phased budget

Cost Distribution CB total

curve type cost

November 2020

9.24 Time-phased budget

December 2020

Cost Adjusted cost

$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

There are three different Distribution types:
» Change order (default setting)
» Costltem
e Manual

When Distribution type is set to Change order, it means it is pulling in the start date, finish date, and
cost curve from the details step of your change order.

The changes to the Adjusted total cost column are then distributed throughout the start and finish
date and shows in the Adjusted Cost column.

If your cost curve was set to linear, roughly the same amount of cost goes into the same fiscal period.
Since some months are longer than others, they will have additional cost.

_ ces Description wes

9.24.6 Time-phased budget at the budget move

o Time phased budget

Distribution October 2021

e Cost Adjusted cost

$9.62
$9.62
39562
$9562
$962
$9.62

§$0.00

November 2021
Adjusted cost

© 6 0 v o o
SN NN N~

Dec 2020 - Dec 2021 ~

Cost

t

View Cost column @)

December 2021
Adjusted cost

SN NN N
&

Time-phased budget is included for both the non-associated and associated budget move.

The total adjusted CB total cost must be zero before you can move budget. This shows as a net zero
budget adjustment when you are moving budget from cost items to other cost items. You can also

move the time-phased budget.

You can set the start date, finish date, and cost curve for the budget move change orders.
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o Details

Choose your Budget move workflow

Associated

Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated

!, Define budget moves freely 1o provide the most flexibility

Change order attrnibutes

Start date Finish date oSt curve
2021 - April b 2021 - December Linear i
Budget move details

Issue & CCO

The Time phased budget step is similar to the Time phased budget step for Contract adjustment. The
distribution type on this step is where you can select to distribute by the change order attributes or the
cost item attributes. You can also manually adjust your cost.

Change register Budget Move
o Time phased budget =
g $000 b 2021 - Aug2021 v View Cost column @)
ces Description wes Stant Finish Cost curve Distril February 2021 March 2021 Apil 2021
position orond WP comt Cost Adjusted cost Cost Adjusted cost Cost
$000 5000
[0 5000
[

» »

Cancel Draft Back | m
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When you adjust the budgeted cost either through a contract adjustment or a budget move, you can
adjust the cost over the different fiscal periods and decide where to place the adjusted cost.

9.24.7 Time-phased budget grids

In the left side gird, you have many of the cost item details in columns. This includes the following

columns:

CBS position
Description

WBS phase code
Start

Finish

Cost curve
Distribution type

CB total cost
Adjusted CB total cost

Pending budget cost: any outstanding budget cost that has not yet been approved. For
example, if you have another pending contract adjustment, it adds those values in this
column.

Phased budget cost delta

CBS Description B total Adjusted CB Pending — Phased budget
position bst total cost budget cost _y cost delta

InEight Inc. | Release 26.5 Page 485 of 632



9.24 Time-phased budget Control User Guide

You can adjust the amount of columns you see using the slider to move between the left side grid and
the right side grid.

The right side grid shows your cost and adjusted cost columns. Your cost columns show current cost
that has been approved.

For example, in the CB total cost column, if you have $1,000 approved, the cost columns for each

month distributes that cost throughout each month.

@ 7 phisea budoe =

$000 Dec 2020 -Dec 2021+ View Costcolumn @)

o
]
&
o

=

CB total Adjusted CB December 2020 January 2021 February 2021 March 2021
cost

Roeition e Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost

$0.00 $962 $7
§0.00 §9.62 §7.69
$0.00 $962 $T
$0.00 $9.62 $769
$0.00 $962 $769
$0.00 $9.62 $7.69

80000 0

9.24.8 Changing Distribution type to cost item

You can change the auto distribute type to Cost item if you want your adjusted budget to use
attributes from the CBS.

To do this, you can select one, many, or all of your cost items in the left side grid, and then click on the
auto distribute icon. Then select Cost item.

[x] Auto distribute adjusted budget based on
cost curve and start/end dates

Change order escipuon Start

&

Cost item

(< < < < 4
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Your Distribution type has changed to cost item. You are now distributing your adjusted budget based
on the cost item attributes that are pulling in from the CBS.

CE
CBS Description Finish Cost Distribution CB total
position curve type cost

This also changes how the Cost curve distributes the adjusted cost. As you can see from the screenshot
above, some cost curves have been adjusted.

9.24.9 Manual distribution of cost adjustment

You can change a specific cost item's cost adjustment to zero and then manually redistribute that
zeroed cost to other months. If you do not distribute the cost to other months, the following missing
amount for the adjustment cost is highlighted in orange.

$40.00 Dec 2020 - Dec 2021 ~ View Cost column (@)
December 2020 January 2021 February 2021
Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost Cost
$10.00 @ $50.00 ® T {
$0.00 $100.00 5$0.00
$0.00 $19.87 $18.54
$20.46 $27.55 §22.04
$1.44 $18.80 $38.78
$5.35 §7.20 $5.76

After redistribution, there are some manual indicators showing what the value was before the change.
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Start Finish Cost December 2020

ost Adjusted cost
$10.00 ®

$0.00

$0.00

$20.46

$1.44

I $5.35

Control User Guide

February 2021

Cost Adjusted cos Adjusted cost

$50.00 ®

Cost
Value before: $0.00
$100.00 $0.00
$19.87 $18.54
$27.55
$18.80

§7.20

$22.04
$38.78
§5.76

The warning indicator on the cost curve column lets you know that your cost item contains manual
time-phased months and is not technically back loaded anymore.

Finish Distribution
type

Cost
curve

N

Cost item contains manual time phased months

9.24.10 Deltas in a adjusted cost columns

Deltas appear on a contract adjustment when the adjusted cost for a cost item does not match the
current budget total cost.

You are not allowed to submit or approve a cost item adjustment that has a delta.

That is where the phased budget cost delta column displays any missing or over budgeted costs for
any one cost item.

This column sums up all of your adjusted cost in the right side grid and compares it to the Adjust CB
total cost.

For example, if you have $10 not distributed, you need to add it to the adjusted cost in that same cost
item before moving onto the next step. If the current budget total cost has $100, you must spread that
total cost amount throughout your months.
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$10.00 Dec 2020 - Dec 2021 + View Cost column
Adjusted CB Pending Phased budget December 2020 January 2021 February 2021
e Ridyeicest sele s Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost
h $000® $5000 @ $4000 @
$0.00 $100.00 $0.00

Hovering over the delta warning in the right side grid shows where the error in cost is occurring. If you
have multiple deltas in different cost items, the delta cost would then sum up all delta costs.

5]?-00' Dec 2020 - Dec 2021

= -

= brua
Phased budget cost delta.

Budget must be allocated before the change order
can be submitted or approved.

o TLFLF LS

If you attempt to submit or approve the contract adjustment with deltas and you return to the Time
phased budget step, the Phased budget cost delta column shows which cost items have a delta. You

need to resolve the deltas and redistribute the costs in the Adjusted cost columns in the right side grid
before moving forward.

$20.00

il CBS Description Adjusted CB Pending Phased budget December 2020 January 2021

( position total cost budget cost cost delta Cost Adjusted cost Cost Adjusted cost

O $10.00 $000® $5000 ®
O 10N $1000 @ $100.00
0 Undistributed budget remaining $0.00 $19.87
O $20.46 $2755

You can also adjust your delta costs using the same Auto distribution button from earlier and selecting
Change order. Change order always distributes without a delta.
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me
[ x

P

hange orger

Cost item
[ |

Now you can submit and approve your contract adjustment. All those values are going to be
committed into your time-phased budget.

For example, if you sync into your ERP, you can receive all changes made in the contract adjustment
right after those changes have been approved.

9.24.11 View cost columns

If you want to view just your adjusted cost columns, select the View Cost column slider to turn off your
cost columns. Only the adjusted cost columns shows. These columns show what you are adjusting in
the active project months for the contract adjustment.

$0.00 Dec 2020 - Dec 2021 = | View Cost column (@)

December 2020 January 2021 February 2021 March 2021 April 2021 May 2021 June 2021 July 2021
Adjusted cost Adjusted cost Adjusted cost Adjusted cost Adjusted cost Adjusted cost Adjusted cost Adjusted cost

$0.00 $9.62 $7.69 $7.69 $7.69 $9.62 $7.69 $

$0.00 §9.62 §769 §7.69 §7.69 §$9.62 §7.69 5}

$0.00 $9.62 $7.69 $7.69 5769 $9.62 $7.69 $

$0.00 5$962 $7.69 §$7.69 §769 Ib $962 $7.69 -

$0.00 $9.62 $7.69 $7.69 $7.69 $9.62 $7.69 $

I $0.00 §962 $769 §$7.69 $7.69 $9.62 $769 S

9.24.12 Date range filter

The date range filter lets you filter the right side grid to show only the months you want to see. You
can view the project months based on the following options:
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This month (current fiscal month you are in)
Next 3 months

Next 6 months

Next 12 months

Through project finish date

$0.00 Dec 2020 - Dec 2021 - View Cost column (@)

t  Timeframe

This month Next 3 months Next 6 months m Through project finish date

From December 2020 * To December * 2021 v

Show months

You can also manually select the months you want to view using the Show months drop-down lists.

9.24.13 Approving budget warnings

You can't approve budget set in the past. If you have any adjusted cost set for the current month
(December) and the contract adjustment is approved in the next month (January), the approver
receives a warning stating you have budget in past or closed periods.

The contract adjustment can still be approved, but the adjusted cost from the closed month moves to
the following month.

The other option the approver has is to revise the adjusted cost. When revising, the adjusted cost from
December has already moved into the adjust cost column for January. If you do not want all of the
previous month added into a single month, you can manually move the additional adjusted cost from
January into the other open fiscal period months.
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CHAPTER 10 — SCHEDULING

10.1 SCHEDULING OVERVIEW

You can use features in Control to track schedule dates at a CBS level. The ability to easily add and
modify this information allows you to accurately track your operations planned and completed dates.

The schedule data can either be mass imported through a Microsoft Excel upload, created and
modified directly within the CBS, or by way of Primavera schedule integration through and XER file
import.

10.2 SCHEDULE DATA BLOCK

The schedule data block is where all information regarding schedule dates is contained. Some of the
key fields inside this data block are:

e Schedule ID

e Planned Start Date
e Planned Finish Date
e Early Start Date

¢ Early Finish Date

e Late Start Date

e Late Finish Date

e Actual Start Date

e Actual Finish Date

You can add and edit this information directly inside the Schedule data block. However, this will only
allow you to modify one CBS line item at a time.

The following Step by Step shows you how to add the Schedule data block, save a Scheduling view, and
add various dates for a specific CBS item.
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Schedule Data Block

1. From the Workspaces page of the Steel Structure Job, remove each data block from the page,
except for the Tasks and Task Details data blocks, by right clicking on the context menu.

-
Current budget {ese ) :
GB total CB total MHrs CB total cost GB MHrs/Unit GB UnityMHr CB unit cost
guantity
= 1.00 0.00 $ 250,000.00 0.00 0.00 % 250,000.00

1A AAn An LEL TS A& annon o Aan 1 An A an nn

2. For each data block you plan to remove, select Remove Data Block

Choose columns
Filter

Save data block as. .

Remove data block

3. Once the data blocks are removed, click the Add Data Block button.

El O m & & = Q
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4. Drag and drop the Schedule Data Block to the right of Task Details.

e)] Steel Structure Job (105091) - Control e

CBS ACS PAY ITEMS CHAMNGE REGISTER

Actions @

Add data block T Tasks i ll Taskdetails < eeee> H
[ -
CBS position Description Resource Forecast UoM
Standard data blocks (T/0)
quantity

.00 ! Lump Sum

Earthy

1000000 Y

Earthwork Review ] 100 Each

Schedule i
Cost category data blocks 22 Earthwork : 5 1000000 CY
_ Structural Steel 100000 Ton
41 Erect Steel - Heavy : 5 350.00 Ton
42 Erect Steel - Light : 5 20000 Ton
5. Select Module [your initials] — [description.]
Tasks i [l Taskdetails < eese> i l Schedule {eee >
CBS position Description Resource Forecast Uoh Scheduled Roll up Schedule WBS Schedule ID Schedule plug Plug days
(1/0) schedule days
quantity
.
42 Erect Steel - Light =5 200.00 Ton : HD.0000105 50,00
43 Bolted Connections : 5 2,000.00 Ea : HD.0000106 1250
1
i

D a4 Module 01 - Erect Steel Heavy 1a 80000  Ton

6. Inthe schedule data block, type your Initials.01234 in the Schedule ID field.

Schedule

Schedulad Roll up Schedule WBS Schadule ID
schedule
} SH.01234
1
1

7. Click the right arrow to move to next set of columns in the schedule data block.
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Schedule ¢ ona )

Scheduled Roll up Schedule WBS Schedule ID
schedule

8. Double click into each field and enter the following:
e Start =10/05/2020
e Finish =10/15/2020
e Early Start =10/01/2020
* Early Finish = 10/15/2020
e Late Start =10/07/2020
 Late Finish = 10/15/2020

Schedule

Finish Early start Early finish Late finish

10/05/2020 10/15/2020 10/01/2020 10/15/2020 10707/ 2020 10/15/2020

¢ Entering dates on any terminal CBS item will auto-populate the parent’s dates. If there are
multiple terminal items under one parent, any start dates will take the earliest and any
finish dates will take the latest

¢ Once all the initial schedule dates are entered, the schedule data block also allows for the
project to track actual dates

9. Click the Right Arrow to move to next set of columns in the schedule data block.

¢ You will leave these columns blank for this Step by Step

Schedule {oee}

Actual start Actual finigh
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10.3 SCHEDULE EXCEL IMPORT

The Control application allows for an Excel import to import data into the Schedule data block. This is
especially useful when bringing in large sets of data for multiple CBS items.

Excel imports can sometimes 'hang' while attempting to import CBS data. If this happens, it's possible
to cancel an Excel import while the system continues the attempt to import the data.

The following Step by Step covers downloading this Excel sheet, entering the necessary data, and
importing it back it into Control.

Excel Import

1. From the Workspaces page, using the Schedule view on the CBS tab, click the Export button,
then CBS as CSV.

E 9 m B || I Q

Export:
-
CBS as CSV

cfinal Forecas 1al Forec
MHrs produ

fact
Schedule as XER 2=

0.00 0.00

¢ This creates a CBSDataBlock folder in your Downloads folder

2. Open the CBSDataBlock.csv file.

Subtotals 44

i 201 8 InEight Inc. Privacy and Terms | v 183

B cesDataBlock (3).csv = A

3. Inside the Excel spreadsheet, delete all rows except for Module [your initials] — [description].
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s %Cut P

Control User Guide

B Copy - Calibri 11 | A A == | - | E¢WrapText General
F‘a'ste ~ Format Painter B I U-[&-|[d- A-|SE==|E=E Merge&Center T 8% | F(;Dr:ﬂd;:tlrr:
Clipboard [P Font [P Alignment [P MNumber [P
B11 v J
A B C D E F G H
1 |CBS position Description Resource Forecast (T/O) quantity UoM Change status Allow as-bu
2 4.4 Module 01 - Erect Steel Heavy | 3 800 Ton All
3
4
5
6
4. Enter the following:
e Actual Start =10/03/2020
e Actual Finish =10/12/2020
AB I AL AD AE
Late finish JActual start Actual finish | Cost curve
10/14/2020 |10/03/2020 10/12/2020 |Linear

5. Save the file to your computer (as .xlsx, .xls, or .csv).

6. From the Control > Workspaces page, click the Import button for Cost Items.
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D o (B B IE Q

Import:
O 10/21/2019
inal Fore Cost items Forecast
rem method

Actuals
3,504 089.00 00 Current estimate

Schedule
SD S 669.03 ——r 00 | Current estimate

7. Click Browse to select your Excel file.

Import CBS data

Import from Excel (_xlsx, x1s) or Comma separated value (_csv)

Drag and drop the file here or browse

Browse._ .

8. Select Cost Items and cost item attributes, Update Existing Items and CBS position.
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Options

*Impaort type

IEI::st items and cost item attributes - I
| ® Update existing and new items |

Cost item matching criteria

| CBS position v |

Update existing items

MNew items

9. Click Next.

=

10. Next, you will map which columns from the Excel sheet get imported to which columns in
Control. Click on CBS Columns to sort A-Z.
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Map columns

Order

CBS columns

Actual finizh

Actual start

CBS columns

User defined &

User defined 7

User defined 8

WES client code 1

WRS client code 2

WEBS phase code

13. Click Next.

InEight Inc. | Release 26.5

Data type

Mapped

12. Do the same for WBS Phase Code.

Mapped

10.3 Schedule Excel Import

Template

Actual Start/Finish

CBS columns

Mapped

File columns

Actual finish

Actual start

File columns

Blank-do not import

Blank-do not import

Blank-do not import

Blank-do not import

Blank-do not import

WEBS phase code

File columns

B ®

Under File Columns, match Actual Finish and Actual Start to the CBS columns description.
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Cancel MNext

e The actual dates you specified import into the Schedule data block

CBS ACS PAY ITEMS. CHANGE REGISTER AUDIT LOt

wions + @ £ ®

CBS Description Resource Forecast UoM Actual start Actusl finish Cost cun
position (T70)
quantity
1 Job Overhead 100 Lump Sum
2 Earthwork 5 1000000 CY
3 Concrete 5 1000000 €Y
N structural Steel 1,00000  Ton 10/03/2020 10/12/2020
a0 Erect Steel - Heavy 6 80000 Ton Linear
42 Erect Steel - Light 5 20000 Ton Bell Shay
43 Bolted Connections 5 200000 Ea
2 11 Module 01 - Erect Steel Heavy 35000 Ton 10/03/2020 10/12/2020

The Excel import can only be accomplished if the Control > Settings > Schedule setting is
set to Manual Entry.

PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE

Define project schedule

Schedule data source:

Manual entry -

Manual entry

XER file type

O T e S T Da S e e g o GUr T e S eI e e SO ST
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10.4 PRIMAVERA SCHEDULE INTEGRATION

The XER (file extension used by Primavera containing project file related data) import functionality
allows the milestones and schedule dates (baseline and current) to be integrated into planning
activities. Schedule IDs in Control are used to map Primavera Activity IDs to import and export the
project information. The status of construction activities and progress are then integrated back into
the InEight scheduling tools.

The Primavera schedule integration not only allows for XER file import of schedule dates but is also
capable of a cost item bi-directional push and pull between Control and Primavera. XER imports
integrate critical milestones and schedule dates into planning activities in the InEight cloud platform.

It's also possible for you to map the existing Control 25 CBS tag fields, and also the existing 15 user
defined fields to P6. Conversely, you can create new fields in P6 based on tagging scheme. This allows
you to filter Primavera and Control in similar ways, with the same sets of dates within both
applications.

You also can push (Physical) % complete to P6. As you are progressing in Plan or Progress, and as
guantities drive the percent complete in Control, it’s possible to push the percent complete back to the
associate activity in P6.

10.4.1 Primavera Schedule Integration Settings

The setting to change the schedule data source to Manual entry or an XER file type is in Settings >
Control > Schedule > Define project schedule.

Under the Schedule data source, it’s possible to manually enter schedule dates, or you can utilize the
XER file type.

Define project schedule

Schedule data source:

XER file type hd

Manual entry =——jp Option 1
XER file type 3 Option 2
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After selecting your Schedule data source, you will have the option of making sure that your schedule
IDs are similar across your baseline and current schedule.

Duplicate field values for Baseline and Current schedule columns:
#| Schedule 1D and Baseline schedule 1D
#| Scheduled and Baseline Scheduled
Schedule WBS and Baseline schedule WBS

Roll up schedule and Baseline roll up schedule

If you uncheck one of these options, and then check it back, you will be given the option to copy
existing Schedule ID column values to Baseline schedule ID column, and vice versa. This is a way to
ensure that data consistencies remain in check for both baseline and current monthly schedule.

X

Select one:

# Copy existing Schedule 1D column values to Baseline schedule ID column

Copy existing Baseline schedule ID column values to Schedule ID column

o)

Under Percent complete, you can either update the XER file with physical percent complete from
Control, or not.

Under the second dropdown for Update XER activities, you have the option to update XER with tags
and user defined fields from Control, or not to.

Update XER activities with cost item tags and user defined fields from

Percent complete: Control:
Do not update percent complete - Do not update tags or user defined fields -
Update XER with physical percent complete from Control Update XER with tags and user defined fields from Control
Do not update percent complete Do not update tags or user defined fields
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10.4 Primavera Schedule Integration

If you choose to update XER with tags and user defined fields, the Define tags and user defined export

rules table appears. The 3 options to choose from are to match using Control field name, match using

external system field name, or do not export.

If you choose to map to an external system field (as shown below using Tag 15 for the second record),
you will need to manually type in the name of the field first. Because this is not an API, the system is

not aware the existing fields within P6. Therefore, you need to self-determine which Control values

you want to populate in P6.

Percent complete:

Do not update percent complete

Define XER tags and user defined export rules:

Update XER activities with cost item tags and user defined fields from

Cantrol:

v Update XER with tags and user defined fields from Control >

Column names in external scheduling system must be an exact match. If the specified name does not have a match with the external system, then a new

column will be added at the project level.

Match using External system field name w

Match using Control field name
Match using External system field name

Do not export

EN_CES tag 8(CBS tag 8)

EN_CBS tag 17(CBS tag 17)

EN_CBS tag 19(CBS tag 19)

EN_CBS tag 25(CBS tag 25)

EN_CBS user defined 6(CBS user defined 6)

EN_CBS user defined 12(CBS user defined 12)

EN_CES tag 4{CBS taq 4)

EN_CBS tag 10(CBS tag 10)

EN_CBS tag 15(CBS tag 15)

Export Rule

Do not export

Match using External system field name

Match using Control field name

Do not export

Do not export

Do not export

Do not export

Do not export

Do not export

Do not export

-

L]

*External system field

Tag 15

EN_CES tag 17(CBS tag 17)

10.4.1.1 Primavera XER Schedule Integration Prerequisites

1. XER file type or manual entry must be selected in Settings > Control > Schedule, in the Schedule

data source section.
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PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE OTHERS

Define project schedule

Schedule data source:

XER file type v

Manual entry

XER file type

2. On the Schedule data block, the Scheduled column must be checked prior to importing a

schedule.
Schedule Ceoe >
Scheduled Schedule Plug days Start Finish
ID plug
days
4 PS1 v 21,682.50 07/18/2019 07/18/2019
L4 Ps.2 L4 0.00 07/18/2019 07/18/2019
L4 XYZ L 0.00 07/18/2019 07/18/2019

3. The Schedule ID in Control must match the Activity ID in the XER file.

Schedule TR
Scheduled Schedule Sched Plug days Start Finish
ID plug
days
4 PS1 v 2168250 07/18/2019 07/18/2019
s PS.2 v 0.00 07/18/2019 07/18/2019
4 XYZ 000 07/18/2019 07/18/2019

The following steps walk you through how to import a Primavera .XER file into Control.
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10.4 Primavera Schedule Integration

Schedule Integration Import

1. From the CBS tab of the Control Workspaces page, select the Import icon on the top right menu
bar, then click Schedule.

Sy o |B] B 1= Q

Import:
oo >
lle WBS Schedulel Costitems 5chedule plug Plug
lays

Actuals/ -
v

Schedule
v
v

2. A warning message appears asking if the XER Activity Ids and Control IDs match. Click Yes if both
IDs match before continuing.

X

Do XER Activity IDs and Control Schedule IDs match?

xer activity IDs must match a Control schedule ID in order to map a
schedule activity to a cost item.

Do not show this warning again Close Yes

3. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.
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Import schedule data

Import from schedule (.xer)

Drag and drop the file here

Browse

Maximum upload file size: 50 MB

Options

Baseline schedule
A fixed project schedule that is the standard by which project performance is measured. and a reflection of all formally authorized scope and schedule
changes. After importing a baseline, you can import a current schedule and derive some key performance indicators (KPI's).

® Current schedule
A schedule update, which reflects progress to date, plus forecast progress going forward and is used for monitoring. Schedule data can be mapped to
domain data such as Control cost items to derive cost based schedules, and time phasing, for example.

4. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.

5. Select the desired .XER file that was generated in Primavera.

» Once the .XER file is uploaded, the Browse box turns green

Import schedule data - Activity ID file xer

Import from schedule (xer)

Drag and drop the file here

Browse

Maximum upload file size: 50 MB

6. In Options, select either the Baseline schedule or Current schedule for the schedule type that
you want to import.

|Option5 |

Baﬁe\ine schedule
A fized project schedule that is the standard by which project performance is measured. and a reflection of all formally authorized scope and schedule
changes. After importing a baseline, you can import a current schedule and derive some key performance indicators (KPI's).

® Current schedule
A schedule update, which reflects progress to date, plus forecast progress going forward and is used for monitoring. Schedule data can be mapped to
domain data such as Control cost items to derive cost based schedules, and time phasing, for example.

7. Select Next.

8. Select Import after reviewing the Schedule summary.
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Import schedule data - Activity ID file.xer

Schedule summary

Schedule name

WSFN Shoreline Protection

Total schedule records
Schedule WBS

Schedule activities

(0

10.4 Primavera Schedule Integration

Schedule type

Current schedule

107

306

i) Import may take some time. You may continue to make changes to your project while the import is processing

¢ The Importing data process screen displays the current status for each step of the .XER

data import.

Processing schedule data import - Activity ID file.xer ("3058™ OPG WSFN Shoreline Protection-A00131-1)

Importing data

Step

Step 1: Preparing data to be sent

Step 2: Placing data in queue

Step 3: Writing data to master library

Step 4: Sending data to project

Step b: Mapping master data to project data

Step 6: Inserting data to project tables

)

Status update is also avaliable in the Import history

Status

° Complete

O Processing - 1mins

O This may take some time. You may continue to make changes to your project while the import is processing.

e If there are errors in any of the steps, you can click on the Pending unmapped items found

link to make the corrections
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Importing data

Step Status

Step 1: Preparing data to be sent o Complete

Step 2: Placing data in queue @ complete

Step 2: Writing data to master library o Complete

Step 4: Sending data to project o Complete

Step 5. Mapping master data to project data | Pending, unmapped items found

Step 6: Inserting data to project tables

¢ You can also navigate to Audit Log > Import history to view the import status, which
includes the Total line items imported

File name Status Processing TotalTine Errors Total Added Added pay Created by Created
Details items imported estimate items dat
resources
NEWPROJ.xer (D... @ Complete All steps 18 0 19 0 0 Asmita Ray 08/02/2019 100

9. If there are corrections to be made, once completed, you can select Import to re-import the
data.

Auditiog > Importhistory > Activity ID file.xer ("

Status details Schedule details Cost item details
Map status XER activity ID Control schedule ID Description CBS position Description WBS phase ‘Scheduled
code
No match found HD.0000003 1 Job Overhead 1002
No match found HD.0000019 2 Earthwork 1069
No match found HD.0000044 3 Concrete on

10. When the import is successful, select the Close button.
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Processing schedule data import - NEWPROJ .xer (Duplicate-NEWPROJ)

Importing data

Step Status

Step 1: Preparing data to be sent o Complete
Step 2: Placing data in queue 0 Complete
Step 3: Writing data to master library Q Complete
Step 4: Sending data to project 0 Complete
Step 5: Mapping master data to project data o Complete
Step 6: Inserting data to project tables ° Complete

This may take some time. You may continue to make changes to your project while the import is
processing

Status update is also avaliable in the Import history

x Job ended successfully.

e Check the Control: Schedule block for newly imported scheduled dates

e This is a quick audit to make sure that the desired Primavera dates imported successfully

.
Tasks : @ Schedule
CBS position Description Scheduled Schedule ID gchedule plug Plug days Start Finish
[ jays
~1 Financial Results A_ 4 PSS ¥4 2168250 | 07/18/2019 07/18/2019
AT 10 - Commercial C. 4 Ps2 ¥4 0.00 | 07/18/2019 07/18/2019

1.1 Dependent G&A 4 XYz 0.00

07/18/2019 07/18/2019

The following steps walk you through how to export a Primavera .XER file from Control.

Primavera Schedule Integration Export

1. From the CBS tab of the Control Workspaces page, select the Export icon on the top right menu

bar, then click Schedule as XER.
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2. Assuming you have Percent Complete and User defined Fields and tags turned on in your
settings, click Export.

e Depending on what you’d like to export, you can always uncheck undesired options

X

Export with the following fields:

¥| Percent complete

# User defined fields and tags

e After selecting Export, an XER file will generate and be placed within your C:/Downloads
folder. The file will be named <job name>(Schedule).xer

e

) 103442(5chedule).xer -

¢ At this point you are ready to import the XER file into Primavera

10.4.2 Percent Complete column updates in CBS

If you are progressing your schedule in P6, it's possible to import this progress data directly into
Control using the Schedule Integration Import process. The % Complete column records within the CBS
can receive updates from the P6 XER file. The XER file can originate from Primavera or InEight
Schedule. As long as the % Complete data is captured within the XER file, it will update the CBS with

this new schedule information.
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Tasks : B Actuals [EEESEN to REEEED O
% CBS position Description WBS phase Schedule ID % Complete Qty complete
code (to date)
1 Financial Results An.. | 1000 PS.001 0.45% 0.00 10/01/2019 08/25/2020
1.1 INDIRECTS & UNASS.. 1001 PS.002 0.76 % 0.01 10/01/2019 08/25/2020
1.1 Commercial Cost 1002 PS.003 230% 0.00 10/01/2019 10/15/2019
1111 Direct Pickup 1016 PsS.013 100.00 % 3050 10/01/2019 11/29/2019

By not using this feature, the % Complete column updates from P6 will not populate the % Complete
column within Control. You would need to update the CBS with the % Complete or claimed quantity via
other methods for completing progress measurement which are addressed in the Progress
Measurement & Forecasting User Guide.

This feature allows for the Schedule Import process to align the P6's schedule % complete with the cost
item's % Complete.

After running the Schedule Integration Import process, you can check the CBS and verify the progress
results in the % Complete column.
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CHAPTER 11 — ACCOUNT CODE
STRUCTURE (ACS)

11.3 Account Code SEIUP ... 516
11.3.1 Staging vs. Published AccountCodes ... 517
11.3.2 Account code PErmMISSIONS ...t 523

11.4 Measurement tYPeS ... 532

11.5 Cost category label customizations ... ... 533

11.1 ACCOUNT CODE STRUCTURE
WORKFLOW

Estimate

Historical Benchmarking

Confrol

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage

Cost Items
Define Qty Account
Analyze Planned
Earned and Actual

Live
Forecast

Forecasts

WBS Structure / Budgeted
Quantities & Hours

ed ch
’3,‘,’5;’?: cU:,;,”f;:dgef Revenue Management

Billed Revenue

Change Management Y|
Change Register Pay Item Register
Budget Move Create/Manage
Pay Items

Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment

Contract

Adjustment Track Billed Revenue
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11.2 WHAT IS AN ACCOUNT CODE?

Account Codes serve as a standardized coding system to track like operations across a company, for
the purpose of global reporting and benchmarking. Account Codes typically follow a hierarchical
structure which allows for summary level reporting rolled up to company standards, but can also be a
flat list.

Account Codes are assigned to cost items similar to a tag on a cost item. Once an account code has
been assigned to all terminal cost items you can view many project and organization reports organized
by the account code structure, rather than individual project cost break down structure which often
differs from project to project. Account Codes can also tie back to InEight Estimate where estimators
can assign the same standard set of account codes to estimate items, and compare them to active or
completed projects for historical benchmarking.

11.3 ACCOUNT CODE SETUP

The master set of account codes is created and stored under Master data libraries > Account Codes.

Steel Structure Training Job (105091) - Project home ~

Favorite projects & organizations Master data libraries

C-xXYZ >
Account codes Units of measure
Cost centers Vendors
Currencies

Custom labels

Disciplines and commodities

Manage favorites
Field attributes

All projects & organizations
Operational resources

() Report >
Qualifications
(%) Explore >
Revenue categories
Master data libraries >
Unions
Suite administration ?
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11.3.1 Staging vs. Published Account Codes

The Account Codes master data library contains four tabs: Published, Staging, Audit Log, and Import
Log.

@ Master data libraries - Account codes v

PUBLISHED sTaciNG €D AUDIT LOG IMPORT LOG

Account code Description UoM primary Currency

00 Overhead PLS US Dollar
00.00000000 00000000 DES-1 PLS US Dollar

00.00000000.MRTER O MRTER 0 PLS US Dollar

¢ The Published tab lists all account codes that have been created and published under the Staging
tab.

e Under the Staging tab, you create and edit account codes, and then publish them for use.
Account codes are not available for use in projects until they are published

¢ The Audit Log tracks changes made to the Account Code Structure, including the value before
and after, the changed date, and who made the change

¢ Under the Import Log tab, you can track the status of all the account code import processes.

¢ When you hover over the Failed with errors imports, a pop-up will provide a brief import
status, along with next steps

e Under the pop-up, there is a down facing blue arrow where you can download a detailed

error log
Failedwitherors 1 0of1  JothiT 07/15/2019 2:15:43 1
| AccountcodeErrorlog07302019085118 - Notepad - m} X

Failed with erroff )
File Edit Format View Help

Failed with errolf Import account codes ACS data: AccountCode_67152019891354.x1sx
File import attempted on: 87/15/19 2:15 AM

Failed with erro
The following errors were detected while attempting to import account code
values.

Failed with errolf Review the errors below. Once all errors have been resolved, reattempt the
import.

Complete

) Row 2 Column "Currency”: has issue
Failed with ermoff Error: has invalid datg

0O 0 00 06 0 o

Account codes are typically maintained at an organization administration level to ensure that
categories and codes remain consistent with company standards.

The account codes within the Account Code Structure are arranged into a hierarchy of parent-child
relationships that can contain varying levels of detail, indicated by color, for each level of the hierarchy.
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You can assign account codes to cost items anywhere, from the highest level to the lowest level. The
lower the level assigned, the higher the level of detail associated to the account code.

The example below shows a level 3 account code (50.03.04) acting as a parent to two subordinate
account codes (50.03.04.002 and 50.03.04.004).

Account code Description
50.03.02.004.02 Break - Concrete Paving Removal
50.03.02.004.04 Load out - Concrete Paving Removal
S0.03.04 Paving Milling and Scarification

Paving Milling and Scarification - Asphalt

Paving Milling and Scarification - Concrete

50.03.06 Litility Line Removals - Underground

Litility Line Removals - Underground (<=4" Depth)
50.03.06.002.02 Utility Line Removal (<4' Depth)

50.03.06.002.04 Storm Sewer Removal (<4' Depth)

The following Step by Step walks you through how to create a new account code.

Create an Account Code

1. From the Project home page, select the 1st Level drop-down menu.
2. Select Master Data Libraries.

3. Select Account Codes.
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Steel Structure Training Job (105091) Project home

Favorite projects & organizations Master data libraries

C-XYZ 3
Account codes Units of measure
Cost centers Vendors
Currencies

Custom labels

Disciplines and commodities

Manage favorites
Field attributes
All projects & organizations

Operational resources

(&) Report >
Qualifications
(2] Explore >
Revenue categories
Master data libraries >
Unions
Suite administration >

¢ All the account codes appear on your screen in a hierarchy format

4. Select the Staging tab.

@)  Master data libraries - Account codes ¥
PUBLISHED | STAGING |
Account code Description | UoM primary Currency UoM secondary Auto qty |
_ Overhead - Edit - publish666_edited PLS US Dollar on
00.002 002-Edit_Test-publish PLS US Dollar off

5. Click the check box next to any of the existing account codes.

PUBLISHED STAGING
® = @
Accountcode Descrption Uoh primary. Gurency UoM secondary Auto qty primary
DTS odule Assembly - Erect Stecl Ton US Dollar on 62.03.04 004
62030400402 Module Assembly - Erect Steel - Erect Seel - Liht (0-19 1L} Ton Us Dollar o
62030400104 Module Assembly - ErectStee - Erect Seel - Medium (20-99 /LF) | Ton Us Dollor o o o
I+ 62030400405 Module Assembly - Erect Steel - Erect Steel - Heavy (4078 Io/LF) Ton US Dolar on on orr ]
) 203040040 Module Assembly - Erect Steel - Erect Scel- Extra Heary (30-118 /L) Tan U Dallar o o off

6. Click the Add Account Code button.

InEight Inc. | Release 26.5 Page 519 of 632



11.3 Account Code Setup Control User Guide

ON NE
! Account code Description Uel
_ Module Assembly - Erect Steel Tor
62.03.04.004.02 Module Azsembly - Erect Steel - Erect Steel - Light (0-19 Ib/LF) Tai
62.03.04.004.04 Module Assembly - Erect Steel - Erect Steel - Medium (20-39 |b/LF) Tar
G 62.03.04.004.00 Module Assembly - Erect Steel - Erect Steel - Heavy (40-79 Ib/LF) Tar

¢ This creates a new account code with the code you selected as the parent

¢ In the Account code details slide out panel, the following can be assigned:

I T S

Parent Account Account Code with lower level “child” account codes below
Code it.

Account Code The alpha numeric sequence assigned as the code.
Description Description detailing the account code’s scope.

Currency The currency assigned to the account code.

UoM Primary The primary unit of measure for the account code.

UoM Secondary The secondary unit of measure for the account code.

Auto Quantity Automatically roll up cost item quantities if the cost items and

Primary/Secondary this account code have the same primary/secondary UoMs.
It can also be set on a project specific basis.

Parent Roll Up Controls whether primary or secondary quantities of
Behavior account code roll up to the parent account code’s primary or
secondary quantity.

Account Code Tags that can be associated to account codes to enable
Tag 1-20 them to be categorized.

User Defined Field  Optional open-text fields you can use to add information
1-10 related to the account code.
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The asterisk (*) at the beginning of a tile indicates it is a required field and it must be
populated before the code will be created.

7. Fill in the information below:

e Account code: Your Initials (Since a parent was selected when creating this new account
code, numbering prior to ‘—Your Initials’ will be the parent’s)

e Description: Your Initials — Account Code
e Currency: US Dollar
e UoM primary: Ton

e Leave all other defaults/blanks

Account code details

= Parent account code + Account code

62.03.04 004 06 - Module Assembly - Erect Steel - 62 -User #

|- Description +Currency

Your Initials ~ Account Code USD - US Dollar -

UoM primary UoM secondary

Ton - -

Associated entity roll up behavior

Auto gquantity primary Auto guantity secondary

8. When you have filled out all the information, click Stage to send the new account code to staging
area.

¢ The new account code now exists in the Account Code Structure on the Staging tab

¢ The new account code will not be available for use within projects until it is published
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9. If you have the permissions to publish account codes, check the box for the account code you
created..

10. Click the Publish button in the top-right corner of the page.

You can also edit existing account codes within the Account Code Structure, as indicted in the steps
below.

Edit Account Code Details

1. From the Account Code — Staging tab, select the account code you created.

2. Click the Edit Account Code button.

PUBLISHED STAGING
®

Account code Description UoM primary Currency UoM secont

Module Assembly - Erect Steel Ton US Dollar

62.03.04.004.02 Module Assembly - Erect Steel - Erect Steel - Light (0-19 Ib/LF) Ton US Dollar

62.03.04.004.04 Module Assembly - Erect Steel - Erect Steel - Medium (20-39 Ib/LF) Ton US Dollar

62.03.04.004.06 Module Assembly - Erect Steel - Erect Steel - Heavy (40-79 Ib/LF) Ton US Dollar
ﬁ Your Initials - Account Code Ton US Dollar ]

o 62.03.04.004.08 Module Aszembly - Erect Steel - Erect Steel - Extra Heavy (80-119 1b/LF)| Ton | US Dollar |

¢ The edit account code page opens where changes can be made

Note that only the description, auto quantity primary, auto quantity secondary, parent roll
up behavior, and account code tags can be edited after an account code has been
created. All other items are greyed out and read only.

3. Once you are done editing the account code, click Stage to update the account code.

Page 522 of 632 InEight Inc. | Release 26.5



Control User Guide

11.3 Account Code Setup

Account code details

« Parent account code + Account code

62

= Description + Currency

*Your Initials — Account Code

= UoM primary UoM secondary

Associated entity roll up behavior

Auto quantity primary Auto quantity secondary

\\oﬁ| |‘0ﬁ:‘i

Parent roll up behavior

Contribute primary to primary Contribute primary to secondary

B2 [ o |

Contribute secondary to secondary

] o |

11.3.2 Account code permissions

If you have the required permissions, you can delete, replace, or rename account codes.

11.3.2.1 Deleting account codes

Follow the step-by-step to delete an account code.

in the Master data libraries to the administrative account.

The account administrator does not have permissions automatically assigned to approve
account codes. Your account administrator must add the permission to approve account codes

If you are deleting a parent account code, all children under the parent are also deleted.
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Deleting account codes

1. Go to the Master data libraries and then select Account codes.
2. From the Staging tab, select an account code you want to delete.

3. Select the Edit icon in the upper-left corner.

A Master data libraries - Account codes =
PUBLISHED STAGING AUDIT LOG IMPORT LOG
© Iy
Staged account code changes and requests may differ from current published codes, refer to Published tab for current information.
Account code Description UoM primary Currency UoM secondary
S | o Acre US Dollar
O ‘ 00 DES WD A2k Hour CFA Franc BCEAO Hour
O 00.00000000000001 desrption updated_1324 Test1920- Copy US Dollar TestSep13
] 00.00000000000001.MRTER 0 DES_P PLS US Dollar
0 [GSGG00G00000000 I MRTERDGOIEE) = DES_PDU TestSep13 US Dollar TestSep13
a 00.00000000000001.nandy kendo nandy TestSep13 Unidad de Fomento TestSep13
O 00.00000000000001.Nandy test ACS Nandy Test Acs TestSep13 US Dollar TestSep13
O 00.00000000000001.New nandy May2... New nandy May20th TestSep13 US Dollar TestSep13
O 00.00000000000001.NR_05082019 00.00000000.NR_05082019_DESC Acre US Dollar
O 00.00000000000001.NR1_05082019 00.00000000.NR1_05082019_DESC Acre US Dollar 098765
O | o000000000000TINRIR05082010M = NR1.09082019_DESC Acre US Dollar
O 100.00000000000001.PK -Oct-2019 PK -Oct-2019-descrption Test01 30-05-2019 US Dollar TestSep13

4. On the Edit account code page, select Delete account code, and then click Next.
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Delete account code Cancel

Delete account code

Replacement account code (optional)

Belect one

In the Replacement account code optional text box, you can enter in an existing account
code to replace the account code you are deleting.

5. On the Delete account code confirmation page, select Delete in the lower-right corner.
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Delete account code Cancel

Delete account code

Confirm deletion

Are you sure you want to delete this account code? This
action cannot be undone.

Back I[ Cancel ]

6. Click the Stage button.
» This takes you back to the Staging page.
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§ 0 ® Q

X
Approve account codes

Are you sure I\u want to approve all pending account codes? This
action cannot be undone

Staging notes
Staging notes entered here will be applied to all account codes
being approved

500

7. From the Staging page, select Approve all, and then select Approve.

* You can view your current items and deleted items in the Published tab.

The deleted account code shows the following error code in the Cost Item Details and in the CBS tab.
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Task details { ovee )

Account code Hide in plan Is terminal
and progress

#REF! (] 0
00

L 0

11.3.2.2 Replacing deleted account codes

Control User Guide

To remove the #REF! error in the cost item details slide-out panel and grid, select the error to open the
Assign Account Code dialog box. Select another account code from the list, and then click Assign. The
error on both the CBS tab and the Cost Item Details slide-out panel is replaced with the account code

you selected.
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Assign account code

11.3 Account Code Setup

X

Sel... Utilized Account code Description UoM
@ 00 Overhead PLS -
) 00 DES WD A2k Hour
) 00.00000000.Core Functi... DES - DUTCH Test123456Test123456Te...

00.00000000000001

desrption updated_1324

Test1920- Copy

O 00.00000000000001. MRT.. DES_P PLS

@) 00.00000000000001.MRT..  DES_PDU TestSep13

D) 00.000000000000017 .nan... nandy TestSepi3

0 00.000000000000017.Nan... Nandy Test Acs TestSepi3

B 00.00000000000001 .New... New nandy May20th TestSepl3
) 00.00000000000001.NR_ 00.00000000.NR_050820 Acre

(oo ) (oo ) (22N

11.3.2.3 Renaming account codes

If you have the required permissions, you can rename account codes. Follow the step by step to
rename an account code.

Renaming account codes

1. Go to the Master data libraries, and then select Account codes.
2. From the Staging tab, select an account code you want to rename.

3. Select the Edit icon in the upper-left corner.
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Q Master data libraries = Account codes ¥
PUBLISHED STAGING AUDITLOG IMPORT LOG
© I
Staged account code changes and requests may differ from current published codes, refer to Published tab for current information.

Account code Description UoM primary Currency UoM secondary
T | o Acre US Dollar
(] ‘ 00 DES WD A2k Hour CFA Franc BCEAO Hour
O 00.00000000000001 desrption updated_1324 Test1920- Copy US Dollar TestSep13
O 00.00000000000001 MRTER 0 DES_P PLS US Dollar
O [ IOG000G0000G00MRTERDIGOIERE) | DEs_POU TestSep13 US Dollar TestSep13
(] 00.00000000000001.nandy kendo nandy TestSep13 Unidad de Fomento TestSep13
(] 00.00000000000001_Nandy test ACS Nandy Test Acs TestSep13 US Dollar TestSep13
(] 00.00000000000001 New nandy May2_. New nandy May20th TestSep13 US Dollar TestSep13
O 00.00000000000001_.NR_05082019 00.00000000.NR_05082019_DESC Acre US Dollar
O 00.00000000000001_NR1_05082019 00.00000000.NR1_05082019_DESC Acre US Dollar 098765
0 [ G000000000000INRIE05082000M = NR1_09082019_DESC Acre US Dollar
O 00.00000000000001.PK -Oct-2019 PK -Oct-2019-descrption Test01 30-05-2019 US Dollar TestSep13

4. On the Edit account code page, enter a new name for your selected account code in the
Description text box. Then enter a new name for your selected account code.

Account code details

* Parent account code * Account code

None - None # No. 001 =
Sta g the code or descrip poting
* Description * Currency

__001 USD - US Dollar s
* UoM primary UoM secondary

Acre [ I

5. Click the Stage button.
» This takes you back to the Staging page.
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§ 0 ® Q

X
Approve account codes

Are you sure Iu want to approve all pending account codes? This
action cannot be undone.

Staging notes
Staging notes entered here will be applied to all account codes
being approved.

500

6. From the Staging page, select Approve all, and then select Approve.

* You can view your current items and renamed items in the Published tab.
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Your renamed account code is viewable through the Account code column, Cost Item
Detail tab, and the ACS tab.

11.4 MEASUREMENT TYPES

In master data libraries units of measure, there are two sections. The sections are Units of measure,
and Measurement types. Using any two Units of measure that share the same Measurement type
(such as area), you are able to do a measurement type conversion in the ACS.

If you have a cost item with a different unit of measure assigned to an account code, but with the same
measurement type, that cost item can contribute to the same account code.

A Master data libraries v Units of measure
Units of measure
Name Description Measurement type
Measurement types #NAME?- Copy AE ae BACKLOGS Area
#NAME?- Copy B DESC Area
#NAME™ DESC Area

-0098765- Copy- Copy1- Copy

-0098765- Copy- Copy1- Cop

You can have a cost item with a measurement type of acre contribute its values to its assigned account
code if the account code has a measurement type of square foot. This is Because acre and square foot
are both a measurement type of Area.

The column Primary to Primary lets you choose the cost item that contributes quantities of the account
code.

Page 532 of 632 InEight Inc. | Release 26.5



Control User Guide 11.5 Cost category label customizations

SAMEy Ly YL DETAILS COST CATEGORIES

2,460.1999 SF

Primary to Primary -

ACS item details

cBs Desc... WBS Forec... UoM CE CE Prim... Prim...
positi_. phase (T/0) final total to to
code code quan... MHrs cost P@rj. Seco.
B 4_ 450 99 9994950
o fou 252 320 0.00000000
avate f 3 95 0.00000000
26 n 0.00000000
Se 35.1( ach 0.00000000
Be 2.0 I 0.00000000
b Meta 80.00000 40329767

The items without a check mark, such as Cubic Yards, have a measurement type that is not considered
an area, so you cannot select Primary to Primary for Cubic Yards, Ton, and Each.

11.5 COST CATEGORY LABEL
CUSTOMIZATIONS

In Master data libraries > Cost categories, there is a Enable custom labels toggle. If this toggle is turned
on, all of your cost category field names come from the custom columns depending on your language
preference in Control. Language preference is located in user settings.

Enable custom labels @ Q

Custom label - EN Custom label - ES-MX Custom label - FR-CA Custom label - PT-BR

You can overwrite the custom labels if you have the applicable permissions. Depending on where you
have cost categories shown in the product, the overwritten labels show with the new custom labels.

These labels can be viewed at the organization level. Every project within that organization can
see these labels.

If the organization prefers a different field name, it can be renamed using the cost category custom
labels.

Dimmed custom labels cannot be overwritten. For example, the Field name Total.
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Field name Is terminal

Total

Labor ( £ 234

Custom label - EN

Control User Guide

Labor Base I L-Base [

If the custom label for the field name is blank, then the custom label column will use the default name

for the field name column.

One way of finding these custom labels in the project is by going to the CBS register. From there, open
the Cost Categories slide-out panel. Under the Cost category column, find your custom label. For

example, the Labor Base field name can be customized and renamed L-Base.

O
-

4
-
I
o=
m
» ol
m
™
0

Latest actuals in forecast
values

Total

Cost category Current budget Total cost (lo date)

Current estimate

S 183.093332000

These changes can take a few minutes to fully generate because custom categories span the

entire project.
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If the Enable custom labels toggle has been shut off, then the category names come from the Field
names in the Master data libraries only.
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CHAPTER 12 — INTERFACES

The InEight cloud platform has multiple options for synchronizing information from one platform to
another. This gives you many options to utilize data efficiently between various programs, saving you
time and resources.

After the initial import from Estimate, you can use the Push and Get actions to integrate directly with
Control. You can use Push actions to send the CBS structure, budget, live forecast, actual quantity, pay
item, billed revenue, or forecast revenue from your job. You can use the Get actions to bring in
guantities, actual cost, man-hours, and billed revenue from other Platform and external applications.

The table below shows you the high-level functions of platforms to help you better understand how
the actions interrelate.

Estimate = Create CBS/ACS/WBS structures
Create cost estimates
Analyze contractor/supplier quotes
Prepare bid proposals
Benchmark estimate values

Contract Create and manage bid packages
Set up and manage contracts
Create and manage issues and change orders

Control Edit CBS/ACS/WBS structures
Manage budgets and contracts
Manage forecasts
Record actuals (manual entry, or import from Plan and ERP)
Calculate job costs/variances, earned values, contract earnings

Plan Associate planning components with CBS/ACS/WBS structures
Create work plans and packages

Progress  Create work plans and daily plans
Record progress and timesheets (as-builts)
Approve executed daily plans

ERP Budget, Payroll, Forecasts, AP/AR, Final Costs
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Control User Guide

The workflow diagram below shows how programs connect and how data flows between the InEight

products.

Estimating Contract Administration Project Control

Field Execution

Structure with

estimated quantities,

costs and resources
e

Structure, budget, and resources

[ 1

CEr—

Cost Estimating ‘ 4 Progress Measurement

A‘ Change
wass

Budget changes

Quote Management Forecasting

E

Work Packaging
Quantity Tracking

Approved
quantities Daily plan from

work package

v
Approved “
Bid Preparation Codes Change Management qﬁgm,"es & Progress
Issue Management B
Account Code Management Daily Planning
Change Management Weekly Timesheet
Budgets, As-built costs,
Jorecasts hours
(F Contract
Bid Packages Accounts > Q Compliance
payable ERP
Contract Management I Form Creation
A Budget le Form Execution
> Approved
Purchase Order details Payroll hours Events Management
APIAR
T Compliance forms Form resuits
v
Structure Q Compliance (Mobile)

Form Execution

12.1 Push and Get ACHIONS ... .. 538
12.2 Scheduled SYNCS ... 543
12.2.1 Syncintegrations ... 544
548

12.3 Audit Log - Integration

12.1 PUSH AND GET ACTIONS

Control integrations are used to move specific data in to or out of the application. As data is generated
or modified in one product, it does not automatically change in other connected products; you must
perform a manual sync action, referred to as a Push or Get action.

e A Push sync occurs when you send information to another InEight cloud Platform application or
an external application.

e A Get sync occurs when you retrieve information from a different InEight cloud Platform
application or an external application.

Click the Actions menu from the Control main page and hover over the Sync option to see the available

integration options.
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CBS

©
Y Update Forecast (T/0) gty with Plan compone._. - TR E e

Claim multiple CBS guantities WES phase Resources Fore:
r| code gty

Budget move and contract adjustment »

his project.
;:1 Lock/unlock budget

Add required cost items

Al sync » || PushCBS structure

Sync Push CBS structure and Budget

Push CBS structure and Live forecast

Push CBS structure and Actual quantities

Push CBS structure, Budget, Live forecast, and ..
Push Pay ltem

Push Billed revenue

Push Forecast revenue

Get quantities »
Get Actual cost and MHrs

Get Billed revenue

Get Revenue

The table below provides a description of the sync type functions.

Sync opton

Push CBS structure Syncs the Control CBS structure to the ERP system.

Push CBS structure Syncs the Control CBS structure, budgeted quantities, man-hours,

and Budget and costs to the ERP system.
Push CBS structure Syncs the Control CBS structure and Live forecasted quantities, man-
and Live forecast hours, and costs to the ERP system.

Push CBS structure Syncs the Control CBS structure and job-to-date actual quantities to
and Actual quantities  the ERP system.

Push CBS structure, Simultaneously performs all the syncing functions listed above (1-4).
Budget, Live forecast,
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and Actual QTY
Push Pay ltem Syncs the Pay item list and data to the ERP system.

Push Billed revenue Syncs job to date billed amounts to the ERP system.

Push Forecast Sync pay item revenue values (billed revenue, earned revenue,
revenue forecast revenue).
Get quantities Retrieves the claimed quantities from InEight applications and

(Through Previous Pay incorporates the information to Actual QTY in Control.
Period or Job To Date

Get Actual cost and Retrieves actual project costs and man-hours from the ERP system
MHrs and incorporates the information to Actual costs and Actual man-
hours within Control.

Get Billed revenue Retrieves billed amounts from the ERP system and incorporates the
information to Billed revenue within Control

Get Revenue Retrieves revenue information from Ineight applications and
incorporates the information to forecasted revenue. This feature is
available with the applicable setup and settings.
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Sync Options

1. From the Control main page, click the Actions menu.

@ Steel Structure Training Job (105091) Control

Actions = @

< CBS position Description WEBS

‘-:‘ phase
code
[ s

2. Select Sync from the Actions drop-down.

Actions = @

Claim multiple CBS guantities
Budget move and contract adjustment »

Unlock budget

Sync [

3. Select Push CBS Structure from the Sync drop-down.
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Actions = @

T reskcetas. coee>

Description Resource Forecast
. . " (T/0)
Claim multiple CBS guantities e
Budget move and contract adjustment »  Earthwork 10,000.00
Unlock budget _ i
Earthwork Review il 1.00

Sync
Push CBS structure

Lnau.nn

Push CBS structure and Budget

bk
Push CBS structure and Live forecast

o Push CBS structure and Actual quantities 000.00

] 41 Push CBS structure, Budget, Live forecast, and Act.. 350.00
Cet Plan quantities »

(] 42 200.00

Get Actual cost and MHrs
@ 43 o , $000.00

¢ A message shows at the top of the page that shows the process initiated.

@ Steel Structure Job (105091) - Control Workspaces w CBS structure sync initiated

CBS ACS PAY ITEMS CHANGE REGISTER

¢ You can follow the same steps for selecting the other sync options

¢ For the Get Plan Quantities option, you must select the Through Previous Pay Period
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option

O 572 Insta Push Forecast revenue 0.00 S000 6
(] ~ g 361N 5o quantities p | Through previous pay period

O & Furni 2
- Get Actual cost and MHrs Job to date .
O 5.3 Insta Get Billed revenue 0.00 sooo 7

e e T L o Tala o PN TAAAT nnn e nnn A

When you want certain types of data to sync automatically, you can schedule syncs. For more
information, see Scheduled syncs.

12.2 SCHEDULED SYNCS

Scheduled syncs allow you to set up automatic syncs, so you don't have to manually perform the syncs.
You can set a time and date for the type of information you want updated from push or get data sync
options. You can do a one-time sync or set up recurring syncs to get up-to-date costs or man-hours.

To use the sync features in Control, you must first select Control with confirmation in Global Options.
For more information, see Cost item integration behavior.

To schedule syncs, you must first configure them for your organization in Application integrations. You
can open Application integrations in Main menu > Suite administration > Application integrations.

The available sync types are:
e Push CBS structure
e Push CBS structure and Budget
e Push CBS structure and Live forecast
e Push CBS structure and Actual quantities
e Push CBS structure, Budget, Live forecast and Actual quantities
e Push Pay item
¢ Push Billed revenue
e Push Forecast revenue
e Get Quantities
e Get Actual cost and MHrs

¢ Get Billed revenue
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For more information about push and get functions, see Push and Get Actions.

12.2.1 Sync integrations

To start scheduling syncs, go to the Sync integrations tab in the Control Project settings. You can add
syncs by selecting the Add sync schedule button. You can schedule all your syncs for the project at one

time.
| General ) X
5[%| Capital
«-| Control 5
Sync Integrations schedule
A2 Plan
3¢ Progress ) ddd ewvne schadude

There are five required fields you must fill out in order to schedule a sync.
¢ Sync type
e Time zone
e Start date
¢ Time to run sync
e Repeat

Sync types lists all available push and get syncs.
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The Time zone is where you select which region's time zone you are in.

Start date functions similarly to selecting a start date for a project. You cannot select to start a sync
from a day in the past. The scheduled sync starts at the current day by default unless you select
otherwise.
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You can only select start times in 30 minute increments.

The Repeat section is where you select how often a scheduled sync repeats. You can choose to have
the sync repeat daily, weekly, monthly, or never depending on your preference. You can end the
schedule syncs on a certain date or end after a number of occurrences.

For daily syncs, select how often you want to repeat the sync or when you want the reoccurring syncs
to end.

For weekly syncs, select which days the sync repeats on as well as when you want the sync to end.

Page 546 of 632 InEight Inc. | Release 26.5



Control User Guide 12.2 Scheduled syncs

* Repeat * End

Monthly ® After 1 & Occurrence(s)

On ﬁ

‘ Never Daly

* Repeaton All Mone

OsOvmOTOwdrdF s

For monthly syncs, select what day in the month the sync repeats and when you want the sync to end.

* Repeat * Repeat on
: :
Never | Daily Weekly Monthly Day =
@® First v Sunday v

« End First

@ After 1§ Occurrence(s) Second
on ﬁ Third

Fourth

Last
Cancel Add

After you click Add, the sync shows in the Sync Integrations tab.

Sync Integrations schedule

@ Add sync schedule

Scheduled syncs [

Push Billed revenue
Sync type: Push Billed revenue Start date: 02/01/2021 [ ®
Time to run sync: 12:00 PM CST Repeat on: Fri
Repeat: Weekly End: 12/31/2021

Get Plan quantities
Sync type: Get Plan quantities - Job to date Start date: 02/08/2021 |Z, ()
Time to run sync: 1:00 PM CST Repeat on: Last - Saturday
Repeat: Monthly End: 12/31/2021
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You can edit syncs or delete them using the Edit and Delete buttons on the right of the sync data box.

When you want to perform manual syncs for certain type of data, you can use the Push or Get action.
For more information, see Push and Get Actions.

12.3 AUDIT LOG - INTEGRATION

As you utilize the sync option, you have the option to go back and audit the status of the actions taken.
The Audit Log Integration section shows all sync processes that have been initiated and their status.
The Integration section captures whether the sync process between InEight Control and the ERP
system was completed successfully. You can also view how long the sync process took to complete and
who requested the sync.

Sync Audit Log

1. From the Control Workspaces page, click the Audit Log tab.

@ Steel Structure Training Job (105091) - Control « Workspaces ~

&£ acs PAY ITEMS CHANGE REGISTER AUDIT LOG View :| Forecasts -

Actions  w @ 3 mj @ IE Q

2. On the left side bar menu, click Integration.

(@) Steel Structure Job (105091) - col
C
Actions =
CBS audit log
e Audit Data Item
D type type
ACS
264307 CBS Cost Item
Pay items
264306 CBS Cost ltem
Integration
264305 CBS Costitem
Import history
264304 CBS Cost Item

The log displays the current sync status
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CHAPTER 13 — INEIGHT
PLATFORM SETTINGS

To manage a project successfully in Control, the correct project details must be added before project
initiation.

You can view project details in the All projects & organizations page of the InEight cloud
platform.

Every new project launch has its own particularities, and the setup and initialization of these projects
depends on multiple factors, such as:

¢ Project organizational structure
e Staff and resources assigned

¢ Location of the project

¢ Units of measurement

e Currencies

¢ Financial reporting period

These settings are set up and configured in InEight Platform.

13.1 ORGANIZATIONAL BREAKDOWN
STRUCTURE

The Organizational Breakdown Structure (OBS) represents the hierarchical company structure. It is the
way your company is structured and divided, such as departments, districts, sectors, etc. Roles and
permissions can be added at different levels in your OBS, so users with district level access would have
access to all the projects under that district’s umbrella. For more information, see Organizational

breakdown structure in Platform.

To access the OBS, from the main menu click All projects & organizations, and then select the
Organizations tab.
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All projects & organizations

Control User Guide

®

Organization

C-X¥Z
C-XYZ :C-XYZ-ND

C-XYZ : C-XY7-ND : C-XYZ-ND-HC

C-XYZ : C-XY7-ND : C-XYZ-ND-BC

C-XYZ : C-XYZ-ND : C-XYZ-ND-M

C-XYZ : C-XYZ-SD
C-XYZ:C-XYZ-SD : C-XYZ-SD-M
C-XYZ:C-XY7-SD : C-XYZ-SD-P.

C-XYZ - C-XYZ-08D

C-XY7 : C-XY¥7-0SD : G-X¥Z7-0SD-M

00000 oo0oooo

C-XYZ : C-XYZ-0SD : C-XYZ-SD-HC

PROJECTS

ORGANIZATIONS

Description

Company XYZ

Company XYZ - North Division

Company XYZ - North Division - Heavy Civil

Company XYZ - North Divisien - Building Construction
Company XYZ - North Division - Mining

Company XYZ - South Division

Company XYZ - South Division - Mining

Company XYZ - South Division - Power

Company XYZ - Over Seas Division

Company XYZ - Over Seas Division - Mining

Company XYZ - South Division - Heavy Civil

13.1.1 Unique budget code segments

You can populate budget segments in Workspaces to show a unique code label. Unique budget code

segments contain additional options to identify a cost item using four independent fields that are

separated by periods. Budget codes can be configured at the organization level and are primarily used

with Time Center.

S @ Allprojects & organizations

All projects & organizations > Edit organization

The segments are combined to create a single

unique budget code separated by periods. They
Budget code cannot be changed once a project has been added
Ve
Using unique budget code? (@)
* Unique budget code
Segment 1 Segment 2 Segment 3 Segment 4
Project v Cost center v Other (String) v Phase code v g
.
Tasks ‘ &| C o3nga02s &
p— Please specify name =
v CBS Description Budget Budget Budget Budget 2 Forecast
other (string) Cost Code position Segment 1 Segment 2 Segment 3 Segment 4 method
(=] 1 Financial Results 103961 1000 Average performan.
QO vz Misc. Rev Intemnal 103961 1103 Rollup
@] 21 Misc. Rev Internal 103961 1104 Manual (EAC)
o v 22 Escalation/Contin. 103961 1101 Rollup
@] 221 General Project R 103961 1102 Current estimate
o v 23 Directs 103961 1001 Rollup

Page 550 of 632

Subtotals 163

InEight Inc. | Release 26.5



Control User Guide 13.1 Organizational breakdown structure

When the edit WBS phase codes and budget segments permission is assigned to a role in Suite
administration > Roles and permissions > Control, users are allowed to populate the WBS phase codes
and budget segments in the CBS workspace. This permission only applies based on configurations set
for the WBS phase code and the budget segments. The edit WBS phase codes and budget segments
permission must be selected to allow users to edit WBS phase codes and budget segments.

= fat  Suite administration / Roles and permissions

Roles and permissions > Edit role

Tasks and cost items Select all

Move cost items up/down o
Indent/outdent cost items
[=# Edit closed projects

(#) Add whbs phase code and budget segments

[=* Edit wbs phase code and budget segments

Take manual snapshots

When only the Add wbs phase code and budget segments permission is assigned, users are only
allowed to import WBS phase code and budget segments, and not to edit them.

When importing, users who have only been assigned the Add wbs phase code and budget segments
permission must use the New items option in the Import CBS data dialog box.
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Import CBS data

Import from Excel {.xlsx, xls) or Comma separated value {.csv)

Drag and drop the file here

Or Drowse

Browse

Options
* Import type (i) Theimport file is read and field mapping can
, ) . be specified. Mapping uses row 1 headers
Cost items and cost item attributes - from the source document
() Update existing and new items For new cost items, if the CBS position field is
mapped then the position specified is where
() Update existing items the cost item will be placed in the hierarchy. If
the CBS position field is not mapped then the
@ New items new cost item will be inserted at the hottom of
the CBS hierarchy.

‘.I,, Cost categories list

Cancel
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Open Project Details

1. From the All projects & organizations page, right-click on your job.

2. Select Edit Project, or click the Edit icon.

13.2 PROJECT PAGE

The Edit Project page is where general project setup information is edited and stored, including the
following settings:

¢ Project Details
e lLocation
¢ Project Dates

¢ Prime Contact and Project contacts
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e Currency and Markets

) Steel Structure Training Job| 105091 / Project details

Allprojects & organizations > Edit project DETAILS INFORMATION ATTRIBUTES

Project details

Project settings

* Project ID *External project ID @ Notes
105091 105091
*Name  status
Add project image
Steel Structure Training Job Active -
Minimum of 540px x 360px
“Phase @ * Organization
_ Freesten . ez '
Location
Country / Region Address 1 Address 2 City
United States Of America v Denver
state Postal / Zip code Latitude Longitude *Time zone.
Colorado v (UTC-06:00) Central Time (US & Ganada) v
Project dates
Project start date Project end date Forecast start date Duration () Forecast completion date ()
10/01/2015 =] 04/12/9399 =] month/day/year B month/day/year B
Forecast. F F completion date
month/day/year B
Prime contract
Company legal name Owner legal name Taxid Original contract amount Contract number Contract date
‘month/day/year
Contract start date Duration () Contract completion date () Certificate of Certificate of
month/day/year B B B month/day/year B
Contract Contract. i ntrac Certificate of final Certificate of final completion(awarded)
yly B B month/day/year il
Currency Project contacts
* Base currency Owner Designer
USD - US Dollar v v v
® Add another currency Contact 1 Gontact 2
Contact 3 Contact 4

Markets

Business case

Market

© Add another market

For more information, see Project initiation in Platform.
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13.3 MANAGE USERS

As an administrator, you can manage users and set up the correct roles and permissions in InEight
Platform to manage and organize the application successfully.

13.3.1 User Management

The User Management page provides a list of users inside your organization. You can view any user’s
project access, roles, and permissions within your organization. Users with applicable administrative
permissions can edit and grant permissions to other users, up to the equivalent level of access they
have been granted. For more information, see User Management in Platform.

13.3.2 Roles and permissions

A role in InEight Platform is defined as the function that a user occupies inside an organization or
project. A role contains a set of predetermined authorizations and permissions. When a role is
assigned to a user, they acquire all the permissions of that role in the project or organization that you
can assign to users or project staff.

With sufficient rights and permissions, you can add or remove a role and all access it provides from the
user. The Roles and Permissions section is where you can view what permissions each role has. For
more information, see Roles and Permissions in Platform.

Control has permissions that control important functions within the program as shown in the image
below.
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13.3 Manage users

Control

‘Select all

Tasks and cost items
(@ Viewtasks
(@ Add cost items
[ Eottasks

(& Edit cost tems

(@ Delete cost items

(%) Defete syncd cost items

Change management

View everyone's change orders

(B) View everyone's draft change erders

(@ Edit any draft change order
() Delete raft change orders

Approvereject change orders

(®) Create change orders

Integrations:
(@) View integrations
Push CBS structure
Push CBS structure and budget
Push CBS structure and live forecast

Push 0BS structure and actudl aty

Push CBS structure, budget live forecast, and actual oty

Audit log
() View auditlog
(@) View 0BS ausitlog

(@) View ACS audit log

<

B (@) View pay fiem audit log

B @ View sync auditlog

<

(@) View import history

Revenue
(@) View billed revenve
[, Eot bilied revenue
@ Viewrevenve
[ Eot revenue forecast
©) View revenue library

[ Ecit revenue library

B seiect all

Bseiectall

Bselect sl

Select all

B select all

View sets.
(@) View personal view sets
@ Add personal view sets
[ Edit personal view sets
(@ Delete personal view sets

Send personal view sets

Send personal views to all users in a project

Actuals
@ View octuals
(@} Edit open period quantities
[ Edit open period costs
[ Edit open period man-hours
(@ Edit open period equip-hours

[ Edit any period quantities

Pay items
(@) View pay items
(@) Create pay items
[ Edit pay items

) Delete pay tems

Resources

() View project ibrary resources

[ E8it project ibrary resources

13.3.3 Considerations

B Select all

a

Esdectal

B selectall

[ select all

Control User Guide

Budgets B Seiectall
{8 View original budget =
(@) View original budget cost categories
@ View current budget

@) View current estimate

@) View current buaget cost categories

[} Edit current estimate

Forecasting B seiectan
@) View private forecasts a
[} Edit private forecasts
Push to shared forecasts

(©) View shared forecasts

@ Edit shared forecasts

(@) View forecast delta data block

Hseiectan

(@) View live forecast in‘the ACS
Push to live forecast in the ACS
[ Edit live forecast in the ACS

(@) View original buaget

L]

@) View current budget

Schedule

(@ View schedule data block

[} Edit scheduie aota

Establishing roles and permissions is an administrative function. As such, access to these settings may

not be available to you, as the setup of these settings may not be within the scope of your daily tasks.
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13.4 ORGANIZATION GENERAL SETTINGS

The organization settings page contains general setup information for all the InEight products,
including Control. The left ribbon menu lets you navigate to the appropriate settings for each
application, including Control.

@ S100000-PKSnc / Setings

HOME PAGE GLOBAL OPTIONS DOCUMENT TYPES CUSTOM LISTS ATTRIBUTE DEFINITIONS MENU OPTIONS SUBSCRIPTIONS

Custom links

Custom links will appear on the organization home page and be visible 1o al projects

= Link name *URL
®  enterlinkname Enter URL
] COREHVTIAJANZSAY o googe com ®

LaunchPad

Piint PO

The general settings are the following:
e Home Page
¢ Global Options
* Fiscal Calendar
e Document Types
¢ Custom Lists
e Attribute Definitions

¢ Menu Options

13.5 HOME PAGE

In the Home Page tab, you can configure custom URL links that show on the organization and project
level home pages.

InEight Inc. | Release 26.5 Page 557 of 632



13.6 Global options Control User Guide

Custom links
= Link name = URL
@ Enter link name Enter URL
] InEight University university.ineight.com ®
O Learn.Ineight www.leamn.ineight.com ®
103961 / Project home
4

w T & Links 4
+
Mgroject image Organization

0
KVK
dds
LaunchPad
Maodel
Document
@ Schedule

InEight University
€3] Design
- Leam.Ineight

Print PO

Project

Quantity forecasting

To go to the Home page, click Main menu > <organization> > Settings.

13.6 GLOBAL OPTIONS

In Global Options, you can configure the following settings:
e Master data libraries
¢ Role Assignment
¢ Project display in primary navigation
e Cost item integration behavior
¢ Email preferences
e Environment indicator
e Session timeout
¢ Landing page default view
e Organization/Project images

¢ Product integrations
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13.6.1 Master data libraries

You can switch the Validate equipment to project currency toggle to On if you want to validate
equipment resources to the project currency. When turned Off, there is no equipment to the project
currency validation. You can assign an equipment resource with a currency that is different
(mismatched) than the project currency or alternate currencies.

When turned On, equipment is checked against the project currency. If the equipment currency is
different than the project currency, you are unable to use that equipment on the project unless the
equipment or project currency are changed to match.

> HOME PAGE GLOBAL OPTIONS FISCAL CALENDAR DOCL >

Cancel

Master data libraries

“,-,i:i] @ Validate equipment to project currency.
o Togagling this to "Off' will turn off equipment validation.

£

The setting is irrelevant if all equipment and the project use the same currency.

13.6.2 Role Assighment

You can switch the Allow users to self-assign roles toggle to ON to let users self-assign their own roles.

Role Assignment

Allow users to self-assign roles? @

13.6.3 Project display in primary navigation

You can select to:

¢ Show the project name first which may truncate the Project ID if name are long.

¢ Show the project ID first which may truncate the project name.
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Project display in primary navigation

(O] Project name first | may truncate Project ID if name... Project ID first | may truncate Project name
Sample: Sample:
Truncated: Truncated

13.6.4 Cost item integration behavior

Provides flexibility in how to configure Control with and without a direct tie to an ERP system. There is
also an option to pass cost items directly from other sources to applications. You can select from the
following options:

¢ Control with confirmation — Use this option if you use Control and an ERP. To sync cost items
between Control and other applications, you must confirm using the sync options in the Actions
menu in Control or set up a sync schedule in Sync Integrations. For more information about sync
integrations, see Scheduled syncs.

¢ Control without confirmation — Use this option if you use Control but not an ERP. Cost items
sync automatically between Control and other applications.

¢ Without Control without confirmation — Use this option if you do not use Control. Cost items
pass directly from other sources to applications.

Cost item integration behavior

(@ Control with confirmation
Contral with confirmation: Use this option if you use Control and an ERP. To sync cost items between Control and other applications, you must
confirm using the sync options in the Actions menu in Control

(O control without confirmation
Control without cenfirmation: Use this option if you use Control but not an ERP. Cost items sync automatically between Control and other
applications.

(O without control without confirmation
Without control without confirmation: Use this option if you do not use Control. Cost items pass directly from other sources to applications

When using a direct integration between InEight Control and your ERP, InEight Control
will serve as the project controls interface for setting up and maintaining the project
budget and cost structure. Every cost item created in InEight Control also needs to exist in
your ERP system so actual costs can be recorded correctly. Your ERP system remains the
system of record for all cost transactions, making it imperative that it remains in sync with
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any budget or structure changes. Your organization will need to consider what frequency
is best for running each sync.

13.6.5 Email preferences

You can enable the following email options:
¢ Use image in email notifications.
¢ Send email to user when there is a role change

¢ Send email to user where there is an email change.

Email preferences

@) Use image in email notifications?
@ Send email to user on role change

@ Send email to user on email change

13.6.6 Environment indicator

You can enable indicators and options for header badge display, header badge color, and footer color.
You can also select the option to Include environment indicator in email subject line.

Environment indicator

* Header badge display Header badge color Footer color

© QA-Main-T01 © . v © M

Include environment indicator in email subject line

13.6.7 Session timeout

You can enable and configure session timeout options.
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Session timeout

Enable session timeout

@

Force signout time
_. 999 MIN

Warn the user 10 min prior to signout

13.6.8 Landing page default view

Select the default landing page view for all users. The default landing page views you can select from
are:

Owner

Contractor

Sub-contractor

Vendor

Landing page default view

Select a landing page view to be used as a default for all users

Contractor v

13.6.9 Organization/Project images

You can enable the Inherit root organization image when creating new projects/sub organizations
toggle to inherit the root organization image when creating new projects or sub-organizations.

Organization/Project images

@ Inherit root organization image when creating new projects/sub organizations
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13.6.10 Product integrations

Enable product settings for all projects created. When a project has a product enabled, the project is
available in the selected product.

Product integrations ®

@ Model @

13.7 FISCAL CALENDAR

13.7.1 Fiscal calendar

The settings in the Fiscal Calendar can be set at the organization and project levels. These settings
specify:

¢ Week ending day
¢ Financial year start month

¢ Period end options of month end day, last weekday, financial period closing day, month end plus
days, financial period closing time, and closing time zone.

e Project fiscal calendar settings (Organizational level only)

It is important to know the different cut-off dates, especially when you pull the current period actual
guantities to compare them to prior periods, or when you synchronize your quantities with the other
applications.

Changes to a project level fiscal calendar only impact the project, while changes to the organization
level fiscal calendar impact all projects that do not have fiscal calendar modifications. If there are no
changes at the project level, and the project matches the organization fiscal calendar settings, the
project inherits the organization-level settings.

Any changes to the project fiscal calendar impact read-only snapshots, which are captured at the
closure of month-end plus days, for the period month being closed. Changes also influence the
monthly time buckets in time-phase forecasting and budgeting and to the time periods in which claims
can or cannot be posted.
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C-XYZ / Settings

Control User Guide

» HOME PAGE GLOBAL OPTIONS FISCAL CALENDAR DOCUMENT TYPES
~
<
\__]: * Week ending day * Financial year start month
(~ . Saturday v January v
@
= .
) Period end
- = Month end day Last weekday
= Last day of the month v
= Financial period closing day = Month end plus days
Same as Month End Plus Days v 7
* Financial period closing time * Closing time zone
23:30 © (UTC-06:00) Central Time (US and Canada) v

Project fiscal calendar settings

(© | Enable project level editing

13.8 DOCUMENT TYPES

CUSTOM LIS

»

4

You can assign a document type to InEight applications. This lets you filter the payload of Document
Types for visibility and use in the assigned application.

(@) Englsh
~ Name Description
= Diagram Diagram
@ O | Photo Photo
(2 ([J | Design Design
& O | Exeouted contract Executed contract
~ O | Executed change order Executed change order
® O | Pemit Permit
2 O Tansnittel Transmittal
[ | Request forinformation Request for information
O | Submittal Submittal
=2 O | other Other
O | Checkist Checklist
[ | Comespondence Comespondence

Product(s)
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Gontrol, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla
Model, Document, Estimate, Control, Pla

Model, Document, Estimate, Control, Pla.

13.8.1 Considerations

The Document Types settings is available at the organization level only.
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System managed

Espafiol
Name Description
Diagrama Diagrama
Imagen Imagen
Design Design

jecutad jecutad
Orden Orden
Permisa Permiso
Transmisién Transmision

Solicitud de informacion
Envio
Otros

Lista de verificacién

Solicitud de informacion
Envio
Otros

Lista de verificacion

ESMX  v|
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13.9 CUSTOM LISTS

Similar to the tag feature in InEight Estimate, you can enter your tags and their values to use later for
categorizing your cost items as you manage your project in Control.

Many of the tag fields are validated fields, meaning you can choose from options in a drop-down list.
You define both the names of the tags and their drop-down values here.

The field names associated with Cost breakdown structure and Account codes, are tags defined and
editable at the organizational level; you cannot edit them at the project level, as indicated by the
statement Inherited from parent organization.

GLOBAL OPTIONS HOME PAGE PROJECT INFORMATION FISCAL CALENDAR FUEL TYPES CUSTOM LISTS )
List name Label name Associated entity Field values Inherited from parent org ) X
ACS tag 3 field values
ACStag1 ACStag1 Account code Multiple Yes 1
ACS tag 2 ACS tag 2 Account code Multiple ves 1 « Description
v/ ACStag3 ACS tag 3 Account code m Yes 1
) Account Code Revision Sept 2015
ACS tag 4 ACStag 4 Account code None ves 1
ACStags ACStag 5 Acceunt code one ves 1 Account Code Revision July 2017
ACS1ag6 ACStag 6 Account code one ves 1 Account Code Revision Mar 10 2015
ACStagT ACStag 7 Account code None ves 1
Change management .. | Change management . Change management None No
Inherited from parent organization 4
Change management . | Change management . Change management one No
Change management .. | Change management.. |~ Change management one No
cBStagl CBStag1 Cost breakdown structure one No m
CBStag1l CBStag11 Cost breakdown structure None ves 1

13.9.1 CBS URL columns

You can create direct links to URL addresses outside of Project Suite under Custom Lists. In the URL
Field values you can define a URL with associated criteria to be used as an attribute for a cost item in
the CBS.

In the URL Builder enter a URL that you want associated with your list name, along with any other
dynamic attributes such as Project ID and CBS position code. Paste your URL and highlight the section
you want to reference with another field. First highlight an attribute in the URL string, and then click
the [T] reference icon to select which field to connect with.

@ Stesl Structure Training Job| 105091 / Settings

FISCAL

S M 1 M
GLOBAL OPTIONS HOME PAGE CALENDAR FUEL TYPES CUSTOM LISTS MENU OPTIONS
List name Label name Associated entity Field values Inherited from parent arg . >
— = = URL builder
j) [  cBstagzs CBStag 25 Cost breakdown structure None No
CBSURL 1 CBSURL1 Cost breakdown structure URL No Editable url @ I
[] CBSURL2 CBS URL 2 Cost breakdown structure URL No = www.google f|Project ID)/[CBS positi Project ID
Control CBS
O | CBSURL3 CBSURL3 Cost breakdown structure URL No
WBS phase code
%) [0 | CBSURL4 CBSURL4 Cost breakdown structure URL Ne
CBS position
O | CBSURLS CBSURLS Cost breakdown structure URL No Account code
D Es:\ma:ing resources .. Es:ima:ing resources .. Estimating resources None No
[} ~ ~timnmtin e ras s Entimantiom ramnnirnnn Crtimatinm ranmtiraan NAma [N
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These quick links are accessible in the CBS and can contain detailed information pertaining to the cost
item and project, which can also link to external reports.

In the CBS cost item details attributes slide-out panel, the URL is concatenated to include the attributes
defined. A link is included on a cost item that opens a new tab.

028

Fiscal calendar settin .
Miscellaneous Revenue Internal

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES
Tasks H
Cup3 CuD4 CUD5
7 CBS Description
position
1 Fi | Result:
o nencialesds cuns cun? cung
~v 2 Miscellanecus Re.
O 21 Craft Cost Ccupg CcuD10 cupm
] 22 B/C To Parent 103..
(] 2.3 Intercompany Aut... cupiz cupts cupi4
O v 3 Miscellaneous Re...
CuD1s CBSURL1_EN CBSURLZ_EN
O 31 Miscellaneous Re... N P
O v o4 Financial Result E https://ineightvisualstudio.com/InterStellar/_workitems/edit/[WBS phase code]
CBSURL3_EN EeTRTEEN CESURCI-EN
O 4.1 Not in Use & & 2
(] 4.2 Not in Use

The links can also be accessed in the CBS register. Up to five CBS URL columns can be viewed in a data
block in the CBS, per project.

]

7 CBS Description WES phase CBS URL 1 CBS URL 2 CBS URL 3 CBSURL4 CBSURL S 2 Forecast
position code total cost

0 1 Job Overhead 1002 & $ 250,000.00
2 Earthwork 1069 & $400,000.00
a 3 Conerete 1071 & $1,500,000.00
(] v 4 Structural Steel 1073 & & & & & $1,516282.48
(m} 41 Erect Steel - Heavy 1074 & & & & & $25666.00
] a2 Erect Steel - Light 1005 & & & & & $ 200,000.00
(] 43 Bolted Connections 1006 & é é @ @ $49,955.00
(] v 5 Materials 1084 & & & & & $1,750,000.00
(m} 51 Earthwork - Mater 1085 & & & & & § 250,000.00
O 532 Concrete - Materi 086 & & & & & $1,000,000.00
(] 53 Structure Steel - 1087 & é é @ @ §500,000.00
O 5 1088 & & & & &

Subtotals 12 (1 rows selected) $4,175,621.00

At the organization level, CBS URL columns 6, 7, and 8 have been added to the CBS register. When you
define a CBS URL, it is then applied to each of the organization’s projects.
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13.10 Attribute definitions

» GLOBAL OPTIONS HOME PAGE C:Il_SE:?l:R
ré: List name Label name Associated entity Field values Inherited from parent arg
e — _ — __
\- []  CBStag24 CBS tag 24 Cost breakdown structure None Mo
[J | CBStag2s CBS tag 25 Cost breakdown structure HNone No
d CBSURL1 CBSURL 1 Cost breakdown structure URL Mo
d CBS URL 2 CBS URL 2 Cost breakdown structure URL Mo
n_ O CBSURL 3 CBSURL 3 Cost breakdown structure URL Mo
T‘ O CBSURL 4 CBSURL 4 Cost breakdown structure URL Mo
[
O CBSURL S CBSURLS Cost breakdown structure URL Mo
z CBS URL 6 CBS URL 6 Cost breakdown structure UBL Yes j‘
CBSURL Y CBSURL 7 Cost breakdown structure UBL Yes j‘
CBSURL 8 CBSURL 8 Cost breakdown structure URL Yes j‘

Creating organization-level CBS URL links lets you associate shared documentation, such as external

standard reports that are used across the organization. Instead of setting up links for every project, you

can create a CBS URL link in Settings > Custom Lists.

Actual verdos
Miirs (1o date]

13.10 ATTRIBUTE DEFINITIONS

Attribute Definitions are used to define project attributes which can be of the types text/date/number

or can have source values from Organization, Project, and Market master data. These definitions are

inherited inas all projects in the organization.
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Cancel
+Fuel type *Cost per UoM *Currency *UoM Account code
Gasoline $1.00000 USD - US Dollar Gallon 71.06.32.016.02 - Turbine Enclosure - Install En ®

13.11 MENU OPTIONS

The below URL addresses specific to InEight products are updated when licenses are purchased or
activated. The URLs are customer specific. The ability to maintain the URLs are intended for users with
account admin only (root Org Setting) permissions. If no other products are purchased or activated, the
URL opens an InEight related page to learn more about the products.

Menu links

Configure the URL addresses for your InEight Products

Product = URL * Target
Mode https://fineight.com/solutions/virtual-design-constr.. | New tab
Document https:/fineight.com/solutions/collaborative-docum... Mew tab
Basis http://my.basisplanning.com Mew tab
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CHAPTER 14 — CONTROL
SETTINGS

As an administrator, you can configure settings at the organization and project level in Control. The
correct setting details must be added to manage projects successfully.

e Organizational settings — Settings configured at the organizational level are inherited when
creating associated child organizations and new projects within the organization. You can
configure organizational settings in Main menu > <organization> > Settings > Control.

¢ Project settings — At the project level, you can refine the default inherited organizational
settings to customize how they are applied in each project. You can configure project settings in
<project> > Settings > Control.

Organizational settings are applied as default settings for new projects. As an administrator, you can
configure the default project settings to how they will apply to your individual project.

14.0.1 Considerations

You must have Level 3 — Account Admin permissions in InEight Platform, or an assignment to the root
organization based on permission configuration.

14.1 PROJECT TRACKING

Project tracking settings configure how your project tracks progress and percent complete in Control.
Organizational Project Tracking settings are configured in Main menu > organization > Settings >
Control. For settings configured at the project level, go to project > Settings > Control.

These settings include the following options:

e Tasks
e Actuals
e Estimated actuals

¢ Time-phasing
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14.2 TASKS

14.2.1 Organizational and project level

14.2.1.1 Generate WBS phase code automatically

In the Tasks section you can manage how WBS phase codes are generated. You can set the Generate
WBS phase code automatically toggle to Yes or No.

= @ C-XYZ / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE SYNC INTEGRATIONS OTHERS

~ -
C>
® Tasks

%)

. Generate WBS phase code automatically?
®

- = )
)

WBS Phase code generation methed WBS Phase codes start value

Continue numbering from the last generated number -

Enable manual snapshats  (7) ) Default CE values to be updated from CB values (3) ®©

When you set the toggle to No, phase codes for newly created cost items must be manually entered.

When you set the toggle to Yes, phase codes for newly created cost items are automatically generated
and the WBS Phase code generation method list option activates. In the WBS Phase code generation
method list, you can choose from the following:

¢ Continue numbering from the last generated number

¢ Regenerates all values beginning from the specified start value — This option activates the
WABS Phase code start value field where you can enter a specified value. The value is the phase
code for the first cost item created. When automatic phase code generation is activated, the
proceeding new cost items is automatically created based on the phase code generation method

selected.

14.2.1.2 Enable Manual Snapshots

You can create a manual snapshot of Control project data in the CBS and Pay Items registers. When the
Enable manual snapshots toggle is enabled, and with the applicable permissions, you can capture a
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snapshot at any point in time. When the setting is disabled, snapshots are captured only when Push
Live forecast and Push Forecast revenue syncs are run or when the month-end plus days elapse.

Enabling the manual snapshots settings lets you select the Take Live Snapshot option from the Current
Live Forecast drop-down menu in the CBS to capture current values in the Live Forecast, Current
Budget and Current Estimate.

- P = - - =
) " T M e Live St . - i
2 Musc Rev It nal 1 A3 LSl Fel o 70305 TN
21 i 3 00 PLS S00n 000 0.00
[ Escalation/Contin 100 Esch § 000 800
2 » onl Snapahot mitited sucoesshully
sl Brrimrt B LU o " M U ITEMS CHANGE REGESTIR

- Live forecast (9 Cumentlive forecast = ¢ omnn

Snapshots can also be taken from the Actions menu.
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= fr  Steel Structure Training Job 3| 10.. / Confrol / Workspaces
CBS ACS PAY ITEMS
Actions ®
Y Global forecast method.. . .
Task details { sses > ]
Set forecast method Resources Forecast (T/0) UoM
- qty

Time phased forecasting
1.00  Lump Sum
‘_:1 Update Forecast (T/0) gty with Plan compone...

5 10,000.00 CY¥
Claim multiple CBS guantities
; Budget move and contract adjustment » ° 1000000 Each
Lock/unlock budget » 100 Each
Sync oy 5 1.00  Ton
Take snapshots Lt 5 100 Ton

Snapshots will capture current values in Live forecast, Current budget, Current estimate, and Revenue

are T T T LTy

4.4 Labor 10,000.00  Each

You can view the draft snapshot by selecting the View draft snapshot from the Current live forecast
drop-down menu. This lets you know that the draft snapshot is not yet finalized for the current month.

Live forecast &) Current live forecast =

- recast & Forecast
total
-

&} Forecast

total cost & Current live forecast

A=

$ 4599 537.039.68. Take Live Snapshot Last Live snapshot : 7/12/2023, 1
12:28:01 PM The draft snapshot is

£ View draft snapshc* t vet finalized for 1l i
$ 200224 9771109.. not yet finalize ﬂ?r e curren
© June 2023 font.

© May 2023

© April 2023

When you select View draft snapshot, the snapshot values load into the CBS in a read-only status.
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14.2 Tasks

Live forec.. | £ Viewdraftsnapshot = A
Forecast Forecast Forecast
total cost total MHrs total

MHrs/unit

{ seme >

Forecast
total

productivity

Forecast
total unit cost

Forecast
method

When you select the Take Live Snapshot option consecutively, a message lets you know that an
existing snapshot already exists and a choice to override the previous snapshot.

Live forecast &P Current live forecast =

&¥ Forecast

B et B Sonraraed frecast
total cost < Current live forecast
unat
Take Live Snapshot
soog @ F
£ View draft snapshot \. X
$2401,829.02 T
Take Live Snapshot
An existing snapshot for 6/26/2023,12:23:46 PM already exists. Do you want to override the previous snapshot?
Last Live snapshot taken: 6/26/2023, 12:23:46 PM by Paul (via Manual snapshot)
-
The same snapshot functionality now exists in Pay Items, with the exact same option.
Pay ITEMS CHANGE REGISTER AUDIT LOG Tice -
hd F B & Q
Revenue snapshol:  Curent revenue forecast Billed date:  MAXINE o 06262023 G
Carrent revense forecast
Last revenue snapshot- Tue Jun 06 2003 4700
Tale revenue snapsho! P
.. — Srapshot will capture cument Revenue values
e iy ool [ b o oo May 2023
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14.2.1.3 Default CE values to be updated from CB values

You can select for the Current estimate cost, man-hours, and quantity values to be updated by default
from an approved change order that contains adjustments to the Current budget cost, man-hours, and

guantity. To set CE values to be updated from CB values, enable the Default CE values to be updated
from CB values toggle. The check boxes are automatically selected in the change orders.

Whether the Default CE values to be updated from CB values toggle is enabled or disabled, you have
the option to manually select or deselect to update the values using the check box options under the
Update CE total cost, Update CE total MHrs, and Update forecast (T/O) gty in the change order.

Net budget Netquantity  Net manhour Markup  Fee Netcontiact  Approval probability
change change change change
$0.00 No 0.00 $000 5000 $0.00 -
o Cost items =
® 1t Q
€8S position Description wes usted CB fees Cost source Update CE total cost Update CE total MHrs Update fosecast (T/0) aty 8 allowance Adj
phase o3t total cost allo
Code
A Pay item 002 - Concrete - Labor & Material [) Adjusted ""“""s"g‘;‘;
3 l
4 S »
Sublotals 2 $0.00 $0.00

14.2.2 Project level

At the project level, you can further define settings for maintaining the CBS structure at a specific level
and allowing syncs to replace manual snapshots.
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Steel Structure Training Job 3| 105093 / Settings

14.2 Tasks

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES

® Tasks

SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

Cancel

Maintain CBS Structure at a specific level?
o~
(%)

- [l
."".\

,ar Generate WBS phase code automatically?

Level to Maintain CBS Structure at

1

o |

WBS Phase code generation method

Centinue numbering from the last generated number

Enable manual snapshots  (§)

S

Allow syncs to replace manual snapshots @

WBS Phase codes start value

Default CE values to be updated from CB values (i)

14.2.2.4 Maintain CBS Structure at a specific level

When set to Yes, the Level to Maintain CBS structure at field is enabled. You can enter at what level to

maintain the CBS structure.

14.2.2.5 Allow syncs to replace manual snapshots

When set to On, the Allow syncs to replace manual snapshots toggle is enabled. When you enable the
Allow syncs to replace manual snapshots toggle, the manual snapshot is replaced when the Push Live
Forecast or Push Forecast revenue is synced. When the Allow syncs to replace manual snapshots

setting is disabled, syncs are replaced with manual snapshots.
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Tasks

WBS Phase code generation method WBS Phase codes start value
Continue numbering from the last generated number -

Enable manual snapshots  (3) ©

Allow syncs to replace manual snapshots (i) &)

If this setting is enabled, a manual snapshot will be
replaced when Push Live forecast and/or Push
Forecast revenue is synced. If this setting is
disabled, syncs will not replace manual snapshots.

14.3 ACTUALS

In the Actuals section of the Project Tracking tab, you can configure actuals settings for your
organization and projects. The image and table below give a brief explanation of Actuals settings.

Actuals

Calculate percent complete for individual cost items as a percentage of Cap percent complete at 100%

Forecast (T/0) gty - Yes -|

Calculate percent complete for roll-up items such as superior cost items and ~ Roll-up percent complete weighted by
account code by:

Cost - Current Budget -
6 Calculate man hours earned at the parent level by @
(@) The summation of man hours earned from direct child items
(O The total man hours multiplied by percent complete
6 Get actual cost from Contract (7) @ Update % complete from Contract (7) @
9 Drive committed cost values from Contract @ © Calculate percent complete for individual cost items as a percentage of 9
Current budget total cost -

Current budget total cost
_ Committed total cost
Forecast total cost

Current estimate total cost
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1 Calculate percent complete for individual cost Calculate percent ~ Organizational
items as a percentage of complete for and project
individual cost items
as a percentage of:

» Forecast
(T/O) Quantity

e Current
Budget
Quantity

2  Cap percent complete at 100% Optionto selectto  Organizational
cap any cost item and project
percent complete

at 100%.
3  Calculate percent complete for roll-up items  Controls whether Organizational
such as superior cost items and account code earned cost or and project
by hours are used

when calculating
percent complete
for roll up items.
The roll up result
can differ
depending on
whether progress is
measured by cost
or by man hours.

e Cost—Rollup
percent
complete is
based on
earned cost
compared to
total cost.

e Man hours —
Roll up
percent
complete is
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based on
earned hours
compared to
total hours.

This setting does
not change the
subordinate item
percent complete. It
only changes the
basis used when
rolling those
subordinate values
up to a superior
item or account
code.

The calculation is:
Roll up % Complete
= Earned cost or
man hours from
Current Budget or
Current Estimate +
Total cost or man
hours from Current
Budget or Current
Estimate

4 Roll-up percent complete weighted by Controls whether Organizational
Current Budgetor  and project
Current Estimate is
used as the
weighting basis
when combining
subordinate items
into aroll up
percent complete.

e Current
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14.3 Actuals

5  Calculate man hours earned at the superior

level by

InEight Inc. | Release 26.5

Budget —
Weights each
subordinate
based on its
budgeted
size.

e Current
Estimate —
Weights each
subordinate
based on its
estimated
final size.

Control applies a
weighted average,
so larger items
have a greater
influence on the
superior result.
The calculation is:
Roll up %
Complete = Earned
cost or man hours
from Current
Budget or Current
Estimate + Total
cost or man hours
from Current
Budget or Current

Estimate
Calculate man- Organizational
hours earned for and project

roll-up items by
summing the man-
hours earned of the
contributing items
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(regardless of roll-
up items percent
complete) by:

e The
summation of
man hours
earned from
direct
subordinate
items.

e The total man
hours
multiplied by
percent
complete.

6  Get actual cost from Contract When switchedto  Project level
On, the subcontract only
actual cost is
received from
Contracts. Actual
costs from Contract
can consist of a
goods receipt, an
accrual, or an
invoice
receipt/payment
form. If a goods
receipt and an
invoice receipt
come in at the
same time for a
record, the higher
cost is recognized
and not duplicated.

7  Update % complete from Contract When switchedto  Project level only
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On, quantities that
are claimed in
Contract for SOV
items updates the
percent complete in
Control. You must
enable this setting
before the contract
is created.
Updating the
percent complete
provides you with
another way to
claim quantities
against schedule of
value items in
Contract.

When quantities are
claimed against a
schedule of values
item in Contract and
the Get quantities
sync is executed in
Control, the cost
items actuals
quantity completed
gets updated with a
percentage claimed
toward the
contract's schedule
value total cost.

8  Calculate percent complete for individual Calculate the Project level
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cost items as a percentage of percent complete only
for individual cost
items as a
percentage of:

e Current
estimate total
cost

o Committed
total cost

» Forecast total
cost

e Current
estimate total
cost

9  Drive committed cost values from Contract When switchedto ~ Organizational
On, the committed  and project
costs are driven
from Contracts.

When switched to
Off, committed
costs are derived
from the ERP.

14.4 ESTIMATED ACTUALS

In the Estimated actuals section of the Project Tracking tab, you can configure estimated actuals
settings for your organization and projects. Organizational settings are inherited in new projects. You
can further define these settings at the project level.

The Estimated actuals settings allows estimated actuals to be accrued to a cost item, then used to
contribute to the forecast. This results in the forecast being more accurate. The estimated actuals are
calculated based on the cost category values associated to the cost items.

When Turn on estimate actuals is switched to On, you can choose to turn estimated actuals to On or
Off for Control and InEight Progress cost categories. The Estimated actual quantities from InEight Plan
and InEight Progress are also enabled.
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14.4 Estimated actuals

When any one of the cost categories are switched to On, the Actuals details Claim Actuals tab shows

the option when claiming quantity to accrue estimated cost based on the amount claimed.

Estimated actuals

Turn on estimated actuals:

Actual type

Labor cost

Labor man hours

Construction Equipment cost

Construction equipment hours

FOM Rented Equipment cost

Supplies cost

Materials cost

Subcontract cost

Fees cost

Allowance cost

G & A cost

Undefined cost

Enable estimated actuals for:

Control Progress
®@ ©
© ©
© ©
© ©
®@
®@
®@

@
®@
®@
@
®

On the CBS, you can access the Claim actuals tab by right clicking the cost item, and then selecting

Actuals details. In the Actuals details slide-out panel you can select the estimated actuals option.
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14.5 TIME-PHASING

Time phasing lets you take for example, your budget, and break it down into more consumable,
estimate related time blocks or periods.

14.5.1 Budget

Time-phasing your budget lets you plan expenditures for your project within active fiscal periods,
letting you break down budget planning into manageable short-term goals. Enabling time-phasing lets
you plan your budget and spread it throughout the length of the project per cost item.

Time phasing

Enable time phasing for the following:

Budget (i)

P
&)

Edit past Time phased budget values )

You can enable time-phasing for budget at the organizational level to set the default for all the projects
within that organization. By default, new projects will inherit the organization settings.

14.5.2 Enable time-phasing for budget

To enable time-phasing the budget for your project, you must have start and end dates assigned to
cost items. When you switch the Budget toggle to On, and do not have start and end dates assigned to
cost items, a Cost items are missing start and end dates dialog box shows.
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Cost items are missing start and end dates.
How would you like to populate the missing cost item start and end dates?

@ Default all budget to current fiscal period
() Default to project start and end dates

) Go back and populate the missing dates

=3

You can select from the following options:

¢ Default all budget to current fiscal period — The first option you have is to default all of the
budget to the current fiscal period. Then, all cost items that don't have defined start and finish
dates have the current budget going to the current fiscal period.

For example, if you look at WBS phase code 1007, you would have $100,000 put into December

2020.
3/ CBS position Description WBS phase CB total cost Start Finish Cost curve Panding
D code budget cost

v 1000 §4879000  01/01/2020 $15

" 1002 $2502000  01/01/2020 Back Loaded o
O 12 10011 $5050.00  12/30/202 Front Loaded $ 4,640.00
13 1003 $512000 540.00
D 14 1004 $1,600.00 $10.00
15 1008 $1.000.00 0.00
D 16 1006 $11.0000 >
0 v 1008 $305,000.00 $000
D v 21 Staff 1010 $ 305,000.00 Linea $000
211 PM 1007 § 10000007 Linear $000
PE 1003 $85,000.00 Linear $000
0 213 Super 10m 120,000 01 Linear $000
3 Staff training 1012 s00
4 Craft training ws | si7se000 Linear $000
B 1014 $000
Subtotals 54 $431.790.00 $150.00

¢ Default to project start and end dates — On the project details page you define all the project
start and end dates. After those are defined, then we can default all those missing start and end
dates to just the project start and end dates.

¢ Go back and populate the missing dates — You can also return to the Time phased budget step
and manually populate the missing dates. If you choose this option, the budget setting turns off
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again (if it wasn't already turned off and on again in previous sections). You then have to go into
the CBS and manually enter all the start and finish dates. Then, you could turn the budget setting
back on and it should distribute the budget.

Currently, time-phased budget data can only be seen in the CBS contract adjustment.

Click Confirm after selecting an option and then save your setting.

14.5.3 Edit previous time-phased budget values
You can enable the Edit past Time phased budget values toggle to edit past fiscal period time phased
budget values.

When this setting is enabled and with the applicable permissions, you can edit your past time phased
budget values via a budget move or a contract adjustment in the time phased budget step.

You can also select to edit time phased budget for closed periods. When you want to edit time phased
budget for closed periods, enable the Edit past Time phased budget values toggle.

For more information, see Time-phased budget.

14.5.4 Switching off time phasing budget

When the Time phasing budget is enabled, it means that there is time phasing budget data in the
database. If you disable time-phasing for the budget at the project level, the following warning
message shows:
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X

Are you sure you want to delete Time phased budget? %

Turning off time phased budget will delete all existing time phased budget
data for the project.

| By selecting this checkbox and accepting these conditions, |
understand that all time phased budget data will be deleted for this
project.

All of your time phased budget data is deleted when you switch time phased budget off. You
must acknowledge that the data will be deleted by selecting the check box in the dialog box.

To disable time phasing budget, select Yes, and then click Save. This will delete the time phasing
budget data from the database.
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14.6 FORECAST

14.7 TIME-PHASING

Time phasing lets you take for example, forecasting, and break it down into more consumable,
estimate related time blocks or periods.

14.7.1 Forecasting

Time-phasing your forecast gives you more visibility into what activities and costs are going to occur in
smaller time periods.

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE SYNC INTEGRATIONS OTHERS

Time phasing

Enable time phasing for the following

®©

Forecasting (i)

©

Push Time phased forecast to Live forecast

Commitments @

©

* Forecasting — Set the Forecasting toggle to On to enable time-phase forecasting to spread
forecast remaining values into the project’s fiscal periods.

¢ Push Time phased forecast to Live forecast — Set the Push Time phased forecast to Live
forecast toggle to On to update the live forecast in the CBS with the modified values in time-
phased forecasting.

¢ Commitments — Set the Commitments toggle to On to spread committed remaining cost and
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uncommitted remaining cost values into the project’s fiscal periods.

Time phasing

Enable time phasing for the following:

Forecasting (i) [S]

Push Time phased for
Time phasing commitments provides the ability to
spread both Committed remaining cost and
Uncommitted remaining cost values into the
project's fiscal periods

commitments (i)

In Project details you can see the start and end dates which define the earliest and latest project
periods.

When time-phased forecasting is enabled, the Time phase forecasting option shows in the CBS’s Action
drop-down list.

For more information, see Time Phased Forecasting.

14.8 FORECAST

In the Forecast section of the Forecast setting, you can configure the percent complete threshold from
a straight-line calculation and select to have mandatory notes when using a manual forecast.

14.8.1 Percent complete value at which delta from straight line
calculation utilizes average performance

By configuring the value of the % complete value at which delta from straight line calculation utilizes
average performance field, you can determine the equation used for the Delta from Straight-Line
column depending on if those cost items have their % complete greater than or less than the value set
in configurations.

Changing the threshold and impacting the formula is necessary because when a cost item has not been
sufficiently completed, the actuals data is not yet reliable enough to predict the final anticipated cost
(forecast cost) of that scope of work, so a different equation should be used until that cost item has
been sufficiently completed.

For example, if the threshold is 3% complete, and a cost item is less than 3%, then delta from straight
line = Forecast total cost - CB total cost. Once the cost item has reached 3% complete, then the calc
switches to Forecast total cost - Average performance total cost.
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14.8.2 Mandatory notes for manual forecasts

You can set manual forecast notes to be mandatory for Manual (EAC) and Manual (ETC) forecasts when
switching to a manual forecast type. This feature helps to keep track of manually entered forecasts.
You can use the notes to explain the forecast. For example, you can enter a rationale for why a manual
forecast is being used.

Forecast
% complete value at which delta from straight line calculation utilizes Mandatory notes for Manual forecasts @
average performance

5 ©

To set notes to be mandatory set the Mandatory notes for Manual forecasts toggle to On. When
manually forecasting, notes are required to be entered in the Forecast notes are required dialog box.
Once confirmed, the notes are captured, and the forecast method automatically changes to Manual.

CBS ACS PAY ITEMS CHANGE REGISTER
Actions W @ Dﬂ ®
b4
Tasks > : ] Forecast 2 Created from Live fore... » Coon >
% CBS Description st & UoM Z Forecast 2 Forecast 2 Latest forecast note 2 Forecast
position total cost notes method
1 Financial Results ... 100 PLS $304824 @ % 2 Changed forecast total cost to $3,048 24 Manual (EAC)

w2 Misc. Rev Internal 100 PLS $2453829.03 % Rollup f
21 Mise. Rev Internal 100 | PLS $0 X

Forecast notes are requwred
Please enter a note to update your forecast.

o o o

v 22 Escalation/Contin. 1.00  Each $ 52,0000

*Notes 500

Changed forecast total cost to $3,048.24
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14.9 CUSTOM FORECAST METHOD
CALCULATIONS

You can create custom forecast methods at both the organization and project levels. The forecast
methods are customized by configuring your own calculations. Custom forecast methods created at
the organization level are inherited in new projects and can only be managed at the organization level.
Custom forecast methods created at the project level can only be viewed and managed at the project
level.

Steel Structure Training Job 3] 105093 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS

Cancel

Custom forecast method calculations

(¥ Add custom forecast method

® Custom forecast methods

v Northeast Forecast @
~ Canada West Region Forecast @
v West Ef X

Enable Forecast methods based on Allow as-built selections

Non-terminal cost items ~

Terminal cost items v

4

To create a custom Forecast Method, click the Add custom forecast method button. Enter the
Forecast method name, Forecast total cost and Forecast total Mhrs calculations manually or click the
Formula icon to choose from the list. You can create a maximum of 10 custom organization and project
level forecast methods each at one time.
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@ Add custom forecast method

New custom forecast method

o Define calculations

* Forecast method name

Midwest Forecast

+ Forecast total cost (3) -

| 1000-4000+6000+3000+10 |

* Forecast total MHrs () Iy

I [Actual eqp hrs (to date]] I — % complete -

Actual cost (to date)

i Actual eqp hrs (to date)
Actual labor cost (to date)

Actual labor cost/MHIr (to dal

Actual labor unit cest (to dat
Custom forecast methods Bctual MHrs (to date)

PRI LY IR PP T T Ry
4 *
- Miduwraet Caranact rz x

In the CBS you can select your custom forecast method in the Forecast method column of the cost
item, which updates the Forecast total cost and Forecast total Mhrs based on the forecast method’s
custom calculations.
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14.9 Custom forecast method calculations

= Gt Steel Structure Tramang Job | 105081 § Contral / Workspaces
CBS ACS PAY ITEMS
. — -
Actions = ® [ )
T -
Tasks : ] Forecast 2 InEight Controbr ¢ wan
< CBS Descrphion WES phase * CB fovecast ? Delta from * Forecast ? Forecssi
(0 position code total MHr &1 straight line notes method
C | Job Overhead 1002 0.00 250,000.00 11" Current estimate
A ( 3 Earthwork 1069 -8,000.00 400,000,00 e} Current estimate
[ 3 Coancrete 1071 - 30,0000 1500000000 ?_: Current estimate
[ v 4 Struciural Stesl 1073 4399.10 1516,282.48 = Ruallup
41 Erect Steel - Heawy 1074 0.00 1,266,327 48 (= Canada West Regio «
n a7 Erect Steel - Light 1005 -4,000.00 200,000.00 &
= [»
O 43 Bolted Connections 1006 -399.10 49.955,00 = -
I v g Materials 1084 0.00 .00 _E:_ Committed cost .
C 51 Earthwork - Mater 1085 0.00 000 &= Midwest Forecast
[ 53 Concrete - Materi... 1086 000 o.00 = Mortheast Forecas
C 53 Structure Steel - 1087 0.00 0.00 =
— _— H7BJHA Forecast
O 6 1088 0.00 000 e
Canada West Regic"_

14.9.1 Enable Forecast methods based on Allow as-built selections

You can select which forecast methods can be used based on the allow as- built settings, for both
terminal and non-terminal cost items.

There are multiple forecasts that allow as-built options to choose from to help you configure your
forecasted cost items, in addition to the existing available Control forecasting methods. When an
option is disabled, that method is not available to select for cost items with the allow as-built selected.

InEight Inc. | Release 26.5 Page 593 of 632



14.9 Custom forecast method calculations Control User Guide

Enable Forecast methods based on Allow as-built selections

Non-terminal cost items ~

When Allow as-built is set to Alfor Cost
Enable the following Forecast methods for non-terminal cost items when Allow as-huilt is set to Aifor Cost

Current estimate @ Manual (ETC) @
il i ~
Current budget @ Manual (EAC) @] VEITIE CEEDS
Average performance @ None @ When Allow as-built is set to Allor Cost
Enable the following Forecast methads for terminal cost items when Allow as-bilt is set to Alor Cost
Committed cost @ Contract @ Current estimate =] Manual (ETC) @
Default Forecast method for non-terminal cost items when Allow as-builtis set to Alfor Cost Current budget @ Manual (EAC) (©]
e it estimats -
srentestimete Average perfarmance @ Hone (@]
Committed cost @ Contract @
When Allaw as-built is set to Quantity
Enable the following Forecast methads for non-taminal cost items when Allow as-built is setto Quantity Detaled ETC @
Curert estimate © Manual ETC) © Default Forecast metho for terminal cost tems when Allow as-buit 5 set to Allo Cost
Current budget © Manual (EAC) @ Current estimate -
Average performance © None @
i P B Wihen Allow as-built is set to Quanti
Default Fi t method f -t | cost it hen All -built s set to Quant
it Forecast method for pon-termina! cost fems when Allow ss-bultis set to Quatty Enabl the following Forecast methads for terminal cost items when Allow as-built is set to Quantiy
Current estimate hd M
Current estimate ] Manual (ETC) ©]
Current budgat @ Manual (EAC) ]
When Allow as-built is set to None
Enable the following Forecast methods for non-terminal cost items when Allow as-built is set to None Average performance © None @
Follup © Hone @ DefauitForecast method fo temminal cos tems when Allow as-buit s setto Quantity
Manual (ETEC) © Manual (EAC) [©] Current estimate M

Default Forecast method for non-terminal cost items when Allow as-built s set to Mone
Rollp When Allow as-bUiltis set to None
Enable the following Forecast methods for terminal cost items when Allow as-built is set to None

Mone

Default Forecast method for terminal cost items when Allow as-built is set to None

None
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14.10 ESTIMATE RESOURCES

14.11 ESTIMATE RESOURCES

In Estimate resources you can configure three scale percentages for wage rate composition.

14.11.1 Wage rate composition

The Wage rate composition section lets you determine what default percentage each labor hour will
be calculated at the scale 1, scale 2, or scale 3 rate.

Wage rate composition

Scale 1 Scale 2

a0 10

Scale 3

10
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14.12 SCHEDULE

14.13 SCHEDULE

In the Schedule settings tab, you can configure the following schedule settings:

¢ Define project schedule
e Cost curves

¢ Plug Day Calculation
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e Schedule ID

@ Steel Structure Training Job 31105093 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS

Cancel

® Define project schedule

‘Schedule data source

Duplicate field values for Baseline and Current schedule columns:

sd
Scheduled and Bas

le 1D and Ba dule D

Scheduled

‘Schedule W8S and Basel

hedule WBS

Roll up schedule and Baseline roll up schedule

Cost curves

Customize cost curve tabl
Data points
2
2
O Employed Cost ftem
O FrontLoaded 2
O Bell shaped 2
O BackLoaded 2
O Linear 2
O Employed Cost ftem
O FrontLoaded 2
O Bell shaped 2
. »

Plug Day Calculation

Plug days default rollup calculation

Longest child -

Schedule ID

Schedule ID settings will only affect newly created cost items

Schedule D prefix Schedule D start value

0 0

Define the delineator

14.14 DEFINE PROJECT SCHEDULE

You can define the project schedule by selecting the following options:

¢ Schedule data source (Project level only) — You can select which data source to use for your
schedule. Click the drop-down list to select to use Manual entry or an XER file type.

¢ Duplicate field values for Baseline and Current schedule columns — Select from the list to
duplicate values for schedule columns. Values selected at the organization level are inherited in
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new projects and cannot be changed. At the project level, you can further refine your selections.

Steel Structure Training Job 3] 105093 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS
@ al
@ Define project schedule

Schedule data source:

Duplicate field values for Baseline and Current schedule columns:
Schedule ID and Baseline schedule ID
Scheduled and Baseline Scheduled

Schedule WBS and Baseline schedule WBS

Roll up schedule and Baseline roll up schedule

14.15 COST CURVES

Cost curves determine the proportion of money to be expended in a certain period. You can create
custom cost curve tables to apply to your progressed work, based on actual costs and schedule. The
default cost curve assigned to a cost item is Linear.

Cost curves

Customize cost curve tables

O Description Data points
Back Loaded 2

a

[ Linear 20

[ Employed Cost ltem

[J  Front Loaded 2
Bell Shaped 21

] p

You can update the cost curve in the following ways:

¢ Cost curve column of the Schedule data block.

e When performing a contract adjustment. The budget time phasing option must be enabled in

settings.
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When the budget is locked, it sets the current budget and original budget equal to the current
estimate. The cost curve can only be changed using a change order.

14.15.1 Manage cost curve tables

Add a custom cost curve table

1. Click the Add icon, and then enter the following:
e Description of cost curve (required)
¢ Number of data points (required)

¢ Value percentages which must equal to 100%

= Description * Number of points

Linear - JS 20

From duration % To duration % Value %

0.00% 5.00% 10.00%
5.00% 10.00% 20.00% |

10.00% 15.00% 20.00%

15.00% 20.00% 5.00%

20.00% 25.00% 5.00%

Total 100.00%

i |

2. Click OK to save.

View a cost curve table

Select a cost curve table, and then click the View icon. In view mode, you can only edit a cost curve
table that is not yet assigned to any cost items.
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Delete a cost curve table

To delete a cost curve table, select a cost curve table, and then click the Delete icon. You can only
delete cost curve tables not yet assigned to cost items.

14.16 PLUG DAY CALCULATION

You can select from the following options to set as default for calculating plug days when rolling up
cost items for scheduling purposes.

¢ Longest child

e Sum of all children

Plug Day Calculation

Plug days default rollup calculation
Longest child -

Longest child

Sum of all children

14.17 SCHEDULE ID

You can define new cost items schedule ID options. The settings you define determine your ID
structure.

When integrating with InEight Schedule, Schedule IDs in Control must correspond to Activity IDs in
InEight Schedule.

When integrating with Primavera, Schedule IDs in Control are used to map Primavera Activity IDs to
import and export project information. The status of construction activities and progress are then
integrated back into the InEight scheduling tools.

When using a XER type file to import a schedule, the Schedule ID in Control must match the Activity ID
in the XER file.
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Schedule ID

Schedule 1D settings will only affect newly created cost items

Schedule 1D prefix Schedule 1D start value

0 0

Define the delineator

You can define the following:
e Schedule ID prefix
¢ Schedule ID start value

¢ Define the delineator
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14.18 REVENUE

14.19 REVENUE

Revenue settings are available at the project level only. You can define and configure setting for the

following:

¢ Revenue and Cost Timing

¢ Billing method default earnings rules

e Pay item to cost item forecast (T/O) quantity relationship

e Markup

14.20 REVENUE AND COST TIMING

In the Revenue and Cost Timing table, you can define a default retainage percentage and set the
reoccurrence payment period at the cost category level for the following:

e Retention percentage

e Tax percentage

e Payment timing - The Payment timing provides the following options:

o

o

e}

o

Same period
Next period
End of project

Set custom reoccurrence — When selected, the Next months column activates to set a
customized reoccurrence.

Subcontract Retention released

Client Retention released

The default retainage percentage is held back from each bill on the pay items. Pay item retainage
creates an incentive for contractors to complete contracted work on a project. Typically, contractors
do not get paid the total amount of money until all work or a set milestone is completed. With pay
item retention, an agreed upon retainage percentage is held back by the owner for each bill by the
client until the owner agrees to release the retention.
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You can set the average calendar days elapsed from the billing collection, in addition to setting the end
of project date to any of the following options in the End of project date drop-down list.

¢ Project end date

e Forecast completion date

e Contract completion date

¢ Certificate of substantial completion (expected)

» Certificate of substantial completion (expected)

=  {d Steel Structure Training Job 31 105093 / Seftings

> PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

Cancel

@ :
@ Revenue and Cost Timing
3]
@ Category Retention Tax Payment timing Next __ months

Labor cost 0.00 % 0.00% Same period

Construction Equipment cost 0.00% 0.00% | Same period

FOM Rented Equipment cost 0.00 % 0.00% Same period

Supplies cost 000% 0.00% | Same period

Materials cost 0.00 % 0.00% Same period

Subcontract cost 000 % 000% Same period

Fees cost 0.00 % 0.00% Same period

G & A cost 0.00 % 0.00% Same period

Allowance cost 0.00 % 0.00% Same period

Undefined cost 0.00 % 0.00% Same period

Billing 0.00 % 0.00% Same period

. »

Payment timing Next _months
Subeontract Retention released Same period
Client Retention released Same period
Average calendar days elapsed from billing to collection End of project date
(] Project end date -
Enforce change order price values to match between Control and Change @
@ w|

When changing the Default Billing retainage percent, a dialog box shows where you can choose to
either update all existing items on a project, update matching existing pay items, or only apply to pay
items created in the future.
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You are making a change to an existing retainage % on this project
How would you like to proceed?

items that were not modified

14.20.1 InEight Change integration

When integrated with Change and approving contract adjustments from Change to Control, you enable
the Enforce change order price values to match between Control and Change toggle to allow change
order pay item values to match or not match the amount received from Change. This is ideal when pay
items are being used in a contract adjustment.

When the Enforce change order price values to match between Control and Change toggle is switched
OFF, pay item amounts are not required to equal the amounts from Change to approve contract
adjustments from Change.

When switched ON, Net contract changes for pay items must equal current price from the received

change order.

14.21 BILLING METHOD DEFAULT EARNINGS
RULES

You can manage the default cost item earnings amounts based on either Forecast (T/O) quantity or CE
total cost for the following billing methods.

¢ Fixed final price

¢ Unit price
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e Cost Plus

£ Steel Structure Training Job 31105093 / Seftings

> PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

Cancel

Billing method default earnings rules

@ Default cost item earnings amounts (@

Fixed final price
Eamings amounts based on:

) Forecast (T/0) gty

@® CE total cost

Unit price
Eamings amounts based on:

() Forecast (T/0) aty

(® CE total cost

Cost Plus

The default earnings are calculated using the forecast takeoff quantity of the cost item and comparing
it to the total forecast takeoff quantities of all the cost items assigned to that pay item to generate the
percentage.

14.21.1 Fixed final price and Unit price

Fixed final price and Unit price lets you select a default way to calculate those earnings amounts based
on takeoff forecast quantity or CE final cost. After the settings are saved, all your fixed final price pay
items that normally calculate based on CE final cost and unit price then calculate forecast takeoff
guantity or any of the other options you select. You can still modify this selection at the pay item level.

14.21.2 Cost plus

Cost plus pay items can have revenue calculated based on the assigned cost items' CE total cost or
Forecast total cost.

14.22 PAY ITEM TO COST ITEM FORECAST
(T/O) QTY RELATIONSHIP

You can manage settings for pay the item to cost item forecast (T/O) quantity relationships using the
Enable pay item Forecast (T/O) qty rollups and Enable pay item Forecast (T/O) gty roll down toggles.
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14.22.1 Enable pay item Forecast (T/O) quantity rollups

The Enable pay item Forecast (T/0) qty rollups toggle is only applicable to unit price pay items. It lets
you enable the pay item forecast take-off quantity to be calculated based on the sum of all the
assigned cost items forecast takeoff quantities.

) Steel Structure Training Job 31105093 / Settings

w

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

| Cancel ‘

Pay item to Cost item Forecast (T/0) gty relationship

) Enable pay item Forecast (T/0) qty rollups () Enable pay item Forecast (T/0) qty roll down ()
@ S

When the Enable pay item Forecast (T/O) gty rollups toggle is enabled, you can no longer edit your pay
item forecast takeoff quantity in the Pay item register.

For example, you cannot add unlike units of measure. Only cost items that have the same unit of
measure as the pay item can contribute to that pay item’s forecast takeoff quantity.

In the following image, the two cost items have different units of measure.

napshot Curent revenue forecast + | Billed date: 09/06/2017 to 04/06/2001 () ® = Q

Pay item Description Total price Unit Fore. U~ Total Price Pay Quantity Unit Price Billing method
number ice i

CBS Position Description orecast (T/0) gty UoM CE final cost

Cost item 1 has a unit of measure of box, which also has the pay item contribute quantity box checked.
Cost item 2 has a unit of measure of bag with the pay item contribute quantity box unchecked. When
you go into the update earning rules editor, you cannot check the pay item contribute quantity box for
cost item 2 because the unit of measure does not match with cost item 1.
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X

Pay item 1D Description Total Price

Pay item - demo Demo $2.700.00

Caleulate earmning amounts by:
@ Forecast (T/0) quantity

CE final cost

CBS Position Descript... Pay item Earning % Eamning Earnings WBS Phas
contrib.. Amount Timing
quantity (Forecast)
M Cost item 1 1 6 $15 )0 Percent complete
4 Percent complete
[ b
Wy
100.00 %
Default Earning Rules

Cancel

If you deselect the pay item contribute quantity box for cost item 1, the cost item’s quantity does not
contribute to the pay item’s quantity. Then, the pay item quantity is zero. If it is checked, cost item 1
with the unit of measure of box has a forecast takeoff quantity of 150. This means the pay item also
has a forecast takeoff quantity of 150.

In the CBS, you can change the Unit of Measure from bag to box and then forecast take off quantity
updates.

By default, they both now have the pay item contribute quantity checked and the pay item forecast
take off quantity is the sum of any cost items that have pay item contribute quantity checked.

CB A PAY IT HA R
Actions - IC*_-}' —.'_l" I:>_(>'
L] - -
LEELE H REELLEELS ¢ oo > H
% CBS position Description WBS phase Resource Forecast (T/0) UoM
code quantity
M Cost item 1 o - BOX
‘_h 42 Cost item 2 02 10000 Bag p -
am
43 Cost item 3 03 100.00 PLS
Ad Cost item 4 04 1.0 PLS

For example, with cost item 2 updated, the forecast takeoff quantity from of 100 is added to the
forecast takeoff quantity of cost item 1. The total forecast takeoff quantity is now 250. It includes both
of them since they now both have a matching unit of measure.
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Also, this affects you earnings percent as well if you have forecast takeoff quantity selected. The pay
item contribute quantity for both cost items drives your earnings percent if the forecast takeoff
guantity radio button is selected. It also decides which cost items are going to contribute to the pay
item’s forecast takeoff quantity.

When you turn to ON Enable pay item Forecast (T/O) qty rollups, the Pay item contribute
quantity column does not show by default. To add it, go into the columns chooser, and then
select that column. After it is added to your view, it remains there until you deselect it from the
columns chooser.

Pay item - demo
Total Price Pay Quantity Unit Price Billing method
R H RDER R
Eamings amounts based on: Forecast (T juantity € finall Y item tribule quantity 7 Update eamning rule
CBS Position Description Pay item Earning % Earming Amount
contribute (Forecast)
qunrn]p

100.00 $25,000.00

In the Update earnings rule dialog box, the Pay item contribute quantity column is a default editable
column in that view. The Pay item contribute quantity column is not editable in the main table. You can
only select to add it to your main table view in the pay item slide-out panel for informational purposes.

The Pay item contribute quantity column is not available when the setting is turned to OFF or if you are
not looking at a unit price pay item. If a user turns the setting to ON and added the column, and then
decided to turn the setting to OFF, the columns no longer show.

14.22.2 Enable pay item Forecast (T/O) quantity roll down

When the amount of contract deliverables changes on unit price contracts, manually updating all the
guantities for every associated cost item can be time consuming. Pay item forecast take off quantity
allocations can be proportionally rolled down to the assigned cost items by setting the Enable pay item
Forecast (T/0O) gty roll down switch to On.
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The unit price pay item Forecast (T/O) quantities proportionally rolls down to the contributing cost
items’ Forecast (T/O) quantities. Pay item to cost item roll down changes also show in the CBS Audit
log.

CBS ACS PAY ITEMS
Actions ® (%
 Pay item Pay item Description Current Current Current UoM Current
O position number unit price pay qty forecast billing
(T/0) gty method
O 3 BP Office $124,730.58 1.000 8000 PLS Cost plus
LY

Carrying Job | . / Control / Workspaces

Actions = ®
Y
Tasks  RERGEES
% CBS position Description Resources
O v 2111 Site .
O 21111 Site ..
O 21112 Temp.. 9 £.000

The Allow as-built setting must be set to All or Quantity for the selected cost items.

14.23 MARKUP

On the Revenue tab, you can configure a default markup percentage that applies the markup to the
entire project. The Markup percent table adds a markup per cost category and per resource type on all
cost categories in resources in the project.
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1t  Steel Structure Training Job 3| 105093 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

Cancel

Markup

Default markup percent

14.00 %

R Cost categories Markup percent Current estimate resources Markup percent

Labor 14.00 % Labor 14.00%
Censtruction Equipment 14.00 % Construction equipment 14.00 %
FOM Rented Equipment 14.00 % Rented construction equipment 14.00 %
Supplies 14.00 % Installed material 14.00 %
Materials 14.00 % Installed equipment 14.00 %
Subcontract 14.00 % supplies 14.00 %
Fees 14.00 %

Allowance 14.00 % ! '
G&A 14.00 %

Undefined 14.00 %

4 »

For example, if you added 10% to Labor resources, then any labor resources automatically have a 10%
markup added to it, and that affects the resources charge rate. Then that charge rate affects the
amount of revenue that cost items can bill for and earn.

After you set labor at 10% and click Save, you can select from the following options to confirm your
change:

__opton | Dearpion

Update all existing This option adds 10% resource markup percent for all labor
cost categories and  resources.
resources in the

project

Update matching This option changes the current charge rates only for resources that
existing cost were not manually modified. Anything that has not been modified
categories and such as a labor resource, this option overrides it with 10%.
resources
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__opton | Desorpion

Only apply to cost This option makes no changes to existing resources. Any newly
items and resources  created resources, labor resources in this example, have a 10%
created in the future  markup added to them.maps

Cost categories are applicable in plug cost items that do not have resources or are not resource driven.
The cost categories have only a blanket cost category markup that helps drive the total revenue
amount on the cost item.

You can view this information from Markup columns such as Billing rate markup amount, CE billable
amount, Markup amount, and CE revenue amount.

£  Steel Structure Training Job| 10.. / Control / Workspaces:

cBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View

Cost categories -
atios v+ ® B O ® B 9 § m I B = Q
X
M Tasks i | Task details < oo [
- Job Overhead
% CBS Description Resources Forecast (1 CURRENT ESTIMATE
position aty DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
1 Job Overhead % complete S Live forecast method Latest actuals in forecast
N values
] 2 Earthwork s 000% Curentestimate ¥ O 03/24/2021
o 3 Conerete 5
Total  Perunit

a Vo4 Structural Steel

o o Erot Stoel - Heary 5 Cost category Current budget Actual cost (to date)  Current estimate & Live forecast o Fu:ca:r':g » :'irl:::.gn:m markup

a 42 Erect Steel - Light s  Total §0.00 $250,000.00 $2504 Forecast remaining cost

a 43 Bolted Connections 5 ~ Labor $0.00 $250,000.00 s 2504 Billing rate markup amount
CE billable amount

o v 5 Materials ~ Construction. $0.00 $0.00
Markup %

[m} 51 Earthwork - Mater. 1 v FOM Rented $000 $000 Markup amount

[m] 52 Concrete - Materi, 1 v Supplies $0.00 $000 CE revenue amount
[J Committed remaining cost

Subtotals 12 (1 rows selected) 4

(O Committed total cost

The following table shows markup column information in the Cost categories tab of the Cost item
details slide out.

CE Current estimate amount + your Billing rate markup amount = CE billable
billable amount
amount

Markup Markup percent x your current estimate = markup amount - The Billing rate

amount markup amount for plug cost items is always set to zero because you can only
have a billing rate on resources. When this is a detailed cost item, this will shows
your billing rate markup amount for all those resources.
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CE CE billable amount + your Markup amount = CE revenue amount - The CE

revenue revenue amountis how much revenue a cost item can have. This is only

amount applicable for cost plus pay items. You can apply markups on cost items, and they
do not affect the revenue on those cost items. The markups affect the revenue for
cost plus pay items and any cost items that are assigned to cost plus pay items.

For more information, see Markup percent.
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14.24 SYNC INTEGRATIONS

14.25 SYNC INTEGRATIONS

You can configure sync integrations for actual cost and man-hour options at the organizational level,
and manage sync schedules at the project level.

14.25.1 Organizational level

14.25.1.1 Actual cost and man-hour sync options
You have the option to choose to receive just one payload request instead of multiple ones for when
the following occurs:

» If there are multiple fiscal periods since the last successful actual cost and man-hour sync.

¢ If the sync has never been ran and the project start date is longer than one fiscal month.

To opt to receive one request, set the Send one request toggle to ON.

{2 S100000-PKS Inc / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE SYNC INTEGRATIONS OTHERS

Cancel

@ Actual Cost and Mhr Sync Options
’;,z: Send one request (§) o

When the actuals cost and mhr sync has not been
ran successfully for multiple fiscal periods send
one request instead of multiple
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14.25.2 Project level

14.25.2.2 Sync integrations schedule

You can schedule sync integrations to run at specific times. Sync types include pushing the CBS
structure, pay items, billed revenue, budget, live forecast, forecast revenue and getting quantities,
actual cost, and man-hours. For more information about push and get actions, see Push and Get
Actions in InEight Control Interfaces.

Sync Integrations schedule selectone
Push CBS structure

Push CBS structure and Budget

(¥ Add sync schedule .
Push CBS structure and Live forecast

Push CBS structure and Actual quantities
Sync type Time zone
Push CBS structure, Budget, Live forecast and Actual quantities
Select one - (UTC-07:00) Moul
Push Pay item
Push Billed revenue
Start Date Time to run sync Push Forecast revenue
05/29/2025 ] 12:00 AM Get quantities »

Get Actual cost and MHrs

Get Billed revenue
Repeat

m Daily Weekly Monthly

Cancel

When adding a sync schedule, you can define the following:
e Sync type

e Time zone

Start Date

Time to run sync

Repeat (Never/Daily/Weekly/Monthly)

The scheduled syncs show at the under the Scheduled syncs section. You can edit or delete scheduled

syncs.
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{3  Design - Test Project | 104783 / Settings

> PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS

Sync Integrations schedule

() Add sync schedule

®
Scheduled syncs
& Push CBS structure, Budget, Live forecast and Actual quantities
Synec type: Push CBS structure, Budget, Live forecast and Actual quantities Start date: 05/29/2025 7 &
Time to run sync: 12:00 AM MST Repeat on:
Repeat: Daily End: 06/30/2025

Get Actual cost and MHrs

Sync type: Get Actual cost and MHrs Start date: 05/29/2025 ® @
Time to run sync: 12:00 AM MST Repeat on
Repeat: Daily End: 06/30/2025

For more information about scheduled syncs, see Scheduled syncs in InEight Control Interfaces.

14.25.3 Considerations

e To use the sync features in Control, you must first select Control with confirmation in Global
Options. For more information, see Cost item integration behavior.

¢ To schedule syncs, you must first configure them for your organization in Application
integrations. You can open Application integrations in Main menu > Suite administration >
Application integrations.
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14.26 OTHERS

14.27 OTHERS

The Others tab contains other Control related items you can define and configure at the organizational
and project level.

14.27.1 Organizational level

The following items are Control related settings you can define and configure at the organizational
level:

¢ Required cost items

¢ Change order details

14.27.1.1 Required cost items

The Required cost items feature lets you create standardized or most commonly used cost items at the
organization level and then add them to the project structure in the CBS register.

Required cost items ®

Prevent project from syncing if required cost items are not added S
(] Description r';?ji phase UoM Account code Allow as-built
] RC1 44446666 Acre 99.99 Quantities
(] RC2 44445555 Cubic Meter Quantities
(] RC3 44447777 Barrel 00.03.01.010 Quantities
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14.27 Others

You can turned to ON the Prevent project from syncing if required cost items are not added toggle to
prevent the project from syncing if required cost items are not added.

In the cost item grid, you can add, edit, and delete required cost items.

14.27.1.2 Change order details

Change Order fields can be configured as validated drop-down list fields at the organization level.

When you set the toggle to ON, the discipline list is populated from Master Data Libraries in InEight
Platform, and the issue number and CCO fields are populated from inEight Change. When the toggle is
set to OFF, these fields are free editable text fields with no validations.

In the example below, six validated issues have been selected to be associated with this change order

after it is submitted.

Required cost items @

PROJECT TRACKING FORECAST ESTIMATE RESDURCES

SCHEDULE OTHERS

©]

de
ACLY

RCL2

AOCI1

m]
(]
(]
O RequiredTest! 233438
(]
(]

ROCI1Z

Change order details

Prevent project from syncing i required cost flems are not sdded | (%)

Description Ll

taake fiekds valideted dropdowns @

Ush Account code

Acre 00.03.01.004 5thr_.

Barrel

Bag 00.03.01.004
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14.27.2 Project level

The following items are Control related settings you can define and configure at the project level:

e Required cost items

¢ Decimal precision

14.27.2.3 Required cost items

You can prevent the project from syncing when required cost items are not included by setting the
Prevent project from syncing if required cost items are not added toggle to ON.

Required cost items

Prevent project from syncing if required cost items are not added @

14.27.2.4 Decimal precision

The image and table below summarize the different decimal precision options:
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Decimal precision

Currency - How many digits should be displayed after the decimal? (standard  Cost Sumimary - How many digits should be displayed after the decimal?

rounding apphied) (standard rounding applied)

4 4
Guantites - How many digits should be displayed afterthe ecimal?
(standard rounding applied)

2

2
stand

Percentages - How many digits should be displayed after the decimal?
(standard rounding applied)

st - How many digts shoud be displayed aftr the decimal?
vd rounding applec)

&

cas ACS PAY ITEMS CHANGE REGISTER AUDITLOG

v cls Description WBS phase Forccast

0O posiion code otal cost = otel
M/

0 1 Job overhead 1002 $250000.0000 000 000 00000 §25000000 $250000.0000
¢t 0 2 Earthwork 1069 5.400000.0000 800000 080 10000 54000 54000000000
m] 3 Concrete 1w0n $0.0000 2000000 200 10000 $000 §0.0000
0 v Structural Steel 073 10500000000 2100000 2100000 19523 $1,050000.00 $1,050,000.0000
0 a ErectSteel - Heavy 1074 $800000.0000 1600000 16000.00 10000 $800000.00 $800,000 0000
0 a2 ErectSteel - Light 1005 $200000.0000 400000 400000 10000 $200000.00 52000000000
O 43 Bolted Connections 1006 $50,000.00¢ 00 100000 1,000.00 1.0000 $5000000 $50,000.0000
Labor 1088 500000 000 000 00000 s000 00000
5 Equipment 1089 $0.0000 000 000 00000 $000 $0.0000
31 Party 1050 50.0000 000 000 00000 5000 500000
O ~vs Materials 1084 $1.750000.0000 000 000 00000 175000000 $1750000.0000
o 51 Earthwork - Mater_ 1085 $250000.0000 000 000 00000 52500 $250000 0000
(u] 52 Concrete - Materi. 1086 $1,000000.0000 000 000 00000 $10000  $1,000000.0000
O 53 Structure Steel - 1087 $500,000.0000 000 000 0.0000 $500.00 $500,000.0000
Subtotals 14 534500000000 59.000.00 $3,450000.0000

T "

1 Currency Number of decimal places for currencies. Any field that includes
currency data will be affected by this setting.

2 Cost Number of decimal places for total cost information both at the terminal
Summary and non-terminal level.

3 Unit Cost Number of decimal places for any unit cost displayed.
4  Quantities Number of decimal places for any quantities displayed.

5 Percentages Percent complete calculations at both the terminal and non-terminal
level.

14.28 FREQUENTLY ASKED QUESTIONS

Why is the actual quantity not rolling up to the parent cost item?

Actual gty (to date) is calculated at the parent level rather than a roll up value of Actual gty (to
date) on the children. There is a section in Control Project Settings > Project Tracking > Actuals
which determines how this is calculated. These settings are Calculate percent complete for roll-up
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items such as superior cost items and account code by: and Roll-up percent complete weighted
by:.

For example, if the project has the following options in the Actuals settings:

e Calculate percent complete for roll-up items such as superior cost items and account code
by: Cost
* Roll-up percent complete weighted by: Current Budget
Then, if CB earned cost is $500 and CB total cost is $1000, the parent cost item is calculated as
$500/$1000 = 50% as the % complete. Actual qty (to-date) is then % complete multiplied by the
Forecast (T/0O) qty or CB total gty depending on what you have selected in settings against
Calculate percent complete for individual cost items as a percentage of. If you had Forecast (T/0)

gty as this setting and the Forecast (T/0) gty on the parent is 1.00, then the Actual gty (to date)
would be 50% x 1.00 = 0.50.

See Also:

Project Settings

Progress Measurement Overview

Related Videos:

n Video Link Title Here

How do | get my Current Budget (CB) and Current Estimate (CE) values to be in sync?

Set the desired values in the CBS for CE total cost, CE total MHrs, and Forecast (T/O) qty. Within a
Contract adjustment using the Start with Cost items option or a Non-associated budget move,
click the Calculate icon to auto-populate the adjusted cost, man-hours, and/or quantities with
values to match the current estimate. Within a Contract adjustment using the Start with Pay
items option or an Associated budget move, click on the Advanced options button to do the
same.

See Also:

Associated Budget Move (Net Zero Dollar Move)

Non-Associated Budget Move

Contract Adjustment

Related Videos:
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n Video Link Title Here

| can’t edit resource values on a cost item - why?

The cost item's cost source must be set to Detail to edit the resource attributes and values on a
cost item.

See Also:

Cost Item Details

Estimate Resources

Related Videos:

n Video Link Title Here

| can’t submit or approve a budget move - why?

Does the overall adjusted cost = 0? If not, you cannot submit. Do you have the permission to
approve change orders? If not, someone else on your project with the Approve change orders
permission will need to approve.

See Also:
*Title Link Here

Related Videos:

n Video Link Title Here

| can’t submit or approve a contract adjustment - why?

Was the contract adjustment initiated from Change? If so, the total adjusted price in the Pay
items step must equal the executed price on the change order from Change.

See Also:

Contract Adjustment

Related Videos:

n Video Link Title Here
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My Forecast (T/O) qty changed without me directly changing it - why?

Check the Qty driver, is it set to Superior CI? And then did someone change the parent qty? This
updates the children with a Qty driver of Superior CI.

See Also:
*Title Link Here

Related Videos:

u Video Link Title Here

| can’t change my Allow as-built option on my cost item - why?

Check the Qty driver, is it set to Superior CI? And then did someone change the parent qty? This
updates the children with a Qty driver of Superior CI.

See Also:

Progress Control Settings

Actuals by Sync

Actuals by Manual Entry

Related Videos:

u Video Link Title Here

| can’t see the change to this field in the audit log - why?

Was it changed through Excel import? Excel import changes do not create an entry in the audit
log.

See Also:

Audit Log

Related Videos:

u Video Link Title Here

When | send a view to an organization, do people assigned to projects get the view or just
people assigned to the org?

People assigned to either the organization or any project under that org will receive the view.
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See Also:
*Title Link Here

Related Videos:

n Video Link Title Here

My forecast calculations are wrong!

Check that your organization isn’t within “plus days”, and if it is, then make sure you are
calculating excluding any actuals with a posting date after the month end date.

See Also:
*Title Link Here

Related Videos:

n Video Link Title Here

14.29 FREQUENTLY ASKED QUESTIONS

Why is the actual quantity not rolling up to the parent cost item?

Actual gty (to date) is calculated at the parent level rather than a roll up value of Actual gty (to
date) on the children. There is a section in Control Project Settings > Project Tracking > Actuals
which determines how this is calculated. These settings are Calculate percent complete for roll-up
items such as superior cost items and account code by: and Roll-up percent complete weighted
by:.
For example, if the project has the following options in the Actuals settings:

e Calculate percent complete for roll-up items such as superior cost items and account code

by: Cost

e Roll-up percent complete weighted by: Current Budget
Then, if CB earned cost is $500 and CB total cost is $1000, the parent cost item is calculated as
$500/51000 = 50% as the % complete. Actual gty (to-date) is then % complete multiplied by the
Forecast (T/0O) qty or CB total gty depending on what you have selected in settings against
Calculate percent complete for individual cost items as a percentage of. If you had Forecast (T/0)

gty as this setting and the Forecast (T/0) gty on the parent is 1.00, then the Actual gty (to date)
would be 50% x 1.00 = 0.50.
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See Also:

Project Settings

Progress Measurement Overview

Related Videos:

n Video Link Title Here

How do | get my Current Budget (CB) and Current Estimate (CE) values to be in sync?

Set the desired values in the CBS for CE total cost, CE total MHrs, and Forecast (T/O) qty. Within a
Contract adjustment using the Start with Cost items option or a Non-associated budget move,
click the Calculate icon to auto-populate the adjusted cost, man-hours, and/or quantities with
values to match the current estimate. Within a Contract adjustment using the Start with Pay
items option or an Associated budget move, click on the Advanced options button to do the
same.

See Also:

Associated Budget Move (Net Zero Dollar Move)

Non-Associated Budget Move

Contract Adjustment

Related Videos:

n Video Link Title Here

| can’t edit resource values on a cost item - why?

The cost item's cost source must be set to Detail to edit the resource attributes and values on a
cost item.

See Also:

Cost Item Details

Estimate Resources

Related Videos:

n Video Link Title Here
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| can’t submit or approve a budget move - why?

Does the overall adjusted cost = 0? If not, you cannot submit. Do you have the permission to
approve change orders? If not, someone else on your project with the Approve change orders
permission will need to approve.

See Also:
*Title Link Here

Related Videos:

n Video Link Title Here

| can’t submit or approve a contract adjustment - why?

Was the contract adjustment initiated from Change? If so, the total adjusted price in the Pay
items step must equal the executed price on the change order from Change.

See Also:

Contract Adjustment

Related Videos:

n Video Link Title Here

My Forecast (T/O) qty changed without me directly changing it - why?

Check the Qty driver, is it set to Superior CI? And then did someone change the parent qty? This
updates the children with a Qty driver of Superior Cl.

See Also:
*Title Link Here

Related Videos:

n Video Link Title Here

| can’t change my Allow as-built option on my cost item - why?

Check the Qty driver, is it set to Superior CI? And then did someone change the parent qty? This
updates the children with a Qty driver of Superior Cl.

See Also:
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Progress Control Settings

Actuals by Sync

Actuals by Manual Entry

Related Videos:

n Video Link Title Here

| can’t see the change to this field in the audit log - why?

Was it changed through Excel import? Excel import changes do not create an entry in the audit
log.

See Also:

Audit Log

Related Videos:

u Video Link Title Here

When | send a view to an organization, do people assigned to projects get the view or just
people assigned to the org?

People assigned to either the organization or any project under that org will receive the view.
See Also:
*Title Link Here

Related Videos:

u Video Link Title Here

My forecast calculations are wrong!

Check that your organization isn’t within “plus days”, and if it is, then make sure you are
calculating excluding any actuals with a posting date after the month end date.

See Also:
*Title Link Here

Related Videos:
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n Video Link Title Here

14.30 WORKFLOWS

14.30.1 Product Workflows

14.30.1.1 InEight Control General Workflow

This workflow illustrates the main features of InEight Control, including managing account
codes, measuring progress, forecasting final man-hours and costs, managing revenue and
managing budget and contract changes.
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InEight Control General Workflow
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Create/Manage
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14.30.2 Business Process Workflows

14.30.2.2 Cost Budgeting and Forecasting: Budget

Management

This workflow illustrates the main features of InEight Control, including managing account

codes, measuring progress, forecasting final man-hours and costs, managing revenue and

managing budget and contract changes.
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14.30.2.3 Cost Budgeting and Forecasting: Forecasting

This workflow shows how InEight Control can be used to create multiple shareable

forecasts as needed, either through automatic calculation or manual entry.
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14.30.2.4 Billing Management

This workflow shows how InEight Control can be used to access current budget and pay
item details and keep the budget up to date throughout the billing cycle.
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14.30 Workflows

14.30.2.5 Earned Value Management

TThis workflow illustrates how InEight Control can be used to track earned value through
a variety of performance indicators.

InEight Inc. | Release 26.5

Page 631 of 632



14.30 Workflows Control User Guide

Control Contract Progress Schedule Design External
Locked Budget and . Manual Progress
Pay ltems Vendor Progress Field progress Schedule Dates Design Progress Entry

<+ |t o

Update Budget with |

Actuals, -
Commitments, | --}-----------~- -~~~ J- -l 4
Schedule & Billed

Re§ue

Calculate Eamed
Value

Page 632 of 632 InEight Inc. | Release 26.5



	Chapter 1 — Overview
	1.1 Overview
	1.1.1 Account Code Management
	1.1.2 Progress Measurement
	1.1.3 Forecasting
	1.1.4 Revenue Management
	1.1.5 Change Management
	1.1.6 InEight Control Workflow


	Chapter 2 — General Navigation
	2.1 Page Navigation
	2.1.1 Navigate the InEight Control Workspaces Page
	2.1.2 Right Toolbar Overview

	2.2 Workspaces
	2.3 CBS register
	2.4 ACS register
	2.4.1 ACS Navigation

	2.5 Pay Items register
	2.5.1 Pay Items register columns
	2.5.1.1 Revenue forecasting columns
	2.5.1.2 Change management columns

	2.5.2 Move Pay Items
	 Move pay items


	2.6 Change Register
	2.7 Audit Log register
	2.8 Columns/Grouping/Sorting
	2.8.1 Resize column width
	2.8.2 Move Columns
	2.8.3 Sort Columns
	2.8.4 Filter Columns
	2.8.4.1 Method 1: Filter from Column Header
	2.8.4.2 Method 2: Filter by Query
	2.8.4.3 Query Builder

	2.8.5 Filter Indicator
	2.8.6 Grouping
	 Group Data by Column Values


	2.9 Data Blocks
	2.9.1 Data Block Categories
	2.9.1.1 Standard Data Block
	2.9.1.2 Forecast Data Block
	2.9.1.3 Cost Category Data Block

	2.9.2 Manage Data Blocks
	2.9.2.4 Thumbnail View
	2.9.2.5 List View

	2.9.3 Data Block Context Menu
	 Edit a Data Block

	2.9.4 Custom Data Blocks
	 Create a Custom Data Block


	2.10 Viewsets
	 Create and Save a Viewset
	2.10.1 Sending Views and Data Blocks
	 Send a Viewset


	2.11 Row Density
	2.12 Audit Log
	2.12.1 CBS
	2.12.2 ACS
	2.12.3 Pay Items
	2.12.4 Integration
	2.12.5 Import history
	2.12.5.1 Pending status
	Option 1
	Option 2

	2.12.5.2 Failed with errors status


	2.13 Project Introduction

	Chapter 3 — Cost Item Setup
	3.1 Cost item setup workflow
	3.2 Cost Item Overview
	3.2.1 Cost Breakdown Structure
	3.2.2 CBS Tree
	3.2.3 Cost Item Menu
	3.2.4 Cost Item Dashboard

	3.3 Cost Items
	3.3.1 Cost Item Creation
	 Create A New Cost Item
	 Create a New Subordinate Cost Item
	3.3.1.1 Create Multiple Cost Items

	3.3.2 Required Cost Items
	3.3.3 Cost Item Arrangement
	 Move a Cost Item

	3.3.4 Viewing the CBS Grouped by Column
	 CBS Group by Column

	3.3.5 Cost Item Deletion
	3.3.6 Copying Cost Items with Resources
	 Copy and paste cost items

	3.3.7 Design total qty and Design total MHrs columns in the CBS
	3.3.8 Create cost items in InEight Change

	3.4 Hide in Plan, Progress, and Design
	3.4.1 Hide feature in a cost item
	3.4.2 Hide feature in the CBS Workspace
	3.4.3 Considerations

	3.5 Cost Item Excel Import
	3.5.1 Forecast Excel Import
	3.5.2 Spreadsheet Rules
	3.5.3 Best Practices and Recommendations
	3.5.4 CBS Hierarchy
	3.5.4.1 CBS Predictive Hierarchy
	 Import CBS Data

	3.5.5 Resolving Import Errors
	3.5.6 Excel Import for committed cost
	3.5.6.2 Generating the commitment cost Excel spreadsheet
	3.5.6.3 Importing commitment data
	 Import Commitment Costs



	Chapter 4 — Cost Item Management
	4.1 Cost item management workflow
	4.2 Estimate Resources
	4.2.1 Navigate to Estimate Resources
	4.2.2 Manage estimate resources
	4.2.3 Resource rates
	4.2.4 Add estimate resources to a job
	Add estimate resources

	4.2.5 Data columns

	4.3 Cost item details
	4.4 Cost item details overview
	4.5 Details tab
	4.5.1 Pay item contribute quantity

	4.6 Attributes tab
	4.7 Cost categories tab
	 Enter Costs in Cost Categories

	4.8 Current Estimate Resources tab
	4.8.1 Cost Driver
	4.8.2 Productivity and overall settings
	4.8.2.1 Updates to resource quantities


	4.9 Forecast Resources tab
	4.9.1 Productivity and overall settings
	4.9.2 Resource Details
	4.9.2.1 Orphan Indicator

	4.9.3 Cost Item Man-Hours
	 Define Cost Item Man-Hours


	4.10 Issue tagging in the CBS
	4.11 Lock Budget
	4.11.1 Budgets vs Estimate
	4.11.1.1 Original Budget
	4.11.1.2 Current Budget
	4.11.1.3 Current Estimate

	4.11.2 Lock Budget and Price
	4.11.3 Unlock Budget and Price

	4.12 Assigned vendors

	Chapter 5 — Progress Measurement
	5.1 Progress measurement workflow
	5.2 Progress Measurement Overview
	5.2.1 Budgets vs Estimate
	5.2.1.1 Original Budget
	5.2.1.2 Current Budget
	5.2.1.3 Current Estimate

	5.2.2 Earned value management terms
	5.2.2.4 Planned Value (PV)
	5.2.2.5 Earned Value (EV)
	5.2.2.6 Schedule Performance Index
	5.2.2.7 Actual Cost (AC)
	5.2.2.8 Variance
	5.2.2.9 Remaining

	5.2.3 Productivity
	5.2.3.10 Compensation Factor (CF)
	5.2.3.11 Labor Efficiency Index (LEI)

	5.2.4 Updating Forecast (T/O) Qty
	5.2.4.12 Forecast (T/O) - CB qty delta column

	5.2.5 Update Forecast (T/O) Qty with Plan components

	5.3 Date Range Setup
	 Date Range Setup

	5.4 Manage Actuals
	5.5 Actuals by Sync
	5.5.1 Sync Quantities
	 Performing a Get Quantities Sync
	5.5.1.1 Types of Get Quantities Syncs

	5.5.2 Sync Hours and Costs
	5.5.3 Audit Log

	5.6 Actuals by Import
	 Import Actuals

	5.7 Actuals by Manual Entry
	 Claim Actuals by Manual Entry
	5.7.1 Claim Quantities
	5.7.1.1 Claim quantities for multiple cost items
	 Claim Quantities for Multiple Cost Items

	5.7.2 Claim Man-hours
	5.7.3 Claim Equipment Hours
	5.7.4 Claim Cost
	5.7.5 Add Additional Claiming entries
	5.7.6 User-Defined Fields

	5.8 Actuals by API
	5.9 User-defined fields
	5.10 Estimated Actuals
	5.10.1 Claim Estimated Actuals in Control
	 Claim Estimated Actuals

	5.10.2 Estimated Actuals from Progress
	5.10.3 Reverse Estimated Actuals
	 Reverse Estimated ACtuals


	5.11 Actuals History
	5.12 Progress Control Settings
	 Progress Control Settings

	5.13 Vendor Work Hours from Progress
	5.13.1 Vendor MHrs from Progress

	5.14 Track Open/Remaining and Total Committed Costs
	 Viewing Open/Remaining and Total Committed Costs

	5.15 Committed cost from Contract

	Chapter 6 — Account Codes
	6.1 Account codes workflow
	6.2 Account Code Assignment
	 Assign Account Codes to Cost Items

	6.3 Quantity Contribution
	6.3.1 ACS Navigation
	6.3.2 Account Code Quantity
	 Define Account Code Quantity

	6.3.3 Quantity Contributors
	6.3.3.1 Contribution Options – Cost Item to Account Code
	6.3.3.2 Contribution Options – Child Account Code to Parent Account Code

	6.3.4 ACS Unit of Measure Toggle
	6.3.5 Account Code Quantity Conversions
	6.3.6 Notes Column

	Review
	Summary

	Chapter 7 — Forecasting
	7.1 Forecasting workflow
	7.2 Forecasting overview
	7.2.1 Private forecasts
	7.2.2 Shared forecasts
	7.2.3 Live forecast

	7.3 Forecast management
	7.3.1 Forecast data block
	7.3.2 Push to shared forecast
	 Push to shared forecast

	7.3.3 Compare forecasts
	7.3.4 Live forecast data block

	7.4 Fiscal Calendar
	7.5 Forecast Methods
	7.5.1 Forecast Method Assignment
	7.5.1.1 Global Forecast Method
	 Set Global Forecast Method
	7.5.1.2 Forecast Method for Selected Items
	 Set the Forecast Method for Selected Items
	7.5.1.3 Forecast Method for Individual Items
	 Set the Forecast Method for Individual Items
	7.5.1.4 Average Performance Forecast Method
	7.5.1.5 Committed Cost Forecast Method
	7.5.1.6 Contract Forecast Method
	Unapproved Contract Line Items

	7.5.1.7 Custom Forecast Method


	7.6 Manual Forecasting
	7.6.1 EAC vs. ETC
	7.6.2 Manual EAC (Estimate at Complete) Forecast
	  Manually Adjust Forecast Final Cost
	7.6.2.1 Proportional Adjustment

	7.6.3 Manual ETC (Estimate to Completion) Forecast
	7.6.3.2 Detailed ETC FC Method


	7.7 Time Phased Forecasting
	7.7.1 TPF Register
	7.7.2 Auto Distribute
	7.7.3 Manual Time Phased Forecast
	7.7.3.1 Proportional Man Hours and Quantity

	7.7.4 Static manual time phased forecasting (TPF)
	7.7.5 Time Phased Forecast Settings
	7.7.5.2 Enable Time Phased Forecasting
	7.7.5.3 Cost Curves

	7.7.6 Time Phased Forecast Prerequisites
	7.7.7 Time Phased Forecast View
	 Time Phased Forecast Planning

	7.7.8 Time Phased Forecast Microsoft Excel import
	 Time phased forecast Microsoft Excel import

	7.7.9 Column Chooser
	7.7.10 Audit Log

	7.8 Push to Live Forecasts
	  Push Live Forecast by Selection in the CBS Tab
	7.8.1 Time phased forecast push to live
	 Time phased forecast push to live forecast


	7.9 Live Forecast Snapshot
	7.9.1 Snapshot settings
	7.9.2 Manage snapshots


	Chapter 8 — Change Management
	8.1 Change management workflow
	8.2 Change management overview
	8.2.1 Managing changes using the InEight Suite
	8.2.2 InEight Change integration with Control

	8.3 Associated Budget Move
	Perform an associated budget move
	8.3.1 Associated Budget Move - Single Cost Item
	Perform an associated budget move within a single cost item


	8.4 Non-Associated Budget Move
	Perform a non-associated budget move
	8.4.1 Auto-Calculate budget move values
	8.4.1.1 Update current budget (CB) adjustments from current estimate (CE)
	 Perform a budget move using Auto-calculate > Update CB from CE
	8.4.1.2 Update Current Estimate from Adjusted Current Budget
	8.4.1.3 Select cost items to update
	8.4.1.4 Select automatic updates for multiple cost items
	8.4.1.5 Set setting for default current estimate update


	8.5 Budget move from InEight Change
	8.5.1 Budget move in Change
	8.5.2 Budget Move Integration Between Change and Control

	8.6 Budget Quantity / Man-Hour Adjustment
	 Perform a Budget Quantity / Man-Hour Adjustment

	8.7 Contract adjustment — Control
	8.8 Contract adjustment in Control overview
	8.8.1 Pay Item vs. Cost Item
	8.8.2 Contract adjustment options
	8.8.3 Contract adjustment header

	8.9 Start with cost items contract adjustment
	Contract adjustment starting with cost items

	8.10 Start with pay items contract adjustment
	 Starting with pay items contract adjustment

	8.11  Auto-calculate contract adjustment values
	8.11.1 Update Current Budget (CB) Adjustments from Current Estimate (CE)
	8.11.1.1 Auto-calculate current budget adjustments on the Start with Cost items workflow
	8.11.1.2 Auto-Calculate Current Budget Adjustments on the Start with Pay Items Workflow

	8.11.2 Update Current Estimate from Adjusted Current Budget
	8.11.2.3 Select automatic updates for multiple cost items
	8.11.2.4 Set setting for default current estimate update


	8.12 Contract adjustment — InEight Change
	8.13 Contract adjustment from InEight Change overview
	8.14 Contract adjustment from InEight Change overview
	8.15 Managing Changes in InEight Change
	8.15.1 InEight Change Integration with InEight Control
	8.15.2 Creating new cost items from Change executed change orders
	8.15.3 Pay item associations from InEight Change executed change orders
	8.15.4 Markup from InEight Change executed change orders
	8.15.5 Revising a CCO-Draft contract adjustment

	8.16 Contract adjustment header
	8.17 Change Approval Process
	8.17.1 Managing changes in the Change Register
	8.17.1.1 Draft changes review
	8.17.1.2 Pending changes review

	8.17.2 Group By option


	Chapter 9 — Revenue Management
	9.1 Revenue management workflow
	9.2 Pay Items
	9.3 Pay Item details
	9.3.1 Pay item details slide-out panel
	9.3.2 Details Tab
	9.3.3 Attributes Tab
	9.3.4 Change Orders
	9.3.5 Cost Items
	9.3.6 Cost Categories

	9.4 Creating and locking pay items
	 Upload pay items from a Microsoft Excel spreadsheet
	9.4.0.1 Adding Pay Item details
	9.4.0.2 Locking in your pricing

	9.5 Billing methods
	9.5.1 Fixed final price
	9.5.2 Unit price
	9.5.3 Cost Plus

	9.6 Bulk Import Pay Items
	9.6.1 Spreadsheet Rules

	9.7 Markup percent
	9.7.1 Markup % column

	9.8 Earning Rules
	  Adjusting Pay Item Earning Rules

	9.9 Billed Revenue
	9.10 Billed Tab
	9.10.1 Unit price proportional billing
	9.10.1.1 Change Orders
	Bill for revenue earned


	9.11 Retention tab
	9.12 Billed history tab
	9.13 Billed revenue columns
	9.14 Pay item revenue billing in bulk
	Bill for multiple pay items

	9.15 Sync billed revenue details
	9.15.1 Sync billed revenue

	9.16 Actualizing revenue
	9.17 Change orders
	9.18 Revenue Forecasting
	9.18.1 Pay Item Position Code Column
	9.18.2 Cost Item Revenue View
	9.18.3 Cost item revenue calculation by allows as-built

	9.19 Revenue forecasting columns
	9.20 Revenue calculations
	9.20.1 Cost Breakdown Structure (CBS) register revenue Calculations
	9.20.2 Pay Items register calculations

	9.21 Cost plus revenue forecast methods
	9.22 Push forecast revenue
	9.22.1 Revenue Snapshots

	9.23 Revenue Forecast Probability
	 Approval Probability

	9.24 Time-phased budget
	9.24.1 Budget organization setting
	9.24.2 Edit Past Time-Phased Budget Values
	9.24.3 Switching off time-phasing budget
	9.24.4 Switching on the time-phasing budget
	9.24.4.1 Default all budget to current fiscal period
	9.24.4.2 Default to project start and end dates
	9.24.4.3 Populate missing dates manually

	9.24.5 Time-phased budget in contract adjustment
	9.24.6 Time-phased budget at the budget move
	9.24.7 Time-phased budget grids
	9.24.8 Changing Distribution type to cost item
	9.24.9 Manual distribution of cost adjustment
	9.24.10 Deltas in a adjusted cost columns
	9.24.11 View cost columns
	9.24.12 Date range filter
	9.24.13 Approving budget warnings


	Chapter 10 — Scheduling
	10.1 Scheduling overview
	10.2 Schedule Data Block
	  Schedule Data Block

	10.3 Schedule Excel Import
	 Excel Import

	10.4 Primavera Schedule Integration
	10.4.1 Primavera Schedule Integration Settings
	10.4.1.1 Primavera XER Schedule Integration Prerequisites
	 Schedule Integration Import
	 Primavera Schedule Integration Export

	10.4.2 Percent Complete column updates in CBS


	Chapter 11 — Account Code Structure (ACS)
	11.1 Account code structure workflow
	11.2 What is an Account Code?
	11.3 Account Code Setup
	11.3.1 Staging vs. Published Account Codes
	 Create an Account Code
	 Edit Account Code Details

	11.3.2 Account code permissions
	11.3.2.1 Deleting account codes
	 Deleting account codes
	11.3.2.2 Replacing deleted account codes
	11.3.2.3 Renaming account codes
	 Renaming account codes


	11.4 Measurement types
	11.5 Cost category label customizations

	Chapter 12 — Interfaces
	12.1 Push and Get Actions
	 Sync Options

	12.2 Scheduled syncs
	12.2.1 Sync integrations

	12.3 Audit Log - Integration
	 Sync Audit Log


	Chapter 13 — InEight Platform settings
	13.1 Organizational breakdown structure
	13.1.1 Unique budget code segments
	    Open Project Details


	13.2 Project page
	13.3 Manage users
	13.3.1 User Management
	13.3.2 Roles and permissions
	13.3.3 Considerations

	13.4 Organization general settings
	13.5 Home page
	13.6 Global options
	13.6.1 Master data libraries
	13.6.2 Role Assignment
	13.6.3 Project display in primary navigation
	13.6.4 Cost item integration behavior
	13.6.5 Email preferences
	13.6.6 Environment indicator
	13.6.7 Session timeout
	13.6.8 Landing page default view
	13.6.9 Organization/Project images
	13.6.10 Product integrations

	13.7 Fiscal calendar
	13.7.1 Fiscal calendar

	13.8 Document types
	13.8.1 Considerations

	13.9 Custom lists
	13.9.1 CBS URL columns

	13.10 Attribute definitions
	13.11 Menu options

	Chapter 14 — Control settings
	14.0.1 Considerations
	14.1 Project tracking
	14.2 Tasks
	14.2.1 Organizational and project level
	14.2.1.1 Generate WBS phase code automatically
	14.2.1.2 Enable Manual Snapshots
	14.2.1.3 Default CE values to be updated from CB values

	14.2.2 Project level
	14.2.2.4 Maintain CBS Structure at a specific level
	14.2.2.5 Allow syncs to replace manual snapshots


	14.3 Actuals
	14.4 Estimated actuals
	14.5 Time-phasing
	14.5.1 Budget
	14.5.2 Enable time-phasing for budget
	14.5.3 Edit previous time-phased budget values
	14.5.4 Switching off time phasing budget

	14.6 Forecast
	14.7 Time-phasing
	14.7.1 Forecasting

	14.8 Forecast
	14.8.1 Percent complete value at which delta from straight line calculation utilizes average performance
	14.8.2 Mandatory notes for manual forecasts

	14.9 Custom forecast method calculations
	14.9.1 Enable Forecast methods based on Allow as-built selections

	14.10 Estimate resources
	14.11 Estimate resources
	14.11.1 Wage rate composition

	14.12 Schedule
	14.13 Schedule
	14.14 Define project schedule
	14.15 Cost curves
	14.15.1 Manage cost curve tables
	Add a custom cost curve table
	View a cost curve table
	Delete a cost curve table


	14.16 Plug day calculation
	14.17 Schedule ID
	14.18 Revenue
	14.19 Revenue
	14.20 Revenue and cost timing
	14.20.1 InEight Change integration

	14.21 Billing method default earnings rules
	14.21.1 Fixed final price and Unit price
	14.21.2 Cost plus

	14.22 Pay item to Cost item Forecast (T/O) qty relationship
	14.22.1 Enable pay item Forecast (T/O) quantity rollups
	14.22.2 Enable pay item Forecast (T/O) quantity roll down

	14.23 Markup
	14.24 Sync integrations
	14.25 Sync integrations
	14.25.1 Organizational level
	14.25.1.1 Actual cost and man-hour sync options

	14.25.2 Project level
	14.25.2.2 Sync integrations schedule

	14.25.3 Considerations

	14.26 Others
	14.27 Others
	14.27.1 Organizational level
	14.27.1.1 Required cost items
	14.27.1.2 Change order details

	14.27.2 Project level
	14.27.2.3 Required cost items
	14.27.2.4 Decimal precision


	14.28 Frequently Asked Questions
	14.29 Frequently Asked Questions
	14.30 Workflows
	14.30.1 Product Workflows
	14.30.1.1 InEight Control General Workflow

	14.30.2 Business Process Workflows
	14.30.2.2 Cost Budgeting and Forecasting: Budget Management
	14.30.2.3 Cost Budgeting and Forecasting: Forecasting
	14.30.2.4 Billing Management
	14.30.2.5 Earned Value Management




